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0003 1. Introducción

Características
Nuevo sensor de imagen CMOS de 
pantalla completa de 36×24 mm

Admite la captura de imagen con resoluciones de 
hasta 6048 × 4032 píxeles.* Al cambiar el modo 
de imagen, la unidad puede admitir de forma 
nativa muchos formatos de filmación, incluidos 
el Super 35 de 24,3 × 12,8 mm con resolución 
4096 × 2160 píxeles (equivalente a la película de 
imagen en movimiento de 3 perforaciones) y el 
Super 35 4:3 anamórfico* de 24,3 × 18,3 mm con 
resolución de 4096 × 3024 píxeles (equivalente 
a la película de imagen en movimiento de 
4 perforaciones).
*	 Los modos anamórfico y de pantalla completa requieren 

licencias que se venden por separado.

Latitud amplia

La unidad admite más de 15 paradas de latitud. 
Produce muy poco ruido y proporciona imágenes 
estupendas en condiciones que van desde la luz 
solar cegadora hasta casi la ausencia de luz, lo que 
permite una libertad creativa sin precedentes a la 
hora de corregir el color.

Amplia captura del espacio de color

Las imágenes pueden capturarse en un espacio de 
color que supere DCI-P3. El grado de libertad de la 
corrección de color mejora drásticamente al usar 
el espacio de color S-Gamut y S-Gamut3.Cine de 
Sony junto con S-Log3.

Base ISO doble

La unidad admite dos ajustes ISO nativos 
seleccionables (ISO500 e ISO2500). El uso de Base 
ISO500 en condiciones de iluminación normales y 
Base ISO2500 en condiciones de poca iluminación 
le permite mantener el equilibrio de latitud en 
condiciones de mucha y poca luz al filmar, sin 
granulado (ruido).

Soporte del objetivo PL

Equipada con el soporte del objetivo PL estándar 
en el sector. El soporte del objetivo admite la 
tecnología Cooke /i y la información del objetivo 
se graba como metadatos fotograma por 
fotograma.

Objetivo con soporte E

Los objetivos con soporte E son compatibles si se 
extrae el adaptador del objetivo PL. Los objetivos 
con soporte E son más pequeños y más ligeros que 
los objetivos PL, y están disponibles en una gama 
diversa para disfrutar de posibilidades ampliadas en la 
reproducción de imágenes.

Cuerpo compacto y uso intuitivo

Un diseño relativamente compacto para un 
dispositivo equipado con un gran sensor de 
imágenes de pantalla completa conseguido 
gracias a la tecnología de miniaturización de Sony, 
que permite una filmación más fácil en espacios 
reducidos o en drones.
La posición, la forma y el tamaño de los botones 
de control reflejan los requisitos de los operadores 
de la cámara para que el uso sea intuitivo. También 
cuentan con retroiluminación para que sea más 
fácil utilizarlos en lugares oscuros.

Diseñada para sobrevivir

El chasis está hecho de aleación de magnesio para 
proporcionarle una gran solidez y durabilidad. El 
sistema de ventilación está totalmente aislado de 
todos los componentes electrónicos para evitar 
que entren polvo, arena y líquidos.*
El ventilador silencioso puede retirarse y limpiarse 
en el set rápida y fácilmente para mantener una 
alta disponibilidad.
*	 El diseño protege contra el polvo y la lluvia, pero no 

puede evitar totalmente que entren polvo y líquido.

Diseño modular

Cuenta con un diseño totalmente modular que le 
permite sostener con flexibilidad varios aparejos y 
equipos periféricos en función de la aplicación de 
la filmación. El asa y el visor superiores se ajustan 
fácilmente para mantener el equilibrio ergonómico 
y la facilidad de uso con los objetivos. La altura del 
eje óptico es la misma que la de la PMW-F55, lo 
que permite el uso de dispositivos periféricos con 
la PMW-F55. Además, se puede conectar de forma 

segura un grabador de memoria portátil AXS-R7 
a la parte trasera de la unidad con cuatro tornillos 
hexagonales.

Filtro ND óptico de 8 posiciones

Utiliza un filtro ND óptico de 8 posiciones. Ofrece 
una amplia rango ND de 0.3ND (1/2 = 1 parada) a 
2.4ND (1/256 = 8 paradas) que reduce la pérdida de 
tiempo en el set al cambiar los filtros ND externos. 
El mecanismo del filtro ND cuenta con servocontrol.

Uso familiar e intuitivo en el set

La pantalla del menú está disponible en ambos 
lados de la cámara y la pantalla de control principal 
se encuentra en el lado del asistente de la cámara 
para que el asistente acceda rápido a los ajustes de 
la cámara durante la filmación.
Una pantalla en miniatura OLED en el lado del 
operador permite que el operador acceda a las 
funciones de acceso frecuente como la posición 
del filtro ND, el obturador, el equilibrio del blanco, 
el índice de exposición (EI) y la velocidad de 
fotograma (FPS), por lo que podrá comprobar el 
estado de la unidad con comodidad.

Control de pintura de RM/RCP y esta 
unidad

La unidad admite el control desde un panel RM/
RCP que puede utilizarse con videocámaras 
de retransmisión y cámaras de sistemas. Al 
conectarse, se pueden seleccionar el espacio de 
color ITU-R Rec. 2020 y HLG, y es compatible el 
ajuste de diversos parámetros de pintura.
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Las operaciones de control de pintura también son 
compatibles si se utiliza el menú completo de la 
unidad.

Filmación High Frame Rate (HFR)

La grabación 4K X-OCN a velocidades de 
fotogramas de hasta 120 fps es compatible si se 
utiliza la unidad junto con un AXS-R7.

Compatibilidad con la unidad de 
control remoto

Al conectar una RM-B170 u otra unidad de control 
remoto, puede controlar algunas funciones de la 
unidad desde la unidad de control remote incluso 
si Technical > System Configuration > RM/RCP 
Paint Control (página 83) se ha establecido en 
Off en el menú completo.

Diversos formatos de grabación

La unidad admite la grabación en tarjetas de 
memoria SxS en los formatos XAVC 4K/QFHD, 
MPEG HD y HD ProRes 422. Además, puede grabar 
con los formatos RAW de 16 bits o X-OCN en la 
tarjeta de memoria AXS cuando se utiliza junto 
con un grabador de memoria portátil AXS-R7 
opcional.

Extensión de bloques del generador 
de imágenes

El bloque de generador de imágenes se puede 
extender desde el cuerpo de la cámara 2,7 m o 
5,5 m conectando el sistema de extensión de 
cámara CBK-3610XS1).
El bloque de generador de imágenes se puede 
extender desde el cuerpo de la cámara 12 m o 3 m 
conectando el sistema de extensión de cámara 
CBK-3620XS2).
1)	 Actualizar a la versión de firmware 3.0 o superior.
2)	 Actualizar a la versión de firmware 6.3 o superior.

Tamaño de imagen efectivo

La unidad admite la filmación en los siguientes tamaños de imagen efectivos.

[Nota]
Se requiere una licencia de software para filmar en 6K 17:9, 6K 1.85:1, 6K 2.39:1, 6K 3:2, 5.7K 16:9, 4K 4:3 y 4K 6:5.

6K 3:2

6K 1.85:1

6K 17:9

4K 6:5

4K 4:3

6K 2.39:1

4K 2.39:1

4K 17:9
(DCI 4K)

3.8K 16:9
(Ultra HD)

5.7K 16:9
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Licencias de software

Puede seleccionar licencias de software (opcional) en función del uso previsto de la unidad.
Las licencias de software se instalan en Maintenance > License Options (página 88) en el menú 
completo.

Licencias de software Modo del 
generador de 
imágenes

Número de 
píxeles 
efectivos
(Píxeles de 
imagen)

Ancho × Alto 
(mm)

Velocidad de fotogramas del 
proyecto

Licencia no requerida 1) 3.8K 16:9 3840 × 2160 22,8 × 12,8 23, 24, 25, 29, 50, 59
3.8K 16:9 
Surround View

3840 × 2160
(4268 × 2400)

22,8 × 12,8
(25,4 × 14,3)

23, 24, 25, 29

4K 2.39:1 4096 × 1716 24,3 × 10,3 23, 24, 25, 29, 47, 50, 59
4K 17:9 4096 × 2160 24,3 × 12,8 23, 24, 25, 29, 47, 50, 59
4K 17:9 
Surround View

4096 × 2160
(4552 × 2400)

24,3 × 12,8
(27,0 × 14,3)

23, 24, 25, 29

Licencia Anamorphic 4K 4:3 4096 × 3024 24,3 × 18,0 23, 24, 25, 29, 47, 502), 592)

4K 4:3 Surround 
View

4096 × 3024
(4552 × 3360)

24,3 × 18,0
(27,0 × 20,0)

23, 24, 25, 29

4K 6:5 4096 × 3432 24,3 × 20,4 23, 24, 25, 29, 472), 502), 592)

Licencia Full Frame 1) 5.7K 16:9 5674 × 3192 33,7 × 18,9 23, 24, 25, 29, 502), 592)

6K 2.39:1 6048 × 2534 35,9 × 15,0 23, 24, 25, 29, 472) 3), 502) 3), 592) 3)

6K 17:9 6054 × 3192 36,0 × 19,0 23, 24, 25, 29, 472) 3), 502) 3), 592) 3)

6K 1.85:1	 6054 × 3272 36,0 × 19,4 23, 24, 25, 29, 472) 3), 502) 3), 592) 3)

6K 3:2 6048 × 4032 35,9 × 24,0 23, 24, 25, 292), 472) 3), 502) 3), 592) 3)

1)	 La licencia Anamorphic es necesaria para habilitar ajustes de relaciones distintos a Off(1.0×) para la función de 
descompresión.

2)	 Solo cuando se activa una licencia High Frame Rate.
3)	 La grabación AXS es compatible, pero la reproducción AXS no es compatible en la unidad.

Velocidades de fotogramas de la filmación y valores De-Squeeze compatibles

En la siguiente tabla se muestran las velocidades de fotogramas de la filmación y los valores De-Squeeze 
compatibles (página 68) en cada modo del generador de imágenes.

Licencia Full Frame Licencia Anamorphic Licencia High Frame Rate

Modo del generador 
de imágenes

Velocidad de fotogramas de la 
filmación

De-Squeeze 

Estándar Velocidades de 
fotogramas de 
extensión

Off (1.0×) 1.25× 1.3× 1.5× 1.65× 1.8× 2.0×

6K 3:2 1 a 25 Hasta 60 Sí Sí Sí Sí Sí Sí Sí
6K 1.85:1 1 a 30 Hasta 60, 66, 72 Sí – – – – – –
6K 17:9 1 a 30 Hasta 60, 66, 72 Sí Sí Sí – Sí Sí Sí
6K 2.39:1 1 a 30 Hasta 60, 66, 72, 75, 

88, 90
Sí – – – – – –

5.7K 16:9 1 a 30 Hasta 60, 66, 72 Sí – – – – – –
4K 6:5 1) 1 a 30 Hasta 60, 66, 72 Sí – – – – – Sí
4K 4:3 Surround 1 a 30 – Sí – Sí – Sí Sí Sí
4K 4:3 2) 1 a 48 hasta 60, 66, 72, 75 Sí – Sí – Sí Sí Sí
4K 17:9 Surround 1 a 48 – Sí Sí Sí – Sí Sí Sí
4K 17:9 1 a 60 66, 72, 75, 88, 90, 96, 

100, 110
Sí Sí Sí – Sí Sí Sí

4K 2.39:1 1 a 60 66, 72, 75, 88, 90, 96, 
100, 110, 120

Sí – – – – – –

3.8K 16:9 Surround 1 a 48 – Sí – – – – – –
3.8K 16:9 1 a 60 66, 72, 75, 88, 90, 96, 

100, 110
Sí – – – – – –

1)	 La opción Only Off (1.0×) está disponible cuando SxS Rec Format se ajusta en ProRes 4444 HD P.
2)	 Las opciones Only Off (1.0×) y 1.3× están disponibles cuando SxS Rec Format se ajusta en ProRes 4444 HD P.
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Surround View

Surround View es un modo disponible en los siguientes modos de imagen que muestra un rango de 
imagen que incluye un 5% de región exterior más allá del tamaño efectivo de la imagen (arriba/abajo/
izquierda/derecha) en el visor y la salida del monitor SDI, lo que le permite visualizar un rango de imagen 
mayor al filmar. La imagen grabada no incluye la región exterior.
3.8K 16:9
4K 17:9
4K 4:3

[Notas]
ˎˎ En este modo, pueden aplicarse las limitaciones del ajuste de la velocidad de fotogramas del proyecto.
ˎˎ En el modo 4K 4:3 con una relación de descompresión de 2.0×, el área de la imagen solo incluye el 5% de las regiones 

exteriores superior e inferior.
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Configuración del sistema

MPC-3610

Adaptador para hombro 
VCT-FSA5

Visor 
DVF-L700 
(cable VF (A-2201-632-A o 
A-2201-633-A) necesario)

Visor 
DVF-EL200
(cable VF A-2203-
745-A (suministrado 
con la unidad) o 
1-912-598-21 
necesario)

Micrófono 
ECM-680S, ECM-678, 
ECM-674 
(EC-0.5X3F5M necesario)

Conjunto de la base del soporte del micrófono (A-2182-
620-B) 
Abrazadera de la varilla (A-2182-621-B) 
Varilla (4-684-612-01)
Conjunto del soporte del micrófono (X-2596-733-2)
Tornillos P2.6×8 (2) (7-627-556-98)

Tarjeta de memoria SxS 
SBP-64/128/256E, SBS-32/64/128G1C, SBP-240F/120F 
 
Tarjeta de memoria XQD 
QD-G32E/G64E/G120F/G240F 
(adaptador de QDA-EX1 XQD ExpressCard necesario)

Lector de tarjetas de memoria SxS 
SBAC-US30/T40

Adaptador de CA 
AC-DN10A

Lector de tarjetas de memoria 
AXS 
AXS-AR1

Batería 
BP-FL75, BP-GL95B

Objetivo PL S35 
SCL-PK6, 
SCL-P11X15

Licencia 
Anamorphic 
CBKZ-3610A, 
CBKZ-3610AM, 
CBKZ-3610AW

Licencia Full Frame 
CBKZ-3610F, 
CBKZ-3610FM, 
CBKZ-3610FW

Objetivo Anamorphic
(soporte PL/soporte E)

Sistema de extensión de 
cámara 
CBK-3610XS 
CBK-3620XS

Objetivo Full Frame
(soporte PL/soporte E)

Objetivo con soporte E 
SELP28135G, SEL1635GM, SEL2470GM, SEL70200GM, SEL100400GM, SEL1224G, 
SEL35F14Z, SEL50F14Z, SEL85F14GM, SEL90M28G, SEL100F28GM

Grabadora de 
memoria portátil  
AXS-R7

Tarjeta de memoria AXS 
AXS-A256S24, AXS-A512S48, 
AXS-A512S24, AXS-A1TS48 
AXS-A1TS24

Lector de tarjetas de 
memoria AXS 
AXS-AR1, AXS-CR1

Unidad de control remoto 
RM-B170/B750 
RCP-1000/1500/1530/3500 
RCP-1001/1501/3501

Licencia High Frame 
Rate 
CBKZ-3610H 
CBKZ-3610HM 
CBKZ-3610HW
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Posición y función de los componentes
Lado del operador

4

678910111213

15

16

14

1 2 3

5

Entrada de 
aire

Bloque de ranuras para  
tarjetas de memoria SxS (página 9)

1.	 Botones ASSIGN 1/2 (asignables) 
(página 43)
Asigne funciones en la página EDIT de la 
pantalla de funciones del usuario 
(página 43).
La función asignada cambiará entre on/off 
(habilitada/deshabilitada) o se activará cada 
vez que los pulse.

2.	 Testigos ASSIGN 1/2 (asignables) 
(página 43)
Cada testigo se ilumina en color naranja 
cuando la función asignada está habilitada o 
activada, y permanece apagado cuando está 
apagada (deshabilitada).

3.	 Teclas ITEM de 1 a 3 de la pantalla en 
miniatura
Controle el funcionamiento de las funciones 
en la pantalla en miniatura (página 92).

4.	 Pantalla en miniatura
Muestra los distintos elementos de 
configuración que se pueden comprobar o 
modificar; por ejemplo, el ángulo del 
obturador (página 92).

5.	 Testigos ACCESS (SLOT A/B)
Cada testigo se enciende cuando el soporte 
de grabación de la ranura para tarjetas SxS A/B 
es el destino de grabación/reproducción y 
cuando los datos se escriben en el soporte de 

grabación de la ranura para tarjetas SxS A/B o 
se leen desde allí (página 24).

6.	 Conector de red (RJ-45)
Conéctelo a una red LAN con cable usando un 
cable LAN (no suministrado) para el control 
remoto de la unidad (página 95).

7.	 Botón CLIPS
Púlselo para mostrar la pantalla de clips en la 
pantalla en miniatura para activar las 
operaciones de clips (página 94).
Al mismo tiempo, la pantalla de la lista de clips 
se muestra en la pantalla secundaria y también 
puede usarse las operaciones de clips.
Pulse el botón HOME para cambiar del modo 
de reproducción al modo de filmación.

8.	 Interruptor de alimentación
Ajústelo en la posición ON () para encender la 
videocámara. Ajústelo en la posición OFF () 
para apagar la videocámara.

	 [Notas]
ˎˎ Esta unidad utiliza una cantidad pequeña de 

alimentación en espera aunque el interruptor de 
alimentación esté ajustado en OFF. Retire la batería 
si no se va a utilizar la unidad durante un periodo 
prolongado.
ˎˎ Al quitar la batería o la alimentación DC IN, asegúrese 

de colocar en primer lugar el interruptor de 
alimentación en la posición OFF. La interrupción del 
suministro de alimentación durante la grabación o 
mientras se accede a una tarjeta de memoria puede 
causar un error de funcionamiento.

9.	 Botón HOME
Púlselo para anular la selección de elementos y 
volver a la pantalla Home de la pantalla en 
miniatura.
Si lo pulsa cuando la unidad está en estado de 
reproducción, la unidad pasa al modo de 
filmación (página 92).

10.	 Interruptor LOCK
Bloquea el funcionamiento de los botones del 
lado del operador. Cuando está bloqueado, los 
LED de fondo se iluminan en color naranja.

11.	 Conector de auriculares (minitoma estéreo)
Conecte los auriculares para monitorizar el 
audio. Puede monitorizar el audio de entrada 
durante la filmación/grabación y el sonido de 
reproducción durante la reproducción 
(página 91).

12.	 Altavoz integrado
Puede monitorizar el audio de entrada durante 
la filmación/grabación y el sonido de 
reproducción durante la reproducción. 
Además, el altavoz emite alarmas para reforzar 
las advertencias visuales (página 91).
Si conecta los auriculares a la toma para 
auriculares, la salida del altavoz se suprimirá 
automáticamente.

13.	 Testigo REC ACTIVE
El testigo se ilumina en verde cuando el botón 
REC está habilitado.

14.	 Testigo ASSIGN 3 (asignable) (página 43)
El testigo se ilumina en color naranja cuando la 
función asignada está habilitada o activada y 
permanece apagado cuando está apagada 
(deshabilitada).

15.	 Botón/testigo REC (inicio/parada de la 
grabación)
Púlselo para comenzar la grabación, lo que 
enciende el testigo REC. Púlselo para detener 
la grabación, lo que apaga el testigo REC 
(página 100).
El testigo REC parpadea cuando se produce 
una advertencia o un error del dispositivo.

16.	 Marca f
La marca f se encuentra en el mismo plano 
que el sensor de imagen.
Para medir la distancia exacta entre la unidad y 
el sujeto, utilice la marca f como referencia.
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Bloque de ranuras para tarjetas de memoria SxS 
(página 24)

Las ranuras para tarjetas de memoria SxS están 
situadas detrás de la tapa.

1

3

2

1.	 Ranuras A/B para tarjetas de memoria SxS

2.	 Terminal de calibración del fabricante
Terminal del fabricante para la calibración y el 
mantenimiento (los usuarios no pueden 
utilizarlo).

3.	 Botón SLOT SELECT (selección de tarjeta de 
memoria SxS)
Púlselo para cambiar de ranura activa.

Lado del asistente

1 2 3 4

6

5

7

8

9

1011
12

13
14

15
16

17

18
1 2 3

4 5 6

1.	 Botón ASSIGN 4 (asignable) (página 43)
Asigne funciones en la página EDIT de la 
pantalla de funciones del usuario 
(página 43).
La función asignada cambiará entre on/off 
(habilitada/deshabilitada) o se activará cada 
vez que los pulse.

2.	 Testigo ASSIGN 4 (asignable) (página 43)
El testigo se ilumina en color naranja cuando la 
función asignada está habilitada o activada y 
permanece apagado cuando está apagada 
(deshabilitada).

3.	 Pantalla secundaria
Permite comprobar el estado de 
funcionamiento de la unidad y llevar a cabo 
distintos ajustes (página 32).
Mantenga pulsado el botón BACK 
(página 10) y gire el mando SEL/SET 
mientras se muestra la pantalla Home para 
ajustar el brillo de la pantalla secundaria y de la 
pantalla en miniatura.
También se puede ajustar el brillo en el menú 
completo con Technical > Control Display > 
Brightness level (página 86).

4.	 Teclas ITEM de 1 a 6 de la pantalla secundaria
Controlan el funcionamiento de las funciones 
en la pantalla secundaria (página 49).

5.	 Gancho para cinta métrica
El gancho para cinta métrica se encuentra en 
el mismo plano que el sensor de imagen. Para 
medir la distancia exacta entre la unidad y el 
sujeto, utilice el gancho para cinta métrica 
como referencia. Puede colocar el extremo de 
una cinta métrica en el gancho y medir la 
distancia a la que se encuentra el sujeto.

6.	 Botón HOME
Púlselo para borrar la pantalla y volver a la 
pantalla Home de la pantalla secundaria 
(página 34).
Si lo pulsa cuando la unidad está en estado de 
reproducción, la unidad pasa al modo de 
filmación.

7.	 Botón MENU (visualización del menú on/off ) 
(páginas 49, 62)
Pulse el botón MENU para mostrar la pantalla 
del menú en la pantalla secundaria. Mantenga 
pulsado el botón MENU durante 2 segundos 
como mínimo para mostrar la pantalla del 
menú completo en la pantalla secundaria. 
Pulse el botón mientras se muestran la pantalla 
del menú o la pantalla del menú completo 
para volver a la visualización de la pantalla 
anterior.

8.	 Mando SEL/SET (seleccionar/configurar) 
(mando MENU)
Cambia la selección de elementos o un ajuste del 
menú (páginas 34, 49, 62).

9.	 Testigo de alimentación de +48V
Se ilumina en verde si el interruptor AUDIO IN 
está configurado en MIC y si se suministra la 
potencia fantasma de +48 V en el conector 
AUDIO IN. No se ilumina si no se suministra la 
potencia fantasma.
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Puede activar/desactivar la potencia fantasma 
de +48 V en la categoría Audio > Audio Details 
> Audio Configuration > Phantom Power +48V 
(página 80) del menú.

10.	 Interruptor AUDIO IN (selector de audio)
Seleccione el tipo de señal de entrada 
correspondiente a la fuente de audio 
conectada al conector AUDIO IN.
LINE: cuando se conecta una fuente de señal 

de audio analógica externa 
AES/EBU: cuando se conecta una fuente de 

señal de audio digital externa
MIC: cuando se conecta un micrófono

11.	 Conector AUDIO IN (XLR 5 terminales)
Permite la entrada de señales de micrófonos o 
equipos de audio externos.
Cuando la fuente de audio se ha ajustado en 
LINE o MIC con el interruptor AUDIO IN, este 
conector actúa como un conector AUDIO IN 
CH-1 y AUDIO IN CH-2.
Cuando la fuente de audio se ha ajustado en 
AES/EBU con el interruptor AUDIO IN, este 
conector actúa como el conector AUDIO IN 
CH-1/2 y AUDIO IN CH-3/4.

12.	 Botón BACK
Cancela los ajustes de menú y sube un nivel en 
la jerarquía mientras se está visualizando el 
menú. Cancela el proceso en ejecución o los 
procesos pendientes cuando están en curso 
(páginas 34, 49, 62).

13.	 Interruptor LOCK
Bloquea el funcionamiento de los botones del 
lado del asistente. Cuando está bloqueado, los 
LED de fondo se iluminan en color naranja.

14.	 Testigo ACCESS (acceso a tarjeta SD) 
(página 26)

15.	 Testigo REC ACTIVE
El testigo se ilumina en verde cuando el botón 
REC está habilitado.

16.	 Botón/testigo REC (inicio/parada de la 
grabación)
Púlselo para comenzar la grabación, lo que 
enciende el testigo REC. Púlselo para detener 
la grabación, lo que apaga el testigo REC 
(página 100).
El testigo REC parpadea cuando se produce 
una advertencia o un error del dispositivo.

17.	 Botón CLIPS
Púlselo para mostrar la pantalla de la lista de 
clips en la pantalla secundaria para activar las 
operaciones de clips (página 89).
Al mismo tiempo, aparece la pantalla de clips 
en la pantalla en miniatura.
Pulse el botón HOME para cambiar del modo 
de reproducción al modo de filmación.

18.	 Botón USER
Púlselo para visualizar la lista de funciones del 
usuario en la pantalla secundaria y para utilizar 
los botones de las funciones del usuario de las 
teclas ITEM de 1 a 5.
La tecla ITEM 6 es el botón EDIT de la lista de 
funciones del usuario. Pulse este botón para 
mostrar la pantalla de selección de funciones 
para los botones de funciones del usuario y los 
botones asignables. Púlselo otra vez cuando se 
muestre la pantalla de funciones del usuario 
para volver a la pantalla anterior (página 43).

Parte delantera

1

23

4

5

1.	 Botón ASSIGN 3 (asignable) (página 43)
Asigne funciones en la página EDIT de la 
pantalla de funciones del usuario 
(página 43).
La función asignada cambiará entre on/off 
(habilitada/deshabilitada) o se activará cada 
vez que los pulse.

2.	 Adaptador de soporte del objetivo PL 
(página 19)

3.	 Conector VF (salida del visor) (página 22)

4.	 Conector LENS (12 terminales)
Admite control de iris, enfoque y zoom desde 
un ordenador, smartphone o tableta 
conectados a la red en la versión 4.0 o superior 
del firmware.

5.	 Conector 24V OUT (salida de 24 V de CC, 
Fischer, 3 terminales)
Conector de salida del suministro de 
alimentación de 24 V de CC (página 113).
La tensión de salida y la corriente de salida 
máxima de este conector varían en función de 
la tensión de entrada a la unidad. La corriente 
máxima incluye la corriente de salida desde el 
conector 24V OUT en el panel trasero 
(página 11).

Entrada de 11 V a 17 V
Tensión de salida: 24 V
Corriente de salida máxima: 1,0 A

Entrada de 22 V a 32 V
Tensión de salida: la misma que la tensión 
de entrada
Corriente de salida máxima: 2,0 A
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Parte trasera

2
1

3
4
5
6

7

8

9

10
11
12
13

1.	 Conector 24V OUT (salida de 24 V de CC, 
Fischer, 3 terminales)
Conector de salida del suministro de 
alimentación de 24 V de CC (página 113).
La tensión de salida y la corriente de salida 
máxima de este conector varían en función de 
la tensión de entrada a la unidad. La corriente 
máxima incluye la corriente de salida desde el 
conector 24V OUT en el panel frontal 
(página 10).

Entrada de 11 V a 17 V
Tensión de salida: 24 V
Corriente de salida máxima: 1,0 A

Entrada de 22 V a 32 V
Tensión de salida: la misma que la tensión 
de entrada
Corriente de salida máxima: 2,0 A

2.	 Conector 12V OUT (salida de 12V de CC, 
Hirose, 4 terminales)
Conector de salida del suministro de 
alimentación de 12 V de CC (página 113).

La tensión de salida y la corriente de salida 
máxima de este conector varían en función de 
la tensión de entrada a la unidad.

Entrada de 11 V a 17 V
Tensión de salida: la misma que la tensión 
de entrada
Corriente de salida máxima: 1,0 A

Entrada de 22 V a 32 V
Tensión de salida: 15 V
Corriente de salida máxima: 0,8 A

3.	 Conector MONITOR OUT (tipo BNC)
Conector de salida de la señal del monitor HD 
SDI (página 113).

4.	 Conector GENLOCK (entrada Genlock) (tipo 
BNC)
Para utilizar la función Genlock de la unidad o 
bloquear el código de tiempo de esta en una 
fuente externa, introduzca una señal de 
referencia externa.
Se admite la entrada de la señal digital y la 
señal analógica.

Señal digital: señal entrelazada HDSDI 1.5G
Señal analógica: Sincronización HD, Analog

5.	 Conector TC IN (entrada de código de 
tiempo) (tipo BNC)
Para bloquear el código de tiempo de la 
unidad en una fuente externa, introduzca una 
señal de código de tiempo de referencia.

6.	 Conector AUX (LEMO, 5 terminales)
Emite la señal del código de tiempo 
(página 114).

7.	 Conector REMOTE (control remoto) 
(8 terminales)
Conéctelo a una unidad de control remoto u 
otro dispositivo de control externo.

8.	 Conector 12V/24V (entrada de alimentación 
de CC) (página 16)
Conector de entrada para el suministro de 
alimentación de CC externo a la unidad. 
Admite la tensión de entrada de 12 V y 24 V.

N.º Señal
1 GND

2 NC

3 NC

4 DC IN (de 11 V a 17 V o de 22 V a 32 V 
de CC)

9.	 Terminal para la colocación de la batería 
(página 16)

10.	 Conectores SDI OUT 1 a 4 (salida digital en 
serie) (tipo BNC) (página 113)

11.	 Soporte para la batería (página 16)

12.	 Palanca de desbloqueo de la batería 
(página 16)

13.	 Conector HDMI OUT (página 113)
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Parte superior

1 2 3 4

1.	 Conector de dispositivo externo
Se utiliza para actualizar una grabadora AXS 
AXS-R7 (opcional) cuando la AXS-R7 se 
conecta a la unidad (página 30) o para usar 
el control remoto inalámbrico de la cámara 
(página 95) conectando un adaptador LAN 
inalámbrico CBK-WA02 (opcional).

2.	 Botón de desbloqueo (página 18)

3.	 Soporte del accesorio de acoplamiento VF/
asa (página 18)

4.	 Orificios de tornillo para montaje de 
accesorios
Tipo de tornillo: 1/4-20UNC (8)
Tipo de tornillo: 3/8-16UNC (10)
Carrera: 10 mm o menos

Base

3

1 2

Salida de aire

1.	 Perforaciones de conexión de la placa del 
trípode
Tipo de tornillo: 1/4-20UNC (2)
Tipo de tornillo: 3/8-16UNC (4)
Carrera: 9 mm o menos

2.	 Tapa inferior
Extraiga los cuatro tornillos hexagonales para 
sacar la tapa.

3.	 Ranura para tarjetas SD (página 26)
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Pantalla del visor / monitor

Durante la filmación (grabación o en espera) y reproducción, se muestra la información seleccionada en 
Monitoring > OSD Appearance > Status Info A/B Setup (página 74) en el menú completo.

Información que aparece en la pantalla durante la grabación

30
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1.	 Indicador de velocidad de fotograma de 
grabación
Muestra la velocidad de fotograma de 
grabación y la velocidad de fotograma del 
proyecto.

2.	 Indicador de la velocidad/ángulo del 
obturador
Muestra el ángulo o la velocidad del obturador 
electrónico, según la configuración de 
Technical > System Configuration en el menú 
completo.

3.	 Indicador del filtro ND
Muestra la densidad del filtro ND. El valor de la 
pantalla es un valor LOG (base 10) 
(página 63).

CLEAR
0.3 (1/2)
0.6 (1/4)
0.9 (1/8)
1.2 (1/16)
1.5 (1/32)
1.8 (1/64)
2.1 (1/128)
2.4 (1/256)

4.	 Icono del termómetro
Se muestra cuando se emite un mensaje de 
advertencia por alta temperatura.
La descripción se muestra en la categoría Info 
del menú.

5.	 Icono de advertencia
Se muestra cuando se emite un mensaje que 
no sea de advertencia por temperatura alta.
La descripción se muestra en la categoría Info 
del menú.

6.	 Índice de exposición (EI)/indicador de 
ganancia
Muestra el valor de EI o el valor de ganancia 
(unidades en dB) establecidos por una RM-
B170 u otra unidad de control remoto.

[Nota]
El valor de ganancia se muestra solo cuando se ajusta 
Technical > System Configuration > RM/RCP Paint 
Control (página 83) en On en el menú completo.

7.	 Indicador de temperatura de color
Muestra la temperatura de color y el valor del 
tinte del equilibrio del blanco.

8.	 Pantalla de información de Look
Muestra el Look seleccionado (página 66).

9.	 Indicador de tensión/capacidad de la batería
Muestra los siguientes indicadores según el 
tipo de batería.

Tipo de batería Pantalla
Batería Sony 
Info

Capacidad de batería y 
tiempo de grabación 
restantes

Batería Anton/
Bauer

Capacidad de batería 
restante (indicador de %)

Otras baterías Tensión de entrada

10.	 Indicador de bloqueo externo del código de 
tiempo/indicador de estado de Genlock
Muestra el estado bloqueado cuando el 
código de tiempo se bloquea en una fuente 
externa. Muestra el estado bloqueado cuando 
se aplica la función Genlock.

11.	 Indicador VF LUT
Muestra la LUT del visor (página 65).

12.	 Indicador VF Double Speed Scan
Muestra si la función que permite doblar la 
velocidad de fotograma de la pantalla del visor 
está activada o desactivada.

13.	 Indicador VF Peaking
Muestra si la función de nitidez de la pantalla 
del visor está activada o desactivada.

14.	 Indicador VF Zebra
Muestra si la función de cebra de la pantalla 
del visor está activada o desactivada 
(página 45).

15.	 Indicador LUT del conector SDI OUT 1/2
Muestra el ajuste de la LUT de los conectores 
SDI OUT 1/2 (página 64).

16.	 Indicador LUT del conector SDI OUT 3/4
Muestra el ajuste de la LUT de los conectores 
SDI OUT 3/4 (página 64).

17.	 Indicador LUT del monitor
Muestra el ajuste de la LUT de la salida Monitor 
(página 65).

18.	 Indicador HDMI LUT
Muestra el ajuste de la LUT de la salida HDMI 
(página 65).
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19.	 Indicador de activación REC de la salida SDI
Muestra el estado de activación REC de la salida SDI.

Estado Pantalla
Technical > System Configuration > SDI Rec Remote 
Trigger en el menú completo

Comando de 
grabación superpuesto 
en la salida SDI

Off – (Vacía)
HD SDI Remote I/F Comando Stop Superior: SDI

Inferior: Stop
Comando Rec Superior: SDI

Inferior: REC
Parallel Rec Comando Stop Superior: SDI-P

Inferior: Stop
Comando Rec Superior: SDI-P

Inferior: REC

20.	 Indicador del estado de la conexión de red
Muestra el estado de la conexión de red (LAN 
o Wi-Fi).

Estado Pantalla
Desconectado u otro error (ajustes 
de conexión de red válidos)

Parpadea

Conectado (ajustes de conexión de 
red válidos)

Encendido

Función de conexión de red no 
utilizada

Vacía

21.	 Indicador High Key/Low Key (salida de 
monitor)
Se muestra cuando la salida del monitor es 
High Key (pantalla para comprobar áreas 
resaltadas apagadas) o Low Key (pantalla para 
comprobar sombras bloqueadas) (se muestra 
para la salida del monitor).

22.	 Indicadores de medidor del nivel de audio
Muestra los niveles de audio de los canales 1 y 
2 durante la grabación.

23.	 Estado del soporte de grabación/indicador 
de capacidad restante en cada ranura de 
soporte
Muestra el estado y la capacidad restante del 

soporte en las ranuras A/B de las tarjetas de 
memoria SxS y AXS.
Una marca  a la izquierda de “AXS” o “SxS” 
indica el soporte de destino de grabación.
Un indicador  en la parte superior derecha 
del icono de la ranura A/B que se encuentra a 
la derecha de “AXS” o “SxS” indica el soporte de 
destino de reproducción (el indicador verde 
muestra que el soporte se está 
reproduciendo).
Se muestra un icono  para el soporte si se 
produce una condición que pudiera tener un 
impacto negativo en la grabación.

24.	 Indicador gráfico del indicador de nivel de 
burbuja
Muestra la inclinación horizontal de la unidad 
en incrementos de ±0,1°, hasta ±10°.
Puede establecer el ajuste en cero del 
indicador de nivel de burbuja ejecutando 
Technical > Special Configuration > Level 
Gauge Adjust (página 83) en el menú 
completo. 
Cuando se conecta un CBK-3620XS a la unidad, 
puede establecer el ajuste en cero del 
indicador de nivel de burbuja del CBK-3620XS 
ejecutando Technical > Special Configuration 

> 3620XS Lev. Gauge Adj. (página 84) en el 
menú completo.

25.	 Indicador del formato del soporte de 
grabación (códec)
Muestra el formato de la grabación en una 
tarjeta de memoria AXS o SxS.

26.	 Indicador de estado de la grabación
Muestra los siguientes estados de grabación 
de la unidad.

Pantalla Descripción

 Rec Grabación

 Stby Grabación en espera

 Cache Grabación en espera de 
caché de imágenes

 CALL Comando CALL entrante

27.	 Pantalla de nombre del clip
Muestra los 8 primeros caracteres del nombre 
del siguiente clip que se grabará en el modo 
de grabación en espera.
Durante la grabación, muestra los 8 primeros 
caracteres del nombre del clip que se está 
grabando en ese momento.

28.	 Indicador High Key/Low Key (salida de visor)
Se muestra cuando la salida del visor es High 
Key (pantalla para comprobar áreas resaltadas 
apagadas) o Low Key (pantalla para comprobar 
sombras bloqueadas) (se muestra para la salida 
del visor).

29.	 Pantalla de datos de tiempo
Muestra la duración o el código de tiempo en 
función del ajuste de la categoría TC/Media > 
TC Display del menú (página 50).

30.	 Indicador de posición del iris
Muestra la posición del iris (solo cuando está 
acoplado un objetivo compatible con la 
función de visualización del ajuste del iris).  
El indicador de posición del iris se muestra en 

incrementos de parada de 1/3 al usar un 
objetivo con soporte E.

[Nota]
El valor F-stop se muestra en lugar del valor T-stop si no 
puede obtenerse el valor T-stop.

31.	 Indicador de posición de enfoque
Muestra la posición de enfoque (solo cuando 
está acoplado un objetivo compatible con la 
función de visualización del ajuste de 
enfoque).

32.	 Indicador de posición del zoom
Muestra la distancia focal del zoom (se 
visualiza solo cuando se conecta un objetivo 
que admite el indicador del ajuste de zoom).

33.	 Indicador de nivel de burbuja
Muestra información numérica del nivel 
horizontal.
R (Roll) indica la inclinación horizontal de 
izquierda a derecha de la unidad.
T (Tilt) indica la inclinación vertical de adelante 
hacia atrás de la unidad.
Puede establecer el ajuste en cero del 
indicador de nivel de burbuja ejecutando 
Technical > Special Configuration > Level 
Gauge Adjust (página 83) en el menú 
completo. 
Cuando se conecta un CBK-3620XS a la unidad, 
se muestra la información del indicador de 
nivel de burbuja del sensor de imagen del 
CBK-3620XS. Puede establecer el ajuste en cero 
del indicador de nivel de burbuja del 
CBK‑3620XS ejecutando Technical > Special 
Configuration > 3620XS Lev. Gauge Adj. 
(página 84) en el menú completo.

34.	 Indicador de estado de grabación simultánea
Muestra el formato de grabación del clip 
secundario en el modo de grabación 
simultánea en 1 ranura (página 101).

35.	 Indicador SxS Sub LUT
Muestra el ajuste LUT para registrarlo para un 
clip secundario en el modo de grabación 
simultánea en 1 ranura SxS.
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36.	 Indicador LUT SxS
Muestra el ajuste LUT para la grabación SxS.

37.	 Indicador Base ISO
Muestra la sensibilidad base configurada.

38.	 Indicador del tamaño de imagen efectivo
Muestra el tamaño de imagen efectivo y si se 
aplica la conversión de la descompresión 
anamórfica, que se ajusta a través de la 
categoría Project > Imager Mode en el menú. 
En el modo Surround View, se muestra un 
icono “Sur.V” debajo del icono de la relación de 
conversión anamórfica (página 50).

Configuración y visualización del menú en la 
pantalla del visor

Cuando se conecta una DVF-EL200 a la unidad, 
mantenga presionado el botón de la DVF-EL200 
para ver los menús de configuración Monitoring 
> VF Display (página 78) y VF Function 
(página 79) en la pantalla del visor. Esto le 
permite configurar estas funciones mientras ve la 
pantalla del visor.

Información mostrada en la pantalla de reproducción

La información siguiente aparece en la imagen de reproducción.

98

54321

6
7

1.	 Pantalla de datos de tiempo
Muestra la duración o el código de tiempo en 
función del ajuste de la categoría TC/Media > 
TC Display del menú (página 50).

2.	 Pantalla de nombre del clip en reproducción
Muestra los 8 primeros caracteres del nombre 
del clip en reproducción.

3.	 Indicador de estado de reproducción
Muestra el estado de la reproducción.
Muestra “CALL” cuando se recibe un comando 
CALL.

4.	 Indicador del formato del soporte de 
reproducción (códec)
Muestra el formato de grabación (códec) del 
clip en reproducción.

5.	 Indicador de soporte de reproducción
Muestra el tipo de soporte de grabación que 
se está reproduciendo.
Si la tarjeta de memoria está protegida contra 

escritura aparece un icono  a la derecha.

6.	 Indicadores de medidor del nivel de audio
Muestra los niveles de audio de los canales 1 y 
2 durante la reproducción.

7.	 Indicador del estado de la conexión de red
Muestra el estado de la conexión de red (LAN 
o Wi-Fi).

Estado Pantalla
Desconectado u otro error (ajustes 
de conexión de red válidos)

Parpadea

Conectado (ajustes de conexión de 
red válidos)

Encendido

Función de conexión de red no 
utilizada

Vacía

8.	 Icono del termómetro
Se muestra cuando se emite un mensaje de 
advertencia por alta temperatura.
La descripción se muestra en la categoría Info 
del menú.

9.	 Icono de advertencia
Se muestra cuando se emite un mensaje que 
no sea de advertencia por temperatura alta.
La descripción se muestra en la categoría Info 
del menú.
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Preparación del suministro de alimentación
Puede usar la batería o la alimentación de CA a 
través de un adaptador de CA.
Por su seguridad, utilice sólo las baterías y los 
adaptadores de CA Sony que se enumeran a 
continuación.

Batería de ion-litio
BP-FL75
BP-GL95B

Adaptador de CA
AC-DN10A

Uso de una batería

Introduzca la batería en el soporte de la batería 
(página 11) del adaptador de la batería y, 
después, muévala hacia abajo hasta que encaje.
Para extraerla, desbloquee la batería deslizándola 
hacia arriba y pulsando al mismo tiempo la 
palanca de desbloqueo de la batería (página 11). 
Después, extráigala.

[Notas]
ˎˎ Antes de utilizarla, cargue la batería con el cargador de 

batería.
ˎˎ Si una batería está caliente justo después de usarla, es 

posible que no se pueda recargar completamente.
ˎˎ Quite el adaptador de la batería mientras sujeta la unidad 

con la mano.

Comprobación de la carga restante de la batería

Cuando la grabación o reproducción está en curso 
con la batería, se muestran el tiempo restante de 
la batería y la tensión de la batería en la pantalla 
secundaria (página 32) y en la pantalla del visor/
monitor (página 13).
En la unidad se indica el tiempo restante de uso 
en minutos, calculando el tiempo disponible con 
la batería si el uso continúa al mismo nivel de 
consumo de alimentación.

Si la carga restante de la batería llega a ser baja

Si la carga restante de la batería baja hasta un 
nivel determinado durante el funcionamiento, 
el indicador de capacidad restante de la batería 
parpadea y el testigo REC parpadea para avisarle.
Si la carga restante disminuye aún más hasta un 
nivel en el que no puede seguir funcionando, 
aparece un mensaje de aviso de batería agotada.
Sustituya la batería por una que esté 
completamente cargada.

Para cambiar los niveles de los mensajes

Para cambiar los niveles, vaya a Technical > Battery 
(página 86) en el menú completo.

Uso de la alimentación de CA 
(alimentación DC IN) 

La unidad puede funcionar con alimentación de 
CA mediante los adaptadores de CA AC-DN10A 
(opcional) o AC-DN2B (opcional) y el cable de CC 
CCDD-X2 (opcional).
Admite los rangos de tensión de entrada de entre 
11 V y 17 V y de entre 22 V y 32 V.

[Notas]
ˎˎ Cuando cambie al suministro de alimentación DC IN 

durante el funcionamiento de la batería, utilice una fuente 
de alimentación que tenga un rango de tensión de entre 
12 V y 17 V.
ˎˎ Si utiliza tensiones de 22 V a 32 V, antes de conectar la 

fuente de alimentación, debe ajustar el interruptor de 
alimentación en la posición OFF.
ˎˎ No cambie directamente de una fuente de alimentación 

de 11 V a 17 V a una de 22 V a 32 V o viceversa. Esto podría 
provocar un error de funcionamiento.

Uso conjunto de una batería y de una 
fuente de alimentación DC IN

Siempre que se aplica un suministro de 
alimentación activo utilizando una batería y un 
suministro de alimentación DC IN, se da prioridad 
al segundo.

[Nota]
Cuando se cambia del funcionamiento con batería al 
suministro de alimentación DC IN, es posible que la unidad 
deje de funcionar si se dan las siguientes circunstancias.
ˎˎ Vibración de los contactos del conector cuando se inserta 

el conector de CC
ˎˎ Caída de tensión al cambiar entre fuentes de alimentación 

(más frecuente cuando la carga externa es mayor)
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Ajuste del reloj
Cuando utilice la unidad por primera vez, la 
pantalla de configuración inicial aparecerá en 
la pantalla secundaria al estar la alimentación 
encendida.
Ajuste la fecha y hora del reloj integrado desde la 
pantalla.

Time Zone

El valor muestra la diferencia horaria con respecto 
al UTC (Tiempo Universal Coordinado). En caso 
necesario, cambie el ajuste.

[Nota]
Cuando cambia el ajuste Time Zone, el ajuste del reloj 
cambia según la diferencia horaria.

Ajuste de fecha y hora

Gire el mando MENU (página 9) para mover 
el cursor y, después, pulse el mando MENU para 
configurar cada opción del menú. Si pulsa el 
mando MENU cuando el cursor se encuentra 
en “Set”, la pantalla de ajuste desaparece y ha 
terminado la configuración del reloj.
Cuando haya desaparecido la pantalla de 
configuración inicial, podrá modificar el ajuste 
Time Zone y los ajustes de fecha y hora desde 
Maintenance > Clock Set (página 87) en el menú 
completo.

[Notas]
ˎˎ Si el ajuste del reloj se borra porque la batería de reserva 

se agota al no recibir alimentación (funcionamiento sin 
batería ni conexión DC IN), la pantalla Configuración inicial 
aparecerá la próxima vez que encienda la unidad.
ˎˎ Cuando se muestre la pantalla Configuración inicial, 

no se podrá realizar ninguna otra operación excepto 
desconectar la alimentación hasta que termine los ajustes 
de esta pantalla.
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Colocación del asa y accesorio de acoplamiento VF
Colocación del accesorio de 
acoplamiento VF

1	 Para colocar el accesorio de acoplamiento VF, 
deslícelo en la dirección de la flecha.

2	 Coloque el accesorio de acoplamiento VF en la 
posición delantera/trasera deseada y gire la 
palanca de bloqueo para fijarlo.

1

2

Palanca de 
bloqueo

	 [Notas]
ˎˎ También puede colocar el acoplamiento VF en la 

orientación frontal/trasera o derecha/izquierda.
ˎˎ Si le cuesta tensar o aflojar la palanca de bloqueo, 

puede utilizar una llave hexagonal (3 mm) en el 
tornillo de bloqueo de la parte superior de la palanca 
de bloqueo.

Extracción del accesorio de acoplamiento VF

Gire la palanca de bloqueo para liberarla, pulse el 
botón de desbloqueo y extraiga el accesorio de 
acoplamiento VF en la dirección opuesta a la que 
lo colocó.

Colocación del asa

1	 Para colocar el asa, deslícela en la dirección de 
la flecha.

2	 Coloque el asa en la posición delantera/trasera 
deseada y gire la palanca de bloqueo para 
fijarla.

2

1

Tornillo de 
bloqueo

Perno 
hexagonal

Palanca de 
bloqueo

	 [Notas]
ˎˎ Para fijarla, también puede colocar un tornillo de 

bloqueo con una llave hexagonal (5 mm).
ˎˎ Si la palanca de bloqueo del asa se libera al usarla, 

puede volver a fijar el asa ajustando un perno 
hexagonal (2 mm) junto al tornillo de bloqueo.
ˎˎ También puede colocar el asa en la orientación 

opuesta.

Extracción del asa

Gire la palanca de bloqueo para liberarla, pulse 
el botón de desbloqueo y extraiga el asa en la 
dirección opuesta a la que la colocó.
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Montaje de un objetivo y ajuste de la distancia focal del plano de montaje
Objetivo con soporte PL recomendado (tamaño Super 
35mm)
SCL-PK6/F, SCL-PK6/M (juego de 6 objetivos, 
20 mm/25 mm/35 mm/50 mm/85 mm/135 mm)
SCL-PK3/F, SCL-PK3/M (juego de 3 objetivos, 
20 mm/25 mm/135 mm)
SCL-P11X15

Objetivo con soporte E recomendado
SELP28135G, SEL1635GM, SEL2470GM, 
SEL70200GM, SEL100400GM, SEL1224G, 
SEL35F14Z, SEL50F14Z, SEL85F14GM, SEL90M28G, 
SEL100F28GM

[Nota]
Puede que algunos objetivos con soporte E no soporten el 
control. Use un objetivo recomendado.

Para obtener más información sobre los objetivos que 
pueden utilizarse con la unidad, póngase en contacto con un 
representante del servicio de Sony.

[PRECAUCIÓN]
No deje el objetivo apuntando al sol. La luz 
solar directa puede entrar a través del objetivo, 
concentrarse en la unidad y producir un incendio.

[Notas]
ˎˎ Apague la unidad antes de colocar o quitar el objetivo y 

el adaptador.
ˎˎ Un objetivo es un componente de precisión. No deje el 

objetivo hacia abajo, con el lado del soporte hacia abajo. 
Colóquele la tapa suministrada con el objetivo.
ˎˎ El interfaz del objetivo de la unidad está configurado 

con los ajustes predeterminados de fábrica para un 
SCL-P11X15 y objetivos con conector de tipo Cooke. Para 
usar un SCL-PK6, un SCL-PK3 u otros objetivos que no 
tienen un conector de tipo Cooke, ajuste Technical > Lens 
Configuration > PL-Mt Interface Position (página 84) 
en Off en el menú completo. Si el ajuste no es correcto, 
aparece un mensaje de alerta al encender la unidad 
después de colocar el objetivo.

Instalación de un objetivo con 
soporte PL

1	 Quite la tapa del soporte del objetivo girando 
la palanca de soporte PL en el sentido 
contrario a las agujas del reloj.

Palanca de 
soporte PL

	 [Nota]
Gire la palanca de soporte PL en el sentido contrario a 
las agujas del reloj hasta la posición del tope.

2	 Introduzca el objetivo en el soporte haciendo 
coincidir la parte cóncava del objetivo con el 
pasador de posición de la parte superior 
derecha del soporte del objetivo.

3	 Fije el objetivo sujetándolo y girando la 
palanca de soporte PL en el sentido de las 
agujas del reloj.

	 [Nota]
No gire el objetivo cuando esté colocando el objetivo 
con soporte PL. Podría provocar datos en la conexión 
directa mediante zapata.

Montaje de un objetivo Cooke/i

Haga coincidir los contactos del objetivo con 
la zapata caliente de la unidad. En el lado del 
adaptador del objetivo hay dos conectores y 
puede utilizar cualquiera de ellos.

Extracción del objetivo

1	 Sujetando el objetivo por debajo, gire la 
palanca del soporte PL en sentido contrario a 
las agujas del reloj.

2	 A continuación, tire del objetivo.

	 [Nota]
Si no va a instalar otro objetivo de forma inmediata, 
haga coincidir la parte cóncava de la tapa del soporte 
y, a continuación, fije la tapa del soporte girando la 
palanca de soporte PL en el sentido de las agujas del 
reloj.

Ajuste de la distancia focal del plano 
de montaje

La unidad se suministra con el ajuste de la 
distancia focal del plano de montaje configurado. 
Si necesita ajustar la distancia focal del plano de 
montaje, extraiga el soporte del objetivo y cambie 
las arandelas por otras del grosor adecuado. Puede 
ajustar el grosor en ±0,1 mm en incrementos de 
0,01 mm.

Arandelas

La unidad se suministra con las siguientes 
arandelas:
1 arandela de 0,05 mm (circular)
15 arandelas de 0,01 mm (1/3 arco)
Las arandelas de 1/3 de arco siempre se deben 
usar como un conjunto de tres arandelas. Inserte 
las arandelas para aumentar la distancia focal del 
plano de montaje. La unidad se suministra con el 
ajuste de la distancia focal del plano de montaje 
configurado utilizando los tres tipos de arandelas 
siguientes:
0,10 mm (circular)
0,05 mm (circular)
0,01 mm (1/3 arco)
Cuando se suministra, se añade un sello que 
muestra el grosor de la arandela.

Ajuste de la distancia focal del plano de montaje

1	 Retire los seis tornillos Torx y extraiga el plano 
de soporte PL.
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1

Plano de soporte PL

2	 Afloje los tornillos Phillips de ambos lados de 
los conectores PL (dos puntos) y extraiga los 
conectores PL y las placas de los conectores 
PL.

3	 Fije las arandelas al adaptador del soporte PL 
(tres puntos).

33

33
33

22
22

Conectores PL

Placas de los conectores 
PL

Al usar arandelas de 1/3 de arco
Fije las arandelas de manera que tengan el 
mismo grosor en los tres puntos.

Arandelas

Al usar arandelas circulares
Fíjelas a la superficie que tiene marcas hacia la 
parte frontal.

Marcas

Marcas

4	 Vuelva a fijar los conectores PC (dos puntos) en 
sus posiciones originales y ajuste los cuatro 
tornillos Phillips con un par de apriete de 
0,18 N·m.

5	 Vuelva a colocar el plano de soporte PL en su 
posición original y apriete los seis tornillos Torx 
con un par de apriete de 0,35 N·m utilizando 
una llave dinamométrica T8.

Limpieza del filtro

Para limpiar el filtro, retire primero el adaptador. 
Tenga cuidado al limpiar la parte central del 
adaptador con un paño o con otro material para 
evitar que las fibras se adhieran a las superficies. 
Si se adhieren fibras, límpielas con un cepillo suave.

Adaptador

Extracción del adaptador del objetivo 
PL

Extraiga el adaptador del objetivo PL si desea 
montar un objetivo con soporte E en la unidad. La 
conexión/extracción se realiza con el lado trasero 
de la unidad orientado hacia abajo.
Retire los seis tornillos hexagonales (2,5 mm) y 
retire el adaptador del objetivo PL.

Adaptador del 
objetivo PL 

[Notas]
ˎˎ La extracción de la batería y la colocación del lado trasero 

de la unidad orientado hacia abajo ofrece estabilidad.
ˎˎ Al conectar/retirar el adaptador, procure no tocar los 

contactos del conector de la unidad y el adaptador del 
objetivo PL.
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Para conectar el adaptador del objetivo PL

1	 Compruebe si la palanca del soporte está en la 
posición de bloqueado.

Palanca de 
soporte

2	 Vuelva a colocar el adaptador del objetivo PL 
en su posición original, inserte los seis tornillos 
hexagonales (2,5 mm) y ajústelos con un par 
de apriete de 0,8 ± 0,12 N·m utilizando una 
llave dinamométrica (2,5 mm).

Instalación de un objetivo con 
soporte E

1	 Retire el adaptador del objetivo PL 
(página 20).

2	 Empuje hacia arriba el interruptor de bloqueo 
y gire la palanca de soporte en el sentido de 
las agujas del reloj para liberar el bloqueo.

Palanca de 
soporte

Interruptor de 
bloqueo

3	 Alinee las marcas de soporte (color blanco) en 
la unidad y el soporte del objetivo y, a 
continuación, inserte el objetivo en el soporte.

4	 Fije el objetivo sujetándolo y girando la 
palanca de soporte en el sentido contrario de 
las agujas del reloj.

 

Marcas de soporte 
(color blanco)

[Nota]
Cuando se conecta un objetivo con soporte E, no se 
garantiza el funcionamiento utilizando un conector de 
objetivo de 12 terminales.

Extracción del objetivo

1	 Empuje hacia arriba el interruptor de bloqueo 
y gire la palanca de soporte en el sentido de 
las agujas del reloj para liberar el bloqueo.

2	 A continuación, tire del objetivo.

	 [Nota]
Si no va a instalar otro objetivo de forma inmediata, 
haga coincidir la parte cóncava de la tapa del soporte 
y, a continuación, fije la tapa del soporte girando la 
palanca de soporte en el sentido contrario de las agujas 
del reloj.
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Instalación de un visor
Visores disponibles para la unidad
DVF-EL200: visor en color OLED
DVF-L700: visor en color LCD

Los visores están disponibles por separado.
Este apartado describe cómo instalar el DVF-EL200 
a modo de ejemplo.

Para obtener más información sobre la instalación de los visores, 
consulte las instrucciones de funcionamiento del visor.

[PRECAUCIÓN]
No deje la unidad con el ocular del visor hacia 
el sol. La luz del sol puede entrar por el ocular, 
enfocarse en el visor y provocar fuego.

[Notas]
ˎˎ Fije/retire el visor mientras la unidad está apagada.
ˎˎ Para instalar el DVF-L700, es necesario un cable VF 

(A-2201-632-A o A-2201-633-A). Encienda la unidad una 
vez configurado el interruptor POWER del DVF-L700 en la 
posición ON.

Instalación de un visor

1	 Alinee la zapata del visor con la ranura del 
soporte del visor en el accesorio de 
acoplamiento VF e instale el visor.

2	 Gire la pantalla de bloqueo del visor a la 
dirección LOCK para fijarla en posición.

2

1

Palanca de 
bloqueo

3	 Conecte el visor y la unidad con el cable de 
conexión VF.
Lado del visor:
Sitúe el conector con la marca roja en la parte 
superior e insértelo por completo.
Lado de la cámara:
Haga coincidir la parte cóncava del conector 
VF con la marca roja del conector e inserte el 
conector por completo.

Abrazadera

	 [Nota]
Fije el cable en la abrazadera según sea necesario.

Desmontaje del visor

1	 Desconecte el cable de conexión VF del visor y 
de la unidad.

2	 Gire la palanca de bloqueo en la dirección 
opuesta a LOCK y extraiga el visor del 
accesorio de acoplamiento VF.

Ajuste de la posición del visor

Ajuste de la posición delantera/trasera

1	 Afloje una o las dos palancas de bloqueo de la 
varilla delanteras/traseras del accesorio de 
acoplamiento VF.

2	 Deslice el accesorio de acoplamiento VF hacia 
adelante/atrás para ajustar la posición del visor.

11
11

22

Palancas de 
bloqueo de 
la varilla

3	 Apriete las palancas de bloqueo de la varilla.

	 [Nota]
Si es difícil girar una palanca de bloqueo de la varilla, 
extraiga la palanca, póngala en una posición en la que 
sea fácil accionarla y vuelva a introducir la palanca.
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Para ajustar la posición izquierda/delantera y de la 
altura (ángulo)

1	 Afloje la palanca de bloqueo de la varilla 
situada en la parte delantera del accesorio de 
acoplamiento VF.

2	 Deslice la varilla del accesorio de acoplamiento 
VF hacia la izquierda/derecha y gire la varilla 
hacia arriba/abajo para ajustar la posición del 
visor.

11

22
22

Tornillo de 
bloqueo

Palanca de 
bloqueo de la 
varilla

3	 Apriete la palanca de bloqueo de la varilla.

	 [Nota]
Cuando haya soltado la palanca de bloqueo de la varilla, 
ajuste el tornillo de bloqueo con la llave hexagonal 
(3 mm) para evitar que el visor se caiga.

Para ajustar el ángulo del visor

Puede ajustar el ángulo del visor durante la 
filmación.

1	 Afloje la palanca de bloqueo de rotación del 
soporte del visor.

2	 Gire el visor hacia arriba/abajo para ajustar el 
ángulo.

11

22

Palanca de bloqueo de rotación

3	 Apriete la palanca de bloqueo de rotación.
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Manipulación de tarjetas de memoria SxS
Esta unidad graba audio y vídeo en tarjetas de 
memoria SxS (opcionales) cargadas en las ranuras 
para tarjetas.

Sobre las tarjetas de memoria SxS

Utilice las siguientes tarjetas de memoria SxS o 
tarjetas de memoria XQD de Sony.*
*	 Cuando se utiliza una tarjeta de memoria XQD, debe 

utilizarse el adaptador XQD ExpressCard (QDA-EX1).

Las tarjetas de memoria compatibles varían en 
función del formato de grabación.

SxS PRO X
SBP-240F/120F: compatibles con todos los 
formatos de grabación.

SxS PRO+
SBP-256D/E, SBP-128B/C/D/E, SBP-64B/C/D/E: 
compatibles con todos los formatos de grabación

SxS PRO
SBP-64A, SBP-32: 
MPEG 1920×1080i, HD ProRes 422,  
HD ProRes 422 Proxy

SxS-1
SBS-128G1B/C, SBS-64G1A/B/C, SBS-32G1A/B/C:
MPEG 1920×1080i, HD ProRes 422,  
HD ProRes 422 Proxy

Tarjeta de memoria XQD de la serie S y la serie G
QD-S64E, QD-S32E, QD-G128A/E, QD-G64A/E, QD-
G32A/E, QD-G120F, QD-G240F: compatible con 
todos los formatos de grabación

Tarjeta de memoria XQD de la serie N y la serie M
QD-N64, QD-M128A, QD-M64A, QD-M32A: 
MPEG 1920×1080i, HD ProRes 422 Proxy

No se garantiza un funcionamiento correcto con 
otras tarjetas de memoria.
Estas tarjetas de memoria son compatibles con el 
estándar ExpressCard.

Para obtener más información sobre cómo utilizar tarjetas de 
memoria SxS y sobre las precauciones relacionadas con su uso, 
consulte el manual de instrucciones de la tarjeta de memoria 
SxS.

ˎˎ SxS, SxS PRO y SxS-1 son marcas comerciales de 
Sony Corporation.
ˎˎ XQD es una marca comercial de Sony 
Corporation.
ˎˎ La marca y el logotipo ExpressCard son 
propiedad de Personal Computer Memory 
Card International Association (PCMCIA) y son 
utilizados por Sony Corporation bajo licencia.
ˎˎ ProRes es una marca comercial registrada de 
Apple Inc.

El resto de marcas comerciales son propiedad de 
sus respectivos propietarios.

Colocación de una tarjeta de 
memoria SxS

1	 Abra la tapa del bloque de ranuras para 
tarjetas (página 9).

2	 Introduzca la tarjeta de memoria SxS en la 
ranura con la etiqueta SxS mirando hacia la 
derecha.
El testigo ACCESS (página 8) se ilumina en 
rojo y después pasa a verde cuando la tarjeta 
de memoria está lista para su uso.

3	 Cierre la tapa.

Estado del testigo ACCESS

Cada una de las ranuras para tarjetas A y B tiene un 
testigo ACCESS que indica el estado de la ranura.

Testigo Estado de la ranura
Se ilumina en 
rojo

Accediendo a la tarjeta de 
memoria SxS (escribiendo/
leyendo datos)

Se ilumina en 
verde

En espera (listo para grabar o 
reproducir usando la tarjeta de 
memoria SxS)

Apagado ˎˎ No se ha cargado ninguna 
tarjeta de memoria SxS. 

ˎˎ La tarjeta cargada no es válida. 

ˎˎ Se ha cargado una tarjeta de 
memoria SxS, pero la otra ranura 
está seleccionada.

Extracción de una tarjeta de memoria 
SxS

1	 Abra la tapa del bloque de ranuras para 
tarjetas.

2	 Extraiga la tarjeta de memoria SxS.

[Nota]
No se garantiza la integridad de los datos si se desconecta 
la alimentación o si se extrae la tarjeta de memoria cuando 
se esté accediendo a la tarjeta. Se podrían destruir todos los 
datos de la tarjeta. Compruebe que el testigo ACCESS está 
iluminado en verde o está apagado cuando desconecte la 
alimentación o extraiga las tarjetas de memoria.

Cambio entre tarjetas de memoria 
SxS

Cuando se hayan cargado tarjetas de memoria 
SxS en las ranuras A y B, pulse el botón SLOT 
SELECT (página 9) para seleccionar la tarjeta de 
memoria SxS que desee usar.
Si una tarjeta se queda sin capacidad, la cámara 
cambia automáticamente a la segunda tarjeta y la 
grabación continúa.

[Nota]
El botón SLOT SELECT queda inhabilitado durante la 
grabación/reproducción. Las tarjetas de memoria no se 
pueden cambiar aunque pulse el botón.
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Formateo (inicialización) de las 
tarjetas de memoria SxS

Cuando se carga una tarjeta de memoria SxS 
formateada o no en otra especificación, aparece 
un mensaje que indica que el soporte tiene 
otro sistema de archivos. En ese caso, formatee 
la tarjeta de memoria mediante el siguiente 
procedimiento.

1	 Seleccione la categoría TC/Media > Format 
Media en el menú.

2	 Seleccione SxS Slot A (ranura A) o SxS Slot B 
(ranura B) y, a continuación, pulse el mando 
MENU.
Aparecerá una pantalla de confirmación 
preguntándole si desea formatear la tarjeta.

3	 Mantenga pulsadas la tecla ITEM 1 y la tecla 
ITEM 3 durante 3 segundos para formatear.
El formateo se iniciará, aparecerá un mensaje 
durante la ejecución y el testigo ACCESS se 
iluminará en rojo.
Cuando finalice el formateo, aparecerá un 
mensaje de finalización. Pulse el mando MENU 
para ignorar el mensaje.

Si falla el formateo

No se podrá formatear una tarjeta de memoria SxS 
con protección contra escritura ni una tarjeta de 
memoria que no sea compatible con esta unidad.
Aparecerá un mensaje de advertencia. Sustituya la 
tarjeta por una tarjeta de memoria SxS adecuada 
según las instrucciones del mensaje.

[Nota]
Todos los datos, incluyendo las imágenes grabadas y los 
archivos de configuración, se borran cuando se formatea una 
tarjeta de memoria.

Formateo durante la grabación

Puede formatear la tarjeta de memoria SxS cargada 
en la otra ranura para tarjetas incluso durante la 
grabación.

Comprobación del tiempo de 
grabación restante

Durante la filmación (grabación o en espera) 
puede comprobar la capacidad restante de las 
tarjetas de memoria SxS cargadas en las ranuras 
con el indicador de capacidad restante del soporte 
de grabación en la pantalla Home de la pantalla 
secundaria (página 32) o en la pantalla del visor/
monitor (página 13).
El tiempo disponible para la grabación con el 
formato de vídeo actual (velocidad de bits de 
grabación) se calcula según el espacio restante de 
cada tarjeta y se muestra en minutos.

[Nota]
Si la tarjeta de memoria está protegida contra escritura, 
aparece un icono .

Cambio de tarjeta de memoria SxS

ˎˎ Si el tiempo total restante en las tarjetas de 
memoria insertadas durante la grabación llega 
a ser inferior al tiempo establecido mediante 
Technical > System Configuration > Media Near 
Full Alarm (página 83) en el menú completo, 
el indicador de la capacidad restante del soporte 
y el testigo REC parpadearán y sonará un aviso 
acústico para advertirle. Sustituya las tarjetas por 
otras con espacio suficiente.
ˎˎ Si sigue grabando, aparecerá el mensaje “Media 
Full” y la grabación se detendrá cuando el 
tiempo total de grabación restante llegue a ser 
0.

[Nota]
Se pueden grabar aproximadamente 600 clips en una tarjeta 
de memoria SxS como máximo.
La visualización del tiempo de grabación restante pasa a “0” 
y aparece el mensaje “Media Full” cuando se alcanza el límite 
del clip.

Restauración de una tarjeta de 
memoria SxS

Si por algún motivo se produce un error en la 
tarjeta de memoria, es necesario restaurarla antes 
de utilizarla.
Si se carga una tarjeta de memoria SxS que es 
necesario restaurar, se mostrará un mensaje en la 
pantalla secundaria que le indicará que realice la 
operación de restauración.
Para comenzar la restauración, seleccione Execute 
girando el mando MENU y, a continuación, pulse el 
mando MENU.
La restauración dará comienzo.
Durante la ejecución, aparecerá un mensaje y el 
testigo ACCESS se iluminará en rojo.
Cuando finalice la restauración, aparecerá un 
mensaje de finalización. Pulse el mando MENU 
para ignorar el mensaje.

Si falla la restauración

ˎˎ No se puede restaurar una tarjeta de memoria 
SxS protegida contra escritura o una en la que se 
haya producido un error. En tal caso, aparece un 
mensaje de advertencia. Cancele la protección 
contra escritura o sustituya la tarjeta según las 
instrucciones del mensaje.
ˎˎ Una tarjeta de memoria SxS en la que se haya 
producido un error puede volver a usarse si se 
reformatea.
ˎˎ Es posible restaurar algunos clips en 
determinados casos, aunque en otros no. La 
reproducción de los clips restablecidos vuelve a 
ser posible.

ˎˎ La siguiente operación puede restaurar una 
tarjeta de memoria SxS para la que aparezca 
repetidamente el mensaje “Could not Restore 
Some Clips” cada vez que intenta el proceso de 
restauración:

[1]	 Copie los clips necesarios en otra tarjeta de 
memoria SxS.

[2]	 Formatee la tarjeta de memoria SxS que no 
se puede usar en la unidad.

[3]	 Copie los clips necesarios de nuevo en la 
tarjeta de memoria SxS recién formateada.

[4]	 Actualice el archivo de gestión como se 
describe a continuación.

[Nota]
Asegúrese de utilizar esta unidad para restablecer los 
soportes grabados con ella.
Es posible que los soportes grabados con un dispositivo que 
no sea esta unidad o con una unidad de versión diferente 
(incluso del mismo modelo) no se restablezcan mediante 
esta unidad.

Actualización del archivo de gestión

Si los clips no pueden reproducirse, la 
actualización del archivo de gestión de la tarjeta 
puede mejorar esta situación.
En el menú completo, vaya a TC/Media > Update 
Media (página 72) para actualizar el archivo de 
gestión.
Si escribe un archivo XAVC importado con el 
visor RAW Viewer V2.2 o posterior en el directorio 
“XDROOT/Clip” de una tarjeta de memoria SxS 
directamente, dicho archivo puede volverse 
reproducible ejecutando Update Media.
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Manipulación de tarjetas SD para guardar los datos de configuración
Tiene la opción de guardar el archivo de 
configuración de la cámara en una tarjeta SD 
(opcional). De este modo, podrá cargar el archivo 
guardado desde la tarjeta SD.

Tarjetas SD compatibles

Tarjetas de memoria SDHC* (velocidad: 4 a 10, no 
UHS; capacidad: de 2 GB a 32 GB)
Tarjetas de memoria SD* (sistema de archivos: FAT 
16; capacidad: hasta 2 GB)
*	 Denominadas “tarjetas SD” en este manual.

Colocación de una tarjeta SD

Coloque una tarjeta SD en la ranura para tarjetas 
SD (página 12).
El testigo ACCESS (página 10) se ilumina en 
rojo y después pasa a verde cuando la tarjeta de 
memoria está lista para su uso.

Estado del testigo ACCESS

Testigo Estado de la ranura
Se ilumina en 
rojo

Accediendo a la tarjeta SD 
(escribiendo/leyendo datos)

Apagado ˎˎ Sin tarjeta SD cargada.

ˎˎ La tarjeta cargada no es válida.

Extracción de una tarjeta SD

Presione ligeramente la tarjeta SD y extráigala.

[Notas]
ˎˎ No se garantiza la integridad de los datos si se desconecta 

la alimentación o si se extrae la tarjeta de memoria 
cuando se esté accediendo a la tarjeta. Se podrían destruir 
todos los datos de la tarjeta. Compruebe que el testigo 
ACCESS está iluminado en verde o está apagado cuando 
desconecte la alimentación o extraiga las tarjetas de 
memoria.
ˎˎ Asegúrese de que la tarjeta no rebota al insertarla o 

extraerla.

Formateo (inicialización) de una 
tarjeta SD

Las tarjetas SD deben formatearse la primera vez 
que se utilizan en la unidad.
Las tarjetas SD que se van a usar en la unidad 
deben formatearse con la función de formato 
correspondiente de la unidad. Asimismo, también 
será necesario formatear una tarjeta de memoria 
SD si aparece un mensaje de advertencia al 
insertarla.
Si una tarjeta SD formateada con un formato no 
compatible se carga en la unidad, aparecerá un 
mensaje de error de coincidencia del sistema de 
archivos.

1	 En el menú, seleccione la categoría TC/Media 
> Format Media > SD Card y, a continuación, 
pulse el mando MENU.
Aparecerá una pantalla de confirmación 
preguntándole si desea formatear la tarjeta.

2	 Mantenga pulsadas la tecla ITEM 1 y la tecla 
ITEM 3 durante 3 segundos para formatear.
El formateo se iniciará, aparecerá un mensaje 
durante la ejecución y el testigo ACCESS se 
iluminará en rojo.

Cuando finalice el formateo, aparecerá un 
mensaje de finalización. Pulse el mando MENU 
para ignorar el mensaje.

[Nota]
Al formatear una tarjeta SD se eliminan todos sus datos y no 
pueden recuperarse.

Para utilizar soportes formateados con esta unidad 
en las ranuras de otros dispositivos

Realice una copia de seguridad del soporte y, 
a continuación, formatéelo utilizando el otro 
dispositivo.
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Uso con la AXS-R7
Puede grabar datos de vídeo/audio en RAW 
o X-OCN en una grabadora AXS-R7 (sistema 
de tarjeta de memoria de acceso) (opcional) 
conectando la grabadora a la unidad.

[Nota]
Para conectar una AXS-R7 a la unidad, es posible que la 
versión de firmware de la AXS-R7 tenga que actualizarse 
de acuerdo con la versión de la unidad (página 30). A 
continuación se muestra la compatibilidad entre versiones.

Versión de la unidad Versión de la AXS-R7
1.0, 1.01 1.1
2.01 2.0
3.0 3.0
4.0 4.0
5.0 5.0

Conexión de la AXS-R7

[Nota]
Fije/retire la AXS-R7 mientras la unidad está apagada.

1	 Retire los cuatro tornillos hexagonales (3 mm) 
de la parte trasera de la unidad y extraiga la 
placa de la batería.

Placa de la batería

2	 Retire los cuatro tornillos hexagonales de la 
parte trasera de la AXS-R7 y extraiga el módulo 
de conexión.

AXS-R7

Módulo de conexión

3	 Coloque la AXS-R7 en la unidad y apriete los 
cuatro tornillos hexagonales.

AXS-R7

Extracción de la AXS-R7

Retire los cuatro tornillos hexagonales y extraiga la 
AXS-R7.

Colocación de una tarjeta de 
memoria AXS

1	 Para abrir la tapa, pulse el botón de apertura 
de la tapa de la ranura de la tarjeta de 
memoria.

2	 Introduzca la tarjeta de memoria AXS en la 
ranura para tarjetas con la etiqueta orientada 
tal y como se indica a continuación.

Etiqueta

3	 Cierre la tapa.

Cambio entre tarjetas de memoria 
AXS

Cuando hay cargadas dos tarjetas de memoria 
AXS, pulse el botón SLOT SELECT de la AXS-R7 para 
cambiar a la ranura activa.

Botón SLOT SELECT

Extracción de una tarjeta de memoria 
AXS

Abra la tapa de la ranura para tarjetas de memoria 
de la AXS-R7 y extraiga la tarjeta de memoria AXS.

[Nota]
No se garantiza la integridad de los datos si se desconecta 
la alimentación o si se extrae una tarjeta de memoria AXS 
cuando se esté accediendo a ella. Se podrían destruir todos 
los datos de la tarjeta. Compruebe que el testigo ACCESS 
está iluminado en verde o está apagado cuando desconecte 
la alimentación o extraiga las tarjetas de memoria.
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Grabación en una tarjeta de memoria AXS

Para seleccionar el formato de grabación en una tarjeta de memoria AXS, vaya en el menú a la categoría 
Project > AXS Rec Format (página 50).
Durante la grabación independiente de AXS en la AXS-R7, la grabación cambia automáticamente a la 
segunda tarjeta de memoria AXS cuando la primera se llena.

Si usa una tarjeta de memoria AXS S24 o S48, se aplicarán las siguientes restricciones en función de los 
ajustes AXS Rec Format y Imager Mode. Si se detecta una tarjeta de memoria AXS S24 para un ajuste 
donde no se admiten tarjetas de memoria AXS S24, se mostrará un mensaje de advertencia.

[Nota]
La grabación simultánea en AXS no es compatible al grabar en formato de vídeo ProRes 4444 HD P.

AXS Rec Format Imager Mode Compatibilidad con la velocidad de fotogramas de la filmación y 
las tarjetas de memoria AXS S24/S48
24 25 30 48 50 60 75 110 120

X-OCN XT 3.8K 16:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 S48 –

3.8K 16:9 Surround 
View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – – – –

4K 2.39:1 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 S48

4K 17:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 S48 –

4K 17:9 Surround 
View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – – – –

4K 4:3 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 S48 – –

4K 4:3 Surround 
View

S24/
S48

S24/
S48

S24/
S48

– – – – – –

4K 6:5 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 – – –

5.7K 16:9 S24/
S48

S24/
S48

S48 S48 S48 – – – –

6K 2.39:1 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 – – –

6K 17:9 S24/
S48

S24/
S48

S48 S48 S48 – – – –

6K 1.85:1 S24/
S48

S24/
S48

S48 S48 S48 – – – –

6K 3:2 S48 S48 S48 – – – – – –

AXS Rec Format Imager Mode Compatibilidad con la velocidad de fotogramas de la filmación y 
las tarjetas de memoria AXS S24/S48
24 25 30 48 50 60 75 110 120

RAW SQ 3.8K 16:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 S48 –

3.8K 16:9 Surround 
View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – – – –

4K 17:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 –

4K 17:9 Surround 
View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – – – –

X-OCN ST 3.8K 16:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 S48 –

3.8K 16:9 Surround 
View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – – – –

4K 2.39:1 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48

4K 17:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 –

4K 17:9 Surround 
View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – – – –

4K 4:3 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 – –

4K 4:3 Surround 
View

S24/
S48

S24/
S48

S24/
S48

– – – – – –

4K 6:5 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 – – –

5.7K 16:9 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 – – –

6K 2.39:1 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 S48 – –

6K 17:9 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 – – –

6K 1.85:1 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 – – –

6K 3:2 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 – – –
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AXS Rec Format Imager Mode Compatibilidad con la velocidad de fotogramas de la filmación y 
las tarjetas de memoria AXS S24/S48
24 25 30 48 50 60 75 110 120

X-OCN LT 3.8K 16:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 S48 –

3.8K 16:9 Surround 
View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – – – –

4K 2.39:1 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

4K 17:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

–

4K 17:9 Surround 
View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – – – –

4K 4:3 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– –

4K 4:3 Surround 
View

S24/
S48

S24/
S48

S24/
S48

– – – – – –

4K 6:5 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 – – –

5.7K 16:9 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 – – –

6K 2.39:1 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– –

6K 17:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – –

6K 1.85:1 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

– – –

6K 3:2 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 – – –

Formateo (inicialización) de una 
tarjeta de memoria AXS

Las tarjetas de memoria AXS deben formatearse la 
primera vez que se utilizan en la AXS-R7 conectada 
a la unidad.
Utilice la función de formateo de la unidad para 
formatear tarjetas de memoria AXS y utilizarlas en 
la AXS-R7. Asimismo, es necesario formatear una 
tarjeta de memoria AXS si aparece un mensaje de 
precaución al encender la unidad con la AXS-R7 
conectada.

Si una tarjeta de memoria AXS formateada con un 
formato no compatible con la AXS-R7 se instala, 
aparecerá un mensaje de error de coincidencia del 
sistema de archivos.

1	 En el menú, seleccione la categoría TC/Media 
> Format Media y, a continuación, pulse el 
mando MENU.

2	 Seleccione AXS Slot A (ranura A) o AXS Slot B 
(ranura B).
Aparecerá una pantalla de confirmación 
preguntándole si desea formatear la tarjeta.

3	 Mantenga pulsadas la tecla ITEM 1 y la tecla 
ITEM 3 durante 3 segundos para formatear.
El formateo se iniciará, aparecerá un mensaje 
durante la ejecución y el testigo ACCESS se 
iluminará en rojo.
Cuando finalice el formateo, aparecerá un 
mensaje de finalización. Pulse el mando MENU 
para ignorar el mensaje.

[Nota]
Al formatear una tarjeta de memoria se eliminan todos sus 
datos y no pueden recuperarse.

Comprobación del tiempo de 
grabación restante

Durante la filmación (grabación o en espera) 
puede comprobar la capacidad restante de la 
tarjeta de memoria AXS cargada con el indicador 
de capacidad restante del soporte de grabación 
en la pantalla Home de la pantalla secundaria 
(página 32) o en la pantalla del visor/monitor 
(página 13).
El tiempo disponible para la grabación con el 
formato de vídeo actual (velocidad de bits de 
grabación) se calcula según el espacio restante de 
cada tarjeta y se muestra en minutos.

[Nota]
Si la tarjeta de memoria AXS está protegida contra escritura, 
aparece un icono .

Restauración de una tarjeta de 
memoria AXS

Si por algún motivo se produce un error en la 
tarjeta de memoria, es necesario restaurarla antes 
de utilizarla.
Si se carga una tarjeta de memoria AXS que es 

necesario restaurar, un mensaje le indicará que 
realice la operación de restauración.
Para comenzar la restauración, seleccione Execute 
girando el mando MENU y, a continuación, pulse el 
mando MENU.
La restauración dará comienzo.
Durante la ejecución, aparecerá un mensaje y el 
testigo ACCESS se iluminará en rojo.
Cuando finalice la restauración, aparecerá un 
mensaje de finalización. Pulse el mando MENU 
para ignorar el mensaje.

Si falla la restauración

ˎˎ No se puede restaurar una tarjeta de memoria 
AXS protegida contra escritura o una en la 
que se haya producido un error. En tal caso, 
aparece un mensaje de advertencia. Cancele la 
protección contra escritura o sustituya la tarjeta 
según las instrucciones del mensaje.
ˎˎ Una tarjeta de memoria AXS en la que se haya 
producido un error puede volver a usarse si se 
reformatea.
ˎˎ Es posible restaurar algunos clips en 
determinados casos, aunque en otros no. La 
reproducción de los clips restablecidos vuelve a 
ser posible.

[Nota]
Asegúrese de utilizar esta unidad para restablecer los 
soportes grabados con ella.
Es posible que los soportes grabados con un dispositivo que 
no sea esta unidad o con una unidad de versión diferente 
(incluso del mismo modelo) no se restablezcan mediante 
esta unidad.

Actualización del archivo de gestión

Si los clips no pueden reproducirse, la 
actualización del archivo de gestión de la tarjeta 
puede mejorar esta situación.
En el menú completo, vaya a TC/Media > Update 
Media (página 72) para actualizar el archivo de 
gestión.
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Actualización de la versión de 
firmware de la AXS-R7

Puede actualizar la versión de firmware de la 
AXS-R7 con la AXS-R7 conectada a la unidad.

[Notas]
ˎˎ La versión de firmware de la unidad debe ser 2.0 o 

posterior para llevar a cabo esta operación.
ˎˎ Ajuste AXS Rec Format (página 50) en Rec Off antes de 

realizar esta operación.

1	 Prepare una memoria flash USB de 4 GB a 32 GB 
para usarla durante la actualización.

2	 Formatee la memoria flash USB con un 
ordenador u otro dispositivo.
Los criterios de formateo se muestran a 
continuación. Las memorias flash USB 
formateadas de forma distinta no se pueden 
utilizar para la actualización.
Sistema de archivos: FAT32
Tamaño de la unidad de asignación: 32 KB

3	 Escriba los datos de la actualización 
especificada en el directorio raíz de la memoria 
flash USB formateada. 
No escriba en la memoria flash USB otros datos 
que no sean los de la actualización.

4	 Inserte el actualizador de memoria flash USB 
en el conector de dispositivos externos 
(página 12).

5	 Ejecute la función de actualización de la 
AXS-R7 usando Maintenance > Firmware > FW 
Update-AXS-R7 (página 88) en el menú 
completo.
El proceso de actualización de versión dura 
alrededor de 15 minutos. Cuando termina el 
proceso de actualización de versión, la unidad 
se reinicia automáticamente y se muestra 
“Firmware Upgrade Done”.
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Pantalla secundaria

3. Operaciones de la cámara

La pantalla secundaria muestra la pantalla de inicio, la pantalla de la lista de clips, la pantalla de reproducción, la pantalla del menú, la pantalla del menú 
completo y la pantalla de funciones del usuario.
Puede cambiar entre pantallas en la pantalla secundaria con los botones del lado del asistente de la unidad.

 

Pantalla de funciones del usuario

Pantalla Home Pantalla de la lista de clips

Pantalla del menú Pantalla del menú completo

Pantalla de reproducción

Botón USER

Botón USER

Botón MENU

Botón HOME

Botón HOME

Botón HOME

Botón CLIPS

Botón CLIPS

Botón CLIPS

Botón USER

Botón MENU

Botón MENU
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Pantalla Home

Pulse el botón HOME del lado del asistente para mostrar la pantalla Home. Puede consultar el estado de la 
unidad y configurar sus ajustes básicos desde la pantalla Home.

Zona de la pantalla 
de función/valor 
de ajuste/nombre 
del elemento

Zona de la 
pantalla de 
estado

Zona de la pantalla de función/valor de ajuste/
nombre del elemento

1 2 3

4 5 6

Tecla ITEM 4 Tecla ITEM 5 Tecla ITEM 6

Tecla ITEM 3Tecla ITEM 2Tecla ITEM 1

[Nota]
Las áreas etiquetadas con los números del 1 al 6 
corresponden a las teclas ITEM de 1 a 6 (página 43). Pulse 
la tecla ITEM para seleccionar el elemento correspondiente. 
Las teclas ITEM para funciones que se muestran con texto de 
color naranja están activadas.

1.	 FPS
Muestra y configura la velocidad de 
fotogramas de vídeo.

2.	 Exposure Index/Gain
Muestra y configura el índice de exposición (EI) 
o muestra la ganancia establecida por una 
RM-B170 u otra unidad de control remoto (el 
icono superior muestra la sensibilidad de 
base).

	 [Nota]
El valor de ganancia se muestra solo cuando se ajusta 
Technical > System Configuration > RM/RCP Paint 
Control (página 83) en On en el menú completo.

3.	 Shutter
Muestra y configura la velocidad/ángulo de 
obturación del obturador electrónico.

4.	 ND Filter
Muestra y configura la posición del filtro ND.

5.	 LUT
Muestra y configura la LUT del monitor.

6.	 WB (White Balance)
Muestra y configura el equilibrio del blanco.
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Zona de la pantalla de estado
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1.	 Pantalla de datos de tiempo
Muestra la duración o el código de tiempo en 
función del ajuste de la categoría TC/Media > 
TC Display del menú (página 50).
Muestra el tipo de datos que aparecen 
actualmente en la pantalla de datos de 
tiempo. Son los siguientes:
TCG: código de tiempo grabado
TCR: código de tiempo de reproducción
Dur: duración

2.	 Indicador de velocidad de fotograma
Muestra el valor del ajuste de la categoría 
Project > Project Frame Rate del menú 
(página 50).

3.	 Indicador de modo del generador de 
imágenes
Muestra el ajuste de la categoría Project > 
Imager Mode del menú y la información de 
descompresión.

4.	 Pantalla de nombre del clip
Muestra “Reel: Camera ID + Reel Number” y 
“ShotNumber”.

5.	 Medidores del nivel de audio
Indica los niveles de reproducción o de 
grabación de audio. Los números 1 y 2 indican 
los canales 1 y 2.

6.	 Indicador de grabación simultánea
Cuando está configurada la grabación 
simultánea en 1 ranura para el soporte 

mostrado, aparece el icono “Sub” a la derecha 
del formato de grabación principal mostrado.

7.	 Indicador del formato de grabación (códec)
Muestra el formato de la grabación en una 
tarjeta de memoria AXS o SxS (página 54).

8.	 Indicador de tensión del suministro de 
alimentación/capacidad restante de la 
batería
Muestra la tensión del suministro de 
alimentación o la capacidad restante de la 
batería.

9.	 Indicador de capacidad del soporte restante
Muestra el icono del soporte activo, el tipo de 
soporte, el tipo de ranura (A/B) y el tiempo de 
grabación restante (cuando se graba en el 
formato de grabación actual).
También muestra el nombre del clip durante la 
reproducción.

10.	 Indicador de estado de la grabación
Muestra los siguientes estados de grabación 
de la unidad.

Pantalla Descripción
     Stby     Grabación en espera

 Rec Grabación

 Cache Grabación en espera de 
caché de imágenes

     CALL Comando CALL entrante

11.	 Icono del termómetro
Se muestra cuando se emite un mensaje de 
advertencia por alta temperatura.
La descripción se muestra en la categoría Info 
del menú.

12.	 Icono de advertencia
Se muestra cuando se emite un mensaje que 
no sea de advertencia por temperatura alta.
La descripción se muestra en la categoría Info 
del menú.

13.	 Icono de Genlock
Muestra el estado bloqueado cuando se aplica 
la función Genlock.

14.	 Icono Ext-LK
Se muestra cuando el generador de código de 
tiempo interno se bloquea en una entrada de 
señal externa en el conector TC IN (entrada de 
código de tiempo).
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Operaciones de la pantalla Home en la pantalla secundaria
Procedimiento básico

1	 Pulse el botón HOME.
Aparecerá la pantalla Home.

2	 Seleccione el elemento que desee configurar 
con las teclas ITEM de 1 a 6.
El valor de ajuste de los elementos que se 
pueden modificar se muestra en naranja.
El siguiente diagrama muestra un ejemplo 
cuando se pulsa la tecla ITEM 3.

3	 Mueva el cursor al elemento o valor de ajuste 
para seleccionarlo con el botón  (tecla ITEM 
2), el botón  (tecla ITEM 5) o el mando 
MENU.

4	 Pulse el mando MENU o el botón Set (tecla 
ITEM 3) para aplicar el ajuste.

Modificación del brillo de la pantalla secundaria

Puede cambiar el brillo de la pantalla secundaria 
en el menú completo con Technical > Control 
Display > Brightness level (página 86).
También puede mantener pulsado el botón BACK 
y girar el mando MENU en el sentido de las agujas 
del reloj en la pantalla Home para cambiar el brillo 
de la pantalla secundaria en la secuencia Minimum 
 Low  Mid  High con el ajuste actual como 
punto base.
También puede mantener pulsado el botón BACK 
y girar el mando MENU en el sentido contrario al 
de las agujas del reloj para cambiar el brillo de la 
pantalla secundaria en la secuencia High  Mid 
 Low  Minimum con el ajuste actual como 
punto base.

[Nota]
El ajuste del brillo de la pantalla es común para la pantalla 
secundaria y la pantalla en miniatura y se refleja en ambas 
pantallas de forma simultánea.

Visualización y funcionamiento cuando se habilita 
RM/RCP Paint Control

ˎˎ Al ajustar Technical > System Configuration 
> RM/RCP Paint Control (página 83) en On 
en el menú completo, el valor de ganancia 
configurado por una RM-B170 u otra unidad 
de control remoto se mostrará en el área de 
control del EI. En este modo, el valor de EI no 
puede cambiarse, pero el valor de ganancia sí 
(página 35). No obstante, el ajuste Base ISO 
puede cambiarse.  
En este modo, se pueden configurar los ajustes 
de LUT del monitor y del visor. Si se selecciona 
R709(800%) o R709-Like, la ganancia de salida 
se puede cambiar usando el ajuste SDR Gain. 
Sin embargo, la ganancia de salida no se puede 
cambiar cuando Project > Basic Setting > Input 
Color Space (página 68) está establecido en 
Rec.709/User Gamma en el menú completo.
ˎˎ Las siguientes zonas de control se muestran 
atenuadas y no pueden utilizarse cuando 

se conecta una RM-B170 u otra unidad 
de control remoto y se ajusta Technical > 
System Configuration > RM/RCP Paint Control 
(página 83) en On en el menú completo. 
Realice su configuración a través de la unidad de 
control remoto (página 108).
ˎˎ Zona de control de obturador
ˎˎ Zona de control de WB

Operación Step Edit

Puede cambiar los ajustes disponibles de la 
selección cuando se muestre “Step Edit” para la 
tecla ITEM 4 en el paso 2 del procedimiento básico. 
Puede añadir y eliminar ajustes en la pantalla de 
edición de ajustes.

1	 En la pantalla de selección de ajustes, mueva el 
cursor hasta el ajuste que desea cambiar o 
eliminar y pulse el botón Step Edit (tecla ITEM 
4).
Se muestra la pantalla de edición de ajustes.

2	 Para eliminar un ajuste, pulse el botón Delete 
(tecla ITEM 4).

	 [Nota]
El ajuste seleccionado puede eliminarse si el conjunto 
de caracteres “Delete” se muestra de color naranja.

3	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para cambiar 
el ajuste.

4	 Al terminar, pulse el botón Add (tecla ITEM 4).
Se añade el ajuste y la pantalla vuelve a la 
pantalla de selección de ajustes.

	 [Nota]
Se puede añadir un ajuste si el conjunto de caracteres 
“Add” se muestra de color naranja.

Cuando se ajusta White Balance

Pulse el botón Coarse/Fine (tecla ITEM 1) de la 
pantalla de edición de ajustes White Balance para 
cambiar la variación de incrementos en 1 paso 
a grueso o fino. También puede pulsar el botón 
Temp/Tint (tecla ITEM 3) para cambiar el valor 
entre temperatura de color (Temp) y tono de color 
(Tint).
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Operación FPS

Pulse la tecla ITEM 1 de la pantalla Home para 
mostrar la pantalla de operación FPS. Pulse el 
botón Variable/Fixed (tecla ITEM 4) para cambiar 
entre “Fixed”, que permite filmar a una velocidad 
constante, y “Variable (Select FPS)”, que permite 
filmar a una velocidad variable.

[Nota]
En el modo “Select FPS” no se graba el audio.

Operación de EI/ganancia

Puede cambiar el valor de EI. Cuando se conecta 
un RM-B170 u otra unidad de control remoto y 
se ajusta Technical > System Configuration > RM/
RCP Paint Control (página 83) en On en el menú 
completo, se muestra el valor de ganancia en lugar 
del valor EI, lo que permite cambiar el valor de 
ganancia.

Cambiar el valor de EI o el valor de ganancia

[Nota]
En esta sección se muestra la pantalla que aparece cuando 
se cambia el valor de EI como ejemplo.

Puede cambiar el valor de EI o de ganancia con la 
tecla ITEM 2 en la pantalla Home.

1	 Pulse la tecla ITEM 2 de la pantalla Home.
Aparece la pantalla de configuración de EI o de 
Gain.

2	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para cambiar 
el ajuste.

3	 Pulse el mando MENU o el botón Set (tecla 
ITEM 3) para aplicar el ajuste.

Cambiar la opción Base ISO

Puede cambiar la Base ISO presionando la tecla 
ITEM 4 en la pantalla de configuración de EI o de 
Gain.

1	 Pulse la tecla ITEM 4 de la pantalla de 
configuración de EI o de Gain.
Se abrirá la pantalla de cambio de Base ISO.

2	 Presione los dos botones Change (tecla ITEM 1 
y tecla ITEM 3) simultáneamente.

La Base ISO se cambia(página 40).

Operación AWB

Pulse la tecla ITEM 6 de la pantalla Home para 
mostrar la pantalla de operación de equilibrio del 
blanco. Pulse el botón Auto White Bal. (tecla ITEM 
1) para ejecutar el equilibrio del blanco. Tras esta 
operación, pulse el botón Add (tecla ITEM 4) para 
añadir el ajuste a un paso. También puede pulsar 
el botón Temp/Tint (tecla ITEM 3) para cambiar el 
valor entre temperatura de color (Temp) y tono de 
color (Tint) para realizar ajustes finos al valor antes 
de añadirlo a un paso.

[Nota]
Durante la operación AWB, filme un fondo blanco bajo unas 
condiciones de iluminación uniformes.

Operación LUT

Ajuste de una LUT

Puede ajustar una LUT para cada sistema de salida 
con la tecla ITEM 5 de la pantalla Home.

1	 Pulse la tecla ITEM 5 de la pantalla Home.
Aparece la pantalla de selección de LUT.

La pantalla de selección de LUT tiene dos 
páginas y se puede cambiar la página 
pulsando la tecla ITEM 1.
En la página 1 puede configurar los ajustes de 
LUT para SDI 1/2 (solo pantalla), SDI 3/4, 
Monitor y HDMI.
En la página 2 puede configurar los ajustes de 
LUT para el visor, SDR Gain, SxS Rec y Sub Rec.

	 [Nota]
La información de gamma del usuario se muestra en 
la pantalla de selección de LUT cuando Project > Basic 
Setting > Input Color Space (página 68) está ajustado 
en Rec.2020/User Gamma o Rec.709/User Gamma en el 
menú completo.

2	 Seleccione la salida que desee configurar con 
las teclas ITEM 2, 3, 5 y 6.
Se muestra la pantalla de edición de ajustes.

3	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para cambiar 
el ajuste.
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4	 Pulse el mando MENU o el botón Set (tecla 
ITEM 3) para aplicar el ajuste.

Modificación de Preset Look

Puede configurar una LUT cuando se seleccione 
Look en la pantalla de selección de LUT utilizando 
el botón Edit Look (tecla ITEM 4) de las páginas 1 
o 2.

1	 Pulse el botón Edit Look (tecla ITEM 4) de la 
pantalla de selección de LUT.
Aparece la pantalla de selección Look.

2	 Pulse el botón Select (tecla ITEM 3).
Se muestran los elementos seleccionables.

3	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para cambiar 
el ajuste.

4	 Pulse el mando MENU o el botón Set (tecla 
ITEM 3) para aplicar el ajuste.

Modificación de la categoría de la LUT

Puede modificar la categoría de destino de las 
operaciones LUT a User 3D LUT, ACES o Preset Look 
(página 66).

1	 Pulse el botón Edit Look (tecla ITEM 4) de la 
pantalla de selección de LUT.
Aparece la pantalla de selección Look.

2	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para activar la 
selección de la categoría.

3	 Pulse el mando MENU o el botón Select (tecla 
ITEM 3).

4	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para 
seleccionar una categoría (User 3D LUT, ACES o 
Preset Look).

5	 Pulse el mando MENU o el botón Set (tecla 
ITEM 3) para aplicar el ajuste.

Carga de un archivo User 3D LUT

Puede cargar en la unidad un archivo User 3D LUT 
almacenado en una tarjeta SD.

[Nota]
Guarde el archivo User 3D LUT en el siguiente directorio de la 
tarjeta SD (página 103).
PRIVATE\SONY\PRO\LUT\

1	 Coloque la tarjeta SD en la ranura para tarjetas 
SD (página 12).

2	 Pulse el botón Edit Look (tecla ITEM 4) de la 
pantalla de selección de LUT.
Aparece la pantalla de selección Look.

3	 Pulse el botón Load File (tecla ITEM 4).

4	 Pulse el mando MENU o el botón Select (tecla 
ITEM 3).
Se muestran los números de destino de carga 
(del 01 al 16).
Se muestra un nombre de archivo para los 
números cargados.

5	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para 
seleccionar un número de destino de carga.

6	 Pulse el mando MENU o el botón Select (tecla 
ITEM 3).
Se muestra el nombre del archivo User 3D LUT 
almacenado en la tarjeta SD.

7	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para 
seleccionar un archivo.

8	 Pulse el mando MENU o el botón Load (tecla 
ITEM 3).
Cuando el archivo se carga correctamente, se 
muestra “Successfully loaded”.

9	 Pulse el botón OK (tecla ITEM 6).

Carga de un archivo ART

Puede cargar en la unidad un archivo ART 
almacenado en una tarjeta SD.

[Nota]
Guarde el archivo ART en el siguiente directorio de la tarjeta 
SD (página 103).
PRIVATE\SONY\PRO\CAMERA\MPC3610\

1	 Coloque la tarjeta SD en la ranura para tarjetas 
SD (página 12).

2	 Pulse el botón Edit Look (tecla ITEM 4) de la 
pantalla de selección de LUT.
Aparece la pantalla de selección Look.

3	 Pulse el botón Load File (tecla ITEM 4).
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4	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para 
seleccionar Load ART File.

5	 Pulse el mando MENU o el botón Select (tecla 
ITEM 3).
Se muestran los números de destino de carga 
(del 01 al 16).
Se muestra un nombre de archivo para los 
números cargados.

6	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para 
seleccionar un número de destino de carga.

7	 Pulse el mando MENU o el botón Select (tecla 
ITEM 3).
Se muestra el nombre del archivo ART 
almacenado en la tarjeta SD.

8	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para 
seleccionar el archivo.

9	 Pulse el mando MENU o el botón Load (tecla 
ITEM 3).
Cuando el archivo se carga correctamente, 
aparece la siguiente pantalla.

10	Pulse el botón BACK o el botón Done (tecla 
ITEM 6).

Carga de un archivo ASC CDL

Puede cargar en la unidad un archivo ASC CDL 
almacenado en una tarjeta SD.

[Nota]
Guarde el archivo ASC CDL en el siguiente directorio de la 
tarjeta SD (página 103).
PRIVATE\SONY\PRO\CDL\

1	 Coloque la tarjeta SD en la ranura para tarjetas 
SD (página 12).

2	 Pulse el botón Edit Look (tecla ITEM 4) de la 
pantalla de selección de LUT.
Aparece la pantalla de selección Look.

3	 Pulse el botón Load File (tecla ITEM 4).

4	 Seleccione Load ASC CDL File y pulse el 
mando MENU o el botón Select (tecla ITEM 3).

Se muestra el nombre del archivo ASC CDL 
almacenado en la tarjeta SD.

5	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para 
seleccionar un archivo.

6	 Pulse el mando MENU o el botón Load (tecla 
ITEM 3).
Puede pulsar el botón Load All Files (tecla ITEM 
1) para cargar todos los archivos.
Cuando el archivo se carga correctamente, se 
muestra “Successfully loaded”.

7	 Pulse el botón OK (tecla ITEM 6).

8	 Especifique la secuencia de procesamiento de 
ASC CDL en ASC CDL Process.
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Cambio del archivo User 3D LUT

Puede cambiar el archivo User 3D LUT 
actualmente seleccionado.

1	 Pulse el botón Edit Look (tecla ITEM 4) de la 
pantalla de selección de LUT.
Aparece la pantalla de selección Look.

2	 Pulse el mando MENU o el botón Select (tecla 
ITEM 3).

3	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para cambiar 
el archivo User 3D LUT.

4	 Pulse el mando MENU o el botón Set (tecla 
ITEM 3) para aplicar el ajuste.

Cambio del archivo ART

Puede cambiar el archivo ART actualmente 
seleccionado.

1	 Pulse el botón Edit Look (tecla ITEM 4) de la 
pantalla de selección de LUT.
Aparece la pantalla de selección Look.

2	 Pulse el mando MENU o el botón Select (tecla 
ITEM 3).

3	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para cambiar 
el archivo ART.

4	 Pulse el mando MENU o el botón Set (tecla 
ITEM 3) para aplicar el ajuste.

Visualización de información del archivo ART

Puede ver la información del archivo ART 
actualmente seleccionado.

1	 Pulse el botón Edit Look (tecla ITEM 4) de la 
pantalla de selección de LUT.
Aparece la pantalla de selección Look.

2	 Seleccione el archivo ART y pulse el botón CDL 
/ ART Info (tecla ITEM 1).

Se muestra la información del archivo ART.

Cambio de un archivo ASC CDL

Puede cambiar el archivo ASC CDL actualmente 
seleccionado.

1	 Pulse el botón Edit Look (tecla ITEM 4) de la 
pantalla de selección de LUT.
Aparece la pantalla de selección Look.

2	 Seleccione ASC CDL Select y pulse el mando 
MENU o el botón Select (tecla ITEM 3).

3	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para cambiar 
el archivo ASC CDL.

	 [Nota]
Los archivos que no se pueden aplicar en la unidad 
quedan atenuados.

4	 Pulse el mando MENU o el botón Set (tecla 
ITEM 3) para aplicar el ajuste.

Visualización de información del archivo ASC CDL

Puede ver la información del archivo ASC CDL 
actualmente seleccionado.

1	 Pulse el botón Edit Look (tecla ITEM 4) de la 
pantalla de selección de LUT.
Aparece la pantalla de selección Look.
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2	 Seleccione la opción ASC CDL Select y pulse el 
botón CDL / ART Info (tecla ITEM 1).

Se muestra la información de archivo de ASC 
CDL.

Acerca de los rangos de ajuste del archivo ASC CDL

Los rangos de ajuste del archivo ASC CDL se 
muestran a continuación. Los archivos que superen 
los rangos no se pueden cargar.
Slope: 0.000 a 3.999
Offset: –1.000 a 1.000
Power: 0.400 a 4.000
Saturation: 0.000 a 3.999

Ajustes de LUT del monitor/visor

Cuando se ajusta Technical > System Configuration 
> RM/RCP Paint Control (página 83) en On en el 
menú completo, puede seleccionar si las salidas 
individuales del monitor y del visor son las mismas 

que la señal principal, como una salida SDI, o si 
están configuradas en R709(800%) o R709-Like.

[Nota]
R709-Like se muestra cuando Project > Basic Setting > Input 
Color Space (página 68) está ajustado en Rec.2020/User 
Gamma en el menú completo.

Cambiar la ganancia

Puede cambiar la ganancia de cada salida 
configurando la salida del monitor o del visor en 
R709(800%) o R709-Like.

1	 En la página 2 de la pantalla Home, pulse el 
botón SDR Gain (tecla ITEM 3).
Aparece la pantalla SDR Gain.

2	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para cambiar 
el ajuste.

3	 Pulse el mando MENU o el botón Set (tecla 
ITEM 3) para aplicar el ajuste.

Elementos de la pantalla Home en la pantalla secundaria

A continuación, indicamos el nombre de los elementos y sus correspondientes valores de configuración.
Los valores predeterminados aparecen en negrita subrayados.

[Nota]
El valor máximo de velocidad de fotogramas de la filmación varía en función del formato de grabación. El valor máximo 
de velocidad de fotogramas de la filmación está restringido a lo siguiente durante la grabación independiente de SxS y la 
grabación simultánea de AXS/SxS.
4K/QFHD XAVC Intra Class 480: 30 fps (máx.)
4K/QFHD XAVC Intra Class 300: 60 fps (máx.)
MPEG HD 422 Codec: 30 fps (máx.)
ProRes 422 Codec: 60 fps (máx)

Elemento Descripción

FPS Define la velocidad de fotogramas de la filmación.
Variable/Fixed: cambia entre una filmación con velocidad variable y velocidad 
constante.
Si la opción “Fixed” está seleccionada, el ajuste queda determinado por el ajuste 
de la categoría Project > Project Frame Rate (página 50) del menú.

Project Frame Rate Pantalla
23.98 Fix 23.98

24 Fix 24.00

25 Fix 25.00

29.97 Fix 29.97

47.95 Fix 47.95

50 Fix 50.00

59.94 Fix 59.94
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Elemento Descripción

Si la opción “Variable” está seleccionada, el ajuste cambia como se indica a 
continuación en función del ajuste de la categoría Project > Imager Mode 
(página 68) del menú.

Imager Mode Ajuste
3.8K 16:9
4K 17:9
4K 2.39:1

De 1 a 60 FPS

3.8K 16:9 1)

4K 17:9 1)

De 1 a 60, 66, 72, 75, 88, 90, 96, 100, 
110 FPS

3.8K 16:9 Surround View
4K 17:9 Surround View
4K 4:3

De 1 a 48 FPS

4K 4:3 1) De 1 a 60, 66, 72, 75 FPS

4K 2.39:1 1) De 1 a 60, 66, 72, 75, 88, 90, 96, 100, 
110, 120 FPS

4K 4:3 Surround View
4K 6:5
5.7K 16:9
6K 2.39:1
6K 17:9
6K 1.85:1

De 1 a 30 FPS

6K 2.39:1 1) De 1 a 60, 66, 72, 75, 90 FPS
4K 6:5 1)

5.7K 16:9 1)

6K 17:9 1)

6K 1.85:1 1)

De 1 a 60, 66, 72 FPS

6K 3:2 De 1 a 25 FPS

6K 3:2 1) De 1 a 60 FPS

Exposure Index Establece el valor de EI. Puede cambiar la configuración de Base ISO pulsando el 
botón Change Base (tecla ITEM 4) y a continuación pulsando simultáneamente los 
dos botones Change (tecla ITEM 1 y tecla ITEM 3) en la siguiente pantalla. Los 
ajustes disponibles varían como se muestra a continuación en función del ajuste 
de Base ISO.
Base ISO 500:

125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/1250EI/ 
1600EI/2000EI

Base ISO 2500:
640EI/800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/4000EI/5000EI/ 
6400EI/8000EI/10000EI

Elemento Descripción

Gain Configura la sensibilidad de base.
–6dB/–3dB/0dB/3dB/6dB/9dB/12dB/15dB/18dB

[Nota]
Configurable solo cuando se conecta una RM-B170 u otra unidad de control remoto y se 
ajusta Technical > System Configuration > RM/RCP Paint Control (página 83) en On en el 
menú completo.

Shutter Define la velocidad del obturador y el ángulo del obturador electrónico.
Pulse el botón Step/Cont. (tecla ITEM 1) para cambiar entre los métodos de 
selección de paso y continuo.
Step: seleccione entre hasta 16 valores preestablecidos registrados como pasos 
del obturador. Puede cambiar cualquier ajuste del valor preestablecido después 
de seleccionarlo pulsando el botón Step Edit (tecla ITEM 4).

En función del ajuste del menú completo Technical > System Configuration > 
Shutter Mode (página 83), muestra las siguientes opciones de selección.

Angle: indicador del ángulo del obturador

Opciones de selección predeterminadas
360/180/172.8/144/90/45/22.5/11.2/5.6

Speed: indicador de la velocidad del obturador

Opciones de selección predeterminadas
1/24, 1/25, 1/30, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000 2)

[Nota]
A continuación se indican los valores de velocidad predeterminados para los distintos 
ajustes de Project Frame Rate (página 50).
23.98/24: 1/24, 25: 1/25, 29.97: 1/30, 47.95: 1/48, 50: 1/50, 59.94: 1/60

Cont.: seleccione un ángulo/velocidad dentro del rango admitido.
ND Filter Define la posición del filtro ND. Están disponibles los siguientes ajustes.

Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4
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Elemento Descripción

LUT Configura ajustes relacionados con la LUT para aplicarlos al vídeo de salida. Los 
ajustes variarán en función del ajuste Technical > System Configuration > RM/RCP 
Paint Control (página 83) del menú completo.

Page 1

SDI 1/2 (tecla ITEM 2)
Cuando se ajusta RM/RCP Paint Control en Off: Log

Solo se visualiza, ya que la LUT no se puede aplicar a la imagen de salida SDI 
1/2.

Cuando se ajusta RM/RCP Paint Control en On: Log/HLG(Natural)/HLG(Live)/
User Gamma

El ajuste de imagen de salida SDI 1/2 es solo de visualización, porque está 
determinado por el ajuste de la categoría Project > Input Color Space del 
menú.

SDI 3/4 (tecla ITEM 3)
Cuando se ajusta RM/RCP Paint Control en Off: Log/Look

Selecciona la LUT para aplicarla a la imagen de salida SDI 3/4.
Desactivado cuando la categoría Monitoring > Output Format > SDI 1/2 se 
ajusta en 4K/QFHD en el menú.

Cuando se ajusta RM/RCP Paint Control en On: Log/HLG(Natural)/HLG(Live)/
User Gamma

El ajuste de imagen de salida SDI 3/4 es solo de visualización, porque está 
determinado por el ajuste de la categoría Project > Input Color Space del 
menú.

Monitor (tecla ITEM 5)
Cuando se ajusta RM/RCP Paint Control en Off:

Selecciona la LUT que se aplicará a la imagen de salida de Monitor.
Cuando se ajusta Output Format > SDI 1/2 en 2K/HD: Log/s709/R709(800%)
Cuando se ajusta Output Format > SDI 1/2 en 4K/QFHD: Log/Look

Cuando se ajusta RM/RCP Paint Control en On:
Selecciona el tipo de imagen de salida del monitor.
El ajuste cambia como se indica a continuación en función del ajuste de la 
categoría Project > Input Color Space del menú.

S-Gamut3.Cine/SLog3 o S-Gamut3/SLog3: Log/R709(800%)
HLG(Natural): HLG(Natural)/R709(800%)
HLG(Live): HLG(Live)/R709(800%)
Rec.2020/User Gamma: User Gamma/R709-Like
Rec.709/User Gamma: User Gamma

Elemento Descripción

HDMI (tecla ITEM 6)
Cuando se ajusta RM/RCP Paint Control en Off: Log/s709/R709(800%)/Look

Muestra la LUT que se aplicará a la imagen de salida HDMI.
Fijado en Log cuando la categoría Monitoring > Output Format > SDI 1/2 se 
ajusta en 4K/QFHD y HDMI se ajusta en 4K/QFHD en el menú. En el resto de 
los casos, las opciones son las mismas que para Monitor.

Cuando se ajusta RM/RCP Paint Control en On (salida 4K/QFHD): Log/
HLG(Natural)/HLG(Live)/User Gamma

Solo visualización, porque el ajuste de imagen de salida HDMI es el mismo 
que SDI 1/2.

Cuando se ajusta RM/RCP Paint Control en On (salida 2K/HD): Log/HLG(Natural)/
HLG(Live)/User Gamma/R709(800%)/R709-Like

Solo visualización, porque el ajuste de imagen de salida HDMI es el mismo 
que Monitor.

Page 2

Viewfinder (tecla ITEM 2)
Cuando se ajusta RM/RCP Paint Control en Off: Log/s709/R709(800%)

Selecciona la LUT que se aplicará a la imagen de salida del visor/monitor.
Cuando se ajusta RM/RCP Paint Control en On:

Selecciona el tipo de imagen de salida de la pantalla del visor/monitor.
El ajuste cambia como se indica a continuación en función del ajuste de la 
categoría Project > Input Color Space del menú.

S-Gamut3.Cine/SLog3 o S-Gamut3/SLog3: Log/R709(800%)
HLG(Natural): HLG(Natural)/R709(800%)
HLG(Live): HLG(Live)/R709(800%)
Rec.2020/User Gamma: User Gamma/R709-Like
Rec.709/User Gamma: User Gamma

SDR Gain (tecla ITEM 3): –15dB a 0dB (–12dB)
Establece la ganancia de salida SDR en modo HDR.

	 [Nota]
Configurable solo cuando se ajusta Technical > System Configuration > RM/RCP Paint 
Control (página 83) en On en el menú completo.

SxS Rec (tecla ITEM 5)
Cuando se ajusta RM/RCP Paint Control en Off: Log/Look

Selecciona la LUT que se aplicará al vídeo grabado en el clip SDI Main.
Desactivado cuando la categoría Project > SxS Rec Format se ajusta en Rec 
Off en el menú, o fijado en Log cuando se ajusta en XAVC.

Cuando se ajusta RM/RCP Paint Control en On: Log/HLG(Natural)/HLG(Live)/
User Gamma

El ajuste de imagen de grabación del clip SxS Main es solo de visualización, 
porque está determinado por el ajuste de la categoría Project > Input Color 
Space del menú.
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Elemento Descripción

Sub Rec (tecla ITEM 6)
Cuando se ajusta RM/RCP Paint Control en Off: Log/Look

Selecciona la LUT que se aplicará al vídeo grabado en el clip SDI Sub.
Desactivado cuando la categoría Project > SxS Rec Format se ajusta en Rec 
Off en el menú.

Cuando se ajusta RM/RCP Paint Control en On: Log/HLG(Natural)/HLG(Live)/
User Gamma

El ajuste de imagen de grabación del clip SxS Sub es solo de visualización, 
porque está determinado por el ajuste de la categoría Project > Input Color 
Space del menú.

Elementos comunes de la Page 1/2

Edit Look: configura una LUT para aplicarla como Look.
s709 / R709(800%) / S-Gamut3.Cine/SLog3 / S-Gamut3/SLog3 / User 3D LUT

WB (White Balance) Configura la temperatura de color/el tono de color del equilibrio del blanco.
Opciones de selección predeterminadas

3200K+00/4300K+00/5500K+00
Puede cambiar el valor preestablecido para el equilibrio del blanco y el valor de 
tinte pulsando el botón Step Edit (tecla ITEM 4).
Auto White Bal.: ejecuta el equilibrio del blanco automático.

1)	 Solo cuando se activa una licencia High Frame Rate.
2)	 Las opciones son 1/60 y valores posteriores cuando la velocidad de fotograma del proyecto es 59.94, 1/50 y valores 

posteriores cuando es 50.0, 1/30 y valores posteriores cuando es 29.97 y 1/25 y valores posteriores cuando es 25.0.
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Pantalla de funciones del usuario
Pulse el botón USER (página 10) para visualizar 
la pantalla de funciones del usuario en la pantalla 
secundaria y utilizar las teclas ITEM de 1 a 5 como 
botones asignables (User de 1 a 5).
Hay también cuatro* botones asignables (del 1 
al 4) (páginas 8, 9, 10) en la unidad y 
tres botones asignables (de la A a la C) en el visor 
(DVF‑EL200) a los que podrá asignar diversas 
funciones.
Las funciones pueden asignarse a estos botones 
con la pantalla de funciones del usuario, además 
de con Project > Assignable Button en el menú 
completo.
*	 Siete (del 1 al 7) cuando se conecta un CBK-3620XS.

 Tecla ITEM 4 Tecla ITEM 5 Tecla ITEM 6

Tecla ITEM 3Tecla ITEM 2Tecla ITEM 1

[Nota]
Cuando está acoplado un objetivo compatible con la 
función de visualización del ajuste del iris, la posición del 
iris se muestra en la parte central izquierda de la pantalla de 
funciones del usuario.

Modificación de funciones de los 
botones

La pantalla de selección de funciones del usuario 
se muestra al pulsar el botón Edit (tecla ITEM 6) 
de la pantalla de funciones del usuario. Puede 
configurar las funciones para los botones User del 
1 al 5, para los botones asignables del 1 al 4 (del 
1 al 7 cuando se conecta un CBK-3620XS) y para 
los botones asignables del visor de la A a la C en la 
pantalla de selección de funciones del usuario.

1	 En la pantalla de selección de funciones del 
usuario, mueva el cursor hasta el botón que desea 
modificar o pulse el botón Select (tecla ITEM 3).
Se muestran las funciones seleccionables.

2	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para cambiar 
el ajuste.

3	 Al terminar, pulse el botón Set (tecla ITEM 3).
La pantalla vuelve a la pantalla de funciones 
del usuario y muestra la función modificada.

En la siguiente tabla se indican las funciones asignadas cuando la unidad se suministra desde la fábrica.

Botón Función Ajuste del botón asignable

Asignable 1 Muestra las áreas resaltadas recortadas en rojo en 
el visor.

VF Highlight Clip Ind

Asignable 2 Sin asignación Not Assigned
Asignable 3 Sin asignación Not Assigned
Asignable 4 Sin asignación Not Assigned
Asignable 5* Sin asignación Not Assigned
Asignable 6* Sin asignación Not Assigned
Asignable 7* Sin asignación Not Assigned
Tecla ITEM 1 Sin asignación Not Assigned
Tecla ITEM 2 Sin asignación Not Assigned
Tecla ITEM 3 Sin asignación Not Assigned
Tecla ITEM 4 Muestra las áreas resaltadas recortadas en rojo en 

la salida Monitor.
Monitor Highlight Clip Ind

Tecla ITEM 5 Selecciona el modo de control del ventilador. Fan Mode
Botón asignable A del 
visor

Activa/desactiva la función de amplificador de 
enfoque del visor.

VF Focus Magnifier

Botón asignable B del 
visor

Activa/desactiva la visualización de la función de 
falso color en un visor.

VF False Color

Botón asignable C del 
visor

Activa/desactiva la pantalla de información en la 
imagen de salida del visor/monitor.

VF Status Info

*	 Configurable cuando se conecta un CBK-3620XS

Funciones que se pueden asignar a las teclas ITEM de 1 a 5

Ajuste del botón 
asignable

Función Estado cuando la unidad está 
encendida

No Assign Sin asignación –
SDI Frame Line Activa/desactiva la superposición de líneas de 

fotogramas en la imagen de salida SDI 3/4.
Valor conservado

SDI Status Info Activa/desactiva la visualización de información 
en la imagen de salida SDI 3/4.

Valor conservado

Press & Hold for SDI Log 1) Desactiva la LUT aplicada a la imagen de salida 
SDI 3/4 mientras se pulsa la tecla y configura la 
calidad de imagen de Log sin aplicar una LUT.

Valor no conservado

Monitor Frame Line Activa/desactiva la superposición de líneas de 
fotogramas en la imagen de salida de Monitor.

Valor conservado

Monitor Status Info Activa/desactiva la visualización de información 
en la imagen de salida de Monitor.

Valor conservado
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Ajuste del botón 
asignable

Función Estado cuando la unidad está 
encendida

Monitor Focus 
Magnifier 2) 3)

Activa/desactiva la función de amplificador de 
enfoque de la imagen de salida de Monitor.

Valor no conservado

Press & Hold for Monitor 
Log 4)

Desactiva la LUT aplicada a la imagen de salida de 
Monitor mientras se pulsa la tecla para una 
calidad de imagen normal sin aplicar una LUT.

Valor no conservado

Monitor Highlight Clip 
Ind 1)

Activa/desactiva la función que muestra las áreas 
resaltadas recortadas en rojo en la imagen de 
salida de Monitor.

Valor conservado

Monitor False Color 1) Activa/desactiva la visualización de la función de 
falso color en un monitor.

Valor conservado

Color Bars 5) Activa/desactiva las barras de color. Valor conservado
AXS Slot Change Cambia la ranura activa cuando se introducen dos 

tarjetas de memoria AXS.
Cambia entre A y B cada vez que se pulsa la tecla.

Valor conservado

SxS Slot Change Cambia la ranura activa cuando se introducen dos 
tarjetas de memoria SxS.
Cambia entre A y B cada vez que se pulsa la tecla.

Valor conservado

Fan Mode Selecciona el modo de control del ventilador.
Cambia entre Auto  Max  Off in Rec/Auto  
Off in Rec/Max cada vez que se pulsa la tecla.

Valor conservado

Format Media AXS Slot A Formatea el soporte de la tarjeta de memoria AXS 
insertada en la ranura A.

–

Format Media AXS Slot B Formatea el soporte de la tarjeta de memoria AXS 
insertada en la ranura B.

–

Format Media SxS Slot A Formatea el soporte de la tarjeta de memoria SxS 
insertada en la ranura A.

–

Format Media SxS Slot B Formatea el soporte de la tarjeta de memoria SxS 
insertada en la ranura B.

–

APR Ejecuta APR. –
PL-Mt Interface Position Establece la posición de la interfaz en el objetivo 

con soporte PL.
Cambia entre Top  Side  Off cada vez que se 
pulsa la tecla.

Valor conservado

VF Highlight Clip Ind 1) Activa/desactiva la función que muestra las áreas 
resaltadas recortadas en rojo en el visor.

Valor conservado

VF False Color 1) Activa/desactiva la visualización de la función de 
falso color en un visor.

Valor conservado

Line A: Aspect Ratio Disp. Activa/desactiva la visualización de Aspect Ratio 
para Line A.

Valor conservado

Line B: Aspect Ratio Disp. Activa/desactiva la visualización de Aspect Ratio 
para Line B.

Valor conservado

Ajuste del botón 
asignable

Función Estado cuando la unidad está 
encendida

Line A: User Frame Disp. Activa/desactiva la visualización de User Frame 
Line 1 y User Frame Line 2 para Line A.
Cada vez que se pulsa la tecla, la visualización 
cambia entre la pantalla User Frame Line 1 y 2  
pantalla User Frame Line 1  pantalla User Frame 
Line 2  User Frame Line 1 y 2 ocultas.

Valor conservado

Line B: User Frame Disp. Activa/desactiva la visualización de User Frame 
Line 1 y User Frame Line 2 para Line B.
Cada vez que se pulsa la tecla, la visualización 
cambia entre la pantalla User Frame Line 1 y 2  
pantalla User Frame Line 1  pantalla User Frame 
Line 2  User Frame Line 1 y 2 ocultas.

Valor conservado

Auto White Balance 5) Ejecuta el equilibrio del blanco automático. –
Picture Cache Rec Activa/desactiva la función de grabación en la 

caché de imágenes.
Valor conservado

Iris Open (1/16 stop) 6) Abre el iris del objetivo.
Manténgalo pulsado para abrir el iris por 
completo.
Esta función está disponible cuando el objetivo 
con soporte E con iris eléctrico está colocado.
El ajuste se encuentra en incrementos de parada 
de 1/16, mientras que la indicación del iris se 
encuentra en incrementos de parada de 1/3.

–

Iris Close (1/16 stop) 6) Cierra el iris del objetivo.
Manténgalo pulsado para cerrar el iris por 
completo.
Esta función está disponible cuando el objetivo 
con soporte E con iris eléctrico está colocado.
El ajuste se encuentra en incrementos de parada 
de 1/16, mientras que la indicación del iris se 
encuentra en incrementos de parada de 1/3.

–

H & V Flip 7) En el modo de filmación, activa o desactiva la 
función para voltear la imagen horizontal y 
verticalmente.

Valor conservado

SxS/Output De-Squeeze Cambia el ajuste Project > Basic Setting > SxS/
Output De-Squeeze del menú completo.
Cada vez que se pulsa la tecla, el ajuste cambia al 
siguiente elemento de la lista de opciones de 
selección de menú.

Valor conservado

1)	 No funciona si la tecla se pulsa cuando se ajusta Technical > System Configuration > RM/RCP Paint Control (página 83) en 
On en el menú completo. 

2)	 También se aplica a la salida HDMI si esta tiene el mismo formato de salida que la salida de Monitor. Puede comprobar el 
ajuste desde Monitoring > OSD Appearance > HDMI (página 73) en el menú completo. La salida HDMI es la misma que la 
salida de Monitor si HDMI se ajusta en “Same as Monitor”.
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3)	 Si el formato de la salida SDI es 1920×1080i, la función de amplificador de enfoque está desactivada y, al pulsar la tecla, no se 
realiza ninguna función.

4)	 Cambia a la misma imagen que la señal principal seleccionada mediante Project > Basic Setting > Input Color Space 
(página 68) en el menú completo mientras la tecla está pulsada.

5)	 No funciona si la tecla se pulsa cuando se conecta una RM-B170 u otra unidad de control remoto y se ajusta Technical > 
System Configuration > RM/RCP Paint Control (página 83) en On en el menú completo.

6)	 No funciona si la tecla se pulsa cuando se conecta una RM-B170 u otra unidad de control remoto.
7)	 No funciona si la tecla se pulsa cuando Technical > Special Configuration > Flip Image (página 83) H & V Flip está 

atenuado en el menú completo.

Funciones que se pueden asignar a los botones asignables del 1 al 7

[Nota]
Los botones asignables del 5 al 7 pueden asignarse y usarse solo cuando hay un CBK-3620XS conectado a la unidad.

Ajuste del botón asignable Función Estado cuando la unidad 
está encendida

No Assign Sin asignación –
SDI Frame Line Activa/desactiva la superposición de líneas de 

fotogramas en la imagen de salida SDI 3/4.
Valor conservado

SDI Status Info Activa/desactiva la visualización de 
información en la imagen de salida SDI 3/4.

Valor conservado

Press & Hold for SDI Log 1) Desactiva la LUT aplicada a la imagen de salida 
SDI 3/4 mientras se pulsa el botón y configura 
la calidad de imagen de Log sin aplicar una 
LUT.

Valor no conservado

Monitor Frame Line Activa/desactiva la superposición de líneas de 
fotogramas en la imagen de salida de Monitor.

Valor conservado

Monitor Status Info Activa/desactiva la visualización de 
información en la imagen de salida de 
Monitor.

Valor conservado

Monitor Focus Magnifier 2) 3) Activa/desactiva la función de amplificador de 
enfoque de la imagen de salida de Monitor.

Valor no conservado

Press & Hold for Monitor Log 4) Desactiva la LUT aplicada a la imagen de salida 
de Monitor mientras se pulsa el botón y 
configura la calidad de imagen de Log sin 
aplicar una LUT.

Valor no conservado

Monitor Highlight Clip Ind 1) Activa/desactiva la función que muestra las 
áreas resaltadas recortadas en rojo en la 
imagen de salida de Monitor.

Valor conservado

Ajuste del botón asignable Función Estado cuando la unidad 
está encendida

Monitor High/Low Key 1) Selecciona el modo de salida de Monitor.
Cambia entre High Key (pantalla para 
comprobar áreas resaltadas apagadas)  Low 
Key (pantalla para comprobar sombras 
bloqueadas)  Off (pantalla normal) cada vez 
que se pulsa el botón.

Valor no conservado

Monitor False Color 1) Activa/desactiva la visualización de la función 
de falso color en un monitor.

Valor conservado

Color Bars 5) Activa/desactiva las barras de color. Valor conservado
AXS Slot Change Cambia la ranura activa cuando se introducen 

dos tarjetas de memoria AXS.
Cambia entre A y B cada vez que se pulsa el 
botón.

–

SxS Slot Change Cambia la ranura activa cuando se introducen 
dos tarjetas de memoria SxS.
Cambia entre A y B cada vez que se pulsa el 
botón.

–

Rec Review Ejecuta la función de revisión de grabación. Valor no conservado
VF Frame Line Activa/desactiva la superposición de líneas de 

fotogramas en la imagen de salida del visor/
monitor.

Valor conservado

VF Zebra Activa/desactiva la función de cebra de la 
imagen de salida del visor/monitor.

Valor conservado

VF Status Info Activa/desactiva la pantalla de información en 
la imagen de salida del visor/monitor.

Valor conservado

VF Focus Magnifier Activa/desactiva la función de amplificador de 
enfoque del visor.

Valor no conservado

Press & Hold for VF Log 6) Desactiva la LUT aplicada a la imagen de salida 
del visor/monitor mientras se pulsa el botón 
para una calidad de imagen normal sin aplicar 
una LUT.

Valor no conservado

VF Highlight Clip Ind 1) Activa/desactiva la función que muestra las 
áreas resaltadas recortadas en rojo en el visor.

Valor conservado

VF High/Low Key 1) Selecciona el modo de salida del visor.
Cambia entre High Key (pantalla para 
comprobar áreas resaltadas apagadas)  Low 
Key (pantalla para comprobar sombras 
bloqueadas)  Off (pantalla normal) cada vez 
que se pulsa el botón.

Valor no conservado

VF False Color 1) Activa/desactiva la visualización de la función 
de falso color en un visor.

Valor conservado
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Ajuste del botón asignable Función Estado cuando la unidad 
está encendida

Line A: Aspect Ratio Disp. Activa/desactiva la visualización de Aspect 
Ratio para Line A.

Valor conservado

Line B: Aspect Ratio Disp. Activa/desactiva la visualización de Aspect 
Ratio para Line B.

Valor conservado

Line A: User Frame Disp. Activa/desactiva la visualización de User Frame 
Line 1 y User Frame Line 2 para Line A.
Cada vez que se pulsa el botón, la visualización 
cambia entre la pantalla User Frame Line 1 y 2 
 pantalla User Frame Line 1  pantalla 
User Frame Line 2  User Frame Line 1 y 2 
ocultas.

Valor conservado

Line B: User Frame Disp. Activa/desactiva la visualización de User Frame 
Line 1 y User Frame Line 2 para Line B.
Cada vez que se pulsa el botón, la visualización 
cambia entre la pantalla User Frame Line 1 y 2 
 pantalla User Frame Line 1  pantalla 
User Frame Line 2  User Frame Line 1 y 2 
ocultas.

Valor conservado

Auto White Balance 5) Ejecuta el equilibrio del blanco automático. La 
ejecución se detiene si se pulsa durante el 
equilibrio del blanco automático.

–

Picture Cache Rec Activa/desactiva la función de grabación en la 
caché de imágenes.

Valor conservado

Iris Open (1/16 stop) 7) Abre el iris del objetivo.
Manténgalo pulsado para abrir el iris por 
completo.
Esta función está disponible cuando el 
objetivo con soporte E con iris eléctrico está 
colocado.
El ajuste se encuentra en incrementos de 
parada de 1/16, mientras que la indicación del 
iris se encuentra en incrementos de parada de 
1/3.

–

Iris Close (1/16 stop) 7) Cierra el iris del objetivo.
Manténgalo pulsado para cerrar el iris por 
completo.
Esta función está disponible cuando el 
objetivo con soporte E con iris eléctrico está 
colocado.
El ajuste se encuentra en incrementos de 
parada de 1/16, mientras que la indicación del 
iris se encuentra en incrementos de parada de 
1/3.

–

Ajuste del botón asignable Función Estado cuando la unidad 
está encendida

ND +1stop Mueve el filtro ND una posición hacia la 
dirección más oscura.

–

ND -1stop Mueve el filtro ND una posición hacia la 
dirección más brillante.

–

Rec Inicia/detiene la grabación. –
H & V Flip 8) En el modo de filmación, activa o desactiva la 

función para voltear la imagen horizontal y 
verticalmente.

Valor conservado

SxS/Output De-Squeeze Cambia el ajuste Project > Basic Setting > SxS/
Output De-Squeeze del menú completo.
Cada vez que se pulsa el botón, el ajuste 
cambia al siguiente elemento de la lista de 
opciones de selección de menú.

Valor conservado

1)	 No funciona si el botón se pulsa cuando se ajusta Technical > System Configuration > RM/RCP Paint Control (página 83) 
en On en el menú completo.

2)	 También se aplica a la salida HDMI si esta tiene el mismo formato de salida que la salida de Monitor. Puede comprobar el 
ajuste desde Monitoring > OSD Appearance > HDMI (página 73) en el menú completo. La salida HDMI es la misma que la 
salida de Monitor si HDMI se ajusta en “Same as Monitor”.

3)	 Si el formato de la salida SDI es 1920×1080i, la función de amplificador de enfoque está desactivada y, al pulsar el botón, no 
se realiza ninguna función.

4)	 Cambia a la misma imagen que la señal principal seleccionada mediante Project > Basic Setting > Input Color Space 
(página 68) en el menú completo mientras el botón está pulsado.

5)	 No funciona si el botón se pulsa cuando se conecta una RM-B170 u otra unidad de control remoto y se ajusta Technical > 
System Configuration > RM/RCP Paint Control (página 83) en On en el menú completo.

6)	 Cuando se ajusta Technical > System Configuration > RM/RCP Paint Control (página 83) en On y Shooting > LUT Select > 
VF LUT (página 65) está configurado en R709(800%) o R709-Like en el menú completo, esto cambia a la misma imagen 
que la señal principal mientras el botón está pulsado. Cuando se ajusta RM/RCP Paint Control en Off y VF LUT no está 
ajustado en Log, esto cambia a la misma imagen que la señal principal mientras el botón está pulsado.

7)	 No funciona si el botón se pulsa cuando se conecta una RM-B170 u otra unidad de control remoto.
8)	 No funciona si el botón se pulsa cuando Technical > Special Configuration > Flip Image (página 83) H & V Flip está 

atenuado en el menú completo.

Funciones que se pueden asignar a los botones asignables de la A a la C del visor 
(DVF-EL200)

Ajuste del botón asignable Función Estado cuando la unidad 
está encendida

No Assign Sin asignación –
Color Bars 1) Activa/desactiva las barras de color. Valor conservado
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Ajuste del botón asignable Función Estado cuando la unidad 
está encendida

AXS Slot Change Cambia la ranura activa cuando se introducen 
dos tarjetas de memoria AXS.
Cambia entre A y B cada vez que se pulsa el 
botón.

–

SxS Slot Change Cambia la ranura activa cuando se introducen 
dos tarjetas de memoria SxS.
Cambia entre A y B cada vez que se pulsa el 
botón.

–

Rec Review Ejecuta la función de revisión de grabación. Valor no conservado
VF Frame Line Activa/desactiva la superposición de líneas de 

fotogramas en la imagen de salida del visor/
monitor.

Valor conservado

VF Zebra Activa/desactiva la función de cebra de la 
imagen de salida del visor/monitor.

Valor conservado

VF Status Info Activa/desactiva la pantalla de información en 
la imagen de salida del visor/monitor.

Valor conservado

VF Focus Magnifier Activa/desactiva la función de amplificador de 
enfoque del visor.

Valor no conservado

Press & Hold for VF Log 2) Desactiva la LUT aplicada a la imagen de salida 
del visor/monitor mientras se pulsa el botón 
para una calidad de imagen normal sin aplicar 
una LUT.

Valor no conservado

VF Highlight Clip Ind 3) Activa/desactiva la función que muestra las 
áreas resaltadas recortadas en rojo en el visor.

Valor conservado

VF High/Low Key 3) Selecciona el modo de salida del visor.
Cambia entre High Key (pantalla para 
comprobar áreas resaltadas apagadas)  Low 
Key (pantalla para comprobar sombras 
bloqueadas)  Off (pantalla normal) cada vez 
que se pulsa el botón.

Valor no conservado

VF False Color 3) Activa/desactiva la visualización de la función 
de falso color en un visor.

Valor conservado

Line A: Aspect Ratio Disp. Activa/desactiva la visualización de Aspect 
Ratio para Line A.

Valor conservado

Line B: Aspect Ratio Disp. Activa/desactiva la visualización de Aspect 
Ratio para Line B.

Valor conservado

Ajuste del botón asignable Función Estado cuando la unidad 
está encendida

Line A: User Frame Disp. Activa/desactiva la visualización de User Frame 
Line 1 y User Frame Line 2 para Line A.
Cada vez que se pulsa el botón, la visualización 
cambia entre la pantalla User Frame Line 1 y 2 
 pantalla User Frame Line 1  pantalla 
User Frame Line 2  User Frame Line 1 y 2 
ocultas.

Valor conservado

Line B: User Frame Disp. Activa/desactiva la visualización de User Frame 
Line 1 y User Frame Line 2 para Line B.
Cada vez que se pulsa el botón, la visualización 
cambia entre la pantalla User Frame Line 1 y 2 
 pantalla User Frame Line 1  pantalla 
User Frame Line 2  User Frame Line 1 y 2 
ocultas.

Valor conservado

Picture Cache Rec Activa/desactiva la función de grabación en la 
caché de imágenes.

Valor conservado

Iris Open (1/16 stop) 4) Abre el iris del objetivo.
Manténgalo pulsado para abrir el iris por 
completo.
Esta función está disponible cuando el 
objetivo con soporte E con iris eléctrico está 
colocado.
El ajuste se encuentra en incrementos de 
parada de 1/16, mientras que la indicación del 
iris se encuentra en incrementos de parada de 
1/3.

–

Iris Close (1/16 stop) 4) Cierra el iris del objetivo.
Manténgalo pulsado para cerrar el iris por 
completo.
Esta función está disponible cuando el 
objetivo con soporte E con iris eléctrico está 
colocado.
El ajuste se encuentra en incrementos de 
parada de 1/16, mientras que la indicación del 
iris se encuentra en incrementos de parada de 
1/3.

–

ND +1stop Mueve el filtro ND una posición hacia la 
dirección más oscura.

–

ND -1stop Mueve el filtro ND una posición hacia la 
dirección más brillante.

–

Rec Inicia/detiene la grabación. –
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Ajuste del botón asignable Función Estado cuando la unidad 
está encendida

H & V Flip 5) En el modo de filmación, activa o desactiva la 
función para voltear la imagen horizontal y 
verticalmente.

Valor conservado

SxS/Output De-Squeeze Cambia el ajuste Project > Basic Setting > SxS/
Output De-Squeeze del menú completo.
Cada vez que se pulsa el botón, el ajuste 
cambia al siguiente elemento de la lista de 
opciones de selección de menú.

Valor conservado

1)	 No funciona si el botón se pulsa cuando se conecta una RM-B170 u otra unidad de control remoto y se ajusta Technical > 
System Configuration > RM/RCP Paint Control (página 83) en On en el menú completo.

2)	 Cambia a la misma imagen que la señal principal seleccionada mediante Project > Basic Setting > Input Color Space 
(página 68) en el menú completo mientras el botón está pulsado.

3)	 No funciona si el botón se pulsa cuando se ajusta Technical > System Configuration > RM/RCP Paint Control (página 83) 
en On en el menú completo.

4)	 No funciona si el botón se pulsa cuando se conecta una RM-B170 u otra unidad de control remoto.
5)	 No funciona si el botón se pulsa cuando Technical > Special Configuration > Flip Image (página 83) H & V Flip está 

atenuado en el menú completo.
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Operaciones del menú
Si pulsa el botón MENU durante la filmación 
(durante la grabación o la grabación en espera) o 
durante la reproducción, podrá mostrar y utilizar la 
pantalla del menú en la pantalla secundaria.
ˎˎ Categoría Project: configuración básica y ajustes 
del formato de grabación
ˎˎ Categoría TC/Media: valor de código de tiempo 
y ajustes de TC Format
ˎˎ Categoría Monitoring: formato de salida de señal 
externa SDI/HDMI/Monitor, OSD y ajustes de 
estado de superposición de marcador
ˎˎ Categoría Audio: fuente de audio y ajustes del 
nivel de audio
ˎˎ Categoría Info: cámara, soporte y estado de la 
batería

Controles

Botón MENU (página 9)
Púlselo para mostrar el menú en la pantalla 
secundaria.

Teclas ITEM de 1 a 6 (página 9)
Selecciona la categoría del menú.

Mando SEL/SET (mando MENU) (página 9)
Gire el cursor para que se mueva en la dirección 
correspondiente con el fin de seleccionar 
elementos de ajuste o valores de ajuste.
Pulse el mando MENU para aplicar el elemento 
seleccionado.

Botón BACK (página 10)
Púlselo para volver al menú anterior. Los cambios 
que no confirme se cancelarán.

Procedimiento básico

1	 Pulse el botón MENU.
Aparece la pantalla del menú.

2	 Seleccione la categoría que desee configurar 
con las teclas ITEM de 1 a 6.

3	 Gire el mando MENU para situar el cursor en la 
opción de ajuste que desea seleccionar.
En cada opción de ajuste, aparecerá el valor de 
ajuste.

“Lista de elementos del menú” (página 50)

4	 Pulse el mando MENU.
Aparecerá la pantalla de selección del valor de 
ajuste junto al elemento seleccionado.

5	 Gire el mando MENU para situar el cursor en el 
valor de ajuste.

6	 Pulse el mando MENU para aplicar el ajuste.
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Lista de elementos del menú

A continuación se muestran las opciones disponibles en cada categoría.

Categoría Project

Los valores predeterminados aparecen en negrita subrayados.

Elemento Ajustes Descripción
Imager Mode 6K 3:2/6K 1.85:1/6K 17:9/ 

6K 2.39:1/5.7K 16:9/4K 6:5/ 
4K 4:3/4K 4:3 Surround View/ 
4K 17:9/ 
4K 17:9 Surround View/ 
4K 2.39:1/3.8K 16:9/ 
3.8K 16:9 Surround View

Define el tamaño de imagen efectivo.

[Notas]
ˎˎ 6K 3:2/6K 1.85:1/6K 17:9 se muestran solo cuando se 

instala una licencia Full Frame.
ˎˎ 4K 6:5/4K 4:3/4K 4:3 Surround View se muestran solo 

cuando se instala una licencia Anamorphic.

Project Frame Rate 23.98/24/25/29.97/47.95/ 
50/59.94

Define la velocidad de fotograma del proyecto.

Input Color Space S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3 /  
HLG(Natural) / HLG(Live) / 
Rec.2020/User Gamma / 
Rec.709/User Gamma

Configura el espacio de color.

[Notas]
ˎˎ HLG(Natural) / HLG(Live) / Rec.2020/User Gamma 

/ Rec.709/User Gamma puede seleccionarse solo 
cuando se ajusta Technical > System Configuration 
> RM/RCP Paint Control (página 83) en On en el 
menú completo.
ˎˎ HLG(Natural) es equivalente a HLG BT.2100.

AXS Rec Format 1)

(solo si hay una AXS-R7 
conectada)

Rec Off/X-OCN XT/ 
RAW SQ/X-OCN ST/ 
X-OCN LT

Define el formato de grabación para las tarjetas 
de memoria AXS cuando tiene una AXS-R7 
conectada.

SxS Rec Format 1) Rec Off/XAVC 4K Class480/
XAVC 4K Class300/ 
XAVC QFHD Class480/ 
XAVC QFHD Class300/ 
MPEG HD P/MPEG HD i/ 
ProRes 4444 HD P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HQ HD i/ 
ProRes 422 HD P/ 
ProRes 422 HD i/ 
ProRes Proxy HD P/ 
ProRes Proxy HD i

Define el formato de grabación principal para 
las tarjetas de memoria SxS.

[Nota]
ˎˎ ProRes 4444 HD P es compatible solo para los 

siguientes tamaños de imagen efectivos.
–– 5.7K 16:9
–– 4K 6:5
–– 4K 4:3
–– 3.8K 16:9

ˎˎ ProRes 4444 HD P no se puede seleccionar cuando 
Input Color Space está establecido en HLG(Natural), 
HLG(Live) o Rec.2020/User Gamma.

Elemento Ajustes Descripción
Sub Rec Format 1) Rec Off/MPEG HD P/ 

MPEG HD i/ 
ProRes 422 Proxy HD P/ 
ProRes 422 Proxy HD i

Define el formato de grabación secundario para 
las tarjetas de memoria SxS.

Project Details
(tecla ITEM 6)

Muestra los contenidos del menú Project 
(página 68) en el menú completo.

1)	 Los formatos de grabación disponibles varían en función de la combinación de los ajustes de la velocidad de fotograma del 
proyecto y del tamaño de imagen efectivo. Para obtener más información acerca de los ajustes, consulte “Ajuste del formato 
de grabación” (página 54).

Categoría TC/Media

Los valores predeterminados aparecen en negrita subrayados.

Elemento Ajustes Descripción
TC Mode Preset F-Run (Ext-Lk)/Preset 

R-Run/Int Regen
Establece el modo de código de tiempo.
Preset F-Run (Ext-Lk): el código de 
tiempo avanza de manera continua a 
partir del valor especificado, 
independientemente de si se está 
grabando o no.
Preset R-Run: el código de tiempo 
avanza a partir del valor especificado 
solo durante la grabación.
Int Regen: el código de tiempo continúa 
desde el del clip anterior.

TC Display Timecode/Duration Cambia la indicación de datos de 
tiempo.

TC Setting
(se ajusta al cambiar 
a otra pantalla)

Setting 
(H, M, S, F)

Ajusta el código de tiempo a un valor 
deseado.

Reset Restablece el código de tiempo en 
00:00:00:00.

TC Format DF/NDF Define el formato del código de tiempo.
DF: omisión de fotograma
NDF: sin omisión de fotograma

TC Source Internal/External Solo visualización.
Cam ID A a Z Define el ID de cámara que se utilizará al 

generar los nombres de los clips.
Nombre del clip: Camera ID + Reel 
Number + Shot Number + fecha + 
cadena aleatoria
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Elemento Ajustes Descripción
Reel# 001 a 999 Define la parte numérica de Reel 

Number que se utilizará al generar los 
nombres de los clips.
Nombre del clip: Camera ID + Reel 
Number + Shot Number + fecha + 
cadena aleatoria

Camera Position C/L/R Define el primer carácter del número de 
toma que se utilizará al generar los 
nombres de los clips.
Nombre del clip: Camera ID + Reel 
Number + Shot Number + fecha + 
cadena aleatoria

Format Media
(se ejecuta al 
cambiar a otra 
pantalla)

AXS Slot A Formatea la tarjeta de memoria AXS 
insertada en la ranura A.

AXS Slot B Formatea la tarjeta de memoria AXS 
insertada en la ranura B.

SxS Slot A Formatea la tarjeta de memoria SxS 
insertada en la ranura A.

SxS Slot B Formatea la tarjeta de memoria SxS 
insertada en la ranura B.

SD Card Formatea la tarjeta SD.
Media Details
(tecla ITEM 6)

Muestra los contenidos del menú TC/
Media (página 71) en el menú 
completo.

Categoría Monitoring

Los valores predeterminados aparecen en negrita subrayados.

[Notas]
ˎˎ La unidad admite la configuración independiente de Status Info y Frame Line en cada sistema. La información de pantalla 

para las imágenes de salida A y B se configura con el menú Monitoring (página 73).
ˎˎ Es posible que Info y Frame Line no se muestren en función del ajuste Output Format. En este caso, se muestra “–” y el ajuste 

no se puede modificar.

Elemento Ajustes Descripción
VF Status Info Info A/Info B/Off Selecciona la información que aparecerá 

superpuesta en la imagen del visor.
Frame Line Line A/Line B/Off Selecciona las líneas de fotogramas que 

aparecerán superpuestas en la imagen 
del visor.

Elemento Ajustes Descripción
SDI 1/2 Output 

Format
Los ajustes disponibles varían 
en función de los ajustes del 
formato de grabación SxS, del 
modo del generador de 
imágenes y de la velocidad de 
fotogramas del proyecto.

Selecciona el formato de salida de SDI 
1/2.1)

Status Info – La pantalla de información no se 
superpone en la salida SDI 1/2.

Frame Line Line A/Line B/Off Selecciona las líneas de fotogramas que 
aparecerán superpuestas en la salida SDI 
1/2.

[Nota]
Las líneas de fotogramas solo se superponen 
si el formato de salida es 4K/QFHD.

SDI 3/4

[Nota]
Según el ajuste Output 
Format de SDI 1/2, es 
posible que los ajustes 
Output Format, Info y 
Frame Line de SDI 3/4 
estén en blanco y no se 
puedan cambiar.

Output 
Format

Los ajustes disponibles varían 
en función del ajuste de SDI 
1/2.

Selecciona el formato de salida de SDI 
3/4.1)

Status Info Info A/Info B/Off Selecciona la información que aparecerá 
superpuesta en la salida SDI 3/4.

Frame Line Line A/Line B/Off Selecciona las líneas de fotogramas que 
aparecerán superpuestas en la salida SDI 
3/4.

Monitor Output 
Format

Los ajustes disponibles varían 
en función del ajuste de SDI 
1/2.

Selecciona el formato de salida de 
Monitor.2)

Status Info Info A/Info B/Off Selecciona la información que aparecerá 
superpuesta en la salida de Monitor.

Frame Line Line A/Line B/Off Selecciona las líneas de fotogramas que 
aparecerán superpuestas en la salida de 
Monitor.

HDMI Output 
Format

Los ajustes disponibles varían 
en función del ajuste de SDI 
1/2.

Selecciona el formato de salida de 
HDMI.2)

Moni. Details
(tecla ITEM 6)

Muestra los contenidos del menú 
Monitoring (página 73) en el menú 
completo.

1)	 Para obtener más información acerca de los formatos disponibles para la selección, consulte “Formatos de salida del 
conector SDI OUT” (página 119).

2)	 Para obtener más información acerca de los formatos disponibles para la selección, consulte “Formatos de salida del 
conector MONITOR OUT/conector HDMI OUT” (página 123).
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Categoría Audio

Los valores predeterminados aparecen en negrita subrayados.

Elemento Ajustes Descripción
Source Switch LINE / AES/EBU / MIC Muestra la posición del interruptor AUDIO IN 

(página 10) que define la fuente de entrada de 
CH1 y CH2.

CH-1 Audio Level Auto/Manual
–99 a ±0 a +99

El nivel de grabación de audio se ajusta 
automáticamente si selecciona Auto.
El nivel de grabación de audio se ajusta 
manualmente si selecciona Manual.

CH-2 Audio Level Auto/Manual
–99 a ±0 a +99

El nivel de grabación de audio se ajusta 
automáticamente si selecciona Auto.
El nivel de grabación de audio se ajusta 
manualmente si selecciona Manual.

MIC Reference –60dB/–50dB/–40dB Selecciona el nivel de entrada de referencia del 
micrófono.

Monitor CH Cuando Monitor Output CH 
Pair está ajustado en CH-1/CH-2

CH-1/CH-2, CH-1, CH-2
Cuando Monitor Output CH 
Pair está ajustado en CH-3/CH-4

CH-3/CH-4, CH-3, CH-4

Selecciona el canal de audio que se emite a los 
auriculares y al altavoz.

Monitor Level 0 a 99 Ajusta el nivel de audio de monitorización.
CH1 Level Meter – Muestra el medidor de nivel CH1.
CH2 Level Meter – Muestra el medidor de nivel CH2.
CH3 Level Meter – Muestra el medidor de nivel CH3.
CH4 Level Meter – Muestra el medidor de nivel CH4.
Audio Details
(tecla ITEM 6)

Muestra los contenidos del menú Audio 
(página 79) en el menú completo.

Comprobación del estado con la categoría Info

Desde la categoría Info, puede consultar el estado del soporte y de la batería, así como el contenido de los 
avisos y errores que se emiten. Los contenidos de la pantalla se actualizan en tiempo real a medida que 
cambia el estado de la unidad.
La categoría Info está compuesta por las siguientes ocho páginas. Gire el mando MENU para pasar de 
página.

N.º Página Descripción
1 Camera Condition Muestra los mensajes de advertencia y error. Si no hay mensajes, 

en la parte superior de la pantalla se lee “All Systems are OK”.
2 Firmware Muestra el número de serie y la versión de firmware de la unidad, 

y el número de serie y la versión de firmware del AXS-R7 
conectado a la unidad.

3 License Muestra el nombre y el estado/validez de la instalación de las 
licencias de software opcionales. Si una opción no está 
agregada, se mostrará “Not Installed” o “Expired” en el estado de 
la instalación.

4 System Muestra la información del sistema que se indica a continuación.
ˎˎ Fecha y hora

ˎˎ Velocidad de rotación del ventilador

ˎˎ Temperatura de detección del sensor

ˎˎ Contador de horas

ˎˎ IP Address

[Notas]
ˎˎ Si la temperatura de detección del sensor alcanza los 65 °C, se emite 

un mensaje de advertencia por alta temperatura.
ˎˎ Aparece “0.0.0.0” si no se consigue obtener la dirección IP.

5 Battery Muestra la información de la batería que se indica a 
continuación.
ˎˎ Nombre o tipo de batería detectada

ˎˎ Capacidad restante (%)

ˎˎ Tiempo restante estimado

ˎˎ Capacidad restante (Ah)

ˎˎ Tensión (V)

ˎˎ Número de veces que se ha cargado la batería

ˎˎ Fuente de alimentación

ˎˎ Tensión suministrada por la fuente de alimentación

6 Media Muestra la capacidad y tiempo de grabación restantes, los datos 
de vida útil de las tarjetas de memoria SxS, AXS (cuando la 
AXS-R7 está conectada) y SD.
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N.º Página Descripción
7 Lens Muestra la siguiente información sobre el objetivo conectado a 

la unidad.
ˎˎ Nombre del modelo de objetivo

ˎˎ Valor T del iris
	 [Nota]

El valor F-stop se muestra en lugar del valor T-stop si no puede 
obtenerse el valor T-stop.

ˎˎ Distancia focal

ˎˎ Distancia de enfoque

ˎˎ Profundidad de campo

ˎˎ Número de serie

8 Network Muestra la información de configuración de la conexión de red.
ˎˎ Estado (LAN/Wireless Access Point/Wireless Station/Off )

ˎˎ IP Address

ˎˎ SSID

ˎˎ MAC Address

[Nota]
Aparece “0.0.0.0” si no se consigue obtener la dirección IP.
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Ajuste del formato de grabación

Es posible seleccionar los siguientes formatos de grabación para distintas combinaciones de ajustes de velocidad de fotogramas del proyecto y tamaño de imagen efectivo.
Si se selecciona un valor mostrado con el texto en negrita y subrayado, se puede aplicar un ajuste de Log o LUT a la señal de vídeo grabado.

Combinaciones de AXS Rec Format y SxS Rec Format

Tamaño de imagen efectivo (Imager 
Mode)

Principal formato de grabación Project Frame Rate
AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94 

6K 3:2
(6048×4032)

X-OCN XT
X-OCN ST
X-OCN LT

None Sí Sí Sí Sí Sí Sí Sí
4K XAVC-I Class480 Sí Sí Sí Sí – – –
4K XAVC-I Class300 Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
FHD ProRes 422 HQ P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy i – – – – – Sí Sí

6K 1.85:1
(6054×3272)

X-OCN XT
X-OCN ST
X-OCN LT

None Sí Sí Sí Sí Sí Sí Sí
4K XAVC-I Class480 Sí Sí Sí Sí – – –
4K XAVC-I Class300 Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
FHD ProRes 422 HQ P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy i – – – – – Sí Sí

6K 17:9
(6054×3192)

X-OCN XT
X-OCN ST
X-OCN LT

None Sí Sí Sí Sí Sí Sí Sí
4K XAVC-I Class480 Sí Sí Sí Sí – – –
4K XAVC-I Class300 Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
FHD ProRes 422 HQ P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy i – – – – – Sí Sí
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Tamaño de imagen efectivo (Imager 
Mode)

Principal formato de grabación Project Frame Rate
AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94 

6K 2.39:1
(6048×2534)

X-OCN XT
X-OCN ST
X-OCN LT

None Sí Sí Sí Sí Sí Sí Sí
4K XAVC-I Class480 Sí Sí Sí Sí – – –
4K XAVC-I Class300 Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
FHD ProRes 422 HQ P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy i – – – – – Sí Sí

5.7K 16:9
(5674×3192)

X-OCN XT
X-OCN ST
X-OCN LT

None Sí Sí Sí Sí – Sí Sí
QFHD XAVC-I Class480 Sí – Sí Sí – – –
QFHD XAVC-I Class300 Sí – Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
FHD ProRes 422 HQ P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy i – – – – – Sí Sí

4K 6:5
(4096×3432)

X-OCN XT
X-OCN ST
X-OCN LT

None Sí Sí Sí Sí Sí Sí Sí
4K XAVC-I Class480 Sí Sí Sí Sí – – –
4K XAVC-I Class300 Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
FHD ProRes 422 HQ P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy i – – – – – Sí Sí

4K 4:3
(4096×3024)

X-OCN XT
X-OCN ST
X-OCN LT

None Sí Sí Sí Sí Sí Sí Sí
4K XAVC-I Class480 Sí Sí Sí Sí – – –
4K XAVC-I Class300 Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
FHD ProRes 422 HQ P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy i – – – – – Sí Sí
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Tamaño de imagen efectivo (Imager 
Mode)

Principal formato de grabación Project Frame Rate
AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94 

4K 4:3 Surround
(4096×3024)
Tamaño de imagen
(4552×3360)

X-OCN XT
X-OCN ST
X-OCN LT

None Sí Sí Sí Sí – – –
MPEG HD422 P Sí – Sí Sí – – –
FHD ProRes 422 HQ P Sí Sí Sí Sí – – –
FHD ProRes 422 P Sí Sí Sí Sí – – –
FHD ProRes 422 Proxy P Sí Sí Sí Sí – – –

4K 17:9
(4096×2160)

X-OCN XT
RAW SQ
X-OCN ST
X-OCN LT

None Sí Sí Sí Sí Sí Sí Sí
4K XAVC-I Class480 Sí Sí Sí Sí – – –
4K XAVC-I Class300 Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
FHD ProRes 422 HQ P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 HQ i – – – – – Sí Sí
FHD ProRes 422 P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 i – – – – – Sí Sí
FHD ProRes 422 Proxy P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy i – – – – – Sí Sí

4K 17:9 Surround
(4096×2160)
Tamaño de imagen
(4552×2400)

X-OCN XT
RAW SQ
X-OCN ST
X-OCN LT

None Sí Sí Sí Sí – – –
MPEG HD422 P Sí – Sí Sí – – –
FHD ProRes 422 HQ P Sí Sí Sí Sí – – –
FHD ProRes 422 P Sí Sí Sí Sí – – –
FHD ProRes 422 Proxy P Sí Sí Sí Sí – – –

4K 4096×1716 2.39:1 X-OCN XT
X-OCN ST
X-OCN LT

None Sí Sí Sí Sí Sí Sí Sí
4K XAVC-I Class480 Sí Sí Sí Sí – – –
4K XAVC-I Class300 Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
FHD ProRes 422 HQ P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy i – – – – – Sí Sí
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Tamaño de imagen efectivo (Imager 
Mode)

Principal formato de grabación Project Frame Rate
AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94 

3.8K (QFHD) 16:9
(3840×2160)

X-OCN XT
RAW SQ
X-OCN ST
X-OCN LT

None Sí Sí Sí Sí – Sí Sí
QFHD XAVC-I Class480 Sí – Sí Sí – – –
QFHD XAVC-I Class300 Sí – Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
FHD ProRes 422 HQ P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 HQ i – – – – – Sí Sí
FHD ProRes 422 P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 i – – – – – Sí Sí
FHD ProRes 422 Proxy P Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 Proxy i – – – – – Sí Sí

3.8K (QFHD) 16:9 Surround
(3840×2160)
Tamaño de imagen
(4268×2400)

X-OCN XT
RAW SQ
X-OCN ST
X-OCN LT

None Sí Sí Sí Sí – – –
MPEG HD422 P Sí – Sí Sí – – –
FHD ProRes 422 HQ P Sí Sí Sí Sí – – –
FHD ProRes 422 P Sí Sí Sí Sí – – –
FHD ProRes 422 Proxy P Sí Sí Sí Sí – – –

Combinaciones de SxS Rec Format y Sub Rec Format

Tamaño de imagen efectivo (Imager 
Mode)

Formato de grabación Project Frame Rate
Formato de grabación principal SxS 
(SxS Rec Format) 1)

Formato de grabación secundario SxS 
(Sub Rec Format) 2)

23.98 24.00 25.00 29.97 47.95 50.00 59.94

6K 3:2
(6048×4032)

4K XAVC-I Class480 None – – – – – – –
4K XAVC-I Class300 None – – – – – – –
MPEG HD422 P None – – – – – – –
FHD ProRes 422 HQ P None – – – – – – –
FHD ProRes 422 P None – – – – – – –
FHD ProRes 422 Proxy P None – – – – – – –
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Tamaño de imagen efectivo (Imager 
Mode)

Formato de grabación Project Frame Rate
Formato de grabación principal SxS 
(SxS Rec Format) 1)

Formato de grabación secundario SxS 
(Sub Rec Format) 2)

23.98 24.00 25.00 29.97 47.95 50.00 59.94

6K 1.85:1
(6054×3272)

4K XAVC-I Class480 None Sí Sí Sí Sí – – –
MPEG HD422 P Sí – Sí Sí – – –
ProRes 422 Proxy P Sí Sí Sí Sí – – –

4K XAVC-I Class300 None Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
ProRes 422 Proxy P Sí Sí Sí Sí – – –
ProRes 422 Proxy i – – – – – Sí Sí

MPEG HD422 P None Sí – Sí Sí – – –
MPEG HD422 i None – – – – – Sí Sí
FHD ProRes 422 HQ P None Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 P None Sí Sí Sí Sí – Sí Sí

6K 17:9
(6054×3192)

4K XAVC-I Class480 None Sí Sí Sí Sí – – –
MPEG HD422 P Sí – Sí Sí – – –
ProRes 422 Proxy P Sí Sí Sí Sí – – –

4K XAVC-I Class300 None Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
ProRes 422 Proxy P Sí Sí Sí Sí – – –
ProRes 422 Proxy i – – – – – Sí Sí

6K 2.39:1
(6048×2534)

4K XAVC-I Class480 None Sí Sí Sí Sí – – –
MPEG HD422 P Sí – Sí Sí – – –
ProRes 422 Proxy P Sí Sí Sí Sí – – –

4K XAVC-I Class300 None Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
ProRes 422 Proxy P Sí Sí Sí Sí – – –
ProRes 422 Proxy i – – – – – Sí Sí

MPEG HD422 P None Sí – Sí Sí – – –
MPEG HD422 i None – – – – – Sí Sí
FHD ProRes 422 HQ P None Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 P None Sí Sí Sí Sí – Sí Sí
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Tamaño de imagen efectivo (Imager 
Mode)

Formato de grabación Project Frame Rate
Formato de grabación principal SxS 
(SxS Rec Format) 1)

Formato de grabación secundario SxS 
(Sub Rec Format) 2)

23.98 24.00 25.00 29.97 47.95 50.00 59.94

5.7K 16:9
(5674×3192)

QFHD XAVC-I Class480 None Sí – Sí Sí – – –
MPEG HD422 P Sí – Sí Sí – – –
ProRes 422 Proxy P Sí – Sí Sí – – –

QFHD XAVC-I Class300 None Sí – Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
ProRes 422 Proxy P Sí – Sí Sí – – –
ProRes 422 Proxy i – – – – – Sí Sí

MPEG HD422 P None Sí – Sí Sí – – –
FHD ProRes 4444 P None Sí Sí Sí Sí – – –
FHD ProRes 422 HQ P None Sí Sí Sí Sí – – –
FHD ProRes 422 P None Sí Sí Sí Sí – – –

4K 6:5
(4096×3432)

4K XAVC-I Class480 None Sí Sí Sí Sí – – –
MPEG HD422 P Sí – Sí Sí – – –
ProRes 422 Proxy P Sí Sí Sí Sí – – –

4K XAVC-I Class300 None Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
ProRes 422 Proxy P Sí Sí Sí Sí – – –
ProRes 422 Proxy i – – – – – Sí Sí

MPEG HD422 P None Sí – Sí Sí – – –
FHD ProRes 4444 P (Anamorphic: None) None Sí Sí Sí Sí – – –
FHD ProRes 422 HQ P None Sí Sí Sí Sí – – –
FHD ProRes 422 P None Sí Sí Sí Sí – – –

4K 4:3
(4096×3024)

4K XAVC-I Class480 None Sí Sí Sí Sí – – –
MPEG HD422 P Sí – Sí Sí – – –
ProRes 422 Proxy P Sí Sí Sí Sí – – –

4K XAVC-I Class300 None Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
ProRes 422 Proxy P Sí Sí Sí Sí – – –
ProRes 422 Proxy i – – – – – Sí Sí

MPEG HD422 P None Sí – Sí Sí – – –
MPEG HD422 i None – – – – – Sí Sí
FHD ProRes 4444 P None Sí Sí Sí Sí – – –
FHD ProRes 422 HQ P None Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 P None Sí Sí Sí Sí – Sí Sí
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Tamaño de imagen efectivo (Imager 
Mode)

Formato de grabación Project Frame Rate
Formato de grabación principal SxS 
(SxS Rec Format) 1)

Formato de grabación secundario SxS 
(Sub Rec Format) 2)

23.98 24.00 25.00 29.97 47.95 50.00 59.94

4K 4:3 Surround
(4096×3024)
Tamaño de imagen
(4552×3360)

MPEG HD422 P None Sí – Sí Sí – – –
FHD ProRes 422 HQ P None Sí Sí Sí Sí – – –
FHD ProRes 422 P None Sí Sí Sí Sí – – –

4K 17:9
(4096×2160)

4K XAVC-I Class480 None Sí Sí Sí Sí – – –
MPEG HD422 Sí – Sí Sí – – –
ProRes 422 Proxy P Sí Sí Sí Sí – – –

4K XAVC-I Class300 None Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
ProRes 422 Proxy P Sí Sí Sí Sí – – –
ProRes 422 Proxy i – – – – – Sí Sí

4K 4096×1716 2.39:1 4K XAVC-I Class480 None Sí Sí Sí Sí – – –
MPEG HD422 P Sí – Sí Sí – – –
ProRes 422 Proxy P Sí Sí Sí Sí – – –

4K XAVC-I Class300 None Sí Sí Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
ProRes 422 Proxy P Sí Sí Sí Sí – – –
ProRes 422 Proxy i – – – – – Sí Sí

MPEG HD422 P None Sí – Sí Sí – – –
MPEG HD422 i None – – – – – Sí Sí
FHD ProRes 422 HQ P None Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 P None Sí Sí Sí Sí – Sí Sí
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Tamaño de imagen efectivo (Imager 
Mode)

Formato de grabación Project Frame Rate
Formato de grabación principal SxS 
(SxS Rec Format) 1)

Formato de grabación secundario SxS 
(Sub Rec Format) 2)

23.98 24.00 25.00 29.97 47.95 50.00 59.94

3.8K (QFHD) 16:9
(3840×2160)

QFHD XAVC-I Class480 None Sí – Sí Sí – – –
MPEG HD422 P Sí – Sí Sí – – –
ProRes 422 Proxy P Sí – Sí Sí – – –

QFHD XAVC-I Class300 None Sí – Sí Sí – Sí Sí
MPEG HD422 P Sí – Sí Sí – – –
MPEG HD422 i – – – – – Sí Sí
ProRes 422 Proxy P Sí – Sí Sí – – –
ProRes 422 Proxy i – – – – – Sí Sí

MPEG HD422 P None Sí – Sí Sí – – –
MPEG HD422 i None – – – – – Sí Sí
FHD ProRes 4444 P None Sí Sí Sí Sí – – –
FHD ProRes 422 HQ P None Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 HQ i None – – – – – Sí Sí
FHD ProRes 422 P None Sí Sí Sí Sí – Sí Sí
FHD ProRes 422 i None – – – – – Sí Sí

3.8K (QFHD) 16:9 Surround 
(3840×2160)
Tamaño de imagen 
(4268×2400)

MPEG HD422 P None Sí – Sí Sí – – –
FHD ProRes 422 HQ P None Sí Sí Sí Sí – – –
FHD ProRes 422 P None Sí Sí Sí Sí – – –

1)	 Cuando el formato principal de grabación SxS se establece en XAVC, LUT está desactivado (fijo) para la grabación XAVC.
2)	 Cuando el formato de grabación SxS se establece en MPEG o ProRes, se puede seleccionar Log o Look (solo FHD).
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Operaciones del menú completo
El menú completo que permite configurar los 
ajustes necesarios para la filmación y reproducción 
aparece en la pantalla secundaria. Para mostrarla, 
mantenga pulsado el botón MENU durante al 
menos dos segundos.

Estructura del menú

Menú Shooting

Este menú se utiliza para realizar los ajustes 
relacionados con la filmación.

Menú Project

Este menú se utiliza para realizar los ajustes básicos 
para un proyecto.

Menú TC/Media

Este menú se utiliza para realizar los ajustes 
relacionados con el código de tiempo y el soporte 
de grabación.

Menú Monitoring

Este menú se utiliza para realizar los ajustes 
relacionados con la salida de vídeo y del visor.

Menú Audio

Este menú se utiliza para realizar los ajustes 
relacionados con el audio.

Menú Paint

Este menú se utiliza para realizar los ajustes 
relacionados con las funciones de pintura.
El menú Paint puede mostrarse y seleccionarse 
solo cuando se ajusta Technical > System 
Configuration > RM/RCP Paint Control 
(página 83) en On en el menú completo.

Menú Technical

Este menú se utiliza para realizar los ajustes 
relacionados con las cuestiones técnicas.

Menú Maintenance

Este menú se utiliza para realizar los ajustes de la 
unidad, como el reloj y el idioma.

Controles

Botón MENU (página 9)
Manténgalo pulsado durante 2 segundos como 
mínimo para mostrar el menú completo en la 
pantalla secundaria.

Mando SEL/SET (mando MENU) (página 9)
Gire el cursor para que se mueva en la dirección 
correspondiente con el fin de seleccionar 
elementos de ajuste o valores de ajuste.
Pulse el mando MENU para aplicar el elemento 
seleccionado.

Botón BACK (página 10)
Púlselo para volver al menú anterior. Los cambios 
que no confirme se cancelarán.

Configuración de los elementos del 
menú

Gire el mando MENU para desplazar el cursor 
hasta el elemento del menú que desea configurar 
y, a continuación, pulse el mando MENU para 
seleccionar el elemento.
ˎˎ El área de selección de elementos de menú 
puede mostrar 9 líneas como máximo. Cuando 
no es posible mostrar todos los elementos 
seleccionables a la vez, puede desplazar la 
pantalla hacia arriba o abajo moviendo el cursor.
ˎˎ Para los elementos con un rango amplio de 
valores disponibles (p. ej.: de –99 a +99), el área 
de selección no se muestra. El ajuste actual se 
resalta para indicar que el valor está listo para 
modificarse.
ˎˎ Si selecciona Execute para un elemento 
ejecutable, la función correspondiente se 
ejecutará.
ˎˎ Cuando selecciona un elemento que debe 
confirmar antes de la ejecución, se muestra un 
mensaje de confirmación. Siga las instrucciones 
del mensaje para ejecutar o cancelar la 
operación.



000 3. Operaciones de la cámara63

Lista de menús completos
A continuación se enumeran las funciones y los ajustes disponibles en cada una de las opciones de menú.

Menú Shooting

Los valores predeterminados aparecen en negrita subrayados.

Shooting > FPS
Define la velocidad de fotogramas de la filmación.

[Nota]
FPS no se puede configurar si Project > Basic Setting > SxS Rec Format en el menú completo está configurado para la 
grabación entrelazada o la grabación ProRes 4444. En este caso, el ajuste Fixed/Variable Select cambia a Fixed.

Elemento del menú Ajustes Descripción
Fixed/Variable Select Fixed/Variable Selecciona si el ajuste FPS está definido en 

filmación con velocidad constante o variable.
FPS Select Cuando Fixed/Variable Select 

está definido en Fixed, se 
muestra uno de los siguientes 
valores.

Fixed 23.98/Fixed 24.00/Fixed 
25.00/Fixed 29.97/Fixed 
47.95/Fixed 50.00/Fixed 59.94

Selecciona la velocidad de fotogramas de la 
filmación.
Los valores predeterminados varían tal y como se 
muestra a continuación en función del ajuste 
Project Frame Rate.

Project 
Frame 
Rate

Valor 
predeterminado 
cuando Fixed/
Variable Select 
es Variable

Valor mostrado 
cuando Fixed/
Variable Select 
es Fixed

59.94 60 Fixed 59.94

50 50 Fixed 50.00

47.95 48 Fixed 47.95

29.97 30 Fixed 29.97

25 25 Fixed 25.00

24 24 Fixed 24.00

23.97 24 Fixed 23.98

Shooting > Shutter
Realiza ajustes relacionados con el obturador electrónico.

[Nota]
Shutter queda atenuado y no puede utilizarse cuando se conecta una RM-B170 u otra unidad de control remoto y se ajusta 
Technical > System Configuration > RM/RCP Paint Control (página 83) en On en el menú completo.

Elemento del menú Ajustes Descripción
Shutter Select Cuando Shutter Mode 

(página 83) se ajusta en Speed
Opciones de selección 
predeterminadas

1/24, 1/25, 1/30, 1/48, 1/50, 
1/60, 1/100, 1/120, 1/250, 
1/500, 1/1000, 1/2000 1)

Cuando Shutter Mode 
(página 83) se ajusta en Angle
Opciones de selección 
predeterminadas

360.0/180.0/172.8/144.0/ 
90.0/45.0/22.5/11.2/5.6

Cuando Step/Cont. Select está 
ajustado en Continuous, el rango 
de selección es 360.0 a 4.2 
(Angle) o 1/241) a 1/80002) 
(Speed).

Selecciona el ángulo o la velocidad del obturador 
electrónico.
A continuación se indican los valores de velocidad 
predeterminados para los distintos ajustes de 
Project Frame Rate (página 68).

23.98/24: 1/24
25: 1/25
29.97: 1/30
47.95: 1/48
50: 1/50
59.94: 1/60

1)	 Las opciones son 1/60 y valores posteriores cuando 
la velocidad de fotograma del proyecto es 59.94, 
1/50 y valores posteriores cuando es 50.0, 1/30 y 
valores posteriores cuando es 29.97 y 1/25 y valores 
posteriores cuando es 25.0.

2)	 Las opciones son 1/7000 y valores anteriores cuando 
la velocidad de fotograma del proyecto es 50.0 o 25.0 
y 1/6000 y valores anteriores cuando es 24.0 o 23.98.

Step/Cont. Select Step/Continuous Selecciona si los valores del obturador electrónico 
son valores de paso o continuo.

Add/Change Step Añade o edita una opción de selección disponible 
en Shutter Select, en el modo Step.
Es posible añadir hasta 16 opciones de selección.

Delete Step Elimina una opción de selección disponible en 
Shutter Select, en el modo Step.

Shooting > ND
Define la posición del filtro ND.

Elemento del menú Ajustes Descripción
ND Position Clear/0.3/0.6/0.9/1.2/1.5/1.8/ 

2.1/2.4
Selecciona la densidad del filtro ND.
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Shooting > Exposure Index
Establece el valor de EI.

[Nota]
Exposure Index queda atenuado y el ajuste no puede cambiarse cuando se ajusta Technical > System Configuration > RM/
RCP Paint Control (página 83) en On en el menú completo.

Elemento del menú Ajustes Descripción
EI Select El ajuste cambia como se indica a 

continuación en función del 
ajuste de Project > Basic Setting 
> Base ISO (página 68) del 
menú completo.
ISO 500:

125EI/160EI/200EI/250EI/ 
320EI/400EI/500EI/640EI/ 
800EI/1000EI/1250EI/1600EI/ 
2000EI

ISO 2500:
640EI/800EI/1000EI/1250EI/ 
1600EI/2000EI/2500EI/ 
3200EI/4000EI/5000EI/ 
6400EI/8000EI/10000EI

Selecciona el valor de EI.

[Nota]
Los ajustes se fijen en los siguientes valores cuando se 
ajusta Technical > System Configuration > RM/RCP Paint 
Control (página 83) en On en el menú completo.
Cuando Base ISO se ajusta en ISO500: 500EI
Cuando Base ISO se ajusta en ISO2500: 2500EI

Shooting > Gain
Realiza ajustes relacionados con la ganancia.

[Nota]
El ajuste Gain no puede cambiarse cuando se conecta una RM-B170 u otra unidad de control remoto o se ajusta Technical > 
System Configuration > RM/RCP Paint Control (página 83) en Off en el menú completo.

Elemento del menú Ajustes Descripción
Gain Select –6dB/–3dB/0dB/3dB/6dB/9dB/ 

12dB/15dB/18dB
Configura la sensibilidad de base.

Shooting > White Balance
Realiza ajustes relacionados con el equilibrio del blanco.

[Nota]
White Balance queda atenuado y no puede utilizarse cuando se conecta una RM-B170 u otra unidad de control remoto y se 
ajusta Technical > System Configuration > RM/RCP Paint Control (página 83) en On en el menú completo.

Elemento del menú Ajustes Descripción
Color Temp. Select 3200K+00/4300K+00/ 

5500K+00
+ otras opciones que se añadan 
(hasta 16)

Muestra y selecciona la temperatura de color/el 
tono de color del equilibrio del blanco.

Add/Change Step Añade o edita una opción de selección 
modificando la temperatura de color y el valor de 
tinte del equilibrio del blanco.

Delete Step Elimina la opción de selección añadida.

Shooting > White Balance
Realiza ajustes relacionados con el equilibrio del blanco.

[Nota]
White Balance queda atenuado y no puede utilizarse cuando se conecta una RM-B170 u otra unidad de control remoto y se 
ajusta Technical > System Configuration > RM/RCP Paint Control (página 83) en On en el menú completo.

Elemento del menú Ajustes Descripción
Auto White Balance Execute/Cancel Ejecuta el equilibrio del blanco automático (se 

ejecuta al seleccionar Execute).

Shooting > LUT Select
Realiza ajustes relacionados con la LUT para aplicarlos a la imagen de salida.

[Nota]
El valor de cada elemento del menú (excepto SDR Gain) varía en función del ajuste de Technical > System Configuration > 
RM/RCP Paint Control (página 83) en el menú completo.

Elemento del menú Ajustes Descripción
SDI 1/2 Cuando se ajusta RM/RCP Paint 

Control en Off:
Log

Solo se visualiza, ya que la LUT no se puede aplicar 
a la imagen de salida SDI 1/2.

Cuando se ajusta RM/RCP Paint 
Control en On:

Log/HLG(Natural)/HLG(Live)/
User Gamma

El ajuste de imagen de salida SDI 1/2 es solo de 
visualización, porque está determinado por el 
ajuste Project > Basic Setting > Input Color Space 
(página 68) en el menú completo.

SDI 3/4 Cuando se ajusta RM/RCP Paint 
Control en Off:

Log/Look/---

Selecciona la LUT para aplicarla a la imagen de 
salida SDI 3/4.

Cuando se ajusta RM/RCP Paint 
Control en On:

Log/HLG(Natural)/HLG(Live)/
User Gamma

El ajuste de imagen de salida SDI 3/4 es solo de 
visualización, porque está determinado por el 
ajuste Project > Basic Setting > Input Color Space 
(página 68) en el menú completo.
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Shooting > LUT Select
Realiza ajustes relacionados con la LUT para aplicarlos a la imagen de salida.

[Nota]
El valor de cada elemento del menú (excepto SDR Gain) varía en función del ajuste de Technical > System Configuration > 
RM/RCP Paint Control (página 83) en el menú completo.

Elemento del menú Ajustes Descripción
Monitor Cuando se ajusta RM/RCP Paint 

Control en Off:
Cuando se ajusta Output 
Format > SDI 1/2 en 2K/HD:

Log/s709/R709(800%)/ART
Cuando se ajusta Output 
Format > SDI 1/2 en 4K/QFHD:

Log/Look

Selecciona la LUT que se aplicará a la imagen de 
salida de Monitor.

[Nota]
ART se puede seleccionar solo cuando Shooting > Look 
> Category (página 66) está ajustado en ART en el 
menú completo.

Cuando se ajusta RM/RCP Paint 
Control en On, el ajusta cambia 
como se indica a continuación 
en función del ajuste de Project 
> Basic Setting > Input Color 
Space (página 68) del menú 
completo.
S-Gamut3.Cine/SLog3 o 
S-Gamut3/SLog3:

Log/R709(800%)
HLG(Natural):

HLG(Natural)/R709(800%)
HLG(Live):

HLG(Live)/R709(800%)
Rec.2020/User Gamma:

User Gamma/R709-Like
Rec.709/User Gamma:

User Gamma

Selecciona el tipo de imagen de salida del 
monitor.

Shooting > LUT Select
Realiza ajustes relacionados con la LUT para aplicarlos a la imagen de salida.

[Nota]
El valor de cada elemento del menú (excepto SDR Gain) varía en función del ajuste de Technical > System Configuration > 
RM/RCP Paint Control (página 83) en el menú completo.

Elemento del menú Ajustes Descripción
HDMI Cuando se ajusta RM/RCP Paint 

Control en Off:
Log/s709/R709(800%)/ART/
Look

Muestra la LUT que se aplicará a la imagen de 
salida HDMI.

[Nota]
ART se puede seleccionar solo cuando Shooting > Look 
> Category (página 66) está ajustado en ART en el 
menú completo.

Cuando se ajusta RM/RCP Paint 
Control en On (salida 4K/QFHD):

Log/HLG(Natural)/HLG(Live)/
User Gamma

Solo visualización, porque el ajuste de imagen de 
salida HDMI es el mismo que SDI 1/2.

Cuando se ajusta RM/RCP Paint 
Control en On (salida 2K/HD):

Log/HLG(Natural)/HLG(Live)/
User Gamma/R709(800%)/
R709-Like

Solo visualización, porque el ajuste de imagen de 
salida HDMI es el mismo que Monitor.

VF LUT Cuando se ajusta RM/RCP Paint 
Control en Off:
Log/s709/R709(800%)/Look

Selecciona la LUT que se aplicará a la imagen de 
salida del visor/monitor.

[Nota]
Se aplicará un valor de ganancia SDR (–12 dB) a la 
imagen de salida del visor/monitor.

Cuando se ajusta RM/RCP Paint 
Control en On, el ajusta cambia 
como se indica a continuación 
en función del ajuste de Project 
> Basic Setting > Input Color 
Space (página 68) del menú 
completo.
S-Gamut3.Cine/SLog3 o 
S-Gamut3/SLog3:

Log/R709(800%)
HLG(Natural):

HLG(Natural)/R709(800%)
HLG(Live):

HLG(Live)/R709(800%)
Rec.2020/User Gamma:

User Gamma/R709-Like
Rec.709/User Gamma:

User Gamma

Selecciona el tipo de imagen de salida de la 
pantalla del visor/monitor.
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Shooting > LUT Select
Realiza ajustes relacionados con la LUT para aplicarlos a la imagen de salida.

[Nota]
El valor de cada elemento del menú (excepto SDR Gain) varía en función del ajuste de Technical > System Configuration > 
RM/RCP Paint Control (página 83) en el menú completo.

Elemento del menú Ajustes Descripción
SxS Rec Cuando se ajusta RM/RCP Paint 

Control en Off:
Log/Look

Selecciona la LUT que se aplicará al vídeo grabado 
en el clip SDI Main.

Cuando se ajusta RM/RCP Paint 
Control en On:

Log/HLG(Natural)/HLG(Live)/
User Gamma

El ajuste de imagen de grabación del clip SxS 
Main es solo de visualización, porque está 
determinado por el ajuste Project > Basic Setting 
> Input Color Space (página 68) en el menú 
completo.

Sub Rec Cuando se ajusta RM/RCP Paint 
Control en Off:

Log/Look

Selecciona la LUT que se aplicará al vídeo grabado 
en el clip SDI Sub.

Cuando se ajusta RM/RCP Paint 
Control en On:

Log/HLG(Natural)/HLG(Live)/
User Gamma

El ajuste de imagen de grabación del clip SxS Sub 
es solo de visualización, porque está determinado 
por el ajuste Project > Basic Setting > Input Color 
Space (página 68) en el menú completo.

SDR Gain –15dB a 0dB (–12dB) 
(incrementos de 1 dB)

Establece la ganancia de salida SDR en modo 
HDR.
Puede usar este ajuste para cambiar la ganancia 
de la salida del monitor o del visor que está 
ajustada en R709(800%) o R709-Like.

[Nota]
Configurable solo cuando se ajusta Technical > System 
Configuration > RM/RCP Paint Control (página 83) en 
On en el menú completo.

Shooting > Look
Realiza ajustes relacionados con el aspecto predeterminado.

[Nota]
Look queda atenuado y el ajuste no puede cambiarse cuando se ajusta Technical > System Configuration > RM/RCP Paint 
Control (página 83) en On en el menú completo.

Elemento del menú Ajustes Descripción
Category Preset Look/ACES/User 3D LUT/

ART
Selecciona la categoría de la LUT.

[Nota]
ACES se puede seleccionar solo cuando Project > Basic 
Setting > Input Color Space (página 68) está ajustado 
en S-Gamut3/SLog3 en el menú completo.

Preset Look Select s709/R709(800%) /  
S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3

Selecciona Preset Look.
Emite imágenes adecuadas para ser el punto de 
inicio para la corrección del color o imágenes que 
se acercan a la calidad de la película de impresión.
s709: color de cine
R709(800%): color fiel
S-Gamut3/SLog3: amplio espacio de color
S-Gamut3.Cine/SLog3: espacio de color para cine 
digital

[Notas]
ˎˎ Configurable solo cuando Category está ajustada en 

Preset Look.
ˎˎ S-Gamut3/SLog3 se puede seleccionar solo 

cuando Project > Basic Setting > Input Color Space 
(página 68) está ajustado en S-Gamut3/SLog3 en el 
menú completo.

ACES Select ACESproxy/ACEScct/ 
ACES 1.0 Output-Rec.709

Selecciona el tipo de Look estándar ACES.
ACESproxy: curva de Log de amplio espacio de 

color (AP1) definida por la academia.
ACEScct: curva de Log de amplio espacio de color 

(AP1) basada en ACESproxy, con la 
característica Toe que reduce el contraste en 
la curva cerca del negro.

ACES 1.0 Output-Rec.709: Look con referencia 
Rec.709 definido por la academia.

[Nota]
Configurable solo cuando Category está ajustada en 
ACES.

User 3D LUT Select El nombre de archivo (01 a 16) de 
los archivos User 3D LUT 
almacenados en la memoria 
interna

Selecciona el archivo User 3D LUT.

[Nota]
Configurable solo cuando Category está ajustada en 
User 3D LUT.

ART Select El nombre de archivo (01 a 16) de 
los archivos ART almacenados en 
la memoria interna

Selecciona el archivo ART.

[Nota]
Configurable solo cuando Category está ajustado en ART.
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Shooting > Look
Realiza ajustes relacionados con el aspecto predeterminado.

[Nota]
Look queda atenuado y el ajuste no puede cambiarse cuando se ajusta Technical > System Configuration > RM/RCP Paint 
Control (página 83) en On en el menú completo.

Elemento del menú Ajustes Descripción
ART Information Muestra información del archivo ART 

seleccionado por ART Select.

[Nota]
Solo se muestra cuando Category está ajustado en ART.

ASC CDL Process CDL Off/Look-> CDL/ 
CDL -> Look

Establecer si aplicar ASC CDL al vídeo de salida. Al 
aplicar, especifique la secuencia de 
procesamiento de ASC CDL.
CDL Off: No aplicar ASC CDL al vídeo de salida.
CDL -> Look: Aplicar CDL antes de aplicar Look.
Look -> CDL: Aplicar CDL después de aplicar Look.

[Notas]
ˎˎ ASC CDL está habilitado para las salidas en las que 

Look se ha seleccionado en Shooting > LUT Select 
(página 64) en el menú completo.
ˎˎ A continuación se muestran las condiciones en 

las que las opciones de ASC CDL Process están 
habilitadas.

Shooting > Look > Project > Basic 
Setting > Input 
Color Space

Opciones 
disponibles 
de ASC CDL 
Process

Category Preset Look 
Select

ACES 
Select

User 3D 
LUT Select

Preset 
Look

s709 – – S-Gamut3/SLog3
S-Gamut3.Cine/
SLog3

CDL Off
Look -> CDL
CDL -> Look

R709(800%)
S-Gamut3/
SLog3
S-Gamut3.
Cine/SLog3

– – S-Gamut3/SLog3
S-Gamut3.Cine/
SLog3

CDL Off
Look -> CDL

ACES – ACESproxy
ACEScct
ACES 1.0 
Output-
Rec.709

– S-Gamut3/SLog3 CDL Off
CDL -> Look

User 3D 
LUT

– – s709xxx.
cube

S-Gamut3/SLog3
S-Gamut3.Cine/
SLog3

CDL Off
Look -> CDL
CDL -> Look

Shooting > Look
Realiza ajustes relacionados con el aspecto predeterminado.

[Nota]
Look queda atenuado y el ajuste no puede cambiarse cuando se ajusta Technical > System Configuration > RM/RCP Paint 
Control (página 83) en On en el menú completo.

Elemento del menú Ajustes Descripción
ASC CDL Select No File/Not Selected Selecciona el ASC CDL registrado en la unidad.
ASC CDL Information Muestra información del archivo ASC CDL 

seleccionado por ASC CDL Select.

Shooting > Look File
Carga un archivo User 3D LUT en la unidad.

[Nota]
Look File queda atenuado y el ajuste no puede cambiarse cuando se ajusta Technical > System Configuration > RM/RCP Paint 
Control (página 83) en On en el menú completo.

Elemento del menú Ajustes Descripción
Load User 3D LUT Carga en la unidad un archivo User 3D LUT 

almacenado en una tarjeta SD.
Reset User 3D LUT Restablece un ajuste de datos de User 3D LUT.
Reset All User 3D LUTs Execute/Cancel Restablece todos los ajustes de datos de User 3D 

LUT (se ejecuta al seleccionar Execute).
Load ART Carga en la unidad un archivo ART almacenado 

en una tarjeta SD.
Reset ART Restablece los ajustes de datos de ART.
Reset All ARTs Execute/Cancel Restablece todos los ajustes de datos de ART (se 

ejecuta al seleccionar Execute).
Load ASC CDL Carga datos de ASC CDL desde una tarjeta SD.
Reset ASC CDL Restablece los ajustes de datos de ASC CDL.
Reset All ASC CDLs Execute/Cancel Restablece todos los ajustes de datos de ASC CDL 

(se ejecuta al seleccionar Execute).

Shooting > Flicker Reduce
Realiza ajustes relacionados con la reducción del parpadeo.

Elemento del menú Ajustes Descripción
Mode On/Off Activa/desactiva la función de reducción del 

parpadeo.
Frequency 50Hz/60Hz Establece la frecuencia de la red de alimentación 

de la iluminación que causa el parpadeo.
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Menú Project

Los valores predeterminados aparecen en negrita subrayados.

Project > Basic Setting
Realiza los ajustes relacionados con el tamaño de imagen y la velocidad de fotograma del proyecto.

Elemento del menú Ajustes Descripción
Imager Mode 6K 3:2/6K 1.85:1/6K 17:9/ 

6K 2.39:1/5.7K 16:9/4K 6:5/ 
4K 4:3/4K 4:3 Surround View/ 
4K 17:9/4K 17:9 Surround View/ 
4K 2.39:1/3.8K 16:9/ 
3.8K 16:9 Surround View

Selecciona el tamaño de imagen efectivo.

[Notas]
ˎˎ 6K 3:2/6K 1.85:1/6K 17:9 se muestran solo cuando se 

instala una licencia Full Frame.
ˎˎ 4K 6:5/4K 4:3/4K 4:3 Surround View se muestran solo 

cuando se instala una licencia Anamorphic.

Project Frame Rate 23.98/24/25/29.97/47.95/ 
50/59.94

Selecciona la velocidad de fotograma del 
proyecto.

Input Color Space S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3 /  
HLG(Natural) / HLG(Live) / 
Rec.2020/User Gamma / Rec.709/
User Gamma

Configura el espacio de color.

[Notas]
ˎˎ HLG(Natural) / HLG(Live) / Rec.2020/User Gamma 

/ Rec.709/User Gamma puede seleccionarse solo 
cuando se ajusta Technical > System Configuration 
> RM/RCP Paint Control (página 83) en On en el 
menú completo.
ˎˎ HLG(Natural) es equivalente a HLG BT.2100.

AXS Rec Format
(solo si hay una AXS-R7 
conectada)

Rec Off/X-OCN XT/RAW SQ/ 
X-OCN ST/X-OCN LT

Selecciona el formato de vídeo para grabar en la 
tarjeta de memoria AXS insertada en la AXS-R7.

SxS Rec Format Rec Off/XAVC 4K Class480/ 
XAVC 4K Class300/ 
XAVC QFHD Class480/ 
XAVC QFHD Class300/ 
MPEG HD P/MPEG HD i/ 
ProRes 4444 HD P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HQ HD i/ 
ProRes 422 HD P/ 
ProRes 422 HD i/ 
ProRes 422 Proxy HD P/ 
ProRes 422 Proxy HD i

Selecciona el formato de vídeo que se grabará en 
una tarjeta de memoria SxS.

[Notas]
ˎˎ ProRes 4444 HD P es compatible solo para los 

siguientes tamaños de imagen efectivos.
–– 5.7K 16:9
–– 4K 6:5
–– 4K 4:3
–– 3.8K 16:9

ˎˎ ProRes 4444 HD P no se puede seleccionar cuando 
Input Color Space está establecido en HLG(Natural), 
HLG(Live) o Rec.2020/User Gamma.

Sub Rec Format Rec Off/MPEG HD P/MPEG HD i/
ProRes 422 Proxy HD P/ 
ProRes 422 Proxy HD i

Selecciona el formato de grabación secundario 
para las tarjetas de memoria SxS.

Base ISO ISO 500/ISO 2500 Configura la sensibilidad de base.

Project > Basic Setting
Realiza los ajustes relacionados con el tamaño de imagen y la velocidad de fotograma del proyecto.

Elemento del menú Ajustes Descripción
SxS/Output De-
Squeeze

Off (1.0×)/1.25×/1.3×/1.5×/ 
1.65×/1.8×/2.0×

Establece el proceso de descompresión para las 
señales de grabación de SxS y las señales de salida 
de vídeo.
Este ajuste está disponible cuando se instala una 
licencia Anamorphic y el modo del generador de 
imágenes se establece en 4K 4:3/4K 4:3 Surround 
View/4K 6:5/4K 17:9/4K 17:9 Surround View/6K 
3:2/6K 17:9, o cuando se instalan una licencia 
Anamorphic y una licencia Full Frame y el modo 
del generador de imágenes se establece en 6K 
3:2/6K 17:9. Las opciones varían en función del 
tamaño de la imagen.

Imager Mode SxS/Output De-Squeeze
Off (1.0×) 1.25× 1.3× 1.5× 1.65x 1.8× 2.0×

6K 3:2 Sí Sí Sí Sí Sí Sí Sí
6K 1.85:1 Sí – – – – – –
6K 17:9 Sí Sí Sí – Sí Sí Sí
6K 2.39:1 Sí – – – – – –
5.7K 16:9 Sí – – – – – –
4K 6:5 Sí – – – – – Sí
4K 4:3 Surround Sí – Sí – Sí Sí Sí
4K 4:3 Sí – Sí – Sí Sí Sí
4K 17:9 Surround Sí Sí Sí – Sí Sí Sí
4K 17:9 Sí Sí Sí – Sí Sí Sí
4K 2.39:1 Sí – – – – – –
3.8K 16:9 Surround Sí – – – – – –
3.8K 16:9 Sí – – – – – –

Se aplican restricciones al tamaño de imagen 
efectivo compatible para la salida RGB en HD 
ProRes 4444. Las opciones disponibles se 
muestran más abajo.

Imager Mode SxS/Output De-Squeeze
Off (1.0×) 1.25× 1.3× 1.5× 1.65× 1.8× 2.0×

5.7K 16:9 Sí – – – – – –
4K 6:5 Sí – – – – – –
4K 4:3 Sí – Sí – – – –
3.8K 16:9 Sí – – – – – –
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Project > Special Recording
Realiza ajustes relacionados con la grabación en la caché de imágenes.

Elemento del menú Ajustes Descripción
Cache Rec Select On/Off Activa/desactiva la función de grabación en la 

caché de imágenes.
No se admite la grabación en caché de imágenes 
(definida en Off y atenuada) en los siguientes 
casos.
ˎˎ Cuando se selecciona el formato de grabación 

XAVC-I Class480 (4K, QFHD)

ˎˎ Para algunas combinaciones de ajustes de tamaño 
de imagen efectivo y frecuencia del sistema

ˎˎ Cuando AXS Rec Format y SxS Rec Format se 
establecen en Rec Off

ˎˎ Durante la grabación simultánea de AXS y SxS

Max Cache Rec 
Duration

2sec/4sec/6sec/8sec/10sec/ 
15sec/24sec/30sec

Establece la duración de reproducción del vídeo 
en la caché en la memoria caché de imágenes.
A continuación se proporciona el valor máximo 
que se puede definir para cada tarjeta de 
memoria.

Cuando se graba en una tarjeta de memoria SxS

SxS Rec Format Project Frame Rate
23.98 24 25 29.97 47.95 50 59.94

4K/QFHD XAVC-I Class480 – – – – – – –
4K/QFHD XAVC-I Class300 2 2 2 2 – – –
FHD ProRes 4444 HQ P 2 2 2 2 – – –
2K/FHD ProRes 422 HQ P 2 2 2 2 – – –
2K/FHD ProRes 422 HQ i – – – – – 2 2
2K/FHD ProRes 422 P 6 6 6 6 – 2 2
2K/FHD ProRes 422 i – – – – – 6 6
MPEG HD422 P 15 – 15 15 – – –
MPEG HD422 i – – – – – 15 15

Project > Special Recording
Realiza ajustes relacionados con la grabación en la caché de imágenes.

Elemento del menú Ajustes Descripción
Cuando se graba en una tarjeta de memoria AXS

Imager 
Mode

AXS Rec 
Format

Project Frame Rate

23.98 24 25 29.97 47.95 50 59.94
6K 3:2 X-OCN XT 4 4 2 2 – – –

X-OCN ST 8 8 8 6 – – –
X-OCN LT 15 15 15 15 6 6 4

6K 1.85:1 X-OCN XT 6 6 6 4 – – –
X-OCN ST 10 10 10 8 2 2 –
X-OCN LT 24 24 24 15 10 10 6

6K 17:9 X-OCN XT 6 6 6 4 – – –
X-OCN ST 10 10 10 8 4 2 2
X-OCN LT 24 24 24 15 10 10 8

6K 2.39:1 X-OCN XT 10 10 10 6 2 2 –
X-OCN ST 15 15 15 10 6 6 4
X-OCN LT 30 30 30 24 15 15 10

5.7K 16:9 X-OCN XT 6 6 6 4 – – –
X-OCN ST 10 10 10 8 – 2 2
X-OCN LT 24 24 24 15 – 10 8

4K 6:5 X-OCN XT 10 10 10 8 2 2 –
X-OCN ST 15 15 15 15 8 6 4
X-OCN LT 30 30 30 30 15 15 10

4K 4:3 X-OCN XT 15 15 10 10 4 4 2
X-OCN ST 24 24 24 15 8 8 6
X-OCN LT 30 30 30 30 15 15 15
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Project > Special Recording
Realiza ajustes relacionados con la grabación en la caché de imágenes.

Elemento del menú Ajustes Descripción

Imager 
Mode

AXS Rec 
Format

Project Frame Rate

23.98 24 25 29.97 47.95 50 59.94
4K 4:3 
Surround

X-OCN XT 15 15 10 10 – – –
X-OCN ST 24 24 24 15 – – –
X-OCN LT 30 30 30 30 – – –

4K 17:9 RAW SQ 24 24 24 15 8 8 6
X-OCN XT 24 24 24 15 8 8 6
X-OCN ST 30 30 30 30 15 15 10
X-OCN LT 30 30 30 30 30 30 24

4K 17:9 
Surround

RAW SQ 24 24 24 15 – – –
X-OCN XT 24 24 24 15 – – –
X-OCN ST 30 30 30 30 – – –
X-OCN LT 30 30 30 30 – – –

4K 2.39:1 X-OCN XT 30 30 30 24 10 10 10
X-OCN ST 30 30 30 30 15 15 15
X-OCN LT 30 30 30 30 30 30 30

3.8K(QFHD) 
16:9

X-OCN XT 24 24 24 15 – 8 6
X-OCN ST 30 30 30 30 – 15 10
X-OCN LT 30 30 30 30 – 30 24

3.8K(QFHD) 
16:9 
Surround

X-OCN XT 24 24 24 15 – – –
X-OCN ST 30 30 30 30 – – –
X-OCN LT 30 30 30 30 – – –

Project > Assignable Button
Asigna funciones a los botones asignables.

Para obtener más información acerca de la asignación de funciones, consulte “Pantalla de funciones del usuario” (página 43).

Elemento del menú Ajustes Descripción
<1> página 43 Asigna una función al botón asignable 1.
<2> página 43 Asigna una función al botón asignable 2.
<3> página 43 Asigna una función al botón asignable 3.
<4> página 43 Asigna una función al botón asignable 4.
<5> página 43 Asigna una función al botón asignable 5.

[Nota]
Se muestra solo cuando se ha conectado un CBK-3620XS 
a la unidad.

<6> página 43 Asigna una función al botón asignable 6.

[Nota]
Se muestra solo cuando se ha conectado un CBK-3620XS 
a la unidad.

<7> página 43 Asigna una función al botón asignable 7.

[Nota]
Se muestra solo cuando se ha conectado un CBK-3620XS 
a la unidad.

<VF A> página 43 Asigna una función al botón asignable A en el 
visor (DVF-EL200).

<VF B> página 43 Asigna una función al botón asignable B en el 
visor (DVF-EL200).

<VF C> página 43 Asigna una función al botón asignable C en el 
visor (DVF-EL200).

<User 1> página 43 Asigna una función a la tecla ITEM 1.
<User 2> página 43 Asigna una función a la tecla ITEM 2.
<User 3> página 43 Asigna una función a la tecla ITEM 3.
<User 4> página 43 Asigna una función a la tecla ITEM 4.
<User 5> página 43 Asigna una función a la tecla ITEM 5.

Project > All File
Realiza ajustes relacionados con los archivos con todos los ajustes.

Elemento del menú Ajustes Descripción
Load SD Card Carga un archivo con todos los ajustes desde una 

tarjeta SD.
Save SD Card Guarda un archivo con todos los ajustes en una 

tarjeta SD.
File ID Muestra el ID de un archivo con todos los ajustes 

para su edición.
Format SD Card Formatea una tarjeta SD.
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Project > Scene File
Realiza ajustes relacionados con los archivos de escena.

[Nota]
Scene File puede mostrarse y seleccionarse solo cuando se ajusta Technical > System Configuration > RM/RCP Paint Control 
(página 83) en On en el menú completo.

Elemento del menú Ajustes Descripción
Recall Internal Memory Carga un archivo de escena desde la memoria 

interna.
Store Internal Memory Guarda un archivo de escena en la memoria 

interna.
Load SD Card Carga un archivo de escena desde una tarjeta SD.
Save SD Card Guarda un archivo de escena en una tarjeta SD.
File ID Muestra el ID del archivo de escena para su 

edición.

Project > User Gamma
Realiza ajustes relacionados con los archivos de gamma del usuario.

[Nota]
User Gamma puede mostrarse y seleccionarse solo cuando se ajusta Technical > System Configuration > RM/RCP Paint 
Control (página 83) en On en el menú completo.

Elemento del menú Ajustes Descripción
Current Settings Muestra el nombre del archivo de gamma del 

usuario actual en la memoria interna.
Load SD Card Carga los datos de la tabla de gamma definida por 

el usuario (archivo de gamma del usuario) desde 
una tarjeta SD a la memoria interna.
Guarda los archivos de gamma del usuario 
creados con RAW Viewer para que la unidad los 
use en el siguiente directorio de la tarjeta SD.
PRIVATE\SONY\PRO\CAMERA\MPC3610

Reset 1/2/3/4/5/All Restablece los archivos de gamma del usuario de 
la memoria interna a los ajustes iniciales.
De 1 a 5: se restablecen individualmente
All: se restablecen todos

Menú TC/Media

Los valores predeterminados aparecen en negrita subrayados.

TC/Media > Timecode
Realiza ajustes relacionados con el código de tiempo.

Elemento del menú Ajustes Descripción
Mode Preset F-Run (Ext-Lk)/ 

Preset R-Run/Int Regen
Selecciona el modo del código de tiempo.
Preset F-Run (Ext-Lk): el código de tiempo avanza 

de manera continua a partir del valor 
especificado, en sincronización con el código 
de tiempo de entrada externo.

Preset R-Run: el código de tiempo avanza a partir 
del valor especificado solo durante la 
grabación.

Int Regen: el código de tiempo continúa desde el 
del clip anterior.

Manual Setting De 00:00:00:00 a 23:59:59:29 Establece un valor de código de tiempo arbitrario.
Reset Execute/Cancel Restablece el código de tiempo a 00:00:00:00 (se 

ejecuta al seleccionar Execute).
TC Format DF/NDF Selecciona el formato del código de tiempo.

DF: omisión de fotograma
NDF: sin omisión de fotograma

TC Source Internal/External Muestra la fuente de sincronización TCG.
Time Data Display Timecode/Duration Selecciona los datos de tiempo que se mostrarán.

TC/Media > Clip Name Format
Configura los nombres de clip. (Nombre del clip: Camera ID + Reel Number + Shot Number + fecha + 
cadena aleatoria)

Elemento del menú Ajustes Descripción
Camera ID A a Z Define el ID de cámara que se utilizará al generar 

los nombres de los clips.
Reel Number 001 a 999 Define la parte numérica de Reel Number que se 

utilizará al generar los nombres de los clips.
Camera Position C/L/R Define el primer carácter del número de toma 

que se utilizará al generar los nombres de los clips.
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TC/Media > Clip Name Format
Configura los nombres de clip. (Nombre del clip: Camera ID + Reel Number + Shot Number + fecha + 
cadena aleatoria)

Elemento del menú Ajustes Descripción
SxS Root Folder Name XDROOT/Cam ID + Reel# Establece el formato de nombres para la etiqueta 

de volumen y los nombres de la carpeta raíz en 
una tarjeta SxS.
XDROOT: la carpeta raíz se llama “XDROOT”.
Cam ID + Reel#: el nombre de la etiqueta de 

volumen y el nombre de la carpeta raíz 
siguen el formato de nombre de Cam ID.

[Notas]
ˎˎ Si el ajuste se cambia, no es posible la reproducción 

en videocámaras Sony y VTR distintas a la MPC-3610 y 
PMW-PZ1 (el ajuste debe cambiarse en la PMW-PZ1).
ˎˎ Los cambios en el nombre de la etiqueta de volumen 

y el nombre de la carpeta raíz se aplican cuando 
comienza la grabación.
ˎˎ En los medios en los que el nombre de la carpeta 

raíz se ha establecido en el formato de nombre 
Camera ID, el nombre de la carpeta raíz no se puede 
restablecer a “XDROOT” utilizando este ajuste.
ˎˎ La carpeta raíz se establece en “XDROOT” cuando se 

da formato al medio.
ˎˎ Si el medio grabado con un nombre de carpeta raíz 

en el formato de nombres Camera ID se inserta en 
un dispositivo que no admite el formato de nombre 
Camera ID (incluido Venice V2.0 o anterior), se crea 
una carpeta XDROOT y se reconoce como la carpeta 
raíz (porque no se puede reconocer una carpeta raíz 
en el formato de nombre Camera ID).

TC/Media > Format Media
Formatea el soporte.

Elemento del menú Ajustes Descripción
AXS Slot A
(solo si hay una AXS-R7 
conectada)

Execute/Cancel Inicia la tarjeta de memoria AXS insertada en la 
ranura A (se ejecuta al seleccionar Execute).

AXS Slot B
(solo si hay una AXS-R7 
conectada)

Execute/Cancel Inicia la tarjeta de memoria AXS insertada en la 
ranura B (se ejecuta al seleccionar Execute).

SxS Slot A Execute/Cancel Inicia la tarjeta de memoria SxS insertada en la 
ranura A (se ejecuta al seleccionar Execute).

SxS Slot B Execute/Cancel Inicia la tarjeta de memoria SxS insertada en la 
ranura B (se ejecuta al seleccionar Execute).

SD Card Execute/Cancel Formatea la tarjeta SD (se ejecuta al seleccionar 
Execute).

TC/Media > Update Media
Actualiza el archivo de gestión del soporte.

Elemento del menú Ajustes Descripción
AXS Slot A
(solo si hay una AXS-R7 
conectada)

Execute/Cancel Actualiza el archivo de gestión de la tarjeta de 
memoria AXS insertada en la ranura A de la 
AXS-R7 (se ejecuta al seleccionar Execute).

AXS Slot B
(solo si hay una AXS-R7 
conectada)

Execute/Cancel Actualiza el archivo de gestión de la tarjeta de 
memoria AXS insertada en la ranura B de la 
AXS-R7 (se ejecuta al seleccionar Execute).

SxS Slot A Execute/Cancel Actualiza el archivo de gestión de la tarjeta de 
memoria SxS insertada en la ranura A (se ejecuta 
al seleccionar Execute).

SxS Slot B Execute/Cancel Actualiza el archivo de gestión de la tarjeta de 
memoria SxS insertada en la ranura B (se ejecuta 
al seleccionar Execute).
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Menú Monitoring

Los valores predeterminados aparecen en negrita subrayados.

Monitoring > Output Format
Realiza ajustes relacionados con el formato de salida.

Elemento del menú Ajustes Descripción
SDI 1/2 Los ajustes disponibles varían en 

función de los ajustes del 
formato de grabación SxS, del 
modo del generador de 
imágenes y de la velocidad de 
fotogramas del proyecto.

Selecciona el formato de salida de SDI 1/2.
Los ajustes varían en función del formato de 
grabación (página 119).

SDI 3/4 Los ajustes disponibles varían en 
función del ajuste de SDI 1/2.

Selecciona el formato de salida de SDI 3/4.
Los ajustes varían en función del formato de 
grabación (página 119).

Monitor Los ajustes disponibles varían en 
función del ajuste de SDI 1/2.

Selecciona el formato de salida de Monitor.
Los ajustes varían en función del formato de 
grabación (página 123).

HDMI Los ajustes disponibles varían en 
función del ajuste de SDI 1/2.

Selecciona el formato de salida de HDMI.
Los ajustes varían en función del formato de 
grabación (página 123).

Monitoring > OSD Appearance
Realiza ajustes relacionados con la información y las líneas de fotogramas superpuestos en cada señal de 
salida.
El ajuste On/Off se selecciona utilizando una casilla de verificación (excepto Frame Line on Playback).
On: casilla de verificación seleccionada
Off: casilla de verificación no seleccionada

Elemento del menú Ajustes Descripción
VF Status Info (On/Off,  

Info. A/Info. B)
Selecciona la información que aparecerá 
superpuesta en la imagen de salida del visor/
monitor.

Frame Line (On/Off, 
Line A/Line B)

Selecciona las líneas de fotogramas que 
aparecerán superpuestas en la imagen de salida 
del visor/monitor.

SDI
SDI 1/2
SDI 3/4

[Nota]
La visualización cambia 
según el juste de Output 
Format > SDI 1/2 y SDI 
3/4.

Status Info (On/Off,  
Info. A/Info. B)

Selecciona la información que aparecerá 
superpuesta en la señal de salida SDI 3/4.

Frame Line (On/Off,  
Line A/Line B)

Selecciona las líneas de fotogramas que 
aparecerán superpuestas en la señal de salida SDI 
3/4.

Monitoring > OSD Appearance
Realiza ajustes relacionados con la información y las líneas de fotogramas superpuestos en cada señal de 
salida.
El ajuste On/Off se selecciona utilizando una casilla de verificación (excepto Frame Line on Playback).
On: casilla de verificación seleccionada
Off: casilla de verificación no seleccionada

Elemento del menú Ajustes Descripción
Monitor Status Info (On/Off,  

Info. A/Info. B)
Selecciona la información que aparecerá 
superpuesta en la señal de salida de Monitor.

Frame Line (On/Off,  
Line A/Line B)

Selecciona las líneas de fotogramas que 
aparecerán superpuestas en la señal de salida de 
Monitor.

HDMI Same as SDI/Same as Monitor Selecciona si la información que aparece 
superpuesta en la señal de salida HDMI coincide 
con la de la señal de salida SDI o con la de la señal 
de salida Monitor.
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Monitoring > OSD Appearance
Realiza ajustes relacionados con la información y las líneas de fotogramas superpuestos en cada señal de 
salida.
El ajuste On/Off se selecciona utilizando una casilla de verificación (excepto Frame Line on Playback).
On: casilla de verificación seleccionada
Off: casilla de verificación no seleccionada

Elemento del menú Ajustes Descripción
Status Info A/B Setup Project

Info. A (On/Off )
Info. B (On/Off )

Selecciona si mostrar el proyecto en la 
información de salida configurada para Status Info 
A y Status Info B.

Timecode
Info. A (On/Off)
Info. B (On/Off )

Selecciona si mostrar el código de tiempo en la 
información de salida configurada para Status Info 
A y Status Info B.

Audio Level Meter
Info. A (On/Off)
Info. B (On/Off)

Selecciona si mostrar el nivel de audio en la 
información de salida configurada para Status Info 
A y Status Info B.

Look Status
Info. A (On/Off)
Info. B (On/Off)

Selecciona si mostrar el tipo de bloqueo 
seleccionado en la información de salida 
configurada para Status Info A y Status Info B.

Output LUT
Info. A (On/Off)
Info. B (On/Off )

Selecciona si mostrar la LUT de salida en la 
información de salida configurada para Status Info 
A y Status Info B.

Recording LUT
Info. A (On/Off)
Info. B (On/Off )

Selecciona si mostrar la LUT de grabación en la 
información de salida configurada para Status Info 
A y Status Info B.

VF Status
Info. A (On/Off )
Info. B (On/Off)

Selecciona si mostrar el estado del visor en la 
información de salida configurada para Status Info 
A y Status Info B.

Lens Status
Info. A (On/Off )
Info. B (On/Off )

Selecciona si mostrar el estado del objetivo en la 
información de salida configurada para Status Info 
A y Status Info B.

Remote Control Status
Info. A (On/Off )
Info. B (On/Off)

Selecciona si mostrar el estado del control remoto 
en la información de salida configurada para 
Status Info A y Status Info B.

Level Gauge
Info. A (On/Off )
Info. B (On/Off)

Selecciona si mostrar el indicador de nivel de 
burbuja gráfico en la información de salida 
configurada para Status Info A y Status Info B.

[Nota]
Level Gauge queda atenuado y no puede utilizarse 
cuando se conecta un CBK-3610XS a la unidad.

Monitoring > OSD Appearance
Realiza ajustes relacionados con la información y las líneas de fotogramas superpuestos en cada señal de 
salida.
El ajuste On/Off se selecciona utilizando una casilla de verificación (excepto Frame Line on Playback).
On: casilla de verificación seleccionada
Off: casilla de verificación no seleccionada

Elemento del menú Ajustes Descripción
Roll/Tilt Value

Info. A (On/Off )
Info. B (On/Off)

Selecciona si mostrar el indicador de nivel de 
burbuja numérico en la información de salida 
configurada para Status Info A y Status Info B.

[Nota]
Roll/Tilt Value queda atenuado y no puede utilizarse 
cuando se conecta un CBK-3610XS a la unidad.

TC/Genlock Status
Info. A (On/Off)
Info. B (On/Off)

Selecciona si mostrar el estado de bloqueo 
externo del código de tiempo y la información 
de estado de Genlock en la información de salida 
configurada para Status Info A y Status Info B.

Frame Line A/B Setup Center Marker
Line A (On/Off )
Line B (On/Off )
Option (Cross/Open Cross/
Dot)

Selecciona si mostrar el marcador central en la 
información de salida configurada para Frame 
Line A y Frame Line B.
Selecciona la forma de visualización (Cross/Open 
Cross/Dot) del marcador central.

Aspect Ratio
Line A (On/Off )
Line B (On/Off )
Option (17:9/16:9/15:9/ 
14:9/13:9/9:16/4:3/1:1/1.43:1/ 
1.66:1/1.85:1/2:1/2.35:1/ 
2.39:1)

Selecciona si mostrar el marcador de la relación 
de aspecto en la información de salida 
configurada para Frame Line A y Frame Line B.
Selecciona el modo (17:9/16:9/15:9/14:9/13:9/ 
9:16/4:3/1:1/1.43:1/1.66:1/1.85:1/2:1/2.35:1/2.39:1) 
al visualizar el marcador de relación de aspecto.

Aspect Safety Zone
Line A (On/Off)
Line B (On/Off)
Option 
(80%/90%/92.5%/95%)

Selecciona si mostrar la zona de seguridad de la 
relación de aspecto en la información de salida 
configurada para Frame Line A y Frame Line B.
Selecciona el tamaño (porcentaje de la pantalla 
completa) del marcador de la zona de seguridad 
de aspecto.

Picture Area
Line A (On/Off )
Line B (On/Off )

Selecciona si mostrar la zona de imagen en la 
información de salida configurada para Frame 
Line A y Frame Line B.

Safety Zone
Line A (On/Off)
Line B (On/Off)
Option 
(80%/90%/92.5%/95%)

Selecciona si mostrar la zona de seguridad en la 
información de salida configurada para Frame 
Line A y Frame Line B.
Selecciona el rango (80%/90%/92.5%/95%) de la 
zona de seguridad.
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Monitoring > OSD Appearance
Realiza ajustes relacionados con la información y las líneas de fotogramas superpuestos en cada señal de 
salida.
El ajuste On/Off se selecciona utilizando una casilla de verificación (excepto Frame Line on Playback).
On: casilla de verificación seleccionada
Off: casilla de verificación no seleccionada

Elemento del menú Ajustes Descripción
User Frame Line 1

Line A (On/Off)
Line B (On/Off)
Option
(Preset/Variable)

Selecciona si mostrar la línea de fotogramas 1 del 
usuario en la información de salida configurada 
para Frame Line A y Frame Line B.
Selecciona si mostrar la línea de fotogramas 1 del 
usuario o la relación de aspecto fija.

User Frame Line 2
Line A (On/Off)
Line B (On/Off)
Option
(Preset/Variable)

Selecciona si mostrar la línea de fotogramas 2 del 
usuario en la información de salida configurada 
para Frame Line A y Frame Line B.
Selecciona si mostrar la línea de fotogramas 2 del 
usuario o la relación de aspecto fija.

Color
Option (White/Yellow/Cyan/
Green/Magenta/Red/Blue)

Establece el color de visualización de las líneas de 
fotogramas.

Surround View Type
Option (Line/Mask/
Line&Mask)

Selecciona la forma de visualización del marcador 
Surround View.
Line: utiliza líneas para mostrar el área de 

grabación.
Mask: muestra el área de grabación 

enmascarando (reduciendo) el nivel de señal 
de vídeo fuera del área de grabación.

Line&Mask: muestra el área de grabación usando 
líneas y enmascarando (reduciendo) el nivel 
de señal de vídeo fuera del área de grabación.

Aspect Ratio Type
Option (Line/Mask/
Line&Mask)

Selecciona la forma de visualización del marcador 
de relación de aspecto.
Line: muestra las líneas con color ajustadas por 

Color.
Mask: muestra un nivel de señal de vídeo más 

bajo de las zonas que se encuentran fuera del 
área del marcador.

Line&Mask: muestra líneas con color definido por 
Color y un nivel de señal de vídeo más bajo 
de las zonas que se encuentran fuera del área 
del marcador.

Mask Level
Option (0 a 15 (12))

Selecciona el brillo de la imagen fuera del 
marcador cuando Aspect Ratio Type o Surround 
View Type esté ajustado en Mask.

Frame Line on Playback
Option (On/Off )

Activa/desactiva la función que superpone líneas 
de fotogramas durante la reproducción.

Monitoring > Monitor Display
Realiza ajustes relacionados con las pantallas.

Elemento del menú Ajustes Descripción
Focus Distance Format Meter/Feet Selecciona las unidades de visualización de la 

posición de enfoque.
Monitor Magnifier 
Ratio

×2.0 / ×4.0 / ×2.0/×4.0 Selecciona el índice de ampliación de enfoque 
para la imagen de salida de Monitor.

[Nota]
Cuando Project Frame Rate (página 68) se ajusta en 
59.94 o 50, solo se puede seleccionar ×2.0.

Monitoring > Frame Line
Realiza ajustes relacionados con las líneas y marcadores mostrados en la imagen de salida.

Elemento del menú Ajustes Descripción
Center Marker Cross/Open Cross/Dot Selecciona la forma de visualización del marcador 

central.
Aspect Ratio 17:9/16:9/15:9/14:9/13:9/9:16/ 

4:3/1:1/1.43:1/1.66:1/1.85:1/2:1/ 
2.35:1/2.39:1

Selecciona el modo al visualizar el marcador de 
relación de aspecto.

Aspect Safety Zone 80%/90%/92.5%/95% Selecciona el tamaño (porcentaje de la pantalla 
completa) del marcador de la zona de seguridad 
de aspecto.

Safety Zone 80%/90%/92.5%/95% Selecciona el rango de la zona de seguridad.
Color White/Yellow/Cyan/Green/

Magenta/Red/Blue
Selecciona el color de visualización de las líneas 
de fotogramas.

Surround View Type Line/Mask/Line&Mask Selecciona la forma de visualización del marcador 
Surround View.
Line: utiliza líneas para mostrar el área de 

grabación.
Mask: muestra el área de grabación 

enmascarando (reduciendo) el nivel de señal 
de vídeo fuera del área de grabación.

Line&Mask: muestra el área de grabación usando 
líneas y enmascarando (reduciendo) el nivel 
de señal de vídeo fuera del área de grabación.

Aspect Ratio Type Line/Mask/Line&Mask Selecciona la forma de visualización del marcador 
de relación de aspecto.
Line: muestra las líneas con color ajustadas por 

Color.
Mask: muestra un nivel de señal de vídeo más 

bajo de las zonas que se encuentran fuera del 
área del marcador.

Line&Mask: muestra líneas con color definido por 
Color y un nivel de señal de vídeo más bajo 
de las zonas que se encuentran fuera del área 
del marcador.
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Monitoring > Frame Line
Realiza ajustes relacionados con las líneas y marcadores mostrados en la imagen de salida.

Elemento del menú Ajustes Descripción
Mask Level 0 a 15 (12) Selecciona el brillo de la imagen fuera del 

marcador cuando Aspect Ratio Type o Surround 
View Type esté ajustado en Mask.

Frame Line on Playback On/Off Activa/desactiva la función que superpone líneas 
de fotogramas durante la reproducción.

Monitoring > User Frame Line 1
Realiza ajustes relacionados con la línea de fotogramas 1 del usuario.

Elemento del menú Ajustes Descripción
Select Preset/Variable Selecciona si mostrar la línea de fotogramas 1 del 

usuario o la relación de aspecto fija.
Preset: muestra la relación de aspecto definida por 

Preset Aspect Ratio, Scaling y Preset Aspect 
Ratio Type.

Variable: muestra un fotograma rectangular 
arbitrario definido por Width, Height, H 
Position, V Position y Variable Aspect Type.

Preset Aspect Ratio 17:9/16:9/15:9/14:9/13:9/9:16/ 
4:3/1:1/1.43:1/1.66:1/1.85:1/2:1/ 
2.35:1/2.39:1/1.90:1 (W34)*
*	 Línea de fotogramas con el mismo 

tamaño de imagen horizontal 
que cuando se establece 1.43:1. 
En el modo 6K 3:2, el tamaño 
horizontal de la imagen es de 
aproximadamente 34 mm.

Selecciona el modo al mostrar una relación de 
aspecto fija.

[Nota]
Configurable solo cuando se ajusta Select en Preset.

Scaling 1% a 100%/--- Define el factor de escala para una relación de 
aspecto fija.

[Notas]
ˎˎ Configurable solo cuando se ajusta Select en Preset.
ˎˎ Se muestra “---” cuando se ajusta Preset Aspect Ratio 

en 1.90:1 (W34) y no se puede configurar.

Preset Aspect Ratio 
Type

Line/Mask/Line&Mask Selecciona la forma de visualización para una 
relación de aspecto fija.
Line: se muestra mediante líneas.
Mask: muestra un nivel de señal de vídeo más 

bajo de las zonas que se encuentran fuera del 
área del marcador.

Line&Mask: muestra líneas y un nivel de señal de 
vídeo más bajo de las zonas que se 
encuentran fuera del área del marcador.

[Nota]
Configurable solo cuando se ajusta Select en Preset.

Monitoring > User Frame Line 1
Realiza ajustes relacionados con la línea de fotogramas 1 del usuario.

Elemento del menú Ajustes Descripción
Aspect Ratio(Pixels) Relación de aspecto (número de 

píxeles, relación anamórfica)
Muestra la relación de aspecto de la línea de 
fotogramas 1 del usuario, el número de píxeles y 
la relación anamórfica para el tamaño efectivo de 
la imagen.

[Nota]
El número de píxeles es el valor del tamaño efectivo 
de la imagen antes de la conversión anamórfica de 
descompresión.

Width 3 a 480 (240) Establece el ancho de la línea de fotogramas 1 del 
usuario (distancia desde el centro hasta los bordes 
izquierdo y derecho).

[Nota]
Configurable solo cuando se ajusta Select en Variable.

Height 3 a 270 (135) Establece el alto de la línea de fotogramas 1 del 
usuario (distancia desde el centro hasta los bordes 
superior e inferior).

[Nota]
Configurable solo cuando se ajusta Select en Variable.

H Position Máx. de –477 a 477 (±0) Establece la posición horizontal del centro de la 
línea de fotogramas 1 del usuario.
El rango de ajuste se vuelve más estrecho a 
medida que el valor del ajuste Width aumenta por 
encima de 3.

[Nota]
Configurable solo cuando se ajusta Select en Variable.

V Position Máx. de –267 a 267 (±0) Establece la posición vertical del centro de la línea 
de fotogramas 1 del usuario.
El rango de ajuste se vuelve más estrecho a 
medida que el valor del ajuste Height aumenta 
por encima de 3.

[Nota]
Configurable solo cuando se ajusta Select en Variable.

Variable Aspect Type Line Muestra el tipo de la visualización de la línea de 
fotogramas 1 del usuario.

[Nota]
Configurable solo cuando se ajusta Select en Variable.
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Monitoring > User Frame Line 2
Realiza ajustes relacionados con la línea de fotogramas 2 del usuario.

Elemento del menú Ajustes Descripción
Select Preset/Variable Selecciona si mostrar la línea de fotogramas 2 del 

usuario o la relación de aspecto fija.
Preset: muestra la relación de aspecto definida por 

Preset Aspect Ratio, Scaling y Preset Aspect 
Ratio Type.

Variable: muestra un fotograma rectangular 
arbitrario definido por Width, Height, H 
Position, V Position y Variable Aspect Type.

Preset Aspect Ratio 17:9/16:9/15:9/14:9/13:9/9:16/ 
4:3/1:1/1.43:1/1.66:1/1.85:1/2:1/ 
2.35:1/2.39:1/1.90:1 (W34)*
*	 Línea de fotogramas con el mismo 

tamaño de imagen horizontal 
que cuando se establece 1.43:1. 
En el modo 6K 3:2, el tamaño 
horizontal de la imagen es de 
aproximadamente 34 mm.

Selecciona el modo al mostrar una relación de 
aspecto fija.

[Nota]
Configurable solo cuando se ajusta Select en Preset.

Scaling 1% a 100%/--- Define el factor de escala para una relación de 
aspecto fija.

[Notas]
ˎˎ Configurable solo cuando se ajusta Select en Preset.
ˎˎ Se muestra “---” cuando se ajusta Preset Aspect Ratio 

en 1.90:1 (W34) y no se puede configurar.

Preset Aspect Ratio 
Type

Line Muestra la forma de visualización para una 
relación de aspecto fija.

[Nota]
Configurable solo cuando se ajusta Select en Preset.

Aspect Ratio(Pixels) Relación de aspecto (número de 
píxeles, relación anamórfica)

Muestra la relación de aspecto de la línea de 
fotogramas 2 del usuario, el número de píxeles y 
la relación anamórfica para el tamaño efectivo de 
la imagen.

[Nota]
El número de píxeles es el valor del tamaño efectivo 
de la imagen antes de la conversión anamórfica de 
descompresión.

Width 3 a 480 (240) Establece el ancho de la línea de fotogramas 2 del 
usuario (distancia desde el centro hasta los bordes 
izquierdo y derecho).

[Nota]
Configurable solo cuando se ajusta Select en Variable.

Monitoring > User Frame Line 2
Realiza ajustes relacionados con la línea de fotogramas 2 del usuario.

Elemento del menú Ajustes Descripción
Height 3 a 270 (135) Establece el alto de la línea de fotogramas 2 del 

usuario (distancia desde el centro hasta los bordes 
superior e inferior).

[Nota]
Configurable solo cuando se ajusta Select en Variable.

H Position Máx. de –477 a 477 (±0) Establece la posición horizontal del centro de la 
línea de fotogramas 2 del usuario.
El rango de ajuste se vuelve más estrecho a 
medida que el valor del ajuste Width aumenta por 
encima de 3.

[Nota]
Configurable solo cuando se ajusta Select en Variable.

V Position Máx. de –267 a 267 (±0) Establece la posición vertical del centro de la línea 
de fotogramas 2 del usuario.
El rango de ajuste se vuelve más estrecho a 
medida que el valor del ajuste Height aumenta 
por encima de 3.

[Nota]
Configurable solo cuando se ajusta Select en Variable.

Variable Aspect Type Line Muestra una línea de fotogramas 2 de usuario 
arbitraria.

[Nota]
Configurable solo cuando se ajusta Select en Variable.

Monitoring > False Color
Realiza ajustes relacionados con los colores falsos.

[Nota]
False Color queda atenuado y el ajuste no puede cambiarse cuando se ajusta Technical > System Configuration > RM/RCP 
Paint Control (página 83) en On en el menú completo.

Elemento del menú Ajustes Descripción
Level Preset/Manual Establece si utilizar el ajuste preset on/off y el 

umbral de cada color falso en la salida del visor/
monitor para definir los colores manualmente.
Cuando se selecciona Manual, se pueden 
configurar los siguientes elementos.

Red On/Off Activa/desactiva la visualización del rojo.
Red Upper Limit 0.0% a 109.0% (96.1%) 

(incrementos de 0.1%)
Establece el límite superior para la visualización en 
rojo.

Red Lower Limit 0.0% a 109.0% (93.4%) 
(incrementos de 0.1%)

Establece el límite inferior para la visualización en 
rojo.

Yellow On/Off Activa/desactiva la visualización del amarillo.
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Monitoring > False Color
Realiza ajustes relacionados con los colores falsos.

[Nota]
False Color queda atenuado y el ajuste no puede cambiarse cuando se ajusta Technical > System Configuration > RM/RCP 
Paint Control (página 83) en On en el menú completo.

Elemento del menú Ajustes Descripción
Yellow Upper Limit 0.0% a 109.0% (93.4%) 

(incrementos de 0.1%)
Establece el límite superior para la visualización en 
amarillo.

Yellow Lower Limit 0.0% a 109.0% (91.3%) 
(incrementos de 0.1%)

Establece el límite inferior para la visualización en 
amarillo.

Orange On/Off Activa/desactiva la visualización del naranja.
Orange Upper Limit 0.0% a 109.0% (90.6%) 

(incrementos de 0.1%)
Establece el límite superior para la visualización en 
naranja.

Orange Lower Limit 0.0% a 109.0% (87.7%) 
(incrementos de 0.1%)

Establece el límite inferior para la visualización en 
naranja.

Pink On/Off Activa/desactiva la visualización del rosa.
Pink Upper Limit 0.0% a 109.0% (58.0%) 

(incrementos de 0.1%)
Establece el límite superior para la visualización en 
rosa.

Pink Lower Limit 0.0% a 109.0% (54.3%) 
(incrementos de 0.1%)

Establece el límite inferior para la visualización en 
rosa.

Light Pink On/Off Activa/desactiva la visualización del rosa claro.
Light Pink Upper Limit 0.0% a 109.0% (50.8%) 

(incrementos de 0.1%)
Establece el límite superior para la visualización en 
rosa claro.

Light Pink Lower Limit 0.0% a 109.0% (47.8%) 
(incrementos de 0.1%)

Establece el límite inferior para la visualización en 
rosa claro.

Cyan On/Off Activa/desactiva la visualización del cyan.
Cyan Upper Limit 0.0% a 109.0% (46.5%) 

(incrementos de 0.1%)
Establece el límite superior para la visualización en 
cyan.

Cyan Lower Limit 0.0% a 109.0% (43.8%) 
(incrementos de 0.1%)

Establece el límite inferior para la visualización en 
cyan.

Green On/Off Activa/desactiva la visualización del verde.
Green Upper Limit 0.0% a 109.0% (42.2%) 

(incrementos de 0.1%)
Establece el límite superior para la visualización en 
verde.

Green Lower Limit 0.0% a 109.0% (38.9%) 
(incrementos de 0.1%)

Establece el límite inferior para la visualización en 
verde.

Light Blue On/Off Activa/desactiva la visualización del azul claro.
Light Blue Upper Limit 0.0% a 109.0% (34.4%) 

(incrementos de 0.1%)
Establece el límite superior para la visualización en 
azul claro.

Light Blue Lower Limit 0.0% a 109.0% (24.6%) 
(incrementos de 0.1%)

Establece el límite inferior para la visualización en 
azul claro.

Blue On/Off Activa/desactiva la visualización del azul.
Blue Upper Limit 0.0% a 109.0% (5.6%) 

(incrementos de 0.1%)
Establece el límite superior para la visualización en 
azul.

Monitoring > False Color
Realiza ajustes relacionados con los colores falsos.

[Nota]
False Color queda atenuado y el ajuste no puede cambiarse cuando se ajusta Technical > System Configuration > RM/RCP 
Paint Control (página 83) en On en el menú completo.

Elemento del menú Ajustes Descripción
Blue Lower Limit 0.0% a 109.0% (3.5%) 

(incrementos de 0.1%)
Establece el límite inferior para la visualización en 
azul.

Purple On/Off Activa/desactiva la visualización del púrpura.
Purple Upper Limit 0.0% a 109.0% (3.5%) 

(incrementos de 0.1%)
Establece el límite superior para la visualización en 
púrpura.

Purple Lower Limit –7.3% a 109.0% (–7.3%) 
(incrementos de 0.1%)

Establece el límite inferior para la visualización en 
púrpura.

Reset Execute/Cancel Restablece el ajuste de activación/desactivación y 
el umbral de cada color (se realiza seleccionando 
Execute).

Monitoring > VF Display
Realiza ajustes relacionados con la visualización del visor.

Elemento del menú Ajustes Descripción
VF LUT Cuando se ajusta Technical > 

System Configuration > RM/RCP 
Paint Control (página 83) en 
Off en el menú completo:

Log/s709/R709(800%)/Look

Selecciona la LUT que se aplicará a la imagen de 
salida del visor/monitor.

Cuando se ajusta RM/RCP Paint 
Control en On, el ajusta cambia 
como se indica a continuación 
en función del ajuste de Project 
> Basic Setting > Input Color 
Space (página 68) del menú 
completo.
S-Gamut3.Cine/SLog3 o 
S-Gamut3/SLog3:

Log/R709(800%)
HLG(Natural):

HLG(Natural)/R709(800%)
HLG(Live):

HLG(Live)/R709(800%)
Rec.2020/User Gamma:

User Gamma/R709-Like
Rec.709/User Gamma:

User Gamma

Selecciona el tipo de imagen de salida de la 
pantalla del visor/monitor.
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Monitoring > VF Display
Realiza ajustes relacionados con la visualización del visor.

Elemento del menú Ajustes Descripción
Status Info Info. A/Info. B/Off Selecciona la información que aparecerá 

superpuesta en la imagen de salida del visor/
monitor.

Frame Line Frame Line A/Frame Line B/Off Selecciona las líneas de fotogramas que 
aparecerán superpuestas en la imagen de salida 
del visor/monitor.

VF Magnifier Ratio ×2.0 / ×4.0 / ×2.0/×4.0 Selecciona el índice de ampliación de enfoque 
para el visor.

Color –99 a ±0 a +99 Ajusta la profundidad de color de las imágenes en 
el visor.

SDR Gain –15dB a 0dB (–12dB)  
(incrementos de 1 dB)

Establece la ganancia de salida SDR en modo HDR.
Puede usar este ajuste para cambiar la ganancia 
de la salida del monitor o del visor que está 
ajustada en R709(800%) o R709-Like.

[Nota]
Configurable solo cuando se ajusta Technical > System 
Configuration > RM/RCP Paint Control (página 83) en 
On en el menú completo.

Monitoring > VF Function
Realiza ajustes relacionados con las funciones del visor.

Elemento del menú Ajustes Descripción
Double Speed Scan On/Off Activa/desactiva la función de exploración de 

doble velocidad del visor.
Peaking Frequency Normal/High Selecciona si durante la nitidez su frecuencia es 

normal o alta.

[Nota]
El nivel de nitidez se ajusta con el menú del visor.

Zebra On/Off Activa/desactiva la función de cebra.
Zebra Select 1/2/Both Selecciona el tipo de patrón de cebra (Zebra 1, 

Zebra 2, Both).
Zebra1 Level De 0% a 107% (41%) Ajusta el nivel de visualización del patrón de cebra 

1.
Zebra1 Aperture Level De 1% a 20% (10%) Ajusta el nivel de apertura del patrón de cebra 1.
Zebra2 Level De 0% a 109% (61%) Ajusta el nivel de visualización del patrón de cebra 

2.
Assign<VF A> página 43 Asigna una función al botón asignable A en el 

visor (DVF-EL200).
Assign<VF B> página 43 Asigna una función al botón asignable B en el 

visor (DVF-EL200).
Assign<VF C> página 43 Asigna una función al botón asignable C en el 

visor (DVF-EL200).

Menú Audio

Los valores predeterminados aparecen en negrita subrayados.

Audio > Audio Input
Realiza ajustes relacionados con los niveles de grabación de audio.

[Nota]
El nivel de grabación de audio se fija con la señal AES/EBU seleccionada.

Elemento del menú Ajustes Descripción
CH-1 Audio Select Auto/Manual Ajusta automáticamente el nivel de grabación de 

audio cuando se establece en Auto.
CH-2 Audio Select Auto/Manual Ajusta automáticamente el nivel de grabación de 

audio cuando se establece en Auto.
CH-1 Audio Level –99 a ±0 a +99 Ajusta el nivel de grabación de audio si CH-1 

Audio Select está ajustado en Manual.
CH-2 Audio Level –99 a ±0 a +99 Ajusta el nivel de grabación de audio si CH-2 

Audio Select está ajustado en Manual.
MIC Reference –60dB/–50dB/–40dB Selecciona el nivel de entrada de referencia del 

micrófono.

Audio > Audio Monitor
Realiza ajustes relacionados con la monitorización de audio.

Elemento del menú Ajustes Descripción
Monitor CH Cuando Monitor Output CH Pair 

está ajustado en CH-1/CH-2
CH-1/CH-2, CH-1, CH-2

Cuando Monitor Output CH Pair 
está ajustado en CH-3/CH-4

CH-3/CH-4, CH-3, CH-4

Selecciona el canal de audio que se emite a los 
auriculares y al altavoz.
CH-1/CH-2 (CH-3/CH-4): canal 1+2 (canal 3+4)
CH-1 (CH-3): solo canal 1 (canal 3)
CH-2 (CH-4): solo canal 2 (canal 4)

Monitor Level 0 a 99 Ajusta el nivel de audio de monitorización.

Audio > Audio Configuration
Realiza ajustes relacionados con la entrada/salida de audio.

Elemento del menú Ajustes Descripción
Alarm Level 0 a 99 Ajusta el nivel de audio de la alarma.
Input Limiter Mode Off/–6dB/–9dB/–12dB/ 

–15dB/–17dB
Selecciona las características de limitador (nivel de 
saturación) para las señales de entrada grandes 
cuando se ajusta manualmente el nivel de 
entrada de audio. Si no utiliza el limitador, 
seleccione Off.

AGC Level –6dB/–9dB/–12dB/ 
–15dB/–17dB

Selecciona las características de AGC (nivel de 
saturación).
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Audio > Audio Configuration
Realiza ajustes relacionados con la entrada/salida de audio.

Elemento del menú Ajustes Descripción
AGC Mono/Stereo Mono/Stereo Ajusta automáticamente el nivel de entrada de las 

señales de audio analógicas grabadas en los 
canales 1 y 2 y, además, selecciona si se realizarán 
los ajustes por separado para cada uno de los 
canales (Mono) o en modo estéreo (Stereo).

MIC Input Mono/
Stereo

Mono/Stereo Selecciona si el micrófono frontal es monoaural 
(Mono) o estéreo (Stereo).

Phantom Power +48V On/Off Activa/desactiva la función que suministra al 
micrófono una fuente externa de +48 V (potencia 
fantasma).

Monitor Output CH 
Pair

CH-1/CH-2, CH-3/CH-4 Configura los canales de salida de audio en los 
canales 1 y 2 o en los canales 3 y 4.

Headphone Mono/ST Mono/Stereo Configura la salida de auriculares en monoaural 
(Mono) o estéreo (Stereo).

Menú Paint

[Nota]
Para habilitar el ajuste de los elementos del menú Paint, debe ajustarse Technical > System Configuration > RM/RCP Paint 
Control (página 83) en On en el menú completo.

Los valores predeterminados aparecen en negrita subrayados.

Paint > Black
Realiza ajustes relacionados con el nivel de negro.

Elemento del menú Ajustes Descripción
Master Black –99 a ±0 a +99 Define el nivel de negro maestro.
R Black –99 a ±0 a +99 Define el nivel de negro R.
B Black –99 a ±0 a +99 Define el nivel de negro B.

Paint > Flare
Realiza ajustes relacionados con la corrección de deslumbramiento.

Elemento del menú Ajustes Descripción
Setting On/Off Activa/desactiva la función de corrección de 

deslumbramiento.
Master Flare –99 a ±0 a +99 Establece el ajuste del usuario de 

deslumbramiento maestro de la corrección de 
deslumbramiento requerida por la unidad.

R Flare –99 a ±0 a +99 Establece el ajuste del usuario de 
deslumbramiento R de la corrección de 
deslumbramiento requerida por la unidad.

G Flare –99 a ±0 a +99 Establece el ajuste del usuario de 
deslumbramiento G de la corrección de 
deslumbramiento requerida por la unidad.

B Flare –99 a ±0 a +99 Establece el ajuste del usuario de 
deslumbramiento B de la corrección de 
deslumbramiento requerida por la unidad.

Paint > Gamma
Realiza ajustes relacionados con la corrección de gamma.

Elemento del menú Ajustes Descripción
Setting On/Off Activa/desactiva la función de corrección de 

gamma.
Gamma Category S-Log3/HLG(Natural)/HLG(Live)/

User
El ajuste de categoría de gamma es solo de 
visualización, porque está determinado por el 
ajuste Project > Basic Setting > Input Color Space 
(página 68) en el menú completo.
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Paint > Gamma
Realiza ajustes relacionados con la corrección de gamma.

Elemento del menú Ajustes Descripción
Gamma Select Cuando se ajusta Gamma 

Category en S-Log3:
S-Log3

Cuando se ajusta Gamma 
Category en HLG(Natural):

HLG(Natural)
Cuando se ajusta Gamma 
Category en HLG(Live):

HLG(Live)
Cuando se ajusta Gamma 
Category en User:

User 1/User 2/User 3/User 4/
User 5

Selecciona la tabla de gamma utilizada para la 
corrección de gamma.

Paint > Black Gamma
Realiza ajustes relacionados con la corrección de gamma de negro.

[Nota]
Black Gamma queda atenuado y no puede utilizarse cuando Project > Basic Setting > Input Color Space (página 68) se 
ajusta en S-Gamut3.Cine/SLog3 o S-Gamut3/SLog3 en el menú completo.

Elemento del menú Ajustes Descripción
Setting On/Off Activa/desactiva la función de corrección de 

gamma de negro.
Range Low/L.Mid/H.Mid Selecciona el rango efectivo de la corrección de 

gamma de negro.
Low: de 0% a 3,6%
L.Mid: de 0% a 7,2%
H.Mid: de 0% a 14,4%

Master Black Gamma –99 a ±0 a +99 Define el nivel de gamma de negro maestro.

Paint > Knee
Realiza ajustes relacionados con la corrección de inflexión.

[Nota]
Knee queda atenuado y no puede utilizarse cuando Project > Basic Setting > Input Color Space (página 68) se ajusta en 
S-Gamut3.Cine/SLog3 o S-Gamut3/SLog3 en el menú completo.

Elemento del menú Ajustes Descripción
Setting On/Off Activa/desactiva la función de corrección de 

inflexión.
Point –99 a ±0 a +99 Define el punto de inflexión.
Slope –99 a ±0 a +99 Define la pendiente de inflexión.

Paint > White Clip
Realiza ajustes relacionados con el ajuste del clip del blanco.

[Nota]
White Clip queda atenuado y no puede utilizarse cuando Project > Basic Setting > Input Color Space (página 68) se ajusta 
en S-Gamut3.Cine/SLog3 o S-Gamut3/SLog3 en el menú completo.

Elemento del menú Ajustes Descripción
Setting On/Off Activa/desactiva la función de ajuste del clip del 

blanco.
Level 60.0% a 108.0% a 109.0% Define el nivel del clip del blanco.

Paint > Detail
Realiza ajustes relacionados con el ajuste de detalles.

Elemento del menú Ajustes Descripción
Setting On/Off Activa/desactiva la función de ajuste de detalles.
Level –99 a ±0 a +99 Define el nivel de detalle.
H/V Ratio –99 a ±0 a +99 Define la relación de mezcla entre el nivel de 

detalle H y el nivel de detalle V.
Crispening –99 a ±0 a +99 Define el nivel de nitidez.
Level Depend On/Off Activa/desactiva la función de ajuste de 

dependencia de nivel.
Level Depend Level –99 a ±0 a +99 Establece el nivel de dependencia de nivel.
Frequency –99 a ±0 a +99 Establece la frecuencia central de la señal de 

detalle H (los valores más grandes proporcionan 
detalles más precisos).

Knee Aperture On/Off Activa/desactiva la función de corrección de 
apertura de inflexión.

Knee Aperture Level –99 a ±0 a +99 Define el nivel de apertura de inflexión.
Limit –99 a ±0 a +99 Define el limitador de detalles para las direcciones 

del lado del blanco y del lado del negro.
White Limit –99 a ±0 a +99 Define el limitador de detalles del lado de blanco.
Black Limit –99 a ±0 a +99 Define el limitador de detalles del lado del negro.

Paint > Matrix
Realiza ajustes relacionados con la corrección de matriz.

Elemento del menú Ajustes Descripción
Setting On/Off Activa/desactiva la función de corrección de 

matriz.
User Matrix On/Off Activa/desactiva la función de corrección de 

matriz del usuario.



000 3. Operaciones de la cámara: Lista de menús completos82

Paint > Matrix
Realiza ajustes relacionados con la corrección de matriz.

Elemento del menú Ajustes Descripción
User Matrix R-G –99 a ±0 a +99 Establece individualmente coeficientes de matriz 

para conseguir un ajuste fino del color de la 
imagen completa.

User Matrix R-B –99 a ±0 a +99
User Matrix G-R –99 a ±0 a +99
User Matrix G-B –99 a ±0 a +99
User Matrix B-R –99 a ±0 a +99
User Matrix B-G –99 a ±0 a +99

Paint > Multi Matrix
Realiza ajustes relacionados con la corrección de matriz múltiple.

[Nota]
Multi Matrix queda atenuado y no puede utilizarse cuando se ajusta Matrix en Off.

Elemento del menú Ajustes Descripción
Setting On/Off Activa/desactiva la función de corrección de 

matriz múltiple para establecer la saturación en el 
espacio de tono de 16 ejes.

Area Indication On/Off Activa/desactiva la visualización de un patrón de 
cebra en el área de color de la pantalla 
seleccionada para la corrección de matriz 
múltiple.

Reset Execute/Cancel Devuelve a los valores predeterminados todos los 
tonos y la saturación en cada eje (se ejecuta 
seleccionando Execute).

Axis B/B+/MG–/MG/MG+/R/R+/YL–/
YL/YL+/G–/G/G+/CY/CY+/B–

Establece el color seleccionado para la corrección 
de matriz múltiple (modo de 16 ejes).

Hue –99 a ±0 a +99 Establece el tono del color seleccionado para la 
corrección de matriz múltiple para cada uno de 
los 16 ejes.

Saturation –99 a ±0 a +99 Establece la saturación del color seleccionado 
para la corrección de matriz múltiple para cada 
uno de los 16 ejes.

Menú Technical

Los valores predeterminados aparecen en negrita subrayados.

Technical > Test Signals
Realiza ajustes relacionados con las barras de color.

Elemento del menú Ajustes Descripción
Color Bars On/Off Activa/desactiva las barras de color.

[Nota]
Cuando se conecta una RM-B170 u otra unidad de 
control remoto, el ajuste de la unidad de control remoto 
se muestra atenuado.

Color Bars Type ARIB/SMPTE Selecciona el tipo de barra de color.
1kHz Tone on Color 
Bars

On/Off Activa/desactiva la función que emite una señal 
de prueba de 1 kHz en las barras de color.

Test Saw On/Off Activa/desactiva la señal de prueba.
Test Type Saw/Step Selecciona el tipo de señal de prueba.

Saw: emite una onda de sierra como señal de 
prueba.

Step: genera una onda de paso como señal de 
prueba.

Technical > Switch & Rec Light
Realiza ajustes relacionados con el botón REC.

Elemento del menú Ajustes Descripción
Lock Operator Side without Rec Button/ 

with Rec Button
Configura si se bloqueará el funcionamiento del 
botón REC cuando se bloqueen los botones con 
el interruptor LOCK del lado del operador.

Lock Assistant Side without Rec Button/ 
with Rec Button

Configura si se bloqueará el funcionamiento del 
botón REC cuando se bloqueen los botones con 
el interruptor LOCK del lado del asistente.

Rec Light On/Off Activa/desactiva el testigo REC.
Rec Start/Stop Beep 0 a 99 Ajusta el volumen del aviso acústico que se emite 

cuando la grabación comienza y termina.
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Technical > System Configuration
Realiza ajustes relacionados con el control de la unidad.

Elemento del menú Ajustes Descripción
Fan Control Auto / Max / Off in Rec/Auto /  

Off in Rec/Max
Selecciona el modo de control del ventilador.
Auto: controla el ventilador automáticamente en 

respuesta a la temperatura interna.
Max: el ventilador gira a la velocidad máxima.
Off in Rec/Auto: el ventilador es silencioso durante 

la grabación y se pone en marcha 
automáticamente en respuesta a la 
temperatura interna cuando no se está 
grabando.

Off in Rec/Max: el ventilador es silencioso durante 
la grabación y gira a la velocidad máxima 
cuando no se está grabando.

RM/RCP Paint Control On/Off Activa/desactiva las funciones de pintura de una 
RM-B170 u otra unidad de control remoto.

[Nota]
Todos los ajustes de la unidad se inician cuando se 
cambia el ajuste RM/RCP Paint Control. Sin embargo, 
RM/RCP Paint Control y otros ajustes, como los ajustes 
de red, no se inician.

SDI Rec Remote Trigger Off / HD SDI Remote I/F /  
Parallel Rec

Selecciona el método de control remoto SDI.
Off: desactiva el control remoto.
HD SDI Remote I/F: utiliza el método de control 

remoto HD SDI.
Parallel Rec: utiliza el método de control de 

indicadores válido.

[Nota]
La señal SDI Rec Remote Trigger no se emite desde 
MONITOR OUT.

3G SDI 1/2/3/4 Output Level A/Level B Seleccione si el formato de la salida 3G SDI es 
Level A o Level B.

SD HDMI On/Off Activa/desactiva la función que permite 
configurar la señal de salida HDMI en el formato 
SD.

Shutter Mode Speed/Angle Selecciona el modo de funcionamiento del 
obturador electrónico.

Media Near Full Alarm 1min/3min/5min Establece el umbral de alarma para notificar que 
la capacidad del soporte restante es baja.

Technical > Special Configuration
Realiza ajustes relacionados con las funciones de volteo de la pantalla y reducción de ruido.

Elemento del menú Ajustes Descripción
Flip Image Normal/Horizontal Flip/ 

Vertical Flip/H & V Flip
En el modo de filmación, activa o desactiva la 
función para voltear la imagen y establece el 
estado de de volteo cuando está activada.

[Notas]
ˎˎ Las imágenes de grabación AXS se guardan sin 

voltear.
ˎˎ Si se selecciona Vertical Flip o H & V Flip, las señales de 

vídeo y audio se retrasan 1 fotograma en la velocidad 
de fotogramas de imagen debido al procesamiento 
interno.

Audio/Video Delay Off/1frame Activa/desactiva la función de sincronización para 
sincronizar el audio y el vídeo con otro dispositivo 
que voltea la imagen retrasando la señal de vídeo 
y la de audio.
Off: sin retraso
1frame: retrasa la señal de vídeo, la señal de audio 

y los metadatos (incluido el código de 
tiempo) aproximadamente 1 fotograma.

[Nota]
Se ajusta en 1frame cuando se establece Flip Image en 
Vertical Flip o H & V Flip.

NR(4K 17:9/16:9 AXS) On/Off Activa o desactiva la reducción de ruido de 
imágenes grabadas en 4K 17:9/16:9 AXS.

[Nota]
Se establece en Off (fijo) cuando están activadas las 
siguientes imágenes.
ˎˎ Select FPS
ˎˎ SxS/Output De-Squeeze: ajustes distintos a Off(1.0×)
ˎˎ Flip Image: ajustes distintos a Normal

Level Gauge Adjust Execute/Cancel Ejecuta el ajuste cero del indicador de nivel de 
burbuja de la unidad (se ejecuta seleccionando 
Execute).

[Nota]
Cuando se conecta un CBK-3610XS o un CBK-3620XS 
a la unidad, Level Gauge Adjust queda atenuado y no 
puede ejecutarse el ajuste cero del indicador de nivel de 
burbuja.

Level Gauge Reset Execute/Cancel Restablece el valor del ajuste cero del indicador 
de nivel de burbuja de la unidad (se ejecuta 
seleccionando Execute).
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Technical > Special Configuration
Realiza ajustes relacionados con las funciones de volteo de la pantalla y reducción de ruido.

Elemento del menú Ajustes Descripción
3620XS Lev. Gauge Adj. Execute/Cancel Ejecuta el ajuste cero del indicador de nivel de 

burbuja del CBK-3620XS (se ejecuta 
seleccionando Execute).

[Nota]
El ajuste cero del indicador de nivel de burbuja del 
CBK‑3620XS puede ejecutarse solo cuando se ha 
conectado un CBK‑3620XS a la unidad.

3620XS Lev. Gauge Rst. Execute/Cancel Restablece el valor del ajuste cero del indicador 
de nivel de burbuja del CBK-3620XS (se ejecuta 
seleccionando Execute).

[Nota]
El ajuste cero del indicador de nivel de burbuja del 
CBK‑3620XS puede ejecutarse solo cuando se ha 
conectado un CBK‑3620XS a la unidad.

360° Shutter Setting Pre Shutter On/Pre Shutter Off Enciende o apaga la función de obturador previo 
cuando se utiliza un ángulo de obturador de 360° 
(obturador apagado).
Pre Shutter On: enciende el obturador previo.
Pre Shutter Off: apaga el obturador previo.

[Nota]
Cuando se establece Pre Shutter Off, es posible que se 
mantenga una imagen posterior para un fotograma 
cuando incida una excesiva cantidad de luz, como 
cuando se dispara con el flash.

Technical > Lens Configuration
Realiza ajustes relacionados con los objetivos.

Elemento del menú Ajustes Descripción
PL-Mt Interface 
Position

Top/Side/Off Configura la interfaz del objetivo antes de 
instalarlo en función del tipo de objetivo que se 
conectará.

[Nota]
Si cambia este ajuste cuando el objetivo esté colocado 
en la unidad, apáguela y vuelva a encenderla.

Lens 12pin On/Off Activa o desactiva la interfaz del objetivo de 
12 pines.

[Nota]
Si cambia este ajuste cuando el objetivo esté colocado 
en la unidad, apáguela y vuelva a encenderla.

E-Mount Shading 
Comp.

Auto/Off Define si se compensa una omisión en la 
iluminación periférica cuando se conecta un 
objetivo compatible.

Technical > Lens Configuration
Realiza ajustes relacionados con los objetivos.

Elemento del menú Ajustes Descripción
E-Mt Chro. Aber. Comp. Auto/Off Define si se compensa la aberración cromática en 

la iluminación periférica cuando se conecta un 
objetivo compatible.

Technical > Authentication
Realiza ajustes básicos relacionados con la autenticación de la red.

Elemento del menú Ajustes Descripción
User Name (Muestra el nombre de usuario 

actual).
Define el nombre de usuario que se utilizará para 
autenticar el acceso.
El ajuste predeterminado de fábrica es “admin”.

Password (*******) Define la contraseña que se utilizará para 
autenticar el acceso (8 o más caracteres 
alfanuméricos que contienen al menos un 
carácter alfabético y uno numérico).
Al introducir una contraseña, si se pulsa la tecla 
ITEM 1 de la pantalla secundaria, los caracteres 
introducidos reemplazan los caracteres de 
asterisco que se muestran.

[Nota]
El ajuste de la contraseña se restablece al actualizar el 
firmware de la unidad desde la versión 5.0 o anterior a la 
versión 5.0 o posterior. En este caso, vuelva a configurar 
la contraseña.

Technical > Network
Realiza ajustes relacionados con la red.

Elemento del menú Ajustes Descripción
Setting LAN/Wireless/Off Activa/desactiva la conexión de red.

[Nota]
Aparece atenuado y no se puede cambiar si no se 
establece una contraseña mediante Technical > 
Authentication > Password (página 84) en el menú 
completo.
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Technical > Network
Realiza ajustes relacionados con la red.

Elemento del menú Ajustes Descripción
LAN DHCP (On/Off ) Activa/desactiva DHCP.

Cuando está ajustado en [On], se asigna una 
dirección IP automáticamente a la unidad. Para 
introducir manualmente la dirección IP de la 
unidad, ajústelo en [Off ].

IP Address (DHCP/On: se obtiene 
automáticamente, DHCP/Off: 
192.168.2.50)

Introduce la dirección IP de la unidad.
Solo está activado cuando DHCP está en [Off ].

Subnet Mask (DHCP/On: se 
obtiene automáticamente, 
DHCP/Off: 255.255.255.0)

Introduce la máscara de subred de la unidad.
Solo está activado cuando DHCP está en [Off ].

Wireless Network Mode (Access Point/
Station)

Establece el modo de red para las conexiones 
inalámbricas.

Scan Networks (Execute/Cancel) Busca puntos de acceso para destinos de 
conexión (se realiza seleccionando Execute).

[Nota]
Solo se puede configurar cuando Network Mode se ha 
definido en Station.

SSID Cuando Network Mode se establece en Access 
Point

Muestra el SSID para la conexión inalámbrica 
con la unidad.

Cuando Network Mode se ha definido en Station
Muestra/configura el SSID del punto de 
acceso de destino de la conexión.

[Nota]
Caracteres válidos para visualización y entrada:
Alfabéticos (A a Z, a a z)
Numéricos (0 a 9 -.@—_())
Símbolos (!"#$%&'*+,/:;<=>?[\]^`{|}~)

Technical > Network
Realiza ajustes relacionados con la red.

Elemento del menú Ajustes Descripción
Password Cuando Network Mode se establece en Access 

Point
Muestra la contraseña para la conexión 
inalámbrica con la unidad.

Cuando Network Mode se ha definido en Station
Configura la contraseña del punto de acceso 
de destino de la conexión.
Al introducir una contraseña, si se pulsa la 
tecla ITEM 1 de la pantalla secundaria, los 
caracteres introducidos reemplazan los 
caracteres de asterisco que se muestran.

[Nota]
Caracteres válidos para visualización y entrada:
Alfabéticos (A a Z, a a z)
Numéricos (0 a 9 -.@—_())
Símbolos (!"#$%&'*+,/:;<=>?[\]^`{|}~)

WPS (Execute/Cancel) Inicia la configuración de la conexión utilizando 
WPS (se realiza seleccionando Execute).

Channel (Auto(5GHz)/Auto/CH1/ 
CH2/CH3/CH4/CH5/CH6/CH7/ 
CH8/CH9/CH10/CH11)

Establece el canal del punto de acceso.

[Notas]
ˎˎ Solo se puede configurar cuando Network Mode se 

ha definido en Access Point.
ˎˎ Puede que Auto(5GHz) no se muestre en función 

del módulo LAN inalámbrico que se esté utilizando. 
Compruebe si se admite el uso del módulo LAN 
inalámbrico en su país/región. Para obtener 
más información, consulte las instrucciones de 
funcionamiento del módulo LAN inalámbrico.

DHCP (On/Off ) Activa/desactiva DHCP.
Cuando está ajustado en [On], se asigna una 
dirección IP automáticamente a la unidad. Para 
introducir manualmente la dirección IP de la 
unidad, ajústelo en [Off ].

[Nota]
Solo se puede configurar cuando Network Mode se ha 
definido en Station.

IP Address (DHCP/On: se obtiene 
automáticamente, DHCP/Off: 
192.168.1.50)

Introduce la dirección IP de la unidad.
Solo está activado cuando DHCP está en [Off ].

[Nota]
Solo se puede configurar cuando Network Mode se ha 
definido en Station.
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Technical > Network
Realiza ajustes relacionados con la red.

Elemento del menú Ajustes Descripción
Subnet Mask (DHCP/On: se 
obtiene automáticamente, 
DHCP/Off: 255.255.255.0)

Introduce la máscara de subred de la unidad.
Solo está activado cuando DHCP está en [Off ].

[Nota]
Solo se puede configurar cuando Network Mode se ha 
definido en Station.

MAC Address Muestra la dirección MAC del adaptador LAN 
inalámbrico conectado a la unidad.

Regenerate Password (Execute/
Cancel)

Vuelve a generar la contraseña (se ejecuta al 
seleccionar Execute).

[Nota]
Solo se puede ejecutar cuando Network Mode se ha 
definido en Access Point.

Technical > APR
Ejecuta APR (restauración automática de píxeles: ajuste automático del sensor de imagen).

Elemento del menú Ajustes Descripción
APR Execute/Cancel Ejecuta la función de reducción de ruido de 

píxeles automática (se ejecuta al seleccionar 
Execute).

Reset Execute/Cancel Elimina las motas blancas que se añaden al 
ejecutar la función de APR (se ejecuta al 
seleccionar Execute).

Technical > Battery
Realiza ajustes relacionados con las baterías.

Elemento del menú Ajustes Descripción
Near End:Info Battery De 5% a 100% (incrementos de 

5%)
Establece el valor límite al cual el indicador de 
capacidad restante de la batería empieza a 
parpadear cuando se utiliza una batería Sony Info.

End:Info Battery De 0% a 5% Establece el valor límite para que se muestre la 
advertencia “Battery End” cuando se utiliza una 
batería Sony Info.

Near End:Sony Battery De 11.5V a 17V (incrementos de 
0.1V)

Establece el valor límite al cual el indicador de 
capacidad restante de la batería empieza a 
parpadear cuando se utiliza una batería Sony que 
no es Info.

End:Sony Battery De 11.0V a 11.5V (incrementos 
de 0.1V)

Establece el valor límite para que se muestre la 
advertencia “Battery End” cuando se utiliza una 
batería Sony que no es Info.

Technical > Battery
Realiza ajustes relacionados con las baterías.

Elemento del menú Ajustes Descripción
Near End:Other Battery De 11.5V a 17V (11.8V) 

(incrementos de 0.1V)
Establece el valor límite en el cual el indicador de 
capacidad restante de la batería empieza a 
parpadear cuando se utiliza una batería que no es 
Sony.

End:Other Battery De 11.0V a 14V (incrementos de 
0.1V)

Establece el valor límite para que se muestre la 
advertencia “Battery End” cuando se utiliza una 
batería que no es Sony.

Detected Battery Sony Info Battery/Sony Battery/
Other Battery/DC IN (12V)/DC IN 
(24V)

Muestra el resultado de la detección automática 
de tipo de batería.

Technical > DC Voltage Alarm
Configura las alarmas relacionadas con la tensión del suministro de CC externa.

Elemento del menú Ajustes Descripción
DC Low Voltage1 De 11.5V a 17V (incrementos de 

0.1V)
Establece el valor límite para que se muestre la 
advertencia de tensión baja cuando se utiliza una 
fuente de alimentación externa conectada al 
conector DC IN.

DC Low Voltage2 De 11.0V a 14V (incrementos de 
0.1V)

Establece el valor límite para que se muestre la 
advertencia de subtensión cuando se utiliza una 
fuente de alimentación externa conectada al 
conector DC IN.

DC(24V) Low Voltage1 De 22.5V a 34.0V (incrementos 
de 0.1V)

Establece el valor límite para que se muestre la 
advertencia de tensión baja cuando se utiliza una 
fuente de alimentación externa de 24 V 
conectada al conector DC IN.

DC(24V) Low Voltage2 De 22.0V a 28.0V (incrementos 
de 0.1V)

Establece el valor límite para que se muestre la 
advertencia de subtensión cuando se utiliza una 
fuente de alimentación externa de 24 V 
conectada al conector DC IN.

Technical > Control Display
Realiza ajustes relacionados con las pantallas.

Elemento del menú Ajustes Descripción
Brightness level High/Mid/Low/Minimum Ajusta el brillo de la pantalla secundaria y de la 

pantalla en miniatura.
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Technical > Genlock
Realiza ajustes relacionados con el genlock.

Elemento del menú Ajustes Descripción
Input Source HD SDI/Analog Selecciona la señal de entrada para la función 

Genlock.
HD SDI: digital
Analog: analógica

Reference Lock Type Internal/External(HD)/
External(SD)

Muestra el estado de Genlock. Muestra el tipo de 
señal cuando se aplica la función Genlock.
Internal: no se aplica la función Genlock.
External(HD): se aplica la función Genlock a través 

de la señal HD.
External(SD): se aplica la función Genlock a través 

de la señal SD.

Menú Maintenance

Los valores predeterminados aparecen en negrita subrayados.

Maintenance > Clock Set
Realiza ajustes relacionados con el reloj integrado.

Elemento del menú Ajustes Descripción
Time Zone UTC + 14:00 a UTC Greenwich a 

UTC – 12:00 (incrementos de 
30 minutos)

Selecciona la diferencia horaria respecto a UTC 
(hora de Greenwich) en incrementos de 
30 minutos.

Date Mode YYMMDD/MMDDYY/DDMMYY Selecciona el formato de visualización de las 
fechas.
YYMMDD: año, mes, día
MMDDYY: mes, día, año
DDMMYY: día, mes, año

Date Configura la fecha actual (se aplica al pulsar Set).
Time Configura la hora actual (se aplica al pulsar Set).

Maintenance > Language
Selecciona el idioma de visualización de los menús y mensajes.

Elemento del menú Ajustes Descripción
Select English/中文(简) Selecciona el idioma de visualización del menú 

completo y de los mensajes.

Maintenance > Hours Meter
Muestra el tiempo de uso acumulado.

Elemento del menú Ajustes Descripción
Camera(System) Muestra el tiempo de uso acumulado de la 

unidad (no se puede restablecer).
R7 Recorder 
(System)
(solo si hay una AXS-R7 
conectada)

Muestra el tiempo de uso acumulado de la 
AXS-R7 conectada a la unidad (no se puede 
restablecer).

Camera(Resettable) Muestra el tiempo de uso acumulado de la 
unidad (se puede restablecer).

R7 Recorder 
(Resettable)
(solo si hay una AXS-R7 
conectada)

Muestra el tiempo de uso acumulado de la 
AXS-R7 conectada a la unidad (se puede 
restablecer).

Reset-Cam 
(Resettable)

Execute/Cancel Restablece la pantalla Camera(Resettable) a 0 (se 
ejecuta al seleccionar Execute).

Reset-R7 
(Resettable)
(solo si hay una AXS-R7 
conectada)

Execute/Cancel Restablece la pantalla R7 Recorder(Resettable) de 
la AXS-R7 conectada a la unidad a 0 (se ejecuta al 
seleccionar Execute).
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Maintenance > Reset to Default
Restaura el estado predeterminado de fábrica de la unidad.

Elemento del menú Ajustes Descripción
Reset Execute/Cancel Inicia todos los ajustes de la unidad (se ejecuta al 

seleccionar Execute).

Maintenance > Network Reset
Restaura el estado predeterminado de fábrica de los ajustes relacionados con la red.

Elemento del menú Ajustes Descripción
Reset Execute/Cancel Inicia todos los ajustes relacionados con la red (se 

ejecuta al seleccionar Execute).

Maintenance > License Options
Instala las opciones de software.

Elemento del menú Ajustes Descripción
Install: <licencia_de_
destino>

Execute/Cancel Instala las opciones de software (se ejecuta al 
seleccionar Execute).

Anamorphic Permanent License Installed/XX 
days Remaining (YY keys)/
Expired/Not Installed

Muestra si la opción Anamorphic está activada.
Permanent License Installed: la licencia 
permanente está instalada
XX days Remaining (YY keys): caducidad de la 
licencia de duración determinada
Expired: la licencia de duración determinada ha 
caducado
Not Installed: no instalada

Full-Frame Permanent License Installed/XX 
days Remaining (YY keys)/
Expired/Not Installed

Muestra si la opción Full Frame está activada.
Permanent License Installed: la licencia 
permanente está instalada
XX days Remaining (YY keys): caducidad de la 
licencia de duración determinada
Expired: la licencia de duración determinada ha 
caducado
Not Installed: no instalada

High Frame Rate Permanent License Installed/XX 
days Remaining (YY keys)/
Expired/Not Installed

Muestra si la opción High Full Frame está activada.
Permanent License Installed: la licencia 
permanente está instalada
XX days Remaining (YY keys): caducidad de la 
licencia de duración determinada
Expired: la licencia de duración determinada ha 
caducado
Not Installed: no instalada

Unique Device ID Muestra el ID que se utiliza para enviar la clave de 
licencia de la opción de software.

Maintenance > Firmware
Muestra la versión de la unidad y la AXS-R7 y, además, actualiza la unidad.

Elemento del menú Ajustes Descripción
Camera Muestra la versión de firmware de la unidad (Vx.

xx).
AXS
(solo si hay una AXS-R7 
conectada)

Muestra la versión de firmware de la AXS-R7 
conectada a la unidad (Vx.xx).

FW Update-camera Execute/Cancel Actualiza la unidad (se ejecuta al seleccionar 
Execute).

FW Update-AXS-R7 Execute/Cancel Actualiza la versión de firmware de la AXS-R7 
conectada a la unidad (se ejecuta al seleccionar 
Execute).
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Operaciones de clips en la pantalla secundaria
Las operaciones de clips se realizan utilizando la pantalla de lista de clips y la pantalla de reproducción. 
Para reproducir un clip, selecciónelo en la pantalla de lista de clips que aparece en la pantalla secundaria.
Cuando AXS Rec Format no se ajusta en Rec Off en la categoría Project del menú, el soporte AXS se vuelve 
reproducible. Del mismo modo, cuando SxS Rec Format no se ajusta en Rec Off, el soporte SxS se vuelve 
reproducible.

Pantalla de la lista de clips

Pulse el botón CLIPS (página 10) de la pantalla del lado del asistente para mostrar la pantalla con la lista 
de clips de los soportes reproducibles en la pantalla secundaria.

5

4

13
12
11
10

9
8
7
6

1.	 Botón de selección de soporte
Muestra “SxS/AXS” si los soportes SxS y AXS son 
reproducibles. Pulse la tecla ITEM 1 para 
cambiar el soporte de reproducción.

2.	 Botón de cursor hacia arriba
Pulse la tecla ITEM 2 para seleccionar el clip 
que desea reproducir de la lista de clips.

3.	 Botón de inicio de reproducción
Pulse la tecla ITEM 3 para mostrar la pantalla de 
reproducción (página 15) e iniciar la 
reproducción.

4.	 Lista de clips
Muestra una lista de los clips del soporte de 
reproducción activo. También muestra el 
estado de los clips con iconos.

Icono Significado
Clip con un clip secundario creado

Clip bloqueado (protección de 
escritura)

5.	 Botón de cursor hacia abajo
Pulse la tecla ITEM 5 para seleccionar el clip 
que desea reproducir de la lista de clips.

6.	 Posición del clip en el soporte de 
reproducción
Muestra el número del clip indicado por el 
cursor y el número total de clips.

7.	 Fecha y hora de creación
Muestra la fecha y hora de creación del clip 
indicado por el cursor.

8.	 Formato (códec)
Muestra el formato de grabación (códec) del 
clip indicado por el cursor.

9.	 Indicador del tamaño de imagen
Muestra el tamaño de imagen efectivo cuando 
se ha grabado el clip indicado por el cursor.

[Nota]
No se muestra cuando el soporte de reproducción es 
una tarjeta de memoria SxS.

10.	 Indicador del modo de grabación especial/
velocidad de fotogramas del proyecto
Muestra la velocidad de fotogramas del 
proyecto y el modo de grabación especial del 
clip indicado por el cursor.

11.	 Duración (Dur)
Muestra la duración del clip indicado por el 
cursor.

12.	 Código de tiempo (TCR)
Muestra el código de tiempo del primer 
fotograma del clip indicado por el cursor.

13.	 Soporte de reproducción activo
Muestra el soporte de reproducción activo de 
la lista mostrada.
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Pantalla Playback

La pantalla de reproducción se muestra al seleccionar un clip en la pantalla de la lista de clips para que se 
reproduzca y pulsar el mando MENU o el botón Play (tecla ITEM 3).

Zona de la pantalla de función

1 2 3

4 5 6

1.	 Botón F Rev
Reproduce hacia atrás a gran velocidad.

2.	 Botón Play/Pause
Reproduce un clip o detiene la reproducción.

3.	 Botón F Fwd
Reproduce hacia delante a gran velocidad.

4.	 Botón Prev
Salta al principio del clip anterior.

5.	 Botón Stop/Clips
Detiene la reproducción y vuelve a la pantalla 
con la lista de clips.

6.	 Botón Next
Salta al principio del clip siguiente.

Zona de la pantalla de estado

1 2 3 4

8 7

510

6

9

1.	 Pantalla de datos de tiempo
Muestra el código de tiempo de la posición de 
la reproducción.

2.	 Número de clip
Muestra el número de clip en reproducción 
actual/número total de clips reproducibles.

3.	 Indicador del modo del generador de 
imágenes/velocidad de fotogramas
Muestra la velocidad de fotogramas del 
proyecto y el tamaño de imagen.

[Nota]
El tamaño de imagen no se muestra cuando el soporte 
de reproducción es una tarjeta de memoria SxS.

4.	 Indicador del modo de grabación especial
Muestra el información sobre el modo de 
grabación especial del clip en reproducción.

5.	 Medidores del nivel de audio
Muestra el nivel del audio de la reproducción.

6.	 Indicador del formato (códec) del clip en 
reproducción
Muestra el formato (códec) del clip en 
reproducción.

7.	 Pantalla de iconos
Muestra el estado del clip con iconos.

Icono Significado
Clip con un clip secundario creado

Clip bloqueado (protección de 
escritura)

8.	 Indicador del nombre del clip
Muestra el nombre del clip.

9.	 Indicador del soporte
Muestra el soporte que se está reproduciendo.

10.	 Indicador de estado de reproducción
Muestra el estado de la reproducción.
Muestra “CALL” cuando se recibe un comando 
CALL.
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Reproducción
Puede reproducir los clips grabados mientras la 
unidad está en el modo de espera.

[Nota]
Los controles de reproducción se muestran en las teclas 
ITEM de la 1 a la 6 (página 9). Pulse la tecla ITEM para 
seleccionar el elemento correspondiente.

1	 Introduzca la tarjeta de memoria SxS desde la 
que desee reproducir.

2	 Pulse el botón CLIPS (página 10) del lado del 
asistente.
La lista de clips del soporte de reproducción 
activo aparece en la pantalla secundaria.

3	 Utilice el botón  (tecla ITEM 2), el botón  
(tecla ITEM 5) o el mando MENU para 
seleccionar el clip que desea reproducir.

4	 Pulse el mando MENU o el botón Play (tecla 
ITEM 3).
La reproducción aparece en la pantalla del 
visor/monitor.

Operaciones de reproducción

Las operaciones de reproducción pueden 
realizarse con los botones de la pantalla secundaria 
(página 90).
Botón Play/Pause: sitúa la reproducción en pausa. 

Para reanudar la reproducción, vuelva a pulsar 
el botón.

Botón F Fwd/F Rev: avanza la reproducción hacia 
adelante/atrás. Para volver a la reproducción 
normal, pulse el botón Play/Pause.

Botón Stop/Clips: detiene la reproducción y vuelve 
a la pantalla con la lista de clips.

Monitorización de audio

Durante el modo de reproducción normal, puede 
monitorizar el audio grabado con el altavoz 
integrado (página 8) o unos auriculares 
conectados.
Al conectar unos auriculares al conector de 
auriculares (página 8), el altavoz integrado se 
desactiva.
Para seleccionar el canal para monitorizarlo y 
ajustar el volumen, vaya a la categoría Audio > 
Monitor CH y Monitor Level (página 52) del 
menú.

Localización

Para reproducir un clip desde el principio, pulse el 
botón Prev en la pantalla secundaria (página 90).
Puede omitir clips y pasar a otro clip de la cola 
pulsando los botones Prev o Next varias veces.

Cambio de las tarjetas de memoria SxS

Cuando hay cargadas dos tarjetas de memoria SxS, 
pulse el botón SLOT SELECT (página 9) para 
cambiar de tarjeta de memoria.

[Nota]
No se puede cambiar de tarjeta de memoria SxS durante la 
reproducción. No es posible la reproducción continua de las 
tarjetas de las ranuras A y B.

Cambio a una tarjeta de memoria AXS

Puede reproducir rápidamente el vídeo grabado 
en una tarjeta de memoria AXS en la AXS-R7.
Para cambiar a una tarjeta de memoria AXS, 
pulse la tecla ITEM 1 (página 89) en la pantalla 
secundaria.

Casos en los que la reproducción en la unidad no 
es compatible

Los clips grabados en soportes AXS en las 
siguientes circunstancias no podrán reproducirse 
en la unidad. Reproduzca los clips usando una 
aplicación de ordenador, como RAW Viewer.
ˎˎ Cuando Imager Mode se ajusta en 6K 3:2, 6K 
1.85:1, 6K 17:9, 6K 2.39:1 o 5.7K 16:9 y Project 
Frame Rate se ajusta en 59.94P, 50P o 47.95P
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Operaciones de la pantalla Home de la pantalla en miniatura
Puede consultar el estado de la unidad y 
configurar sus ajustes básicos desde la pantalla 
Home de la pantalla en miniatura.

1
2
3
4
5

1.	 FPS
Define la velocidad de fotogramas de la 
filmación.

2.	 Shutter
Muestra y configura la velocidad/ángulo de 
obturación del obturador electrónico.

3.	 ND Filter
Muestra y define la densidad del filtro ND.

4.	 Exposure Index/Gain
Muestra y configura el índice de exposición (EI) 
o bien muestra y establece el valor de 
ganancia (unidades en dB) establecidos por 
una RM-B170 u otra unidad de control remoto.

	 [Nota]
El valor de ganancia se muestra solo cuando se ajusta 
Technical > System Configuration > RM/RCP Paint 
Control (página 83) en On en el menú completo.

5.	 WB (White Balance)
Muestra y configura el equilibrio del blanco.

Visualización y funcionamiento cuando se habilita 
RM/RCP Paint Control

ˎˎ El valor de ganancia se muestra en lugar de 
Exposure Index cuando se ajusta Technical > 
System Configuration > RM/RCP Paint Control 
(página 83) en On en el menú completo. En 
este modo, el valor de EI no puede cambiarse, 
pero el valor de ganancia sí.

ˎˎ Los siguientes elementos no pueden utilizarse 
cuando se conecta una RM-B170 u otra unidad 
de control remoto y se ajusta Technical > 
System Configuration > RM/RCP Paint Control 
(página 83) en On en el menú completo. 
Realice su configuración a través de la unidad de 
control remoto (página 109).
ˎˎ Shutter
ˎˎ WB (White Balance)

Controles

Botón HOME (página 8)
Púlselo para volver a la pantalla Home. Los 
cambios que no confirme se cancelarán.

Tecla ITEM 1 ( ) (página 8)
Púlsela para seleccionar elementos de la pantalla 
Home.

Tecla ITEM 2 ( ) (página 8)
Púlsela para aplicar el elemento seleccionado.

Tecla ITEM 3 ( ) (página 8)
Púlsela para seleccionar elementos de la pantalla 
Home.

Procedimiento básico

1	 Pulse las teclas ITEM 1, 2 o 3.
Aparece el cursor.

2	 Seleccione el elemento que desea configurar 
con el botón  (tecla ITEM 1) o el botón  
(tecla ITEM 3).

3	 Pulse el botón  (tecla ITEM 2).
Aparecerá la pantalla de selección del valor de 
ajuste para el elemento seleccionado.

	 [Nota]

La marca  indica cuál es el ajuste actual.

4	 Mueva el cursor al elemento o valor de ajuste 
con el botón  (tecla ITEM 1) o con el botón 

 (tecla ITEM 3).

5	 Pulse el botón  (tecla ITEM 2) para aplicar el 
ajuste.

6	 Pulse el botón HOME para ocultar el cursor.
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Elementos de la pantalla Home en la pantalla en miniatura

A continuación, indicamos el nombre de los elementos y sus correspondientes valores de configuración.
Los valores predeterminados aparecen en negrita subrayados.

Elemento Descripción

FPS Define la velocidad de fotogramas de la filmación.
Variable/Fixed: cambia entre la filmación con velocidad variable y velocidad 
constante en la pantalla Home (página 39) de la pantalla secundaria.
Si la opción “Fixed” está seleccionada, el ajuste queda determinado por el ajuste 
de la categoría Project > Project Frame Rate (página 50) del menú.

Project Frame Rate Pantalla
23.98 Fix 23.98

24 Fix 24.00

25 Fix 25.00

29.97 Fix 29.97

47.95 Fix 47.95

50 Fix 50.00

59.94 Fix 59.94

Si la opción “Variable” está seleccionada, el ajuste cambia como se indica a 
continuación en función del ajuste de la categoría Project > Imager Mode 
(página 68) del menú.

Imager Mode Ajuste
3.8K 16:9
4K 17:9
4K 2.39:1

De 1 a 60 FPS

3.8K 16:9 1)

4K 17:9 1)

De 1 a 60, 66, 72, 75, 88, 90, 96, 100, 110 FPS

3.8K 16:9 Surround View
4K 17:9 Surround View
4K 4:3

De 1 a 48 FPS

4K 4:3 1) De 1 a 60, 66, 72, 75 FPS

4K 2.39:1 1) De 1 a 60, 66, 72, 75, 88, 90, 96, 100, 110, 120 FPS

4K 4:3 Surround View
4K 6:5
5.7K 16:9
6K 2.39:1
6K 17:9
6K 1.85:1

De 1 a 30 FPS

Elemento Descripción

Imager Mode Ajuste
6K 2.39:1 1) De 1 a 60, 66, 72, 75, 90 FPS
4K 6:5 1)

5.7K 16:9 1)

6K 17:9 1)

6K 1.85:1 1)

De 1 a 60, 66, 72 FPS

6K 3:2 De 1 a 25 FPS

6K 3:2 1) De 1 a 60 FPS

Exposure Index Establece el valor de EI. El ajuste cambia como se indica a continuación en 
función del ajuste de Project > Basic Setting > Base ISO (página 68) del menú 
completo.
ISO 500:

125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/ 
1250EI/1600EI/2000EI

ISO 2500:
640EI/800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/4000EI/ 
5000EI/6400EI/8000EI/10000EI

Gain Configura la sensibilidad de base.
–6dB/–3dB/0dB/3dB/6dB/9dB/12dB/15dB/18dB

[Nota]
Configurable solo cuando se conecta una RM-B170 u otra unidad de control remoto y se 
ajusta Technical > System Configuration > RM/RCP Paint Control (página 83) en On en el 
menú completo.

Shutter Define la velocidad del obturador y el ángulo del obturador electrónico.
Seleccione entre los valores preestablecidos registrados como pasos del 
obturador.

[Nota]
No disponible cuando la operación del obturador electrónico está ajustada en Continuous.

En función del ajuste del menú completo Technical > System Configuration > 
Shutter Mode (página 83), muestra las siguientes opciones de selección.
Angle (Δ): indicador del ángulo del obturador

360.0/180.0/172.8/144.0/90.0/45.0/22.5/11.2/5.6 2)

Speed (SS): indicador de la velocidad del obturador
1/24, 1/25, 1/30, 1/48, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000 2)

ND Filter Define la densidad del filtro ND. Están disponibles los siguientes ajustes.
Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4

WB (White Balance) Configura la temperatura de color del equilibrio del blanco.
Seleccione entre los valores preestablecidos registrados como pasos del equilibrio 
del blanco.

3200K+00/4300K+00/5500K+00 2)

1)	 Solo cuando se activa una licencia High Frame Rate.
2)	 Es posible cambiar las opciones de selección con Step Edit en la pantalla Home de la pantalla secundaria.
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Operaciones de clips en la pantalla en miniatura
Para reproducir un clip, selecciónelo en la pantalla 
de clips que aparece en la pantalla en miniatura.
Cuando AXS Rec Format no se ajusta en Rec Off 
en la categoría Project del menú, el soporte AXS se 
vuelve reproducible. Del mismo modo, cuando SxS 
Rec Format no se ajusta en Rec Off, el soporte SxS 
se vuelve reproducible.
Si la reproducción de los soportes AXS y SxS está 
activada, puede seleccionar el soporte activo en 
la pantalla con la lista de clips (página 89) de la 
pantalla secundaria.

Pantalla Clip

Pulse el botón CLIPS (página 8) de la pantalla 
del lado del operador para mostrar la pantalla 
con los clips de los soportes reproducibles en la 
pantalla en miniatura.

7

6

5

1
2
3
4

1.	 Indicador de estado de reproducción
Muestra el estado de reproducción del clip.

2.	 Soporte de reproducción activo
Muestra el soporte de reproducción activo del 
clip seleccionado.

3.	 Nombre del clip
Muestra el nombre del clip seleccionado.

4.	 Posición del clip en el soporte de 
reproducción
Muestra el número de clip/número total del 
clip seleccionado.

5.	 Botón F Fwd/Next
Salta al siguiente clip cuando se pulsa la tecla 
ITEM 3 ( ) mientras la reproducción está en 
pausa.
Avanza rápido el clip cuando se pulsa la tecla 
ITEM 3 ( ) durante la reproducción.

6.	 Botón Play/Pause
Reproduce/detiene la reproducción del clip 
cuando se pulsa la tecla ITEM 2 ( ).

7.	 Botón F Rev/Prev
Salta al clip anterior cuando se pulsa la tecla 
ITEM 1 ( ) mientras la reproducción está en 
pausa.
Rebobina rápido el clip cuando se pulsa la 
tecla ITEM 1 ( ) durante la reproducción.

Reproducción

Puede reproducir los clips grabados mientras la 
unidad está en el modo de espera.

1	 Introduzca la tarjeta de memoria SxS desde la 
que desee reproducir.

2	 Pulse el botón CLIPS (página 8) del lado del 
operador.
El clip en reproducción activo aparece en la 
pantalla en miniatura.

3	 Utilice el botón Prev (tecla ITEM 1) o el botón 
Next (tecla ITEM 3) para seleccionar el clip que 
desea reproducir.

4	 Pulse el botón Play/Pause (tecla ITEM 2).
La reproducción aparece en la pantalla del 
visor/monitor.

Operaciones de reproducción

Las operaciones de reproducción pueden 
realizarse con los botones de la pantalla en 
miniatura (página 94).
Botón Play/Pause: sitúa la reproducción en pausa. 
Para reanudar la reproducción, vuelva a pulsar el 
botón.
Botón F Fwd/F Rev: avanza la reproducción hacia 
adelante/atrás. Para volver a la reproducción 
normal, pulse el botón Play/Pause.

Monitorización de audio

Durante el modo de reproducción normal, puede 
monitorizar el audio grabado con el altavoz 
integrado (página 8) o unos auriculares 
conectados.
Al conectar unos auriculares al conector de 
auriculares (página 8), el altavoz integrado se 
desactiva.
Para seleccionar el canal para monitorizarlo y 
ajustar el volumen, vaya a la categoría Audio > 
Monitor CH y Monitor Level (página 52) del 
menú.

Cambio de las tarjetas de memoria SxS

Cuando hay cargadas dos tarjetas de memoria SxS, 
pulse el botón SLOT SELECT (página 9) para 
cambiar de tarjeta de memoria.

[Nota]
No se puede cambiar de tarjeta de memoria SxS durante la 
reproducción. No es posible la reproducción continua de las 
tarjetas de las ranuras A y B.
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Configuración y operaciones de red
Si conecta la unidad a una red, puede controlar 
distintos ajustes de la unidad desde un ordenador, 
smartphone, tableta u otro dispositivo y visualizar 
información acerca de la unidad.

Introducción de la función Network

Cuando la unidad y el dispositivo se conectan a 
través de una LAN inalámbrica o LAN con cable, es 
posible acceder a la unidad desde un navegador 
con el dispositivo, visualizar el control remoto web 
y activar las siguientes operaciones.
ˎˎ Controlar la grabación de la unidad 
(página 98)
ˎˎ Controlar la reproducción en la unidad 
(página 98)
ˎˎ Configurar los ajustes de filmación de la unidad 
(página 99)
ˎˎ Controlar el objetivo conectado a la unidad 
(página 99)
ˎˎ Configurar y accionar botones asignables en la 
unidad (página 99)

Con el control remoto web es posible iniciar/
detener la grabación y configurar los ajustes 
de manera remota; además, es práctico para 
aplicaciones en las que la unidad se coloca en una 
ubicación remota o sobre una grúa, por ejemplo.

Dispositivos compatibles

Puede utilizar un ordenador, smartphone o 
tableta para configurar y accionar la unidad. En la 
siguiente tabla se muestran los dispositivos, SO y 
navegadores verificados.

Dispositivo SO Navegador
Ordenador Microsoft Windows 8.1/

Microsoft Windows 10
Chrome

macOS 12.x Safari
Smartphone Android 12.x Chrome

iOS 15.x/16.x Safari
Tableta Android 10.x/11.x Chrome

iPadOS 15.x/16.x Safari

[Nota]
Es posible que los controles no se muestren de forma normal 
en función de la versión de navegador que esté utilizando. 
Se ha comprobado el funcionamiento en las siguientes 
versiones de navegadores.
Safari: 15/16
Chrome: 106

Conexión de la unidad y el dispositivo 
mediante una LAN con cable

Puede conectar la unidad a un dispositivo a través 
de una conexión LAN con cable o de un router 
mediante el conector de red de la unidad.

1	 Conecte el conector de red (página 8) de la 
unidad al ordenador a través de un cable de 
LAN. O conecte el conector de red de la 
unidad al router a través de un cable de LAN.

2	 Defina en LAN la opción Technical > Network 
> Setting (página 84) en el menú completo.

3	 Configure la unidad.
Para obtener la dirección IP de la unidad 
automáticamente:
Defina en On la opción Technical > Network > 
LAN > DHCP (página 85) en el menú 
completo y, a continuación, seleccione Set 
para aplicar el ajuste.
Para introducir la dirección IP de la unidad 
manualmente:

Defina en Off la opción Technical > Network > 
LAN > DHCP en el menú completo, introduzca 
la dirección especificada en LAN > IP Address 
y, a continuación, seleccione Set para aplicar el 
ajuste.

[Nota]
Seleccione Set en la pantalla de configuración Technical 
> Network > LAN en el menú completo. Si no selecciona 
Set, los ajustes configurados no se aplican.

Cuando la conexión LAN con cable está 
activada, se muestra el icono LAN del 
indicador de estado de conexión de la red 
(página 14) en la pantalla del visor/monitor.

Conexión de la unidad y el dispositivo 
mediante una LAN inalámbrica

La unidad puede conectarse a dispositivos 
utilizando una conexión LAN inalámbrica 
conectando el adaptador LAN inalámbrico CBK-
WA02 (opcional) a la unidad.

Conexión del CBK-WA02

[Nota]
Apague siempre la unidad antes de conectar el CBK-WA02.

1	 Conecte el adaptador de extensión USB al 
punto que se muestra en el siguiente 
diagrama y gire el tornillo de fijación en 
sentido contrario a las agujas del reloj para 
fjiarlo en su posición.

Tornillo de retención

Adaptador de extensión USB

Puede ajustar la posición del adaptador de 
extensión USB sobre el rango que se muestra 
en el siguiente diagrama.

2	 Conecte el tapón de protección (suministrado) 
al conector USB del adaptador de extensión 
USB.
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3	 Abra la tapa del bloque de conectores del 
dispositivo externo e inserte el conector USB 
del adaptador de extensión USB en el conector 
del dispositivo externo.

4	 Inserte el CBK-WA02 en el conector USB del 
adaptador de extensión USB.

Conexión en el modo de punto de acceso

Cuando se configura una unidad como punto de 
acceso, puede conectarse a dispositivos a través 
de la LAN inalámbrica.

Smartphone/
Tableta

Ordenador

Conexión utilizando dispositivos equipados con WPS
Es posible conectar dispositivos que admitan WPS 
con WPS.

1	 Defina en Wireless la opción Technical > 
Network > Setting (página 84) en el menú 
completo.

2	 Defina en Access Point la opción Technical > 
Network > Wireless > Network Mode 
(página 85) en el menú completo.

3	 Seleccione Technical > Network > Wireless > 
WPS (página 85) en el menú completo.

4	 Seleccione Execute girando el mando MENU y, 
a continuación, pulse el mando MENU.

5	 Abra ajustes de red o ajustes de Wi-Fi del 
dispositivo y active Wi-Fi.

6	 Presione el botón WPS en las preferencias de 
ajustes de red o ajustes de Wi-Fi del dispositivo.

[Nota]
Los pasos varían en función del dispositivo utilizado.

Conexión utilizando el SSID y contraseña en el dispositivo
Conexión introduciendo el SSID y contraseña en el 
dispositivo.

1	 Defina en Wireless la opción Technical > 
Network > Setting (página 84) en el menú 
completo.

2	 Defina en Access Point la opción Technical > 
Network > Wireless > Network Mode 
(página 85) en el menú completo.

3	 Abra ajustes de red o ajustes de Wi-Fi del 
dispositivo y active Wi-Fi.

4	 Seleccione el SSID de la unidad en la lista de 
SSID de la red Wi-Fi e introduzca una 
contraseña para conectarse.
Para el SSID y contraseña de la unidad, 
consulte Technical > Network > Wireless > 
SSID y Password (página 85) en el menú 
completo.

[Nota]
Los pasos varían en función del dispositivo utilizado.

Conexión en el modo estación

La unidad puede conectarse a puntos de acceso 
LAN inalámbrica existentes como un cliente.
El dispositivo se conecta a través del punto de 
acceso.

Smartphone/
Tableta

Ordenador

Punto de 
acceso

Conexión a un punto de acceso utilizando WPS
Si un punto de acceso admite la función WPS, 
puede conectarse utilizando un ajuste básico.

1	 Encienda el punto de acceso.

2	 Encienda la unidad.

3	 Defina en Wireless la opción Technical > 
Network > Setting (página 84) en el menú 
completo.

4	 Defina en Station la opción Technical > 
Network > Wireless > Network Mode 
(página 85) en el menú completo.
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5	 Seleccione Technical > Network > Wireless > 
WPS (página 85) en el menú completo.

6	 Seleccione Execute girando el mando MENU y, 
a continuación, pulse el mando MENU.

7	 Presione el botón WPS del punto de acceso.
Para obtener más información sobre el 
funcionamiento del botón WPS, consulte el 
manual de instrucciones del punto de acceso.

[Nota]
Si la conexión falla, realice el procedimiento de nuevo desde 
el paso 1.

Conexión introduciendo un SSID y una contraseña
Realice la conexión introduciendo el SSID y 
contraseña en la unidad.

1	 Defina en Wireless la opción Technical > 
Network > Setting (página 84) en el menú 
completo.

2	 Defina en Station la opción Technical > 
Network > Wireless > Network Mode 
(página 85) en el menú completo.

3	 Defina los siguientes elementos en Technical > 
Network > Wireless (página 85) en el menú 
completo.
ˎˎ SSID
ˎˎ Password
ˎˎ DHCP
ˎˎ IP Address
ˎˎ Subnet Mask

4	 Seleccione Set para confirmar.

[Nota]
Utilice siempre Set para confirmar los ajustes. Si los ajustes 
configurados no se confirman con Set, no se aplicarán.

Conexión utilizando la detección automática del punto de 
acceso
La unidad puede conectarse detectando 
automáticamente los puntos de acceso sin tener 
que introducir el SSID manualmente.

1	 Defina en Wireless la opción Technical > 
Network > Setting (página 84) en el menú 
completo.

2	 Defina en Station la opción Technical > 
Network > Wireless > Network Mode 
(página 85) en el menú completo.

3	 Seleccione Technical > Network > Wireless > 
Scan Networks (página 85) en el menú 
completo.

4	 Seleccione Execute girando el mando MENU y, 
a continuación, pulse el mando MENU.
La unidad comienza la detección automática 
de los puntos de acceso. Una vez que termina 
la detección automática, las redes disponibles 
para la conexión se muestran en una lista.

5	 Seleccione la red a la que quiere conectarse 
girando el mando MENU y, a continuación, 
pulse el mando MENU.

6	 Seleccione Set para confirmar.
Aparece una pantalla de introducción de 
contraseña.

7	 Introduzca la contraseña y, a continuación, 
seleccione Done.
Aparece la pantalla de preferencias de Wireless.

8	 Defina los siguientes elementos en Technical > 
Network > Wireless en el menú completo y, a 
continuación, seleccione Set para confirmar.
ˎˎ DHCP
ˎˎ IP Address
ˎˎ Subnet Mask

[Nota]
Utilice siempre Set para confirmar los ajustes. Si los ajustes 
configurados no se confirman con Set, no se aplicarán.

Visualización del control remoto web

El control remoto web se muestra cuando se 
accede a la unidad desde el navegador de un 
dispositivo. El tamaño de la pantalla de control 
remoto web se ajusta automáticamente según el 
tamaño de la pantalla del dispositivo conectado.

1	 Conecte la unidad y el dispositivo tal y como 
se describe en “Conexión de la unidad y el 
dispositivo mediante una LAN con cable” o 
“Conexión de la unidad y el dispositivo 
mediante una LAN inalámbrica”.

2	 Abra un navegador en el dispositivo y escriba 
“http://dirección IP de la unidad/rm.html” en la 
barra de direcciones URL.
Puede comprobar la dirección IP de la unidad 
en categoría Info > System > IP Address 
(página 52) en el menú.
Por ejemplo, si la dirección IP es 192.168.1.1, 
introduzca “http://192.168.1.1/rm.html” en la 
barra de direcciones URL.

3	 Introduzca el nombre de usuario y la 
contraseña (Technical > Authentication 
(página 84) en el menú completo) en la 
pantalla del navegador.
Cuando la conexión se realiza correctamente, 
aparece la pantalla de control remoto en el 
dispositivo.

[Nota]
Puede que la página no se muestre correctamente en un 
smartphone u otro dispositivo si el modo de visualización se 
ha configurado como páginas móviles. Cambie el modo de 
visualización a páginas de escritorio.

Pantalla de control remoto web

Global Menu

Seleccione , en la parte superior izquierda de 
la pantalla de control remoto web, para mostrar 
Global Menu. Seleccione el elemento que desee 
configurar.

Pantalla Camera Control

La pantalla Camera Control contiene la pantalla 
Camera, la pantalla Lens y la pantalla Info. 
Seleccione la pestaña Camera para mostrar la 
pantalla Camera, la pestaña Lens para mostrar 
la pantalla Lens y la pestaña Info para mostrar la 
pantalla Info.
Aparecen distintos elementos y botones de 
operación en la pantalla Camera Control (comunes 
a la pantalla Camera, la pantalla Lens, la pantalla 
Info y la pantalla de reproducción).
ˎˎ Estado de la conexión de red (Connected/
Disconnected)
ˎˎ Camera ID*
ˎˎ Botón Rec
ˎˎ Botones asignables (1 a 7, A a C)

*	 El color de texto de Camera ID es el mismo color definido 
utilizando Frame Line A/B Setup > Color.
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Pantalla Camera

En la pantalla Camera puede configurar los 
mismos elementos que se muestran en la pantalla 
Home de la pantalla secundaria.

[Nota]
Del mismo modo que para la pantalla de visualización 
secundaria, la zona de la pantalla EI cambia para pasar a ser 
la zona de la pantalla Gain y las restricciones se aplicarán a 
los elementos (página 34) que puedan utilizarse al ajustar 
Technical > System Configuration > RM/RCP Paint Control 
(página 83) en On en el menú completo.

ˎˎ Ajustes de filmación (página 32) 
FPS, EI, Shutter, ND, LUT, WB
ˎˎ Pantalla de estado de la cámara (página 33) 
Estado de funcionamiento, datos de tiempo, 
medidor del nivel de audio, nombre del clip, 
formato de grabación, estado del soporte/
espacio libre, tensión de la batería/capacidad de 
la batería restante

Pantalla Lens

Los controles del objetivo zoom, enfoque e iris se 
muestran en la pantalla Lens.

Pantalla Info

La pantalla Info muestra el mismo contenido 
que la categoría Info (página 52) de la pantalla 
del menú de visualización secundaria, lo que 
le permite consultar el estado de la cámara, el 
soporte y la batería.

Pantalla Full Menu

Seleccione Full Menu en Global Menu para ver la 
pantalla del menú completo para configurar los 
elementos (página 63).

[Nota]
Puede que algunos elementos no se puedan configurar 
desde el control remoto web.

Pantalla OSS (Open Source Software) Information

Seleccione OSS Information en Global Menu para 
mostrar la información acerca del software de 
código abierto.

Pantalla de reproducción

Puede reproducir clips en la pantalla de 
reproducción. La información acerca del clip en 
reproducción se muestra en la zona de la pantalla 
de estado de la pantalla.
ˎˎ Pantalla Function (página 90) 
F Rev, Play/Pause, F Fwd, Prev, Stop/Clips, Next
ˎˎ Pantalla de estado de reproducción 
(página 90) 
Datos de tiempo, número de clip, velocidad 
de fotogramas/tamaño de imagen de clip de 
reproducción (solo AXS), modo de grabación 
especial, medidor de nivel de audio, formato de 
clip de reproducción (códec), icono (protección, 
clip secundario), nombre de clip, medio de 
reproducción y estado de reproducción.

Botón HOME

Pulse el botón HOME para volver a la pantalla 
Camera.
Cuando la cámara está en el modo de 
reproducción, si pulsa el botón HOME, vuelve al 
estado de filmación de la cámara, incluso cuando 
la pantalla de reproducción se muestra en la 
pantalla de control remoto web.

Botón CLIPS

Pulse el botón CLIPS para volver a la pantalla 
Reproducción. (La unidad cambia a la pantalla de 
lista de clips (página 89).)

Grabación

Presione el botón Rec de la pantalla Camera 
Control para iniciar la grabación y mostrar el 
testigo REC en rojo. Haga clic de nuevo para 
detener la grabación.
El botón Rec está activado cuando el testigo REC 
ACTIVE que aparece más abajo y a la derecha del 
botón Rec está en verde.

Para bloquear el botón Rec

Deslice el control deslizante Lock situado debajo 
del botón Rec hacia la derecha para desactivar el 
funcionamiento del botón Rec.

Reproducción

Presione el botón CLIPS en la pantalla Camera 
para volver a la pantalla de reproducción en el 
estado de reproducción. (La pantalla secundaria 
de la unidad muestra la pantalla de lista de clips 
(página 89).)
Seleccione el clip que desea ver en la pantalla de 
reproducción y use los controles de reproducción 
para reproducir el clip.

Para cambiar entre medios de reproducción

El botón de selección de soporte se muestra 
cuando la unidad está en el estado de 
reproducción. Si se puede reproducir medios 
SxS y AXS, el botón de selección de soporte está 
habilitado. Pulse el botón para cambiar el soporte 
de reproducción.
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Configuración de los ajustes de 
filmación

En la pantalla Camera puede configurar y accionar 
los mismos elementos que se muestran en la 
pantalla Home de la pantalla secundaria de la 
unidad.

[Nota]
La operación Step Edit para Shutter no es compatible.

El funcionamiento es el mismo que en la pantalla 
Home de la pantalla secundaria.

“Operaciones de la pantalla Home en la pantalla secundaria” 
(página 34)

Control del objetivo

Puede comprobar el estado de los ajustes del 
objetivo con soporte E (zoom, enfoque, iris) en la 
pantalla Lens; asimismo, puede controlar el zoom, 
el enfoque y el iris a través de controles deslizantes 
si el objetivo conectado se puede controlar.
El control de comunicación de objetivo Cooke con 
soporte PL se admite en la pantalla Lens.
Además, el control de comunicación de objetivo 
de 12 pines se admite en la pantalla Lens.

[Nota]
Los controles deslizantes quedan atenuados y no pueden 
utilizarse cuando se conecta una RM-B170 u otra unidad de 
control remoto y se ajusta Technical > System Configuration 
> RM/RCP Paint Control (página 83) en On en el menú 
completo. Los controles deslizantes de enfoque y zoom 
quedan atenuados cuando se activan el control remoto del 
enfoque y el zoom, respectivamente.

Configuración/funcionamiento de los 
botones asignables

Los botones asignables del 1 al 4, los botones 
asignables del 5 al 7 y los botones asignables 
del visor de la A a la C se muestran en la pantalla 
Camera Control.
Pulse los botones asignables del 1 al 4, los 
botones asignables del CBK-3620XS del 5 al 7 o 
los botones asignables del DVF-EL200 de la A a la 
C para cambiar las funciones asignadas entre on/
off (habilitada/deshabilitada) o para activar las 
funciones asignadas de la misma forma que los 
botones asignables en la unidad.
Seleccione el nombre de función de un botón 
asignable para mostrar las opciones de selección 
en un menú desplegable. Seleccione una opción 
para cambiar la función asignada al botón 
asignable.

“Funciones que se pueden asignar a los botones asignables del 1 
al 7” (página 45)

“Funciones que se pueden asignar a los botones asignables de la 
A a la C del visor (DVF-EL200)” (página 46)

[Nota]
Las funciones asignadas a botones asignables que se 
activan únicamente cuando se pulsa un botón o a través de 
pulsación larga no pueden accionarse desde los botones 
asignables del control remoto web. Se incluyen las siguientes 
funciones.

–– Press & Hold for SDI Log
–– Press & Hold for Monitor Log
–– Press & Hold for VF Log
–– Iris Open (1/16 stop)
–– Iris Close (1/16 stop)

Bloqueo de la pantalla de control 
remoto web

Puede desactivar el funcionamiento de la pantalla 
de control remoto web deslizando el control 
deslizante Lock hacia la derecha en la parte 
superior de la pantalla de control remoto web.
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Procedimientos básicos

5. Filmación

Los procedimientos descritos a continuación 
explican las operaciones básicas de grabación.

1	 Asegúrese de que la unidad tiene conectados 
los dispositivos necesarios y de que estos 
reciben alimentación.

2	 Coloque el interruptor de alimentación 
(página 8) en la posición ON.
Aparece la pantalla de grabación en el pantalla 
del visor.

3	 Cargue la(s) tarjeta(s) de memoria.
Si carga dos tarjetas de memoria AXS o SxS, la 
grabación continúa automáticamente 
pasando a la segunda tarjeta cuando la 
primera tarjeta se llena.

	 [Nota]
Las tarjetas no cambian automáticamente durante la 
grabación simultánea.

4	 Pulse el botón REC (páginas 8, 10).
El testigo REC se enciende y se inicia la 
grabación.

	 [Nota]
Si la unidad no puede comenzar a grabar 
inmediatamente después de pulsar el botón REC, el 
testigo REC parpadeará. El indicador REC se ilumina 
cuando se inicia la grabación.

5	 Para detener la grabación, vuelva a pulsar el 
botón REC.
Se detiene la grabación y la unidad pasa al 
modo STBY (grabación en espera).
Al detener la grabación, el vídeo, el audio y los 
datos adicionales desde el principio hasta el 
final de la grabación se graban como un solo 
clip.

Nombres de clip

Los nombres de los clips se graban con el formato 
“Cam ID + Reel#”. Para crear el nombre de un clip 
se siguen estas normas.
ˎˎ Si ya existe un clip almacenado con el formato 
de nombre “Cam ID + Reel#” en las tarjetas de 
memoria SxS o AXS insertadas, el nuevo archivo 
lo hereda del archivo más reciente.  
Por ejemplo: cuando “B002C003_XXXXXXXX” 
se encuentra en la tarjeta de memoria AXS, el 
siguiente clip que se cree se llamará “B002C004_
XXXXXXXX”.
ˎˎ Si la tarjeta de memoria AXS insertada no 
contiene ningún archivo, “1” se añade al Reel 
Number del clip que se grabó en último lugar.  
Por ejemplo: si se graba en una tarjeta vacía 2 
después de grabar hasta “D001CXXX_XXXXXXXX” 
en la tarjeta 1, el siguiente clip que se cree se 
llamará “D002C001_XXXXXXXX”. El nombre del 
clip se muestra subrayado hasta que comienza 
la grabación.
ˎˎ Si configura el Camera ID y el Reel Number 
desde el menú de la categoría TC/Media, se 
aplicará esa información.  
Por ejemplo: si cambia el Camera ID a “F” y el 
Reel Number a “001” desde el menú para la 
tarjeta de memoria AXS que ha grabado hasta 
“E003CXXX_XXXXXXXX”, el siguiente clip se 
llamará “F001CXXX_XXXXXXXX”. Cuando cambia 
únicamente el Camera ID, el Reel Number 
cambia a “001”.

Duración máxima de un clip

La longitud máxima de un clip que puede grabar 
en una tarjeta de memoria SxS es de 6 horas. El 
tiempo máximo de grabación es de 24 horas.
La grabación ampliará los clips si el tiempo de 
grabación supera la longitud máxima del clip.
La grabación se detiene cuando el tiempo de 
grabación alcanza las 24 horas.
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Funciones útiles
Grabación simultánea

Es posible grabar dos tamaños de imagen a la 
vez en la tarjeta de memoria SxS en una ranura. 
También puede grabar de forma simultánea una 
señal HD en la tarjeta de memoria SxS de la unidad 
mientras se graban vídeo y audio con formato 
RAW en la AXS-R7.
Puede realizar grabaciones simultáneas con la 
categoría Project > AXS Rec Format y SxS Rec 
Format o SxS Rec Format y Sub Rec Format del 
menú como se describe en “Ajuste del formato de 
grabación” (página 54).

En la grabación simultánea en 1 ranura, el clip de 
XAVC 4K Class480/XAVC 4K Class300/XAVC QFHD 
Class480/XAVC QFHD Class300 se graba en el 
directorio XDROOT/Clip de la tarjeta de memoria 
SxS, pero el clip MPEG2 1920×1080 se graba en el 
directorio XDROOT/Sub de la tarjeta de memoria 
SxS. El sufijo “S02” se añade al final del nombre del 
clip.

[Nota]
La grabación simultánea no es compatible con el formato de 
vídeo ProRes 4444 HD P.

Visualización de líneas de fotogramas 
del usuario

Puede seleccionar si mostrar las líneas de 
fotogramas del usuario configuradas de forma 
arbitraria o una relación de aspecto fija.
Es posible establecer User Frame Line 1 y User 
Frame Line 2 para líneas de fotogramas del usuario.
Para establecer líneas configuradas por el usuario, 
seleccione Variable desde Monitoring > User 
Frame Line 1 (página 76) o User Frame Line 2 
(página 77) > Select en el menú completo y 
especifique los elementos de menú Width, Height, 
H Position y V Position.
Para establecer una relación de aspecto fija, 
seleccione Preset desde Monitoring > User 
Frame Line 1 (página 76) o User Frame Line 2 
(página 77) > Select en el menú completo y 
especifique los elementos de menú Preset Aspect 
Ratio, Scaling y Preset Aspect Ratio Type.
Puede comprobar la relación de aspecto, el 
número de píxeles y la relación anamórfica de las 
líneas de fotogramas del usuario para las líneas 
configuradas por el usuario o una relación de 
aspecto fija mediante Aspect Ratio(Pixels).

[Notas]
ˎˎ El ajuste User Frame Line 2 > Preset Aspect Ratio Type está 

ajustado en Line (fijo).
ˎˎ La relación anamórfica no se muestra para los ajustes del 

tamaño de imagen efectivo (Imager Mode) para los que 
no se puede configurar la relación anamórfica.

Operaciones del botón asignable

Puede mostrar/ocultar la visualización de User 
Frame Line 1 y User Frame Line 2 configurada 
para Line A asignando Line A: User Frame Disp. 
a cualquiera de los botones asignables del 1 al 4 
(del 1 al 7 cuando se conecta un CBK-3620XS), los 
botones asignables del visor del A al C y las teclas 
ITEM de la 1 a la 5 (página 43).
Cada vez que se pulsa el botón asignable, la 
visualización cambia entre la pantalla User Frame 

Line 1 y 2  pantalla User Frame Line 1  
pantalla User Frame Line 2  User Frame Line 1 y 
2 ocultas.
Del mismo modo, puede mostrar/ocultar la 
visualización de User Frame Line 1 y User Frame 
Line 2 configurada para Line B asignando Line B: 
User Frame Disp. a un botón o una tecla asignable.
También puede mostrar/ocultar la opción Aspect 
Ratio configurada para Line A o Line B asignando 
Line A: Aspect Ratio Disp. o Line B: Aspect Ratio 
Disp. a cualquiera de los botones asignables del 1 
al 4 (del 1 al 7 cuando se conecta un CBK‑3620XS), 
los botones asignables del visor del A al C y las 
teclas ITEM de la 1 a la 5. Cada vez que se pulsa el 
botón asignable, la visualización cambia entre la 
pantalla Aspect Ratio y Aspect Ratio oculto.

Grabación en caché de imágenes

La unidad siempre mantiene una caché de datos 
de audio y vídeo durante un intervalo definido 
(30 segundos máximo) en la memoria cuando se 
graba, lo que le permite grabar varios segundos de 
filmación antes de iniciar la grabación.
Cuando inicia la grabación con Project > Special 
Recording > Cache Rec Select (página 69) 
definido On en el menú completo, se graba 
retroactivamente vídeo de una duración definida 
en Project > Special Recording > Max Cache Rec 
Duration (página 69).
También puede activar o desactivar la grabación 
en caché de imágenes utilizando un botón 
asignable asignado con la función Picture Cache 
Rec.

[Notas]
ˎˎ Pueden aplicarse restricciones al ajuste Max Cache Rec 

Duration en función de la frecuencia del sistema, el 
formato de grabación y el soporte de grabación. Para 
obtener más información, consulte página 69.
ˎˎ El cambio de los ajustes del sistema,como el formato 

de grabación, borra todas las imágenes guardadas en la 
memoria. Por tanto, las imágenes grabadas justo antes de 
cambiar los ajustes no se grabar si la grabación comenzó 
inmediatamente después de cambiar los ajustes. El modo 
de caché de imágenes se libera automáticamente.
ˎˎ La grabación en el modo de caché de imágenes no está 

disponible durante la grabación simultánea en una ranura 
o en la grabación simultánea en AXS/SxS.
ˎˎ Los ajustes de caché de imágenes no se pueden cambiar 

durante la grabación.
ˎˎ Al grabar en MPEG 422 a bajas velocidades de filmación, 

puede que sea necesario cierto tiempo para detener la 
grabación o para cambiar entre tarjetas de memoria.
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Revisión de grabaciones (Rec Review)

Puede revisar el último clip grabado en la pantalla 
asignando la función Rec Review a uno de los 
botones asignables del 1 al 4 (del 1 al 7 cuando se 
conecta un CBK-3620XS) (página 43).
Cuando deje de grabar y pulse el botón al que 
se le asignó la opción Rec Review, el clip se 
reproducirá a velocidad normal desde el primer 
fotograma.
El clip se reproducirá hasta el final, la función Rec 
Review finalizará y la unidad volverá al modo STBY 
(grabación en espera).
Si se pulsa el botón HOME que se encuentra en 
el lado del operador o en el lado del asistente 
durante la reproducción, esta se detendrá y la 
unidad cambiará al modo de filmación.

Función de ampliador de enfoque de 
alta definición

Puede ampliar la visualización de la pantalla del 
visor o de la salida de Monitor.
Si pulsa el botón FOCUS MAG del visor (DVF-EL200, 
DVF-L700) conectado a la unidad, o si pulsa un 
botón asignable asignado con la función VF Focus 
Magnifier, podrá ampliar la parte central de la 
pantalla del visor, por lo que será más fácil ajustar 
el enfoque. Si pulsa un botón asignable asignado 
con la función Monitor Focus Magnifier, podrá 
ampliar la parte central de la imagen de salida 
de Monitor, por lo que será más fácil ajustar el 
enfoque.
La imagen ampliada no afecta a la imagen grabada 
ni a las demás señales de salida distintas a la salida 
de Monitor.
La ampliación de enfoque normal reduce la 
resolución debido a que simplemente aumenta 
una parte de la imagen mostrada. Sin embargo, 
el enfoque de dos aumentos (×2) de la unidad 
ofrece una ampliación de enfoque a la vez que se 
mantiene la resolución de la pantalla recortando 
la parte que se desea ampliar a partir de la imagen 
4K en lugar de hacerlo a partir de la imagen 
grabada u otras señales de salida distintas a la 
salida de Monitor.
La selección de la ampliación de enfoque de 
cuatro aumentos (×4) también es compatible al 
usar la función de recorte de imagen 4K.
Las siguientes funciones de ampliación de 
enfoque se pueden asignar a un botón asignable 
(página 45).
ˎˎ Función de amplificador de enfoque del visor: VF 
Focus Magnifier
ˎˎ Función de amplificador de enfoque de la salida 
de Monitor: Monitor Focus Magnifier

La secuencia de ampliación del botón FOCUS MAG 
y de los botones asignables asignados con una 
función de ampliación de enfoque se ajusta con 
los siguientes elementos.

ˎˎ Pantalla del visor: Monitoring > VF Display > 
VF Magnifier Ratio (página 79) en el menú 
completo
ˎˎ Salida de Monitor: Monitoring > Monitor Display 
> Monitor Magnifier Ratio (página 75) en el 
menú completo

Cuando VF Magnifier Ratio se establece en 
×2.0/×4.0, la secuencia de ampliación cada vez 
que pulsa un botón asignable asignado con VF 
Focus Magnifier es ×2.0  ×4.0  ×1.0  ×2.0.
Del mismo modo, cuando Monitor Magnifier Ratio 
se establece en ×2.0/×4.0, la ampliación cambia 
cada vez que pulsa un botón asignable asignado 
con Monitor Focus Magnifier.

[Notas]
ˎˎ En el modo High Frame Rate (velocidad de fotogramas 

de la filmación de 61 fps o superior), la resolución de 
la imagen de la pantalla de enfoque de dos o cuatro 
aumentos se reduce debido a que no es compatible la 
pantalla de recorte a partir de una imagen 4K.
ˎˎ Cuando Project Frame Rate se ajusta en 59.94 o 50 y el 

ajuste de la salida de Monitor es 1920×1080P, no se puede 
ajustar Monitor Magnifier Ratio en ×4.0 ni ×2.0/×4.0. 
Cuando el ajuste de la salida de Monitor es 1920×1080i, 
Monitor Focus Magnifier no funciona.
ˎˎ Monitor Focus Magnifier también se aplica a la salida 

HDMI si esta tiene el mismo formato de salida que la 
salida de Monitor. Puede comprobar el ajuste desde 
Monitoring > OSD Appearance > HDMI (página 73) 
en el menú completo. La salida HDMI es la misma que la 
salida de Monitor si HDMI se ajusta en “Same as Monitor”.

Highlight Clip Indicator

Puede mostrar las áreas resaltadas recortadas en 
color rojo en la imagen de salida del monitor y la 
imagen de salida del visor.
Pulse los botones asignables (páginas 43, 
45) asignados con Monitor Highlight Clip Ind 
y VF Highlight Clip Ind para activar/desactivar los 
indicadores de clips resaltados.

[Nota]
Los indicadores de clips resaltados no funcionan cuando 
se ajusta Technical > System Configuration > RM/RCP Paint 
Control (página 83) en On en el menú completo.

High Key/Low Key

Puede comprobar las áreas resaltadas apagadas y 
las sombras bloqueadas en la imagen de salida del 
monitor y la imagen de salida del visor.
Active High Key para diferenciar las áreas de alta 
luminancia y hacerlas más fáciles de ver, para 
comprobar las áreas resaltadas apagadas.
Active Low Key para diferenciar las áreas de baja 
luminancia y hacerlas más fáciles de ver, para 
comprobar las sombras bloqueadas.
Pulse los botones asignables del 1 al 4 (del 1 al 7 
cuando se conecta un CBK‑3620XS) (página 45) 
asignados con Monitor High/Low Key y VF High/
Low Key para alternar los ajustes de High Key y 
Low Key.

[Nota]
La tecla High/Low no funciona cuando se ajusta Technical > 
System Configuration > RM/RCP Paint Control (página 83) 
en On en el menú completo.



000 5. Filmación: Funciones útiles103

Pantalla de falso color

Puede ver el color falso en el visor pulsando el 
botón B/False Color (DVF-EL200) o el botón SPARE 
(DVF-L700) en el visor conectado a la unidad.
También puede mostrar el color falso en la salida 
del monitor.

Color de 
pantalla

Nivel de señal
S-Log3 
(predeterminado)

S-Log2 (referencia 
PMW-F55)

Rojo 93,4% a 96,1% 105,5% a 109,5%
Amarillo 91,3% a 93,4% 102,5% a 105,5%
Naranja 87,7% a 90,6% 97,4% a 101,5%
Rosa 54,3% a 58,0% 50,2% a 55,2%
Rosa claro 47.8% a 50.8% 

(18% gris + 1 stop)
41.5% a 45.4% 
(18% gris + 1 stop)

Cyan 43,8% a 46,5% 36,3% a 39,6%
Verde 38.9% a 42.2% 

(18% gris)
30.4% a 34.4% 
(18% gris)

Azul claro 24,6% a 34,4% 15,5% a 25,2%
Azul 3,5% a 5,6% 3,0% a 4,0%
Púrpura –7,3% a 3,5% –7,3% a 3,0%

ˎˎ Puede establecer si utilizar el ajuste Preset on/
off y el umbral de cada color falso en el visor 
y la salida del monitor, o definir los colores 
manualmente con Monitoring > False Color 
(página 77).
ˎˎ Puede activar o desactivar la visualización de la 
función de color falso en el visor pulsando un 
botón asignable asignado con VF False Color.
ˎˎ Puede activar o desactivar la visualización 
de la función de color falso en un monitor 
presionando un botón asignable asignado con 
Monitor False Color.

[Notas]
ˎˎ En la DVF-L700, la visualización se admite solo cuando 

Gamma se ha definido en S-Log2 para la salida de señal 
de vídeo en el visor.
ˎˎ La función de color falso no funciona cuando se ajusta 

Technical > System Configuration > RM/RCP Paint Control 
(página 83) en On en el menú completo.

Función de exploración de doble 
velocidad del visor

Si la velocidad de fotograma del proyecto es 
23.98P, 24P, 25P o 29.97P, la imagen podría 
aparecer borrosa y ser difícil de visualizar debido 
a la baja frecuencia de fotograma que se produce 
al grabar mientras la unidad se balancea hacia la 
derecha y hacia la izquierda.
En este caso, puede reducir la borrosidad de la 
imagen y facilitar su visualización activando la 
función de exploración de doble velocidad del 
visor.
Para activar la función, ajuste la categoría 
Monitoring > VF Function > Double Speed Scan 
(página 79) del menú completo en On.

[Notas]
ˎˎ Cuando se activa esta función, el ángulo del obturador de 

la función de obturador electrónico se limita a 180 grados 
como máximo.
ˎˎ Esta función se fija en desactivado durante la filmación de 

velocidad variable.
ˎˎ Esta función se activa en las siguientes combinaciones 

de tamaño de imagen y velocidad de fotogramas del 
proyecto.  
3.8K 16:9 (23.98p, 24p, 25p, 29.97p) 
4K 17:9 (23.98p, 24p, 25p, 29.97p) 
3.8K 16:9 Surround (23.98p, 24p) 
4K 17:9 Surround (23.98p, 24p) 
4K 4:3 (23.98p, 24p) 
4K 2.39:1 (23.98p, 24p, 25p, 29.97p)

User 3D LUT

Puede cargar un archivo CUBE (*.cube) para un 3D 
LUT de 17 o 33 cuadrículas creado usando RAW 
Viewer o DaVinci Resolve (de Blackmagic Design 
Pty. Ltd.) (página 36).
Ajuste Input Color Space para que coincida con el 
espacio de color de entrada de cuando se creó el 
archivo CUBE.
Si el archivo se creó usando S-Gamut3.Cine/SLog3, 
fije categoría Project > Basic Setting > Input Color 
Space (página 68) en el menú en S-Gamut3.
Cine/SLog3.
Guarde el archivo User 3D LUT en el siguiente 
directorio de la tarjeta SD.
PRIVATE\SONY\PRO\LUT\

ART

Puede importar en la videocámara archivos ART 
(Advanced Rendering Transform) (*.art) creados 
con RAW Viewer (página 36).
Un archivo ART es un archivo Look propiedad de 
Sony creado en formato binario. Un archivo ART 
ofrece una salida de monitor de mayor calidad que 
si se importa un archivo User 3D LUT en la unidad.
Guarde el archivo ART creado para la unidad en el 
siguiente directorio de la tarjeta SD.
PRIVATE\SONY\PRO\CAMERA\MPC3610\

ASC CDL

Puede importar en la unidad archivos ASC CDL 
(The American Society of Cinematographers Color 
Decision List) (*.cdl) creados con herramientas 
externas.
Esto le permite grabar con parámetros ASC CDL 
aplicados a Look.
Guarde el archivo ASC CDL en el siguiente 
directorio de la tarjeta SD.
PRIVATE\SONY\PRO\CDL\
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Datos de configuración del usuario
Puede guardar/cargar los ajustes del menú 
completo en la memoria interna y en las tarjetas 
SD. Esto le permite recuperar con rapidez un 
conjunto adecuado de ajustes de menú para la 
situación actual.
Para guardar los datos de configuración en 
una tarjeta SD, inserte una tarjeta SD grabable 
(página 26) en la ranura para tarjetas SD 
(página 12) antes de continuar.
Para obtener más información sobre los ajustes 
guardados en cada archivo, consulte “Elementos 
guardados en los archivos” (página 130).

Archivos All

Los archivos con todos los ajustes se utilizan para 
guardar/cargar los datos de configuración de 
todos los menús.
Puede guardar hasta 64 archivos en una tarjeta SD.

[Nota]
Los datos específicos del dispositivo (el sombreado, los 
niveles de salida y otros datos que requieren ajustes para el 
dispositivo específico) no se guardan.

Archivos de escena

Los archivos de escena se utilizan para guardar/
cargar ajustes para pintar elementos con el fin de 
filmar una escena en particular. Puede guardar 
hasta cinco archivos en la memoria interna y hasta 
64 archivos en una tarjeta SD.
Los archivos de escena le permiten guardar los 
siguientes tipos de datos.
ˎˎ Valores establecidos en el menú Paint
ˎˎ Ajustes de Shutter, ND filter, Gain, Base ISO, Input 
Color Space y NR
ˎˎ Datos del equilibro del blanco

[Nota]
Los ajustes no se pueden guardar ni cargar cuando se ajusta 
Technical > System Configuration > RM/RCP Paint Control 
(página 83) en Off en el menú completo.

User Gamma

Puede guardar hasta cinco archivos de gamma 
del usuario definidos por el usuario en la memoria 
interna.

[Nota]
No se pueden guardar cuando se ajusta Technical > System 
Configuration > RM/RCP Paint Control (página 83) en Off 
en el menú completo.
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Archivos All
Guardar datos de configuración como 
archivo All

1	 Seleccione Project > All File > Save SD Card 
(página 70) en el menú completo.
Aparece una pantalla para seleccionar un 
destino para guardar un archivo All.

2	 Seleccione un destino de guardado girando el 
mando MENU y, a continuación, pulse el 
mando MENU.
Puede guardar archivos en filas con un File ID 
de “No File”.
Al seleccionar una fila con un nombre de File 
ID especificado, se sobrescribirá el archivo 
seleccionado.
El File ID se genera automáticamente, pero 
puede modificarlo.

3	 Seleccione Execute en la pantalla de 
confirmación girando el mando MENU y, a 
continuación, pulse el mando MENU.

Si aparece un mensaje de error

Puede aparecer uno de los siguientes mensajes de 
error durante o después de la operación. En ese 
caso, no se guarda el archivo.

Mensaje de 
error

Problema Solución

File Access 
NG

No se ha 
introducido una 
tarjeta SD 
grabable.

Introduzca una 
tarjeta SD 
grabable.

Cambiar el File ID

1	 Seleccione Project > All File > File ID 
(página 70) en el menú completo.
Aparece una pantalla para editar el File ID.

2	 Seleccione los caracteres e introduzca el File 
ID.

3	 Seleccione Done girando el mando MENU y, a 
continuación, pulse el mando MENU.
Se ha actualizado el File ID.

Cargar datos de configuración

1	 Seleccione Project > All File > Load SD Card 
(página 70) en el menú completo.
Aparece en la pantalla una lista de archivos All.

2	 Seleccione el archivo que desea cargar girando 
el mando MENU y, a continuación, pulse el 
mando MENU.
Aparece una pantalla de confirmación.

3	 Seleccione Execute girando el mando MENU y, 
a continuación, pulse el mando MENU.

[Notas]
ˎˎ Al cargar un archivo desde una tarjeta SD, los datos 

guardados en la memoria interna se sobrescriben.
ˎˎ No cargue un archivo en un dispositivo que sea 

una versión anterior al dispositivo desde el que se 
guardó el archivo, ya que podría provocar un error de 
funcionamiento.
ˎˎ La unidad se reiniciará automáticamente después de 

cargar los datos de configuración.

Si no es posible cargar un archivo

Puede aparecer uno de los siguientes mensajes de 
error durante o después de la operación. En este 
caso, el archivo no está cargado.

Mensaje de 
error

Problema Solución

File Access 
NG

ˎˎ La carga del 
archivo ha 
terminado de 
forma anómala

ˎˎ Los datos 
del archivo 
correspondiente 
en la tarjeta SD 
están corruptos

ˎˎ Intente cargar 
de nuevo

ˎˎ Vuelva a insertar 
la tarjeta SD

ˎˎ Guarde un 
archivo válido 
en la tarjeta SD

[Notas]
ˎˎ Los archivos guardados por una unidad con una AXS-R7 

conectada no se pueden cargar en una unidad que no 
tenga una AXS-R7 conectada.
ˎˎ Los archivos guardados por una unidad con una opción 

de software instalada no se pueden cargar en una 
unidad que no tenga instalada la opción de software 
correspondiente.
ˎˎ Para cargar un archivo guardado por una unidad con la 

versión 3.0 o una versión anterior, primero debe ajustar 
Technical > System Configuration > RM/RCP Paint Control 
(página 83) en Off en el menú completo.

Restaurar todos los ajustes actuales a 
sus valores predeterminados

1	 Seleccione Maintenance > Reset to Default 
(página 88) en el menú completo.
Aparece una pantalla de confirmación.

2	 Seleccione Execute girando el mando MENU y, 
a continuación, pulse el mando MENU.

[Nota]
La unidad se reiniciará automáticamente después de la 
ejecución.
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Archivos de escena
Guardar un archivo de escena en la 
memoria interna

1	 Seleccione Project > Scene File > Store Internal 
Memory (página 71) en el menú completo.
Aparece una pantalla con una lista de los 
archivos de escena.
Si se ajusta File ID en el destino “Standard”, se 
guardan los ajustes estándar preconfigurados.

2	 Seleccione un destino de guardado girando el 
mando MENU y, a continuación, pulse el 
mando MENU.
Se guarda el archivo de escena en el destino 
seleccionado, sobrescribiendo cualquier 
archivo existente.

3	 Seleccione Execute en la pantalla de 
confirmación girando el mando MENU y, a 
continuación, pulse el mando MENU.

Guardar un archivo de escena en una 
tarjeta SD

1	 Seleccione Project > Scene File > Save SD Card 
(página 71) en el menú completo.
Aparece una pantalla para seleccionar un 
destino para guardar un archivo de escena.

2	 Seleccione un destino de guardado girando el 
mando MENU y, a continuación, pulse el 
mando MENU.
Puede guardar archivos en filas con un File ID 
de “No File”.
Al seleccionar una fila con un nombre de File 
ID especificado, se sobrescribirá el archivo 
seleccionado.

El File ID se genera automáticamente, pero 
puede modificarlo.

3	 Seleccione Execute en la pantalla de 
confirmación girando el mando MENU y, a 
continuación, pulse el mando MENU.

Cambiar el File ID

1	 Seleccione Project > Scene File > File ID 
(página 71) en el menú completo.
Aparece una pantalla para editar el File ID.

2	 Seleccione los caracteres e introduzca el File 
ID.

3	 Seleccione Done girando el mando MENU y, a 
continuación, pulse el mando MENU.
Se ha actualizado el File ID.

Cargar un archivo de escena desde la 
memoria interna

1	 Seleccione Project > Scene File > Recall 
Internal Memory (página 71) en el menú 
completo.
Aparece una pantalla con una lista de los 
archivos de escena.

2	 Seleccione el archivo que desea cargar girando 
el mando MENU y, a continuación, pulse el 
mando MENU.
Aparece una pantalla de confirmación.

3	 Seleccione Execute girando el mando MENU y, 
a continuación, pulse el mando MENU.

Cargar un archivo de escena desde 
una tarjeta SD

1	 Seleccione Project > Scene File > Load SD Card 
(página 71) en el menú completo.
Aparece una pantalla con una lista de los 
archivos de escena.

2	 Seleccione el archivo que desea cargar girando 
el mando MENU y, a continuación, pulse el 
mando MENU.
Aparece una pantalla de confirmación.

3	 Seleccione Execute girando el mando MENU y, 
a continuación, pulse el mando MENU.
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Archivos User Gamma
Uso de archivos User Gamma creados 
con RAW Viewer V3.5 o posterior

Puede utilizar archivos User Gamma creados con 
RAW Viewer V3.5 o posterior.
Guarde los archivos creados en el siguiente 
directorio de una tarjeta SD.
PRIVATE\SONY\PRO\CAMERA\MPC3610
Para obtener información sobre RAW Viewer V3.5 o 
posterior, póngase en contacto con su distribuidor 
Sony o con un representante del servicio técnico 
de Sony.

Para realizar operaciones de carga, comprobación, 
restablecimiento o de otro tipo en archivos 
gamma del usuario, ajuste Technical > System 
Configuration > RM/RCP Paint Control 
(página 83) en On en el menú completo para 
habilitar las funciones de pintura.

Cargar un archivo User Gamma desde 
una tarjeta SD

1	 Seleccione Project > User Gamma > Load SD 
Card (página 71) en el menú completo.
Aparece en la pantalla una lista con los 
archivos de gamma del usuario.
Puede seleccionar hasta cinco archivos en la 
pantalla de la lista de archivos de gamma del 
usuario.

	 [Nota]
Las cinco operaciones de carga se realizan 
conjuntamente. Los archivos no se pueden seleccionar y 
cargar individualmente.

2	 Pulse el mando MENU.
Aparece una pantalla de confirmación.

3	 Seleccione Execute girando el mando MENU y, 
a continuación, pulse el mando MENU.
Los cinco archivos se cargan en la memoria 
interna.

Comprobación de los archivos User 
Gamma almacenados actualmente 
en la memoria interna

Seleccione Project > User Gamma > Current 
Settings (página 71) en el menú completo para 
mostrar una lista de los archivos de gamma de 
usuario almacenados actualmente en la memoria 
interna.

[Nota]
Antes de cargar los archivos de gamma del usuario desde 
una tarjeta SD, se muestra “709(800%)” debajo de “Name” 
cuando se ajusta Project > Basic Setting > Input Color 
Space (página 68) en Rec.709/User Gamma en el menú 
completo. “HLG(Natural)” se muestra para ajustes distintos de 
Rec.709/User Gamma.

Ajuste de los archivos User Gamma 
almacenados en la memoria interna

1	 Ajuste Project > Basic Setting > Input Color 
Space (página 68) en Rec.2020/User Gamma 
o Rec.709/User Gamma en el menú completo.

	 [Nota]
Rec.2020/User Gamma y Rec.709/User Gamma pueden 
seleccionarse solo cuando se ajusta Technical > System 
Configuration > RM/RCP Paint Control (página 83) en 
On en el menú completo.

2	 Seleccione una opción de User 1 a User 5 en 
Paint > Gamma > Gamma Select (página 81) 
en el menú completo.

	 [Nota]
Las opciones de User 1 a User 5 en Gamma Select 
corresponden a los números 1 a 5 en la pantalla de la 
lista de archivos de gamma del usuario.

Restauración de los archivos User 
Gamma almacenados en la memoria 
interna al estado predeterminado

1	 Seleccione Project > User Gamma > Reset 
(página 71) en el menú completo.
Aparece una pantalla de selección para 
restablecer el número de archivo de gamma.

2	 Gire el mando MENU para seleccionar el 
número del archivo de gamma que desea 
restablecer (del 1 al 5).
Para restablecer todos los archivos de gamma, 
seleccione All.
Aparece una pantalla de confirmación.

3	 Seleccione Execute girando el mando MENU y, 
a continuación, pulse el mando MENU.
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Conexión de una unidad de control remoto
Al conectar una unidad de control remoto 
RM-B170, un panel de control remoto RCP-
1001/1501/3501 u otra unidad de control, algunas 
funciones pueden controlarse desde dicho 
dispositivo.

Conexión de una unidad de control 
remoto

Conecte el conector de la cámara de la unidad de 
control al conector REMOTE (8 terminales) de la 
unidad usando un cable de control remoto.
Cuando encienda la unidad después de realizar la 
conexión, la unidad entrará en modo de control 
remoto, lo que permite operaciones de menú y de 
filmación.

[Notas]
ˎˎ No conecte ni desconecte la unidad de control remoto 

cuando esté encendida.
ˎˎ No se suministra cable de control remoto con el panel de 

control remoto RCP-1001/1501/3501.

Desbloqueo del modo de control 
remoto

Apague la unidad y desconecte la unidad de 
control remoto.

Ajuste de la función de pintura

Para habilitar la función de pintura, Technical > 
System Configuration > RM/RCP Paint Control 
(página 83) debe estar ajustado en On en el 
menú completo.
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Principales funciones que se pueden controlar con RCP-1001/1501/3501 o RM-B170/B750

Leyenda de la tabla
A continuación, se indica la compatibilidad de controles remotos en la pantalla.
Sí: control compatible
–: control no compatible

Elemento Elemento secundario Elemento secundario Opción de selección RCP-1001 RCP-1501/3501 RM-B170 RM-B750
Shooting FPS Fixed/Variable Select On/Off – Sí Sí 1) Sí

FPS Select 1FPS a 120FPS – Sí Sí 1) Sí
Shutter Select 2) Shutter ON/OFF On/Off – Sí Sí Sí

ECS ON/OFF On/Off – Sí Sí Sí
Shutter Speed Valores registrados para Step.

Los siguientes valores pueden mostrarse.
1/32
1/33
1/48
1/50
1/60
1/96
1/100
1/120
1/125
1/250
1/500
1/1000
1/2000
1/3000
1/4000
1/5000

– Sí Sí Sí

ECS Frequency – – Sí Sí Sí
ND ND Position 1: (CLEAR)

2: (densidad 0.3)
3: (densidad 0.6)
4: (densidad 0.9)
5: (densidad 1.2)
6: (densidad 1.5)
7: (densidad 1.8)
8: (densidad 2.1)
9: (densidad 2.4)

Sí Sí Sí Sí

Gain 2) Gain(Step) –6dB/–3dB/0dB/3dB/6dB/9dB/12dB/15dB/18dB Sí Sí Sí Sí
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Elemento Elemento secundario Elemento secundario Opción de selección RCP-1001 RCP-1501/3501 RM-B170 RM-B750
White Balance 2) Color Temp 2000K a 15000K 3) – Sí – Sí

Color Temp Balance (equivalente a Tint) –99 a ±0 a +99 4) – Sí – Sí
R Gain –99 a ±0 a +99 Sí Sí Sí Sí
B Gain –99 a ±0 a +99 Sí Sí Sí Sí
Auto White Balance – Sí Sí Sí Sí

Project Scene File 2) 5) – – – Sí – Sí
Standard 6) – – Sí Sí – Sí

Paint 2) Switch Status Gamma On/Off – Sí Sí 1) Sí
Black Gamma 7) On/Off – Sí Sí 1) Sí
Matrix On/Off – Sí – Sí
Knee 7) On/Off – Sí Sí 1) Sí
White Clip 7) On/Off – Sí – Sí
Detail On/Off – Sí – Sí
Flare On/Off – Sí Sí 1) Sí
Test Saw 8) On/Off – Sí Sí 1) Sí

Black Master Black –99 a ±0 a +99 Sí Sí Sí Sí
R Black –99 a ±0 a +99 Sí Sí Sí Sí
B Black –99 a ±0 a +99 Sí Sí Sí Sí

Flare Setting On/Off – Sí Sí 1) Sí
Master Flare –99 a ±0 a +99 – Sí Sí 1) –
R Flare –99 a ±0 a +99 – Sí – Sí
G Flare –99 a ±0 a +99 – Sí – Sí
B Flare –99 a ±0 a +99 – Sí – Sí

Gamma Setting On/Off – Sí Sí 1) Sí
Gamma Category (solo visualización) 9) User – Sí – Sí
Gamma Select User 1/User 2/User 3/User 4/User 5 – Sí – Sí

Black Gamma 7) Setting On/Off – Sí Sí 1) Sí
Range Low/L.Mid/H.Mid – Sí – Sí
Master Black Gamma –99 a ±0 a +99 – Sí Sí 1) Sí

Knee 7) 10) Setting On/Off Sí Sí Sí Sí
Point –99 a ±0 a +99 Sí Sí Sí Sí
Slope –99 a ±0 a +99 Sí Sí – Sí

White Clip 7) Setting On/Off – Sí – Sí
Level –99 a ±0 a +99 – Sí – Sí
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Elemento Elemento secundario Elemento secundario Opción de selección RCP-1001 RCP-1501/3501 RM-B170 RM-B750
Detail Setting On/Off – Sí – Sí

Level –99 a ±0 a +99 – Sí – Sí
H/V Ratio –99 a ±0 a +99 – Sí – Sí
Crispening –99 a ±0 a +99 – Sí – Sí
Level Depend On/Off – Sí – Sí
Level Depend Level –99 a ±0 a +99 – Sí – Sí
Frequency –99 a ±0 a +99 – Sí – Sí
Knee Aperture On/Off – Sí – Sí
Knee Aperture Level –99 a ±0 a +99 – Sí – Sí
Limit –99 a ±0 a +99 – Sí – Sí
White Limit –99 a ±0 a +99 – Sí – Sí
Black Limit –99 a ±0 a +99 – Sí – Sí

Matrix Setting On/Off – Sí – Sí
User Matrix On/Off – Sí – Sí
User Matrix R-G –99 a ±0 a +99 – Sí – Sí
User Matrix R-B –99 a ±0 a +99 – Sí – Sí
User Matrix G-R –99 a ±0 a +99 – Sí – Sí
User Matrix G-B –99 a ±0 a +99 – Sí – Sí
User Matrix B-R –99 a ±0 a +99 – Sí – Sí
User Matrix B-G –99 a ±0 a +99 – Sí – Sí

Multi Matrix Setting On/Off – Sí – Sí
Area Indication On/Off – Sí – Sí
Reset Execute/Cancel – Sí – Sí
Axis B/B+/MG–/MG/MG+/R/R+/YL–/YL/YL+/G–/G/G+/CY/CY+/B– – Sí – Sí
Hue –99 a ±0 a +99 – Sí – Sí
Saturation –99 a ±0 a +99 – Sí – Sí

Technical Test Signals Color Bars On/Off On/Off Sí Sí Sí Sí
Test Saw 8) On/Off – Sí Sí 1) Sí

Rec – – – – – Sí Sí
Play – – – – – Sí Sí
Stop – – – – – Sí Sí
F.Rev – – – – – Sí Sí
F.Fwd – – – – – Sí Sí
Rec Review – – – – – Sí Sí
Next – – – – – Sí –
Prev. – – – – – Sí –
White Mode 2) Preset ON/OFF – On/Off – – Sí Sí
Iris Iris Level – (Rango de control de objetivo de destino) Sí Sí Sí Sí

Close – On/Off Sí Sí – Sí
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Elemento Elemento secundario Elemento secundario Opción de selección RCP-1001 RCP-1501/3501 RM-B170 RM-B750
Zoom 11) Remote – On/Off – Sí 1) Sí 1) –

Speed – – – – – –
Tele to Wide – – – Sí 1) Sí 1) –
Zoom Value[%] – – – Sí 1) Sí 1) –
Focal Length[mm] – – – Sí 1) Sí 1) –

Focus 11) Remote – On/Off – Sí 1) Sí 1) –
Focus Position – – – Sí 1) Sí 1) –
Focus Value[%] – – – Sí 1) Sí 1) –
Focus Length[m] – – – Sí 1) Sí 1) –

Call – – – Sí Sí Sí Sí
1)	 Controlable cuando se asigna al bloque de operaciones del controlador.
2)	 Controlable solo cuando se ajusta Technical > System Configuration > RM/RCP Paint Control (página 83) en On en el menú completo.
3)	 Puesto que Color Temp se recorta a 2000K y 15000K durante el funcionamiento de R/B Gain, puede que no sea posible mostrar el valor correcto de Color Temp para el valor R/B Gain.
4)	 Puesto que Color Temp Balance se recorta a ±99, puede que no se muestre el valor correcto de Color Temp Balance para el valor R/B Gain.
5)	 Los archivos de escena 1 a 5 se pueden seleccionar o deseleccionar solo después de que se hayan cargado en la unidad.
6)	 Le permite restaurar los ajustes de la unidad al estado estándar desde el controlador sin que se haya cargado ningún archivo de escena.
7)	 Configurable solo cuando Project > Basic Setting > Input Color Space (página 68) está ajustado en HLG(Natural), HLG(Live), Rec.2020/User Gamma o Rec.709/User Gamma en el menú completo.
8)	 La señal de prueba no se puede encender/apagar durante la ejecución del equilibrio del blanco automático.
9)	 Puede que no se muestre en función del modelo y la versión del controlador.
10)	 La función de inflexión normal de la unidad controla la inflexión de alta luminancia equivalente a HDR Knee.
11)	 Las instrucciones del controlador de zoom y enfoque desde una unidad de control remoto están desactivadas cuando se instala un objetivo con soporte E.
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Conexión de dispositivos de grabación y monitores externos
Para mostrar imágenes que se estén grabando/
reproduciendo en un monitor externo, seleccione 
la señal de salida y utilice un cable adecuado para 
el monitor que vaya a conectar.
La señal de salida de la unidad puede grabarse si 
conecta un dispositivo de grabación, como por 
ejemplo un grabador de vídeo.
La información de estado y los menús pueden 
verse exactamente igual en el monitor externo 
que en la pantalla del visor. Configure el contenido 
que desea mostrar, en función de la señal de 
salida para el monitor, con el menú Monitoring 
(página 73).

[Nota]
Cuando FPS está ajustado en Variable, el desplazamiento 
horizontal de la imagen puede producirse solo con una 
salida de 4K. Este fenómeno es evidente en velocidades de 
fotogramas más rápidas (FPS). Sin embargo, no afecta a la 
imagen grabada y la imagen se reproduce correctamente.

Conector SDI OUT (tipo BNC)

Configure el formato de salida con el menú 
Monitoring (página 73).
Utilice un cable coaxial de 75 ohmios de venta 
comercial para la conexión.

[Nota]
Compruebe que la conexión a tierra entre la unidad y 
el dispositivo externo es segura antes de conectar la 
alimentación. (Le recomendamos que encienda la unidad y 
el dispositivo externo después de conectar un cable coaxial 
de 75 ohmios).
Si conecta un dispositivo externo a la unidad mientras está 
encendida, conéctelo a la unidad después de conectar un 
cable coaxial de 75 ohmios al dispositivo externo.

Para iniciar la grabación sincronizada en un 
dispositivo externo

Al seleccionar la salida de la señal SDI, es posible 
realizar grabaciones sincronizadas enviando 
una señal de activación REC a un dispositivo de 
grabación externo conectado al conector SDI 

OUT. Para permitir la grabación sincronizada, vaya 
al menú Technical > System Configuration > SDI 
Rec Remote Trigger (página 83) y configure la 
opción HD SDI Remote I/F o Parallel Rec.

[Nota]
Si un dispositivo externo conectado no es compatible 
con una señal de activación REC, el dispositivo no podrá 
utilizarse.

Conector MONITOR OUT (tipo BNC)

Envía una señal HD SDI.
Configure el formato de salida con el menú 
Monitoring (página 73).
Utilice un cable coaxial de 75 ohmios de venta 
comercial para la conexión.

[Nota]
El audio y el código de tiempo no se superponen en esta 
salida.

Conector HDMI OUT (conector tipo A)

Configure el formato de salida con el menú 
Monitoring (página 73).
Utilice un cable HDMI de venta comercial para las 
conexiones.
Si el formato de salida tiene la misma resolución 
que la señal del conector MONITOR OUT, se emitirá 
la misma señal de audio.

Conector 12V OUT (salida de 12V de 
CC, Hirose, 4 terminales)

Suministra alimentación de 12 V de CC a un 
accesorio cuando el interruptor de alimentación 
está ajustado en ON. Se puede emitir una señal 
REC Tally y recibir una señal REC Trigger a través del 
conector 12V OUT.

N.º Señal I/O Especificación
1 UNREG GND – GND para UNREG
2 REC TALLY OUT Salida del colector 

abierto
(máx. 50 mA)
Bajo: REC

3 REC TRIGGER IN Abierto o +5 V CC: 
normal
GND: activo (REC)

4 UNREG +12 V 
OUT

OUT Salida de +11 V a 17 V 
CC
Entrada de 11 V a 
17 V
Tensión de salida: la 
misma que la tensión 
de entrada
Corriente de salida 
máxima: 1,0 A
Entrada de 22 V a 
32 V
Tensión de salida: 
15 V
Corriente de salida 
máxima: 0,8 A

Conector 24V OUT (salida de 24 V de 
CC, Fischer, 3 terminales)

Suministra alimentación de 24 V de CC a un 
accesorio cuando el interruptor de alimentación 
está ajustado en ON. Se puede recibir una señal 
REC Trigger a través del conector 24V OUT.

N.º Señal Especificación
1 GND
2 24V-AUX Entrada de 11 V a 17 V

Tensión de salida: 24 V
Corriente de salida máxima: 
1,0 A
Entrada de 22 V a 32 V
Tensión de salida: la misma 
que la tensión de entrada
Corriente de salida máxima: 
2,0 A

3 REC TRIGGER Abierto o +5 V CC: normal
GND: activo (REC)
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Conector AUX (LEMO, 5 terminales)

Emite la señal del código de tiempo.

N.º Señal
1 Factory Use
2 NC
3 –
4 TC OUT
5 GND
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Sincronización externa
Cuando se filma con varias unidades, es posible 
realizar una grabación sincronizada mediante una 
señal de referencia específica que sincroniza el 
código de tiempo en todas las unidades.

Sincronización de la fase de la señal 
de vídeo (Genlock)

La operación Genlock se habilita enviando una 
de las siguientes señales de referencia al conector 
GENLOCK IN (página 11) de la unidad.
ˎˎ HDSDI 1.5G digital (entrelazada o PsF)
ˎˎ HD Y analógica
ˎˎ SD VBS analógica

Configure la señal de entrada Genlock en el menú 
completo con Technical > Genlock > Input Source 
(página 87).
También puede comprobar el estado de la 
función Genlock mediante Technical > Genlock 
> Reference Lock Type (página 87) en el menú 
completo, en la pantalla Home de la visualización 
secundaria (página 32) y en el indicador de 
estado de Genlock (página 13).
Las señales de referencia de entrada válidas varían 
en función del ajuste de velocidad de fotograma 
del proyecto.

Velocidad de 
fotogramas 
del proyecto

Señal de referencia válida
Analógica Digital

23.98/47.95 1920×1080 
47.95i (23.98PsF)

1920×1080 
47.95i (23.98PsF)

24 1920×1080 48i 
(24PsF)

1920×1080 48i 
(24PsF)

25/50 1920×1080 50i 
(25PsF)
720×576 50i

1920×1080 50i 
(25PsF)

29.97/59.94 1920×1080 60i 
(29.97PsF)
720×486 59.94i

1920×1080 60i 
(29.97PsF)

Para comprobar el estado de la función Genlock, 
vaya al menú y utilice Technical > Genlock > 
Reference Lock Type (página 87).

[Notas]
ˎˎ Si la señal de referencia es inestable, no podrá utilizarse la 

función Genlock.
ˎˎ La portadora secundaria no se sincroniza.

Sincronización del código de tiempo 
con otro dispositivo

Ajuste la unidad que emite el código de tiempo en 
un modo en el que la salida del código de tiempo 
siga avanzando (Modo Free Run).

1	 En el menú TC/Media > Timecode > Mode 
(página 71), indique la opción Preset F-Run 
(Ext-Lk).

2	 Envíe una señal de vídeo de referencia HD o 
SD al conector GENLOCK IN (página 11) y el 
código de tiempo de referencia sincronizado 
con dicha señal al conector TC IN 
(página 11).

El generador de código de tiempo integrado de su 
unidad queda bloqueado en el código de tiempo 
de referencia y el mensaje “Ext-Lk” aparece en la 
pantalla Home de la visualización secundaria.
Diez segundos después de que se bloquee el 
código de tiempo, el estado de bloqueo externo 
continúa aunque se desconecte la fuente externa 
del código de tiempo.

[Notas]
ˎˎ Compruebe que el código de tiempo de referencia y 

la señal de vídeo de referencia se encuentran en una 
relación de fase que cumple con los estándares de código 
de tiempo SMPTE.
ˎˎ Una vez finalizado el procedimiento anterior, el código 

de tiempo se sincroniza inmediatamente con el código 
de tiempo externo, y la indicación de datos de tiempo 
mostrará el valor del código de tiempo externo. Sin 
embargo, espere unos segundos hasta que el generador 
de código de tiempo se estabilice antes de grabar.
ˎˎ Si la frecuencia de la señal de vídeo de referencia y 

la frecuencia de fotogramas no son las mismas, no 
se producirá un bloqueo y la unidad no funcionará 
correctamente. En ese caso, el código de tiempo no 
se bloqueará correctamente con el código de tiempo 
externo.
ˎˎ Cuando se elimine la conexión, el avance del código de 

tiempo puede variar un fotograma a la hora con respecto 
al código de tiempo de referencia.

Para cancelar el bloqueo externo

Cambie el ajuste TC/Media > Timecode > Mode 
(página 71) en el menú.
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Precauciones de uso
Lea esta sección junto con la información 
proporcionada en el documento “Antes de utilizar 
esta unidad”.

Utilización y almacenamiento

No someta la unidad a golpes fuertes

El mecanismo interno se puede dañar y el cuerpo 
de la cámara se puede deformar.

No cubra la unidad durante el funcionamiento

Por ejemplo, si se coloca una tela sobre la unidad 
puede acumularse un calor excesivo en el interior.

Después de su uso

Coloque el interruptor de alimentación en OFF.

Antes de guardar la videocámara durante un 
período prolongado

Extraiga la batería.

No deje la unidad con el objetivo apuntando al sol

La luz solar directa puede entrar a través del 
objetivo, concentrarse en la unidad y producir un 
incendio.

Transporte

ˎˎ Extraiga las tarjetas de memoria antes de 
transportar la unidad.
ˎˎ Si se envía la unidad por carretera, mar, aire 
u otro servicio de transporte, hágalo en el 
embalaje original de la unidad.

Mantenimiento de la unidad

Si la carcasa de la unidad está sucia, límpiela con 
un paño suave y seco. En casos extremos, utilice 
un paño humedecido con un detergente neutro y, 
a continuación, séquela.
No utilice disolventes orgánicos, como alcohol 
o diluyente, puesto que pueden producir 
decoloración u otros daños en el acabado de la 
unidad.
Evite limpiarla con un equipo de aire a alta presión, 
por ejemplo, una aspiradora de polvo, ya que 
podría dañar los componentes ópticos.

En caso de problemas de funcionamiento

Si experimenta problemas con la unidad, póngase 
en contacto con su distribuidor Sony.

Sustitución periódica del ventilador y 
la batería

El ventilador y la batería son consumibles que 
deben sustituirse periódicamente.
Si utiliza la unidad a temperatura ambiente, 
el ciclo de sustitución normal será de 5 años 
aproximadamente. Sin embargo, esto representa 
solo una directriz general y no constituye 
ninguna garantía de su vida útil. Para obtener 
más información acerca de la sustitución de 
componentes, póngase en contacto con el 
distribuidor.

Vida útil del condensador electrolítico

La vida útil del condensador electrolítico 
es de unos 5 años con las temperaturas de 

funcionamiento habituales y un uso normal 
(8 horas al día, 25 días al mes).
Si el uso supera la frecuencia normal indicada, es 
posible que la vida útil se vea reducida.

Nota acerca del terminal de la batería

La terminal de la batería de esta unidad (el 
conector para paquetes de pilas y adaptadores de 
CA) es una parte consumible.
Puede que la unidad no funcione correctamente 
si los contactos de las pilas están doblados o 
deformados debido a algún golpe o a vibraciones 
o si se han corroído debido a un uso prolongado 
en el exterior.
Se recomienda realizar inspecciones periódicas 
para que la unidad continúe funcionando 
correctamente y para prolongar su vida útil. 
Contacte con el servicio de asistencia técnica de 
Sony o con el responsable de ventas para obtener 
más información sobre las inspecciones.

Ubicaciones de uso y 
almacenamiento

Guárdela en un lugar estable y ventilado.
Evite utilizar o almacenar la unidad en los siguientes 
lugares:
ˎˎ Bajo calor o frío excesivo (límites de temperatura 
de funcionamiento: de 0 °C a 40 °C)  
Recuerde que en verano, en climas cálidos, 
la temperatura en el interior de un automóvil 
con las ventanillas cerradas puede superar 
fácilmente los 50 °C.
ˎˎ En lugares húmedos o polvorientos
ˎˎ Lugares donde la unidad pueda estar expuesta 
a la lluvia
ˎˎ Lugares sujetos a vibraciones violentas

ˎˎ Cerca de campos magnéticos potentes
ˎˎ Cerca de emisoras de radio o TV que generen 
campos electromagnéticos intensos.
ˎˎ En directa exposición al sol o cerca de fuentes 
de calor durante tiempo prolongado

Para evitar interferencias electromagnéticas de 
dispositivos de comunicación portátiles

El uso de teléfonos y otros dispositivos de 
comunicación portátiles cerca de esta unidad 
puede producir un funcionamiento incorrecto e 
interferencias con las señales de audio y vídeo.
Se recomienda desconectar los dispositivos de 
comunicaciones móviles cuando se encuentren 
cerca de esta unidad.

Nota sobre los rayos láser

Los rayos láser pueden dañar el sensor de imagen 
CMOS. Si filma una escena que incluya un rayo 
láser, evite que este se dirija directamente al 
objetivo de la unidad. Específicamente, los 
rayos láser de alta potencia procedentes de los 
dispositivos médicos o de otros dispositivos 
podrían causar daños debido a los efectos de la luz 
reflejada y la luz dispersa.

Acerca de las pantallas

ˎˎ No deje las pantallas expuestas a la luz solar 
directa, ya que de esta forma podría dañar las 
pantallas.
ˎˎ No empuje ni mueva las pantallas por la fuerza, 
ni coloque objetos sobre ellas, ya que podría 
provocar un fallo de funcionamiento como por 
ejemplo irregularidades en la imagen, etc.
ˎˎ Las pantallas podrían calentarse durante 
su uso. Este fenómeno no es un fallo de 
funcionamiento.
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Paneles LCD

El panel LCD de esta unidad ha sido fabricado con 
tecnología de alta precisión y ofrece un índice de 
píxeles funcionales de al menos el 99,99%. Por ello, 
es posible que quede una pequeña proporción 
de píxeles “atascados”, o bien siempre apagados 
(negro), siempre encendidos (rojo, verde o azul), 
o parpadeando. Además, a lo largo de un amplio 
periodo de tiempo, esos píxeles “atascados” 
pueden ir apareciendo espontáneamente debido 
a las características de la pantalla de cristal líquido.
Esto no significa que la unidad funcione mal.
Tenga en cuenta que dichos problemas no 
producen efectos en los datos grabados.

Paneles OLED

La pantalla OLED de esta unidad ha sido fabricada 
con tecnología de alta precisión y ofrece un 
índice de píxeles funcionales de al menos el 
99,99%. Por ello, es posible que quede una 
pequeña proporción de píxeles “atascados”, o bien 
siempre apagados (negro), siempre encendidos, 
o parpadeando. Además, a lo largo de un amplio 
periodo de tiempo, esos píxeles “atascados” 
pueden ir apareciendo espontáneamente debido 
a las características del diodo emisor de luz 
orgánico. Esto no significa que la unidad funcione 
mal. Tenga en cuenta que dichos problemas no 
producen efectos en los datos grabados.
Debido a las características del material utilizado 
en la pantalla OLED, es posible que se produzca 
una pérdida de brillo y un efecto quemado 
permanentes.
Esto no significa que la unidad funcione mal.

Acerca de la condensación

Si la unidad se lleva de repente de un lugar frío a 
uno cálido o si la temperatura ambiente sufre un 
aumento repentino, es posible que se acumule 
humedad en la superficie exterior o interior 
de la unidad. Este fenómeno se conoce como 
condensación. Si se produce condensación, 
apague la unidad y espere a que se evapore antes 
de ponerla en marcha. No la utilice en ese estado, 
ya que podría dañarla.

Fenómenos específicos de los 
sensores de imagen CMOS

Los siguientes fenómenos que aparecen en las 
imágenes son específicos de los sensores de 
imagen CMOS (semiconductor de metal óxido 
complementario). No indican anomalías.

Motas blancas

Aunque los sensores de imagen CMOS se realizan 
con tecnologías de alta precisión, se pueden 
generar pequeñas motas blancas en la pantalla 
en casos excepcionales, causadas por los rayos 
cósmicos, etc. Esto está relacionado con el 
principio de los sensores de imagen CMOS y no se 
trata de un error de funcionamiento.
Las motas blancas tienden a verse sobre todo en 
los casos siguientes.
ˎˎ Cuando se trabaja a temperaturas ambiente 
elevadas

Efecto moaré

Cuando se graban patrones finos, rayas o 
líneas, estos pueden aparecer distorsionados o 
parpadeando.

Plano focal

Debido a las características de los elementos 
captadores (sensores CMOS) para leer las señales 
de vídeo, los sujetos que se mueven con rapidez 
por la pantalla pueden aparecer ligeramente 
inclinados.

Banda de flash

La luminancia de la parte superior e inferior de la 
pantalla puede cambiar al filmar un flash o una 
fuente de luz que parpadea rápidamente.

Parpadeo

Si se realiza la grabación con iluminación 
producida por tubos de descarga, como los focos 
de vapor de mercurio, los fluorescentes o los de 
sodio, es posible que la pantalla parpadee, que 
los colores varíen o que las rayas horizontales 
aparezcan distorsionadas.
El parpadeo se puede reducir con la función 
de reducción del parpadeo de la unidad 
(página 67).

Nota sobre la pantalla

ˎˎ La imagen de la pantalla del visor puede 
verse distorsionada al realizar las siguientes 
operaciones:

–– Cambiar el formato de vídeo
ˎˎ Cuando se cambia la línea de visión en el visor, 
es posible que se vean los colores primarios rojo, 
verde y azul, pero no se trata de un defecto de la 
unidad. Estos colores primarios no se graban en 
ningún medio de grabación.

Fragmentación

Si las imágenes no se pueden grabar/reproducir 
correctamente, intente formatear el soporte 
de grabación. Cuando se repite la grabación/
reproducción de una imagen con un soporte 
de grabación específico durante un periodo 
prolongado, es posible que los archivos 
del soporte se fragmenten, y no se realice 
correctamente la grabación/el almacenamiento. 
En ese caso, realice una copia de seguridad de los 
clips del soporte y formatee el soporte desde el 
menú TC/Media > Format Media (página 72).
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Tensiones de salida de la unidad

La potencia de salida total que puede 
suministrarse a los dispositivos periféricos desde 
la unidad varía según la tensión de entrada a la 
unidad y el estado de los accesorios conectados. 
En función de las condiciones, es posible que 
no se alcance la capacidad nominal de salida 
máxima de los siguientes conectores que pueden 
suministrar alimentación.

Conector LENS: máx. 1 A
Conector de 12V OUT (4 terminales):

máx. 0,8 A (tensión de entrada: de 22 V a 
32 V)
máx. 1 A (tensión de entrada: de 11 V a 17 V)

Conector de 24V OUT (3 terminales):
máx. 2 A (tensión de entrada: de 22 V a 32 V)
máx. 1 A (tensión de entrada: de 11 V a 17 V)

La entrega de potencia nominal disponible para 
los accesorios (AXS-R7, DVF-EL200 y CBK-3610XS) y 
dispositivos periféricos es limitada en función de la 
tensión de entrada de la unidad.

Tensión del suministro de alimentación a la 
unidad: X [V]
Potencia nominal total de los dispositivos 
periféricos: Y [W]
Consumo de energía de la unidad: aprox. 60 W
	Consumo de energía de la AXS-R7: aprox. 

24 W
	Consumo de energía de DVF-EL200: aprox. 

2,5 W
	Consumo de energía de CBK-3610XS: aprox. 

3,9 W

Y [W] = X [V] × 9,0 [A]1) – (60 +  +  + )2) [W]

Cuando se suministra alimentación a los 
accesorios y dispositivos periféricos anteriores, 
asegúrese de que el valor Y dado por la ecuación 
anterior no es negativo.
(Tenga en cuenta que la ecuación no es aplicable 
si el resultado calculado Y excede la suma de la 

potencia de salida máxima permitida de cada 
conector de salida de potencia.)
1)	 6,0 [A] al usar el AC-DN10A.
2)	 Cuando utilice una AC-DN10A, no utilice las unidades  

y  al mismo tiempo. En función del entorno de uso, 
puede que se supere el valor nominal de la fuente de 
alimentación.

Nota sobre seguridad

ˎˎ SONY NO SE HACE RESPONSABLE POR DAÑOS 
DE NINGÚN TIPO DEBIDOS A LA OMISIÓN DE 
LAS MEDIDAS DE SEGURIDAD ADECUADAS 
EN DISPOSITIVOS DE TRANSMISIÓN, FUGAS 
DE DATOS INEVITABLES DERIVADAS DE LAS 
ESPECIFICACIONES DE TRANSMISIÓN O 
PROBLEMAS DE SEGURIDAD DE CUALQUIER 
TIPO.
ˎˎ En función del entorno operativo, es posible 
que terceros no autorizados en la red puedan 
acceder a la unidad. Al conectar la unidad 
a la red, confirme siempre que la red está 
correctamente protegida.
ˎˎ Desde el punto de vista de la seguridad, 
al utilizar la unidad conectada a la red, se 
recomienda encarecidamente acceder a la 
ventana de control a través de un navegador 
web y modificar la limitación de acceso 
de los valores predeterminados de fábrica 
(página 84).  
Asimismo, se recomienda cambiar la contraseña 
periódicamente.
ˎˎ No visite otros sitios web con el navegador web 
mientras ajuste la configuración o justo después. 
El navegador web recuerda los ajustes de inicio 
de sesión, por lo que debe cerrarlo al completar 
la configuración para evitar que terceros 
no autorizados utilicen la unidad o evitar la 
instalación de programas maliciosos.
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Grabación de formatos y señales de salida
Formatos de salida del conector SDI OUT

La señal digital en serie desde un conector SDI OUT se envía dependiendo de la categoría Project y de los ajustes de la categoría Monitoring del menú.
Para obtener más información acerca de las combinaciones de los ajustes de la categoría Project, consulte “Ajuste del formato de grabación” (página 54).
Puede establecer el formato de la salida 3G SDI en Level A o Level B mediante Technical > System Configuration > 3G SDI 1/2/3/4 Output (página 83) en el menú completo.

Los valores predeterminados aparecen en negrita subrayados.

Project Monitoring > Output Format Formato de salida
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
59.94/50 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
4K 4:3/ 
4K 17:9/ 
4K 2.39:1 1)

XAVC-I 4K Class300/
Rec Off

4096×2160P 12G – 4096×2160P YPbPr 12G 4096×2160P YPbPr 12G Sin salida Sin salida
4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 3G
4096×2160P 2SI 4096×2160P 2SI 4096×2160P YPbPr 3G

2048×1080P 
1920×1080P 

2048×1080P YPbPr 3G 2048×1080P YPbPr 3G
1920×1080P YPbPr 3G 1920×1080P YPbPr 3G 

1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

1920×1080P 
1920×1080P 

1920×1080P YPbPr 3G 1920×1080P YPbPr 3G
1920×1080P YPbPr 3G 1920×1080P YPbPr 3G 

1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G
1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

5.7K 16:9/ 
3.8K 16:9

XAVC-I QFHD Class300/
Rec Off

3840×2160P 12G – 3840×2160P YPbPr 12G 3840×2160P YPbPr 12G Sin salida Sin salida
3840×2160P Square 3840×2160P Square 3840×2160P YPbPr 3G
3840×2160P 2SI 3840×2160P 2SI 3840×2160P YPbPr 3G

1920×1080P 
1920×1080P 

1920×1080P YPbPr 3G 1920×1080P YPbPr 3G
1920×1080P YPbPr 3G 1920×1080P YPbPr 3G 

1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G
1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9/ 
3.8K 16:9

ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P 
1920×1080P 

1920×1080P YPbPr 3G 1920×1080P YPbPr 3G
1920×1080P YPbPr 3G 1920×1080P YPbPr 3G 

1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

MPEG 1920×1080i/
ProRes 422 HQ HD i/ 
ProRes 422 HD i/ 
ProRes 422 Proxy HD i 

1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G
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Project Monitoring > Output Format Formato de salida
Project Frame Rate Imager Mode AXS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
47.95 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9/ 
4K 2.39:1

RAW SQ/ 
X-OCN XT/ 
X-OCN ST/ 
X-OCN LT/ 
Rec Off

4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 3G 

4096×2160P 2SI 4096×2160P 2SI 4096×2160P YPbPr 3G 

2048×1080P 1920×1080P 2048×1080P YPbPr 3G 1920×1080P YPbPr 1.5G

1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P YPbPr 1.5G

Project Monitoring > Output Format Formato de salida
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
29.97/25 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9 2)/ 
4K 6:5/ 
4K 4:3/ 
4K 17:9/ 
4K 2.39:1 1)

XAVC-I 4K Class480/
XAVC-I 4K Class300/ 
Rec Off

4096×2160P 6G – 4096×2160P YPbPr 6G 4096×2160P YPbPr 6G Sin salida Sin salida
4096×2160P 2SI – 4096×2160P YPbPr 3G Sin salida Sin salida
4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 1.5G

2048×1080PsF
1920×1080P

2048×1080PsF 
YPbPr 1.5G

2048×1080PsF 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
5.7K 16:9 3)/ 
3.8K 16:9

XAVC-I QFHD Class480/
XAVC-I QFHD Class300/
Rec Off

3840×2160P 6G – 3840×2160P YPbPr 6G 3840×2160P YPbPr 6G Sin salida Sin salida

3840×2160P 2SI – 3840×2160P YPbPr 3G Sin salida Sin salida

3840×2160P Square 3840×2160P Square 3840×2160P YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 6:5/ 
4K 4:3/ 
4K 17:9/ 
3.8K 16:9

MPEG 1920×1080P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
ProRes 4444 HD P 4)

1920×1080P RGB 

1920×1080P

1920×1080P RGB 3G 1920×1080P RGB 3G 

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
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Project Monitoring > Output Format Formato de salida
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
24 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
4K 6:5/ 
4K 4:3/ 
4K 17:9/ 
4K 2.39:1 1)

XAVC-I 4K Class480/
XAVC-I 4K Class300/ 
Rec Off

4096×2160P 6G – 4096×2160P YPbPr 6G 4096×2160P YPbPr 6G Sin salida Sin salida
4096×2160P 2SI – 4096×2160P YPbPr 3G Sin salida Sin salida
4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 1.5G

2048×1080P 1920×1080P
2048×1080PsF 

YPbPr 1.5G
2048×1080PsF 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P
1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G 1920×1080P 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 6:5/ 
4K 4:3/ 
4K 17:9/ 
3.8K 16:9

ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P

1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

ProRes 4444 HD P 4)

1920×1080P RGB 1920×1080P 1920×1080P RGB 3G 1920×1080P RGB 3G 
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

3.8K 16:9 Rec Off 3840×2160P 6G – 3840×2160P YPbPr 6G 3840×2160P YPbPr 6G Sin salida Sin salida
3840×2160P Square 3840×2160P Square 3840×2160P YPbPr 1.5G
3840×2160P 2SI – 3840×2160P YPbPr 3G 3840×2160P YPbPr 3G Sin salida Sin salida

1920×1080P

1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G 1920×1080P 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
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Project Monitoring > Output Format Formato de salida
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
23.98 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9 2)/ 
4K 6:5/ 
4K 4:3/ 
4K 17:9/ 
4K 2.39:1 1)

XAVC-I 4K Class480/
XAVC-I 4K Class300/ 
Rec Off

4096×2160P 6G – 4096×2160P YPbPr 6G 4096×2160P YPbPr 6G Sin salida Sin salida
4096×2160P 2SI – 4096×2160P YPbPr 3G Sin salida Sin salida
4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 1.5G

2048×1080P 1920×1080P
2048×1080PsF 

YPbPr 1.5G
2048×1080PsF 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P
1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G 1920×1080P 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
5.7K 16:9 3)/ 
3.8K 16:9

XAVC-I QFHD Class480/
XAVC-I QFHD Class300/ 
Rec Off

3840×2160P 6G – 3840×2160P YPbPr 6G 3840×2160P YPbPr 6G Sin salida Sin salida

3840×2160P 2SI – 3840×2160P YPbPr 3G Sin salida Sin salida

3840×2160P Square 3840×2160P Square 3840×2160P YPbPr 1.5G

1920×1080P
1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G 1920×1080P 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 6:5/ 
4K 4:3/ 
4K 17:9/ 
3.8K 16:9

MPEG 1920×1080P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P

1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

ProRes 4444 HD P 4)

1920×1080P RGB 1920×1080P 1920×1080P RGB 3G 1920×1080P RGB 3G 
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1)	 SxS Rec Format se ajusta en Rec Off cuando Imager Mode está establecido en 4K 2.39:1.
2)	 SDI 1/2 y SDI 3/4 no pueden ajustarse en 4096×2160P.
2)	 SDI 1/2 y SDI 3/4 pueden ajustarse en 3840×2160P.
4)	 Configurable solo para los siguientes tamaños de imagen efectivos.
	 5.7K 16:9
	 4K 6:5
	 4K 4:3
	 3.8K 16:9

[Nota]
Los ajustes y la salida de 4096×2160P y 3840×2160P son compatibles cuando SxS Rec Format está ajustado en uno de los formatos siguientes y AXS Rec Format no está ajustado en Rec Off.
MPEG HD422 P
MPEG HD422 i
FHD ProRes 422 HQ P
FHD ProRes 422 HQ i
FHD ProRes 422 P
FHD ProRes 422 i
FHD ProRes 422 Proxy P
FHD ProRes 422 Proxy i
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Formatos de salida del conector MONITOR OUT/conector HDMI OUT

La señal digital desde los conectores MONITOR OUT y HDMI OUT se envía dependiendo de la categoría Project y de los ajustes de la categoría Monitoring del menú.
Para obtener más información acerca de las combinaciones de los ajustes de la categoría Project, consulte “Ajuste del formato de grabación” (página 54).

Los valores predeterminados aparecen en negrita subrayados.

Project Monitoring > Output Format Formato de salida
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
59.94/50 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9/ 
4K 2.39:1

XAVC-I 4K Class300/ 
Rec Off

4096×2160P 12G –
1920×1080P Level A 

4096×2160P
1920×1080P YPbPr 3G Level A

4096×2160P
1920×1080P 1920×1080P

1920×1080i
4096×2160P

1920×1080i YPbPr 1.5G
4096×2160P

1920×1080i 1920×1080i 

4096×2160P 2SI 4096×2160P 2SI
1920×1080P Level A

4096×2160P
1920×1080P YPbPr 3G Level A

4096×2160P
1920×1080P 1920×1080P

1920×1080i
4096×2160P

1920×1080i YPbPr 1.5G
4096×2160P

1920×1080i 1920×1080i

4096×2160P Square 4096×2160P Square
1920×1080P Level A 1920×1080P 1920×1080P YPbPr 3G Level A 1920×1080P
1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i 

2048×1080P 
1920×1080P 1920×1080P Level A 1920×1080P 1920×1080P YPbPr 3G Level A 1920×1080P
1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

1920×1080P 
1920×1080P 1920×1080P Level A 1920×1080P 1920×1080P YPbPr 3G Level A 1920×1080P
1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

1920×1080i 1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i
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Project Monitoring > Output Format Formato de salida
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

5.7K 16:9/ 
3.8K 16:9

XAVC-I QFHD Class300/
Rec Off

3840×2160P 12G –
1920×1080P Level A

3840×2160P
1920×1080P YPbPr 3G Level A

3840×2160P
1920×1080P 1920×1080P

1920×1080i
3840×2160P

1920×1080i YPbPr 1.5G
3840×2160P

1920×1080i 1920×1080i 

3840×2160P 2SI 3840×2160P 2SI 
1920×1080P Level A

3840×2160P
1920×1080P YPbPr 3G Level A

3840×2160P
1920×1080P 1920×1080P

1920×1080i
3840×2160P

1920×1080i YPbPr 1.5G
3840×2160P

1920×1080i 1920×1080i

3840×2160P Square 3840×2160P Square 
1920×1080P Level A 1920×1080P 1920×1080P YPbPr 3G Level A 1920×1080P
1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i 

1920×1080P 
1920×1080P 1920×1080P Level A 1920×1080P 1920×1080P YPbPr 3G Level A 1920×1080P
1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

1920×1080i 1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i
6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9/ 
3.8K 16:9

ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P 
1920×1080P 1920×1080P Level A 1920×1080P 1920×1080P YPbPr 3G Level A 1920×1080P

1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

ProRes 422 HQ HD i/ 
ProRes 422 HD i/ 
ProRes 422 Proxy HD i 

1920×1080i 1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

MPEG 1920×1080i 
1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

–
720×480P 1) 2) Sin salida 720×480P
720×576P 1) 3) Sin salida 720×576P

Project Monitoring > Output Format Formato de salida
Project Frame Rate Imager Mode AXS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
47.95 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
4K 4:3/ 
4K 6:5/ 
4K 17:9/ 
4K 2.39:1

RAW SQ/ 
X-OCN XT/ 
X-OCN ST/ 
X-OCN LT/ 
Rec Off

4096×2160P Square 4096×2160P Square 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
4096×2160P 2SI 4096×2160P 2SI 
2048×1080P 1920×1080P
1920×1080P 1920×1080P
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Project Monitoring > Output Format Formato de salida
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
29.97/25 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9 4)/ 
4K 6:5/ 
4K 4:3/ 
4K 17:9/ 
4K 2.39:1

XAVC-I 4K Class480/
XAVC-I 4K Class300/ 
Rec Off 4096×2160P 6G –

1920×1080P
4096×2160P

1920×1080P YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

1920×1080PsF
4096×2160P 

1920×1080PsF YPbPr 1.5G
4096×2160P

1920×1080PsF 1920×1080PsF

4096×2160P 2SI –
1920×1080P

4096×2160P
1920×1080P YPbPr 1.5G

4096×2160P
1920×1080P 1920×1080P

1920×1080PsF
4096×2160P

1920×1080PsF YPbPr 1.5G
4096×2160P

1920×1080PsF 1920×1080PsF

4096×2160P Square 4096×2160P Square
1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

2048×1080PsF
1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

1920×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

5.7K 16:9 5)/ 
3.8K 16:9

XAVC-I QFHD Class480/
XAVC-I QFHD Class300/
Rec Off 3840×2160P 6G –

1920×1080P
3840×2160P

1920×1080P YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

1920×1080PsF
3840×2160P

1920×1080PsF YPbPr 1.5G
3840×2160P

1920×1080PsF 1920×1080PsF

3840×2160P 2SI –
1920×1080P

3840×2160P
1920×1080P YPbPr 1.5G

3840×2160P
1920×1080P 1920×1080P

1920×1080PsF
3840×2160P

1920×1080PsF YPbPr 1.5G
3840×2160P

1920×1080PsF 1920×1080PsF

3840×2160P Square 3840×2160P Square
1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

1920×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 6:5/ 
4K 4:3/ 
4K 17:9/ 
3.8K 16:9

MPEG 1920×1080P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

ProRes 4444 HD P 6)

1920×1080P RGB
1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF
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Project Monitoring > Output Format Formato de salida
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
24 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
4K 6:5/ 
4K 4:3/ 
4K 17:9/ 
4K 2.39:1

XAVC-I 4K Class480/
XAVC-I 4K Class300/ 
Rec Off

4096×2160P 6G – 1920×1080P
4096×2160P

1920×1080P YPbPr 1.5G
4096×2160P

1920×1080 1920×1080P

4096×2160P 2SI – 1920×1080P
4096×2160P

1920×1080P YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P
4096×2160P Square 4096×2160P Square 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
2048×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
1920×1080PsF

6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 6:5/ 
4K 4:3/ 
4K 17:9/ 
3.8K 16:9

ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF

ProRes 4444 HD P 6)

1920×1080P RGB 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

3.8K 16:9 Rec Off
3840×2160P 6G – 1920×1080P

3840×2160P
1920×1080PsF YPbPr 1.5G

3840×2160P
1920×1080P 1920×1080PsF

3840×2160P Square 3840×2160P Square 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

3840×2160P 2SI – 1920×1080P
3840×2160P

1920×1080P YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P
1920×1080P

1920×1080P 1920×1080PsF 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
1920×1080PsF
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Project Monitoring > Output Format Formato de salida
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
23.98 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9 4)/ 
4K 6:5/ 
4K 4:3/ 
4K 17:9/ 
4K 2.39:1

XAVC-I 4K Class480/
XAVC-I 4K Class300/ 
Rec Off

4096×2160P 6G – 1920×1080P
4096×2160P

1920×1080P YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

4096×2160P 2SI – 1920×1080P
4096×2160P

1920×1080P YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P
4096×2160P Square 4096×2160P Square 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
2048×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
1920×1080PsF

5.7K 16:9 5)/ 
3.8K 16:9

XAVC-I QFHD Class480/
XAVC-I QFHD Class300/
Rec Off

3840×2160P 6G – 1920×1080P
3840×2160P

1920×1080 YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

3840×2160P 2SI – 1920×1080P
3840×2160P

1920×1080P YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P
3840×2160P Square 3840×2160P Square 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
1920×1080PsF

6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 6:5/ 
4K 4:3/ 
4K 17:9/ 
3.8K 16:9

MPEG 1920×1080P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080PsF

ProRes 4444 HD P 6)

1920×1080P RGB 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1)	 Con AXS Rec Format ajustado en Rec Off, esta salida se selecciona cuando se ajusta Technical > System Configuration > SD HDMI en On en el menú.
2)	 Cuando Project Frame Rate es 59.94.
3)	 Cuando Project Frame Rate es 50.0.
4)	 SDI 1/2 y SDI 3/4 no pueden ajustarse en 4096×2160P.
5)	 SDI 1/2 y SDI 3/4 pueden ajustarse en 3840×2160P.
6)	 Configurable solo para los siguientes tamaños de imagen efectivos.
	 5.7K 16:9
	 4K 6:5
	 4K 4:3
	 3.8K 16:9

[Nota]
Los ajustes y la salida de 4096×2160P y 3840×2160P son compatibles cuando SxS Rec Format está ajustado en uno de los formatos siguientes y AXS Rec Format no está ajustado en Rec Off.
MPEG HD422 P
MPEG HD422 i
FHD ProRes 422 HQ P
FHD ProRes 422 HQ i
FHD ProRes 422 P
FHD ProRes 422 i
FHD ProRes 422 Proxy P
FHD ProRes 422 Proxy i
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Indicaciones de error/advertencia
Si en la unidad se genera un estado de funcionamiento, advertencia o precaución que requiere 
confirmación, aparece un mensaje en la pantalla secundaria, el testigo REC empieza a parpadear y se 
emite una advertencia acústica.
El aviso acústico se produce en el altavoz integrado o en los auriculares conectados al conector de 
auriculares.
Al encender la unidad, aparece un mensaje en la pantalla de visualización secundaria que le solicita que 
ejecute APR si el ajuste automático del sensor de imagen (APR) no se ha realizado durante un periodo 
determinado de tiempo. En ese caso, siga las instrucciones en pantalla para ejecutar APR (página 86).

Pantalla de error

La unidad dejará de funcionar cuando se genere uno de los siguientes tipos de pantalla.

Indicación de pantalla 
de error

Aviso 
acústico

Testigo REC Causa y solución

E + código de error Intermitente Parpadeo 
rápido

La unidad puede estar defectuosa. La grabación se 
detiene aunque aparezca REC en la pantalla del 
visor/monitor.
Desconecte la alimentación y compruebe el equipo 
conectado, los cables y los soportes. Si el error 
continúa cuando se vuelve a encender la unidad, 
póngase en contacto con su representante del 
servicio técnico de Sony. (Si no se puede desconectar 
la alimentación desactivando el interruptor de 
alimentación, retire la batería o la fuente DC IN).

Pantalla de advertencia

Cuando se genere uno de los siguientes mensajes, utilice la tabla siguiente para resolver el problema.

Indicación de pantalla 
de advertencia

Aviso 
acústico 

Testigo REC Causa y solución

Media Full 1) Continuo Parpadeo 
rápido

Los clips no se han podido grabar, copiar o dividir 
porque el espacio libre de la tarjeta de memoria SxS se 
ha agotado.
Sustituir inmediatamente.

Battery End 1) Continuo Parpadeo 
rápido

La batería se ha agotado. La grabación se desactiva.
Detenga la operación y recargue la batería.

Indicación de pantalla 
de advertencia

Aviso 
acústico 

Testigo REC Causa y solución

Temperature High 1) Intermitente Parpadea La temperatura interna es elevada.
Apague la unidad y deje que se enfríe antes de volver 
a ponerla en marcha.

Insufficient Voltage 1) Continuo Parpadeo 
rápido

La tensión de DC IN es demasiado baja. La grabación 
se desactiva.
Conecte otra fuente de alimentación.

EXT. I/F Signal Error Intermitente Parpadeo 
rápido

Se ha detectado un error en la señal en el terminal de 
montaje para una unidad de expansión.
Compruebe la conexión a la AXS-R7 o a otro 
dispositivo.

AXS Firmware 
Mismatch

Continuo Parpadeo 
rápido

La AXS-R7 no puede manejarse correctamente.
Actualice la versión de firmware de la AXS-R7.

AXS Recorder Temp. 
High 1)

Intermitente Parpadeo 
rápido

La temperatura interna de la AXS-R7 es elevada.
Apague la unidad y deje que se enfríe antes de volver 
a ponerla en marcha.

Lens Signal Error – – Se ha detectado un error en la señal en el terminal de 
montaje para una unidad de expansión.
Compruebe la conexión al objetivo o a otro 
dispositivo.

1)	 El mensaje no se muestra en la pantalla del monitor.

Acerca de las advertencias de temperatura

Las advertencias Temperature High y AXS Recorder Temp. High pueden mostrarse cuando se utiliza la 
unidad dentro del rango de temperatura de funcionamiento garantizada de la unidad, en función del 
modo de funcionamiento y el entorno de uso. La grabación no se detiene inmediatamente cuando se 
muestran estos mensajes; sin embargo, las indicaciones de la columna Causa y solución de la tabla deben 
seguirse de inmediato.

Pantalla de confirmación de operaciones y precauciones

Pueden aparecer los siguientes mensaje de confirmación de funcionamiento y precaución en la pantalla 
del monitor o en la pantalla secundaria y es posible que se muestren los iconos de advertencia y los 
mensajes en la categoría Info > Camera Condition del menú. Para solucionar el problema, siga las 
indicaciones.

Indicación de pantalla Causa y solución
Battery Error
Please Change Battery

Se ha detectado un error en la batería.
Sustituya la batería por una normal.
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Indicación de pantalla Causa y solución
Backup Battery End
Please Change

La capacidad de la batería de reserva es insuficiente.
Sustituya la batería de reserva.

Cannot Use SxS(A)*
Please Change

Se ha insertado una tarjeta de memoria que se ha 
particionado o contiene más clips de los que la 
unidad puede gestionar.
La tarjeta no puede usarse en la unidad y debe 
reemplazarse.

Cannot Use SxS(A)*
Unsupported File System

Se ha introducido una tarjeta que utiliza otro sistema 
de archivos o una tarjeta sin formatear.
La tarjeta no puede usarse en la unidad y debe 
reemplazarse o formatearse utilizando la unidad.

Media Error
SxS(A)* Needs to be Restored

Se ha producido un error en la tarjeta de memoria. Es 
necesario restaurar la tarjeta.
Restaure la tarjeta.

SxS(A)* Error
Recording Stopped
Playback Stopped

La grabación o la reproducción se han detenido por 
un error en la tarjeta de memoria.
Si el problema continúa, reemplace la tarjeta de 
memoria.

Input AES/EBU is Invalid Emphasis Se ha recibido una señal Énfasis no compatible con la 
entrada AES/EBU.
La unidad es compatible únicamente con Énfasis 
50u-15u.

Input AES/EBU is not Pro Use Se ha recibido una señal distinta a Uso profesional en 
la entrada AES/EBU.
La unidad es compatible únicamente con Uso 
profesional.

Fan Stopped El ventilador de la unidad se ha detenido.
Evite utilizarlo en condiciones de temperatura 
elevadas. Apague la unidad y póngase en contacto 
con un representante del servicio técnico de Sony.

AXS Recorder Fan Stopped El ventilador de la AXS-R7 que está conectado a la 
unidad se ha detenido.
Evite utilizarlo en condiciones de temperatura 
elevadas. Quite la AXS-R7 de la unidad y póngase en 
contacto con un representante del servicio técnico de 
Sony.

Unsupported FPS
Change AXS(A) to AXS S48 Memory

Se detectó una memoria AXS no compatible.
No se puede llevar a cabo la grabación. Cambie el 
formato de grabación para la tarjeta de memoria AXS 
o cambie la tarjeta a una AXS-A512S48 o AXS-A1TS48.

Indicación de pantalla Causa y solución
Abnormal Lens Communication
Please Check “Lens IF” Setting

El tipo de objetivo conectado no coincide con el 
ajuste de la unidad.
Compruebe el ajuste Technical > Lens Configuration > 
PL-Mt Interface Position en el menú completo.

Please Execute APR El ajuste automático del sensor de imagen (APR) no se 
ha utilizado durante un periodo de tiempo 
determinado.
Utilice APR pulsando el mando MENU.

XXXX License Y days Remaining 
(XXXX: tipo de licencia, Y: número de días restantes)

Quedan 2 días para que caduque la licencia del 
software.

Lens I/F Error Se detectó un error en la comunicación I/F del 
objetivo al conectar un objetivo con soporte E.
Compruebe la conexión al objetivo con soporte E.

AXS Rec Format was changed. El formato de grabación AXS ha cambiado. 
Compruebe la combinación de AXS Rec Format y SxS 
Rec Format (página 54).

SxS Rec Format was changed. El formato de grabación SxS ha cambiado. 
Compruebe la combinación de AXS Rec Format y SxS 
Rec Format (página 54).

FPS was set to Fixed. La velocidad de fotogramas ha cambiado de una 
velocidad variable a una velocidad fija. La grabación 
de velocidad variable no es compatible con el modo 
de grabación simultánea en una ranura.

Sub Rec was set to Off. La grabación secundaria SxS se ha desactivado. La 
filmación a velocidad variable y la grabación en el 
modo de caché de imágenes no están disponibles 
durante la grabación simultánea en una ranura.

Set the “Password” of “Authentication”. Technical > Authentication > Password (página 84) 
no se ha configurado aún. Configure el ajuste.

*	 Se muestra “SxS(B)” para la tarjeta de memoria SxS de la ranura B, “AXS(A)” para la tarjeta de memoria AXS de la ranura A de la 
AXS-R7 y “AXS(B)” para la tarjeta de memoria AXS de la ranura B de la AXS-R7.
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Elementos guardados en los archivos
Leyenda de la tabla
Sí: guardado
No: no guardado
–: no guardado (ajuste temporal)

Menú Shooting

Elemento Elemento secundario Tipo de archivo
All Scene

FPS Fixed/Variable Select Sí No
FPS Select Sí No

Shutter 1) Shutter Select Sí Sí
Step/Cont. Select Sí Sí
Add/Change Step – –
Delete Step – –

ND ND Position Sí Sí
Exposure Index EI Select Sí Sí
Gain Gain Select Sí Sí
White Balance 1) Color Temp. Select Sí Sí

Add/Change Step – –
Delete Step – –
Auto White Balance – –

LUT Select SDI 1/2 – –
SDI 3/4 Sí No
Monitor Sí No
HDMI – –
VF LUT Sí No
SxS Rec Sí No
Sub Rec Sí No

SDR Gain Sí No

Elemento Elemento secundario Tipo de archivo
All Scene

Look Category Sí No
Preset Look Select Sí No
ACES Select Sí No
User 3D LUT Select Sí No
ART Select Sí No
ART Information – –
ASC CDL Process Sí No
ASC CDL Select Sí No
ASC CDL Information – –

Look File Load User 3D LUT – –
Reset User 3D LUT – –
Reset All User 3D LUTs – –
Load ART – –
Reset ART – –
Reset All ARTs – –
Load ASC CDL – –
Reset ASC CDL – –
Reset All ASC CDLs – –

Flicker Reduce Mode Sí No
Frequency Sí No

1)	 Las opciones de selección añadidas o editadas por un usuario también se guardan.
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Menú Project

Elemento Elemento secundario Tipo de archivo
All Scene

Basic Setting Imager Mode Sí No
Project Frame Rate Sí No
Input Color Space Sí Sí
AXS Rec Format Sí No
SxS Rec Format Sí No
Sub Rec Format Sí No
Base ISO Sí Sí
SxS/Output De-Squeeze Sí No

Special Recording Cache Rec Select Sí No
Max Cache Rec Duration Sí No

Assignable Button <1> Sí No
<2> Sí No
<3> Sí No
<4> Sí No
<5> Sí No
<6> Sí No
<7> Sí No
<VF A> Sí No
<VF B> Sí No
<VF C> Sí No
<User 1> Sí No
<User 2> Sí No
<User 3> Sí No
<User 4> Sí No
<User 5> Sí No

All File Load SD Card – –
Save SD Card – –
File ID Sí No
Format SD Card – –

Scene File Recall Internal Memory – –
Store Internal Memory – –
Load SD Card – –
Save SD Card – –
File ID No Sí

Elemento Elemento secundario Tipo de archivo
All Scene

User Gamma Current Settings – –
Load SD Card – –
Reset – –
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Menú TC/Media

Elemento Elemento secundario Tipo de archivo

All Scene
Timecode Mode Sí No

Manual Setting – –
Reset – –
TC Format Sí No
TC Source – –
Time Data Display Sí No

Clip Name Format Camera ID 1) Sí No
Reel Number 1) Sí No
Camera Position 1) Sí No
SxS Root Folder Name Sí No

Format Media AXS Slot A – –
AXS Slot B – –
SxS Slot A – –
SxS Slot B – –
SD Card – –

Update Media AXS Slot A – –
AXS Slot B – –
SxS Slot A – –
SxS Slot B – –

1)	 Al cargar un archivo All, los datos guardados en la memoria interna no se sobrescriben.

Menú Monitoring

Elemento Elemento secundario Tipo de archivo
All Scene

Output Format SDI 1/2 Sí No
SDI 3/4 Sí No
Monitor Sí No
HDMI Sí No

OSD Appearance VF Sí No
SDI
SDI 1/2
SDI 3/4

Sí No

Monitor Sí No
HDMI – –
Status Info A/B Setup Sí No
Frame Line A/B Setup Sí No

Monitor Display Focus Distance Format Sí No
Monitor Magnifier Ratio Sí No

Frame Line Center Marker Sí No
Aspect Ratio Sí No
Aspect Safety Zone Sí No
Safety Zone Sí No
Color Sí No
Surround View Type Sí No
Aspect Ratio Type Sí No
Mask Level Sí No
Frame Line on Playback Sí No

User Frame Line 1 Select Sí No
Preset Aspect Ratio Sí No
Scaling Sí No
Preset Aspect Ratio Type Sí No
Aspect Ratio(Pixels) – –
Width Sí No
Height Sí No
H Position Sí No
V Position Sí No
Variable Aspect Type – –
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Elemento Elemento secundario Tipo de archivo
All Scene

User Frame Line 2 Select Sí No
Preset Aspect Ratio Sí No
Scaling Sí No
Preset Aspect Ratio Type – –
Aspect Ratio(Pixels) – –
Width Sí No
Height Sí No
H Position Sí No
V Position Sí No
Variable Aspect Type – –

Elemento Elemento secundario Tipo de archivo
All Scene

False Color Level Sí No
Red Sí No
Red Upper Limit Sí No
Red Lower Limit Sí No
Yellow Sí No
Yellow Upper Limit Sí No
Yellow Lower Limit Sí No
Orange Sí No
Orange Upper Limit Sí No
Orange Lower Limit Sí No
Pink Sí No
Pink Upper Limit Sí No
Pink Lower Limit Sí No
Light Pink Sí No
Light Pink Upper Limit Sí No
Light Pink Lower Limit Sí No
Cyan Sí No
Cyan Upper Limit Sí No
Cyan Lower Limit Sí No
Green Sí No
Green Upper Limit Sí No
Green Lower Limit Sí No
Light Blue Sí No
Light Blue Upper Limit Sí No
Light Blue Lower Limit Sí No
Blue Sí No
Blue Upper Limit Sí No
Blue Lower Limit Sí No
Purple Sí No
Purple Upper Limit Sí No
Purple Lower Limit Sí No
Reset – –

VF Display VF LUT Sí No
Status Info Sí No
Frame Line Sí No
VF Magnifier Ratio Sí No
Color Sí No
SDR Gain Sí No
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Elemento Elemento secundario Tipo de archivo
All Scene

VF Function Double Speed Scan Sí No
Peaking Frequency Sí No
Zebra Sí No
Zebra Select Sí No
Zebra1 Level Sí No
Zebra1 Aperture Level Sí No
Zebra2 Level Sí No
Assign<VF A> Sí No
Assign<VF B> Sí No
Assign<VF C> Sí No

Menú Audio

Elemento Elemento secundario Tipo de archivo
All Scene

Audio Input CH-1 Audio Select Sí No
CH-2 Audio Select Sí No
CH-1 Audio Level Sí No
CH-2 Audio Level Sí No
MIC Reference Sí No

Audio Monitor Monitor CH Sí No
Monitor Level Sí No

Audio Configuration Alarm Level Sí No
Input Limiter Mode Sí No
AGC Level Sí No
AGC Mono/Stereo Sí No
MIC Input Mono/Stereo Sí No
Phantom Power +48V Sí No
Monitor Output CH Pair Sí No
Headphone Mono/ST Sí No



000 8. Apéndice: Elementos guardados en los archivos135

Menú Paint

Elemento Elemento secundario Tipo de archivo
All Scene

Black Master Black Sí Sí
R Black Sí Sí
B Black Sí Sí

Flare Setting Sí Sí
Master Flare Sí Sí
R Flare Sí Sí
G Flare Sí Sí
B Flare Sí Sí

Gamma Setting Sí Sí
Gamma Category – –
Gamma Select Sí Sí

Black Gamma Setting Sí Sí
Range Sí Sí
Master Black Gamma Sí Sí

Knee Setting Sí Sí
Point Sí Sí
Slope Sí Sí

White Clip Setting Sí Sí
Level Sí Sí

Detail Setting Sí Sí
Level Sí Sí
H/V Ratio Sí Sí
Crispening Sí Sí
Level Depend Sí Sí
Level Depend Level Sí Sí
Frequency Sí Sí
Knee Aperture Sí Sí
Knee Aperture Level Sí Sí
Limit Sí Sí
White Limit Sí Sí
Black Limit Sí Sí

Elemento Elemento secundario Tipo de archivo
All Scene

Matrix Setting Sí Sí
User Matrix Sí Sí
User Matrix R-G Sí Sí
User Matrix R-B Sí Sí
User Matrix G-R Sí Sí
User Matrix G-B Sí Sí
User Matrix B-R Sí Sí
User Matrix B-G Sí Sí

Multi Matrix Setting Sí Sí
Area Indication No No
Reset – –
Axis No No
Hue Sí Sí
Saturation Sí Sí
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Menú Technical

Elemento Elemento secundario Tipo de archivo
All Scene

Test Signals Color Bars Sí No
Color Bars Type Sí No
1kHz Tone on Color Bars Sí No
Test Saw Sí No

Test Type Sí No

Switch & Rec Light Lock Operator Side Sí No

Lock Assistant Side Sí No
Rec Light Sí No
Rec Start/Stop Beep Sí No

System Configuration Fan Control Sí No
RM/RCP Paint Control Sí No
SDI Rec Remote Trigger Sí No
3G SDI 1/2/3/4 Output Sí No
SD HDMI Sí No
Shutter Mode Sí Sí
Media Near Full Alarm Sí No

Special Configuration Flip Image Sí No
Audio/Video Delay Sí No
NR(4K 17:9/16:9 AXS) Sí Sí
Level Gauge Adjust – –
Level Gauge Reset – –
3620XS Lev. Gauge Adj. – –
3620XS Lev. Gauge Rst. – –
360° Shutter Setting Sí No

Lens Configuration PL-Mt Interface Position Sí No
Lens 12pin Sí No
E-Mount Shading Comp. Sí No
E-Mt Chro. Aber. Comp. Sí No

Authentication User Name No No
Password No No

Network Setting Sí No
LAN Sí No
Wireless Sí 1) No

Elemento Elemento secundario Tipo de archivo
All Scene

APR APR – –
Reset – –

Battery Near End:Info Battery Sí No
End:Info Battery Sí No
Near End:Sony Battery Sí No
End:Sony Battery Sí No
Near End:Other Battery Sí No
End:Other Battery Sí No
Detected Battery – –

DC Voltage Alarm DC Low Voltage1 Sí No
DC Low Voltage2 Sí No
DC(24V) Low Voltage1 Sí No
DC(24V) Low Voltage2 Sí No

Control Display Brightness level Sí No
Genlock Input Source Sí No

Reference Lock Type – –
1) Los siguientes elementos no se guardan.

ˎˎ Scan Networks
ˎˎ SSID
ˎˎ Password
ˎˎ WPS
ˎˎ MAC Address
ˎˎ Regenerate Password
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Menú Maintenance

Elemento Elemento secundario Tipo de archivo
All Scene

Clock Set Time Zone Sí No
Date Mode Sí No
Date – –
Time – –

Language Select Sí No
Hours Meter Camera(System) – –

R7 Recorder(System) – –
Camera(Resettable) – –
R7 Recorder(Resettable) – –
Reset-Cam(Resettable) – –
Reset-R7(Resettable) – –

Reset to Default Reset – –
Network Reset Reset – –
License Options Install: xxx – –

Anamorphic – –
Full-Frame – –
High Frame Rate – –
Unique Device ID – –

Firmware Camera – –
AXS – –
FW Update-camera – –
FW Update-AXS-R7 – –

[Nota]
Cuando se ajusta Technical > System Configuration > RM/RCP Paint Control (página 83) en On en el menú completo, los 
siguientes elementos de la unidad de control remoto (página 109) también se guardan en un archivo con todos los ajustes.
ˎˎ Black
ˎˎ Flare
ˎˎ Gamma 1)

ˎˎ Black Gamma 1)

ˎˎ Gain

1) Salvo cuando se establece en S-Log3.
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Lista de metadatos de grabación y salida
Leyenda de la tabla
Opc: incluido si hay información disponible (opcional)
Sí: definido
–: No definido

Elemento Ejemplo de notación en RAW Viewer RAW/ 
X-OCN 
MXF

RAW/ 
X-OCN 
XML

XAVC XAVC 
XML

ProRes ProRes 
XML

MPEG HD MPEG HD 
XML

HD-SDI

Creation Date 2019-10-29 11:04:05 Sí Sí Sí Sí Sí Sí Sí Sí –
Last Update 2019-10-30 11:04:05 – Sí Sí Sí Sí Sí Sí Sí –
UMID 060A2B340101010501010D4313000000070BF41D2F494EB7A16DD045A68CDF2E Sí Sí Sí Sí Sí Sí Sí Sí –
Start 03:36:29:20 Sí Sí Sí Sí Sí Sí Sí Sí –
End 03:36:32:19 Sí Sí Sí Sí Sí Sí Sí Sí –
Duration 00:00:03:00 Sí Sí Sí Sí Sí Sí Sí Sí –
Poster Frame – – – – – – – – –
Recording Mode – Sí – Sí – Sí – Sí –
Drop Frame NDF Sí Sí Sí Sí Sí Sí Sí Sí –
Camera VENICE/CineAltaV Sí Sí Sí Sí – Sí Sí Sí –
Video Codec X-OCN XT Sí Sí Sí Sí Sí Sí Sí Sí –
Resolution 6048×4032 Sí Sí Sí Sí Sí Sí Sí Sí –
Aspect Ratio 3:2 Sí Sí Sí Sí Sí Sí Sí Sí –
Format FPS 23.98p Sí Sí Sí Sí Sí Sí Sí Sí –
Capture FPS 23.98p Sí Sí Sí Sí – Sí Sí Sí –
Flip normal – Sí – – – – – – –
Number of Audio Channels 4 Sí Sí Sí Sí Sí Sí Sí Sí –
Audio Codec LPCM Sí Sí Sí Sí Sí Sí Sí Sí –
Audio Bit Depth 24 Sí Sí Sí Sí Sí Sí Sí Sí –
Audio Sampling Rate 48000 Sí Sí Sí – Sí – Sí – –
Auto Exposure Mode ManualExposureMode Sí – Sí – – – Sí – Sí
Exposure Index 500 Sí Sí Sí – Sí – Sí – Sí
Auto Focus Sensing Area Setting ManualFocusMode Opc – Opc – – – Opc – Opc
ND Filter Wheel 1/4 Sí Sí Sí – – – Sí – Sí
Image Sensor Dimension 
Effective Width

35925um Sí – Sí – – – Sí – Sí

Image Sensor Dimension 
Effective Height

23950um Sí – Sí – – – Sí – Sí

Image Sensor Readout Mode ProgressiveFrame Sí Sí Sí – – – Sí – Sí
Shutter Speed Angle 172.50deg Sí Sí Sí – – – Sí – Sí
Shutter Speed Time 1/50sec Sí – Sí – – – Sí – Sí
Camera Master Gain Adjustment 0.00dB Sí – Sí – – – Sí – Sí
ISO Sensitivity 500 Sí Sí Sí – Sí – Sí – Sí
Electrical Extender Magnification 100% Sí – Sí – – – Sí – Sí
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Elemento Ejemplo de notación en RAW Viewer RAW/ 
X-OCN 
MXF

RAW/ 
X-OCN 
XML

XAVC XAVC 
XML

ProRes ProRes 
XML

MPEG HD MPEG HD 
XML

HD-SDI

Auto White Balance Mode PresetWhiteBalanceSetup Sí – Sí – Sí – Sí – Sí
White Balance 5500 Sí Sí Sí – Sí – Sí – Sí
Tint Correction 0.00000 Sí – Sí – – – – – Sí
Camera Master Black Level 3.0% – – Sí – – – Sí – Sí
Capture Gamma Equation scene-linear Sí Sí Sí Sí Sí Sí Sí Sí Sí
Gamma for CDL rec709 Sí Sí Sí – Sí – Sí – Sí
Color Primaries (Capture Color 
Primaries)

– – Sí Sí Sí – – – Sí

Camera Attributes MPC-36109999999Version5.00 Sí Sí Sí – – – – – Sí
Effective Marker Aspect Ratio 6048:3202 Sí Sí Sí – – – – – Sí
User Frame Line 1 1920×1080+0+0 Sí – Sí – – – – – Sí
User Frame Line 2 1920×1080+0+0 Sí – Sí – – – – – Sí
Active Area Aspect Ratio 6048:4032 Sí Sí Sí – – – – – Sí
Pixel Aspect Ratio 1:1 Sí Sí Sí – Sí – – – Sí
Image Orientation normal Sí – Sí – – – – – Sí
Raw Black Code 512 Sí Sí – – – – – – –
Raw Gray Code 1504 Sí Sí – – – – – – –
Raw White Code 5472 Sí Sí – – – – – – –
Gamma for Look s-log3-cine Sí Sí Sí – – – – – Sí
Color for Look s-gamut3-cine Sí Sí Sí – – – – – Sí
Pre-CDL Transform LUT:SL3SG3Ctos709.cube Sí Sí Sí – – – – – Sí
Post-CDL Transform none Sí Sí Sí – – – – – Sí
Look Process Baked false Sí Sí Sí – – – – – Sí
Monitoring Characteristics rec709 Sí Sí Sí – – – – – Sí
Monitoring Base Curve rec709 Sí Sí Sí – Sí – – – Sí
Monitoring Color Primaries rec709 Sí Sí Sí – – – – – Sí
Monitoring Coding Equations rec709 Sí Sí Sí – – – – – Sí
Monitoring Descriptions LUT:SL3SG3Ctos709.cube Sí Sí Sí – Sí – – – Sí
Camera Tilt Angle 2.70000 Sí – Sí – – – – – Sí
Camera Roll Angle 1.30000 Sí – Sí – – – – – Sí
Focus Distance 2296mm Opc – Opc – – – – – Opc
Aperture Value 3.14 Opc – Opc – – – – – Opc
Aperture Ring T Stop Position 2.8 + 3/10 Opc – Opc – – – – – Opc
Current Focal Length 0mm Opc – Opc – – – – – Opc
Hyperfocal Distance 219224mm Opc – Opc – – – – – Opc
Near Focus Distance 2273mm Opc – Opc – – – – – Opc
Far Focus Distance 2319mm Opc – Opc – – – – – Opc
Horizontal Field of View 27.9deg Opc – Opc – – – – – Opc
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Elemento Ejemplo de notación en RAW Viewer RAW/ 
X-OCN 
MXF

RAW/ 
X-OCN 
XML

XAVC XAVC 
XML

ProRes ProRes 
XML

MPEG HD MPEG HD 
XML

HD-SDI

Entrance Pupil Position +51mm Opc – Opc – – – – – Opc
Normalised Zoom Value 0.000 Opc – Opc – – – – – Opc
Lens Serial Number xxxxxxxx Opc – Opc – – – – – Opc
Iris F-Number 2.87 Opc – Opc – – – Opc – Opc
Iris T-Number 3.1 Opc – Opc – – – Opc – Opc
Iris Ring Position Opc – Opc – – – Opc – Opc
Focus Position from Image Plane 2.296m Opc – Opc – – – Opc – Opc
Focus Ring Position Opc – Opc – – – Opc – Opc
Macro Setting OFF Opc – Opc – – – Opc – Opc
Lens Zoom 35mm Still Camera 
Equivalent

85mm Opc – Opc – – – Opc – Opc

Lens Zoom Actual Focal Length 85mm Opc – Opc – – – Opc – Opc
Zoom Ring Position Opc – Opc – – – Opc – Opc
Anamorphic Lens Squeeze Ratio Opc – Opc – – – – – Opc
Optical Extender Magnification 100% Opc – Opc – – – – – Opc
Lens Attributes xxxxxxxx Opc Opc Opc – – – Opc – Opc
Cooke /i technology Opc – Opc – – – – – Opc
Cooke /i2 technology Opc – Opc – – – – – Opc
Cooke /i3 technology Opc – Opc – – – – – Opc
ZEISS eXtended Data Opc – Opc – – – – – Opc
Description – – – – – – – – –
Circle – – – – – – – – –
Project – – – – – – – – –
Director Name – – – – – – – – –
Director of Photography Name – – – – – – – – –
Production – – – – – – – – –
Camera Index – Sí – – – – – – –
Reel – Sí – – – – – – –
Scene – – – – – – – – –
Cut – – – – – – – – –
Take – – – – – – – – –
Shot – Sí – – – – – – –
Mark In – – – – – – – – –
Mark Out – – – – – – – – –
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Licencias
Licencia MPEG-4 Visual Patent 
Portfolio

ESTE PRODUCTO ESTÁ BAJO LICENCIA DE 
PORTAFOLIO DE PATENTE MPEG-4 VISUAL. PARA 
EL PERIODO Y USO NO COMERCIAL DE UN 
CONSUMIDOR PARA

(i) VÍDEO CODIFICADO QUE CUMPLA CON LA 
NORMA MPEG-4 (“MPEG-4 VIDEO”) Y/O
(ii) DESCODIFICACIÓN DE VÍDEO MPEG-4 
CODIFICADA PARA UN CONSUMIDOR QUE 
REALIZA ACTIVIDADES PERSONALES O NO 
COMERCIALES Y/U OBTUVO DE UN PROVEEDOR 
DE VÍDEO CON LICENCIA DE MPEG LA PARA LA 
ENTREGA DE VÍDEO MPEG-4.

NO SE CONCEDERÁ NI SE CONSIDERARÁ NINGUNA 
LICENCIA PARA CUALQUIER OTRO USO. PUEDE 
OBTENER INFORMACIÓN ADICIONAL, INCLUIDA LA 
RELACIONADA CON LOS USOS PROMOCIONALES, 
INTERNOS Y COMERCIALES Y LAS LICENCIAS, EN 
MPEG LA, LLC. VISITE HTTP://WWW.MPEGLA.COM

MPEG LA ofrece licencias para (i) fabricación/venta 
de cualquier disco que contenga información de 
vídeo MPEG-4 Visual (ii) distribución/retransmisión 
de información de vídeo MPEG-4 Visual en 
cualquier medio (como el servicio de distribución 
de vídeo en línea, retransmisión por Internet y 
televisión).
Cualquier otro uso de este producto podría 
requerir la obtención de una licencia de MPEGLA. 
Para más información, póngase en contacto con 
MPEG LA. MPEG LA. L.L.C., 250 STEELE STREET, 
SUITE 300, DENVER, COLORADO 80206
http://www.mpegla.com

Licencia de la cartera de patentes de 
MPEG-4 AVC

LOS CONSUMIDORES PUEDEN UTILIZAR ESTE 
PRODUCTO BAJO LA AUTORIZACIÓN DE LA 
LICENCIA DE LA CARTERA DE PATENTES DE AVC 
PARA SU USO PERSONAL O PARA OTROS USOS, 
POR LOS CUALES NO SE RECIBE REMUNERACIÓN 
ALGUNA EN CASO DE

(i) CODIFICAR VÍDEO DE CONFORMIDAD CON EL 
ESTÁNDAR DE AVC (“VÍDEO AVC”) Y/O
(ii) DESCODIFICAR VÍDEO AVC CODIFICADO 
POR UN CONSUMIDOR COMO PARTE DE UNA 
ACTIVIDAD PERSONAL Y/U OBTENIDO DE UN 
PROVEEDOR DE VÍDEO CON LICENCIA PARA 
PROPORCIONAR VÍDEO AVC.

NO SE OTORGA NINGÚN TIPO DE LICENCIA 
O NO EXISTE NINGUNA LICENCIA IMPLÍCITA 
PARA NINGÚN OTRO USO. PUEDE OBTENER 
INFORMACIÓN ADICIONAL EN MPEG LA, L.L.C. 
CONSULTE HTTP://WWW.MPEGLA.COM

Acceso al software al que se aplica la 
licencia GPL/LGPL

Este producto utiliza software al que se aplica la 
licencia GPL/LGPL. Recuerde que tiene derecho a 
acceder, modificar y redistribuir código fuente de 
estos programas de software bajo las condiciones 
de la licencia GPL/LGPL.
El código fuente se proporciona en Internet. 
Utilice la siguiente URL y siga las instrucciones de 
descarga.
http://www.sony.net/Products/Linux/common/
search.html

Preferimos que no se ponga en contacto con 
nosotros para obtener información sobre el 
contenido del código fuente.

Para ver el contenido de estas licencias, conecte la 
unidad a una red y mire la pantalla de información 
de OSS (página 98) en la pantalla de control 
remoto web.

Licencias de software de código 
abierto

Sobre la base de los contratos de licencia entre 
Sony y los titulares del copyright del software, este 
producto utiliza software de código abierto.
Para cumplir con los requisitos de los titulares 
del copyright del software, Sony está obligado a 
informarle sobre el contenido de estas licencias.
Para ver el contenido de estas licencias, conecte la 
unidad a una red y mire la pantalla de información 
de OSS (página 98) en la pantalla de control 
remoto web.
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CONTRATO DE LICENCIA DE USUARIO 
FINAL

Last Updated: 2022-9

IMPORTANT:
BEFORE USING THE SOFTWARE, PLEASE READ 
THIS END USER LICENSE AGREEMENT (“EULA”) 
CAREFULLY. BY USING THE SOFTWARE YOU ARE 
AGREEING TO BE BOUND BY THE TERMS OF THIS 
EULA. IF YOU DO NOT AGREE TO THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between (i) you 
and any entity you represent (collectively “you”) 
and (ii) Sony Corporation (“SONY”). This EULA 
governs your rights and obligations regarding 
the product software of SONY and/or its third 
party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-
PARTY SUPPLIERS”), together with any updates/
upgrades, any printed, on-line or other electronic 
documentation for such software and any data 
files, each provided by SONY or the THIRD-PARTY 
SUPPLIERS, or created by operation of such 
software (collectively, the “SOFTWARE”). 

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU 
General Public license and Lesser/Library General 
Public License) shall be covered by such applicable 
separate end user license agreement in lieu of the 
terms of this EULA to the extent required by such 
separate end user license agreement (“EXCLUDED 
SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The 
SOFTWARE is protected by copyright and other 
intellectual property laws and international 
treaties. 

COPYRIGHT
All right and title in and to the SOFTWARE 
(including, but not limited to, any images, 
photographs, animation, video, audio, music, text 
and “applets” and other content incorporated into 
the SOFTWARE) is owned by SONY or one or more 
of the THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited, non-exclusive, personal, 
non-transferable license to use the SOFTWARE 
solely in connection with your compatible device 
(including, but not limited to, SONY’s products 
which the SOFTWARE is embedded in or bundled 
with) (“DEVICE”) solely in accordance with this 
EULA and the usage instructions as may be made 
available to you by SONY or the THIRD-PARTY 
SUPPLIERS. SONY and the THIRD-PARTY SUPPLIERS 
expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual 
property rights) in and to the SOFTWARE that this 
EULA does not specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, 
attempt to derive source code, modify, reverse 
engineer, decompile, or disassemble any of the 
SOFTWARE, whether in whole or in part, or create 
any derivative works from or of the SOFTWARE 
unless such derivative works are intentionally 
facilitated by the SOFTWARE. You may not modify 
or tamper with any digital rights management 
functionality of the SOFTWARE. You may not 
bypass, modify, defeat or circumvent any of the 
functions or protections of the SOFTWARE or any 
mechanisms operatively linked to the SOFTWARE. 
You may not separate any individual component 
of the SOFTWARE for use on more than one 
DEVICE unless expressly authorized to do so by 
SONY. You may not remove, alter, cover or deface 
any trademarks or notices on the SOFTWARE. You 
may not share, distribute, rent, lease, sublicense, 
assign, transfer or sell the SOFTWARE. You may not 
use the SOFTWARE in connection with violation of 

laws, regulations, court decisions or other legally 
binding dispositions by a public authority or public 
policy, or infringement of the rights or legally 
protected interests (including, but not limited 
to, intellectual and other property rights, rights 
to trade secrets, honors, privacy and publicity) of 
SONY, each of the THIRD-PARTY SUPPLIERS or any 
third parties. The software, network services or 
other products other than the SOFTWARE upon 
which the SOFTWARE’S performance depends 
might be modified, interrupted or discontinued at 
the discretion of the suppliers (software suppliers, 
service suppliers, or SONY). SONY and such 
suppliers do not warrant that the SOFTWARE, 
network services, contents or other products will 
continue to be available, or will operate without 
interruption or modification. You shall not, nor shall 
you instruct or permit, procure, enable or request 
any third party (including your users, third party 
personnel or other personnel, staff or contractors) 
to, take any action designed or intended to: (i) 
use the SOFTWARE (or any part thereof ) in any 
manner or for any purpose that is inconsistent 
with this EULA; (ii) introduce to the SOFTWARE 
any “back door,” “drop dead device,” “time bomb,” 
“Trojan horse,” “virus,” or “worm” (as such terms are 
commonly understood in the software industry) 
or any other equivalent code, files, scripts, agents, 
programs, software routine or instructions 
designed or intended to disrupt, disable, harm or 
otherwise impede in any manner the operation 
of the SOFTWARE or any device or system owned 
or controlled by you or any third party, or which 
otherwise may damage or destroy any data or file 
(“Malicious Code”); (iii) interfere with the proper 
working of the SOFTWARE; (iv) circumvent, disable, 
or interfere with security-related features of the 
SOFTWARE or features that prevent or restrict 
use, access to, or copying the SOFTWARE, or that 
enforce limitations on use of the SOFTWARE; or 
(v) impose (or which may impose, in your sole 
discretion) an unreasonable or disproportionately 
large load on the SOFTWARE.

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license 
grant, you acknowledge that the SOFTWARE may 
include EXCLUDED SOFTWARE. Certain EXCLUDED 
SOFTWARE may be covered by open source 
software licenses (“Open Source Components”), 
which means any software licenses approved as 
open source licenses by the Open Source Initiative 
or any substantially similar licenses, including 
but not limited to any license that, as a condition 
of distribution of the software licensed under 
such license, requires that the distributor make 
the software available in source code format. If 
and to the extent disclosure is required, please 
visit oss.sony.net/Products/Linux or other SONY-
designated web site for a list of applicable OPEN 
SOURCE COMPONENTS included in the SOFTWARE 
from time to time, and the applicable terms and 
conditions governing its use. Such terms and 
conditions may be changed by the applicable 
third party at any time without liability to you. 
To the extent required by the licenses covering 
EXCLUDED SOFTWARE, the terms of such licenses 
will apply in lieu of the terms of this EULA. To 
the extent the terms of the licenses applicable 
to EXCLUDED SOFTWARE prohibit any of the 
restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will not 
apply to such EXCLUDED SOFTWARE. To the extent 
the terms of the licenses applicable to Open 
Source Components require SONY to make an 
offer to provide source code in connection with 
the SOFTWARE, such offer is hereby made.

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used 
by you to view, store, process and/or use content 
created by you and/or third parties. Such content 
may be protected by copyright, other intellectual 
property laws, and/or agreements. You agree to 
use the SOFTWARE only in compliance with all 
such laws and agreements that apply to such 
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content. You acknowledge and agree that SONY 
may take appropriate measures to protect content 
stored, processed or used by the SOFTWARE. Such 
measures include, but are not limited to, refusal 
to accept your request to enable backup and 
restoration of content through certain SOFTWARE 
features, and termination of this EULA in the event 
of your illegitimate use of the SOFTWARE.

CONTENT SERVICE
PLEASE ALSO NOTE THAT THE SOFTWARE MAY 
BE DESIGNED TO BE USED WITH CONTENT 
AVAILABLE THROUGH ONE OR MORE CONTENT 
SERVICES (“CONTENT SERVICE”). USE OF THE 
SERVICE AND THAT CONTENT IS SUBJECT TO THE 
TERMS OF SERVICE OF THAT CONTENT SERVICE. 
IF YOU DECLINE TO ACCEPT THOSE TERMS, YOUR 
USE OF THE SOFTWARE WILL BE LIMITED. You 
acknowledge and agree that certain content and 
services available through the SOFTWARE may be 
provided by third parties over which SONY has no 
control. WHERE CONTENT SERVICE IS NOT UNDER 
SONY’S CONTROL, SONY SHALL NOT BE LIABLE IN 
RESPECT OF ANY DAMAGES (OR OTHER LIABILITY) 
RELATED TO SUCH CONTENT SERVICE. USE OF 
THE CONTENT SERVICE REQUIRES AN INTERNET 
CONNECTION. THE CONTENT SERVICE MAY BE 
MODIFIED OR DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet 
connection for which you are solely responsible. 
Further, you are solely responsible for payment of 
any fees associated with your Internet connection, 
including but not limited to Internet service 
provider or airtime charges. Operation of the 
SOFTWARE may be limited or restricted depending 
on the capabilities, bandwidth or technical 
limitations of your Internet connection and 
service. The provision, quality and security of such 
Internet connectivity are your responsibility or 
that of the third party providing such service. You 

are solely responsible in the event any Malicious 
Code introduced in the SOFTWARE because of or 
through, your internet connections.

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and 
re-export restrictions and regulations of the area or 
country in which you reside or use the SOFTWARE, 
and not to transfer, or authorize the transfer, of the 
SOFTWARE to a prohibited country or otherwise in 
violation of any such restrictions or regulations. 

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not 
designed, manufactured or intended for use or 
resale as on-line control equipment in hazardous 
environments requiring fail-safe performance, 
such as in the operation of nuclear facilities, aircraft 
navigation or communication systems, air traffic 
control, direct life support machines, or weapons 
systems, in which the failure of the SOFTWARE 
could lead to death, personal injury, or severe 
physical or environmental damage (“HIGH RISK 
ACTIVITIES”). SONY, each of the THIRD-PARTY 
SUPPLIERS, and each of their respective affiliates 
specifically disclaim any express or implied 
warranty, duty or condition of fitness for HIGH RISK 
ACTIVITIES. 

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the 
SOFTWARE is at your sole risk and that you 
are responsible for use of the SOFTWARE. The 
SOFTWARE is provided “AS IS,” without warranty, 
duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS 
(for purposes of this Section, SONY and each of 
the THIRD-PARTY SUPPLIERS shall be collectively 
referred to as “SONY”) EXPRESSLY DISCLAIM ALL 
WARRANTIES, DUTIES OR CONDITIONS, EXPRESS 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
QUALITY, FITNESS FOR A PARTICULAR PURPOSE, 

ACCURACY, TITLE AND NONINFRINGEMENT. 
WITHOUT LIMITING THE GENERALITY OF THE 
FOREGOING, SONY DOES NOT WARRANT OR 
MAKE ANY CONDITIONS OR REPRESENTATIONS 
(A) THAT THE FUNCTIONS CONTAINED IN ANY OF 
THE SOFTWARE WILL MEET YOUR REQUIREMENTS 
OR THAT THEY WILL BE UPDATED, (B) THAT THE 
OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY 
DEFECTS WILL BE CORRECTED, (C) THAT THE 
SOFTWARE WILL NOT DAMAGE ANY OTHER 
SOFTWARE, HARDWARE OR DATA, (D) THAT ANY 
SOFTWARE, NETWORK SERVICES (INCLUDING 
THE INTERNET) OR PRODUCTS (OTHER THAN 
THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED, TIMELY, SECURE OR 
UNMODIFIED, (E) THAT THE SOFTWARE OR ANY 
EQUIPMENT, SYSTEM OR NETWORK ON WHICH 
THE SOFTWARE IS USED (INCLUDING THE DEVICE) 
WILL BE FREE OF VULNERABILITY TO INTRUSION 
OR ATTACK AND (F) REGARDING THE USE OR THE 
RESULTS OF THE USE OF THE SOFTWARE IN TERMS 
OF ITS CORRECTNESS, ACCURACY, RELIABILITY, OR 
OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY SONY OR AN AUTHORIZED 
REPRESENTATIVE OF SONY SHALL CREATE A 
WARRANTY, DUTY OR CONDITION OR IN ANY 
WAY INCREASE THE SCOPE OF THIS WARRANTY. 
SHOULD THE SOFTWARE PROVE DEFECTIVE YOU 
ASSUME THE ENTIRE COST OF ALL NECESSARY 
SERVICING, REPAIR OR CORRECTION. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OF IMPLIED WARRANTIES, SO THESE EXCLUSIONS 
MAY NOT APPLY TO YOU TO THE EXTENT THEY 
ARE CONTRARY TO APPLICABLE LAW OF YOUR 
JURISDICTION.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS 
(for purposes of this Section, SONY and each of 
the THIRD-PARTY SUPPLIERS shall be collectively 

referred to as “SONY”) SHALL NOT BE LIABLE FOR 
ANY INCIDENTAL, INDIRECT, SPECIAL, EXEMPLARY 
OR CONSEQUENTIAL LOSS OR DAMAGES FOR 
BREACH OF ANY EXPRESS OR IMPLIED WARRANTY, 
BREACH OF CONTRACT, NEGLIGENCE, STRICT 
LIABILITY OR UNDER ANY OTHER LEGAL THEORY 
RELATED TO THE SOFTWARE, INCLUDING, BUT 
NOT LIMITED TO, ANY DAMAGES ARISING OUT 
OF LOSS OF PROFITS, LOSS OF REVENUE, LOSS 
OF DATA, LOSS OF USE OF THE SOFTWARE OR 
ANY ASSOCIATED HARDWARE, DOWN TIME AND 
USER’S TIME, EVEN IF ANY OF THEM HAVE BEEN 
ADVISED OF THE POSSIBILITY OF SUCH LOSSES 
OR DAMAGES. IN ANY CASE, EACH AND ALL 
OF THEIR AGGREGATE LIABILITY UNDER ANY 
PROVISION OF THIS EULA SHALL BE LIMITED TO 
THE GREATER OF (i) THE AMOUNT ACTUALLY PAID 
FOR THE SOFTWARE, SONY’S PRODUCT WHICH 
THE SOFTWARE IS EMBEDDED IN OR BUNDLED 
WITH AND/OR SONY’S SERVICE TO WHICH THE 
SOFTWARE IS DEDICATED OR (ii) THE FIXED 
AMOUNT AGREED IN WRITING BETWEEN SONY 
AND YOU. SOME JURISDICTIONS DO NOT ALLOW 
SUCH EXCLUSIONS OR LIMITATIONS OF LIABILITY, 
SO THE ABOVE EXCLUSIONS OR LIMITATIONS 
MAY NOT APPLY TO YOU TO THE EXTENT THEY 
ARE CONTRARY TO APPLICABLE LAW OF YOUR 
JURISDICTION.

INDEMNITY
Except as prohibited by applicable law, you agree 
to indemnify and hold harmless SONY and the 
THIRD-PARTY SUPPLIERS and their respective 
affiliates, officers and employees, from any loss, 
claim or demand, including reasonable attorneys’ 
fees, made by any third party due to or arising 
out of your use of the SOFTWARE and/or the 
DEVICE (including, without limitation, any software 
vulnerability caused by such use), your violation of 
this EULA or your failure to fulfill your responsibility 
under this EULA.
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AUTOMATIC UPDATE FEATURE 
From time to time, SONY or the THIRD-PARTY 
SUPPLIERS may automatically update or otherwise 
modify the SOFTWARE, including, but not limited 
to, for purposes of enhancement of security 
functions, error correction and improvement of 
functions, at such time as you interact with SONY’s 
or third parties’ servers, or otherwise. Such updates 
or modifications may delete or change the nature 
of features or other aspects of the SOFTWARE, 
including, but not limited to, functions you may 
rely upon. You acknowledge and agree that such 
activities may occur at SONY’s sole discretion and 
that SONY may condition continued use of the 
SOFTWARE upon your complete installation or 
acceptance of such update or modifications. Any 
updates/modifications shall be deemed to be, 
and shall constitute part of, the SOFTWARE for 
purposes of this EULA. By acceptance of this EULA, 
you consent to such update/modification. 

FORCE MAJEURE
SONY shall not be liable for any delay or failure 
to perform resulting from causes outside its 
reasonable control, including, but not limited to, 
fire, floods, storms, earthquakes, epidemics, acts of 
God, war, terrorism, riots, insurrection, embargos, 
acts of civil, military or governmental authorities, 
nuclear or other accidents, explosions, strikes or 
shortages of transportation facilities, fuel, energy, 
labor or materials.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY 
This EULA (and SONY’s applicable privacy policy 
separately presented to you, if any), as amended 
and modified from time to time, constitute the 
entire agreement(s) between you and SONY with 
respect to the SOFTWARE. The failure of SONY to 
exercise or enforce any right or provision of this 
EULA shall not constitute a waiver of such right or 
provision. If any part of this EULA is held invalid, 
illegal, or unenforceable, that provision shall be 
enforced to the maximum extent permissible so as 
to maintain the intent of this EULA, and the other 
parts will remain in full force and effect. 

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for 
the International Sale of Goods shall not apply 
to this EULA. This EULA shall be governed by 
the laws of Japan, without regards to conflict of 
laws provisions. Any dispute arising out of this 
EULA shall be subject to the exclusive venue of 
the Tokyo District Court in Japan, and the parties 
hereby consent to the venue and jurisdiction of 
such courts. The foregoing does not apply to you 
to the extent applicable law of your jurisdiction 
restricts or prohibits such agreements.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA 
to the contrary, you acknowledge and agree that 
any violation of or non-compliance with this EULA 
by you will cause irreparable harm to SONY, for 
which monetary damages would be inadequate, 
and you consent to SONY obtaining any injunctive 
or equitable relief that SONY deems necessary or 
appropriate in such circumstances. SONY may also 
take any legal and technical remedies to prevent 
violation of and/or to enforce this EULA, including, 
but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its 
sole discretion that you are violating or intend to 
violate this EULA. These remedies are in addition 
to any other remedies SONY may have at law, in 
equity or under contract.

TERMINATION
Without prejudice to any of its other rights, SONY 
may suspend your access or use of the SOFTWARE 
and/or terminate this EULA if you fail to comply 
with any of its terms. In case of such termination, 
you must: (i) cease all use, and destroy any 
copies, of the SOFTWARE; (ii) comply with the 
requirements in the section below entitled “Your 
Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF 
THE TERMS OF THIS EULA AT ITS SOLE DISCRETION 
BY POSTING NOTICE ON A SONY DESIGNATED 
WEB SITE, BY EMAIL NOTIFICATION TO AN EMAIL 
ADDRESS PROVIDED BY YOU, BY PROVIDING 
NOTICE AS PART OF THE PROCESS IN WHICH YOU 
OBTAIN UPGRADES/UPDATES OR BY ANY OTHER 
LEGALLY RECOGNIZABLE FORM OF NOTICE. If 
you do not agree to the amendment, you should 
promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective 
date of any such notice shall be deemed your 
agreement to be bound by such amendment. 

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express 
intended third-party beneficiary of, and shall have 
the right to enforce, each provision of this EULA 
with respect to the software of such party.

YOUR ACCOUNT RESPONSIBILITIES
Should you return your DEVICE to its place of 
purchase, sell or otherwise transfer your DEVICE, 
or if this EULA is terminated, you are responsible 
for and must, if reasonably possible, uninstall 
the SOFTWARE from the DEVICE and delete any 
and all accounts you may have established on 
DEVICE or are accessible through the SOFTWARE. 
You are solely responsible for maintaining the 
confidentiality of any accounts you have with 
SONY or third parties and any usernames and 
passwords associated with your use of the DEVICE.

Should you have any questions concerning this 
EULA, you may contact SONY by writing to SONY 
at the applicable contact address for each area or 
country.
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Especificaciones
Especificaciones generales

Peso	 Aprox. 3,9 kg (sin asa, accesorio de 
acoplamiento VF, tapa inferior)

Dimensiones
		  Consulte página 147.
Requisitos de alimentación
		  12 V CC (de 11 V a 17 V)
		  24 V CC (de 22 V a 32 V)
Consumo de energía
		  Aprox. 60 W (cuando se graba XAVC) 

(11 V a 17 V)
		  Aprox. 220 W (cuando se utiliza la 

AXS-R7 y los periféricos)  
(22 V a 32 V)

Temperatura de funcionamiento
		  De 0 °C a 40 °C
Temperatura de almacenamiento
		  De –20 °C a +60 °C
Tiempo de funcionamiento continuo
		  Aprox. 60 minutos (con BP-FLX75)
Formato de grabación (vídeo)
	 X-OCN XT (cuando la AXS-R7 está conectada)
	 RAW SQ (4K 17:9, 3.8K 16:9) (cuando la AXS-R7 

está conectada)
	 X-OCN ST (cuando la AXS-R7 está conectada)
	 X-OCN LT (cuando la AXS-R7 está conectada)
	 XAVC-I Class480 (4K, QFHD)
	 XAVC-I Class300 (4K, QFHD)
	 MPEG HD422 (HD)
	 Apple ProRes 422 HQ (HD)
	 Apple ProRes 422 (HD)
	 Apple ProRes 422 Proxy (HD)
	 Apple ProRes 4444 (HD)
Formato de grabación (audio)
	 LPCM 8CH (grabación/reproducción de 

2 canales), 24 bits, 48 kHz
Velocidad de fotogramas del proyecto de 

grabación
	 RAW SQ (cuando la AXS-R7 está conectada):
		  4K 17:9/3.8K 16:9
			   59.94P/50P/29.97P/25P/24P/ 

23.98P

	 X-OCN (cuando la AXS-R7 está conectada):
		  6K 3:2
			   25P/24P/23.98P
		  6K 17:9/6K 1.85:1/6K 2.39:1/5.7K 

16:9/4K 6:5/4K 17:9 Surround 
View/4K 4:3/4K 4:3 Surround 
View/3.8K 16:9 Surround View

			   29.97P/25P/24P/23.98P
		  4K 17:9/4K 2.39:1/3.8K 16:9
			   59.94P/50P/29.97P/25P/24P/ 

23.98P
		  4K 4:3/4K 17:9
			   47.95P
	 XAVC-I Class480:
		  4K: 4096×2160
			   29.97P/25P/24P/23.98P
		  QFHD: 3840×2160
			   29.97P/25P/ 23.98P
	 XAVC-I Class300:
		  4K: 4096×2160
			   59.94P/50P/29.97P/25P/24P/ 

23.98P
		  QFHD: 3840×2160
			   59.94P/50P/29.97P/25P/23.98P
	 MPEG HD422(50Mbps):
		  HD: 1920×1080
			   29.97P/25P/23.98P/59.94i/50i
	 Apple ProRes 422 HQ:
		  HD: 1920×1080
			   23.98P/24P/25P/29.97P/50i/59.94i/

50P/59.94P
	 Apple ProRes 422:
		  HD: 1920×1080
			   23.98P/24P/25P/29.97P/50i/59.94i/

50P/59.94P
	 Apple ProRes 422 Proxy (HD)
		  HD: 1920×1080
			   23.98P/24P/25P/29.97P/50i/59.94i/

50P/59.94P
	 Apple ProRes 4444 (HD)
		  HD: 1920×1080
			   23.98P/24P/25P/29.97P

Tiempo de grabación/reproducción
	 XAVC-I Class480 23.98P
		  Aprox. 34 minutos cuando se utiliza 

SBP‑128B/C/D
	 XAVC-I Class300 23.98P
		  Aprox. 54 minutos cuando se utiliza 

SBP‑128B/C/D
	 MPEG2 HD422
		  Aprox. 108 minutos cuando se utiliza 

SBS‑64G1A/B
	 Apple ProRes 422 HQ (HD) 23.98P
		  Aprox. 33 minutos cuando se utiliza 

SBP‑64B/C/D/E
	 Apple ProRes 422 (HD) 23.98P
		  Aprox. 49 minutos cuando se utiliza 

SBP‑64A/B/C/D/E
	 Apple ProRes 422 Proxy (HD) 23.98P
		  Aprox. 145 minutos cuando se utiliza 

SBS‑64G1A/B/C
	 Apple ProRes 4444 (HD) 23.98P
		  Aprox. 22 minutos cuando se utiliza 

SBP‑64B/C/D/E

[Notas]
ˎˎ Los tiempos de grabación y reproducción indicados se 

refieren a la grabación continua como un único clip. Los 
tiempos reales pueden ser menores, según el número 
de clips grabados. El tiempo de grabación/reproducción 
puede variar según las condiciones de uso y las 
características de la memoria.
ˎˎ 	La grabación 6K 3:2 50P/59.94P y 4K 4:3 50P/59.94P X-OCN 

es compatible pero la reproducción en la unidad no.

Cámara

Dispositivo de imagen
		  Sensor de imagen CMOS de un 

solo chip de 35 mm de tamaño 
completo

Número de píxeles
		  24,8 M (total)

Filtros integrados

Filtro ND A

Clear 0.3 (1/2) 0.6 (1/4)
Filtro 
ND B

Clear Clear 0.3 (1/2) 0.6 (1/4)
0.9 (1/8) 0.9 (1/8) 1.2 (1/16) 1.5 (1/32)

1.8 
(1/64)

1.8  
(1/64)

2.1 
(1/128)

2.4 
(1/256)

Sensibilidad ISO
		  ISO 500 (fuente de luz D55)
		  ISO 2500 (fuente de luz D55)
Soporte del objetivo
		  Soporte PL (con el adaptador de 

soporte de objetivo)
		  Soporte E (sin el adaptador de soporte 

del objetivo)
Distancia focal del plano de montaje
		  Soporte PL: 52 mm
		  Soporte E: 18 mm
Latitud	 Más de 15 paradas

Entrada/salida

Entrada de audio
		  CH-1/CH-2: tipo XLR de 5 terminales 

(hembra) (1), LINE / AES/EBU /  
MIC / MIC+48V para seleccionar

Entrada de CC
		  Tipo XLR de 4 terminales (macho) (1), 

de 11 V a 17 V o de 22 V a 32 V CC
Salida CC (12 V)
		  4 terminales Hirose (1), 

de 11 V a 17 V CC (tensión de 
salida: la misma que la tensión 
de entrada; corriente de salida 
máxima: 1,0 A), 
de 22 V a 32 V CC (tensión de 
salida: 15 V; corriente de salida 
máxima: 0,8 A), 
con adaptador de batería
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[Notas]
ˎˎ Se puede emitir una señal REC Tally y recibir una señal REC 

Trigger a través del conector 12V OUT.
ˎˎ Conecte al conector 12V OUT únicamente dispositivos 

con un consumo de 1,0 A o menos cuando la tensión de 
entrada sea de 11 V a 17 V, o de 0,8 A o menos cuando la 
tensión de entrada sea de 22 V a 32 V.

Salida CC (24 V)
		  3 terminales Fischer (2), 

de 11 V a 17 V CC (tensión de 
salida: 24 V; corriente de salida 
máxima: 1,0 A), 
de 22 V a 32 V CC (tensión de 
salida: la misma que la tensión 
de entrada; corriente de salida 
máxima: 2,0 A)

[Nota]
Conecte al conector 24V OUT únicamente dispositivos con 
un consumo de 1,0 A o menos cuando la tensión de entrada 
sea de 11 V a 17 V, o de 2,0 A o menos cuando la tensión de 
entrada sea de 22 V a 32 V.

Salida SDI	 Tipo BNC (4)
		  3G-SDI: SMPTE ST424/425 Level B-DL/

DS
		  HD SDI: cumple con SMPTE ST292
AUX	 LEMO 5 terminales (1)
Salida del visor
		  LEMO 26 terminales (1)
Red		 Tipo RJ45 (1)
Control remoto
		  8 terminales (1)
Salida MONITOR
		  Tipo BNC (1)
		  HD SDI: cumple con SMPTE ST292
Entrada de código de tiempo
		  TC IN: Tipo BNC (1)
Entrada GENLOCK
		  Tipo BNC (1)
Salida HDMI
		  Tipo A (1)
Conector de dispositivo externo
		  Host USB: Tipo A (1)
Salida de auriculares
		  Minitoma estéreo (1)

Salida de altavoces
		  Monoaural

Ranuras de soportes

Tipo	 Ranura ExpressCard/34 (2)
		  Ranura para tarjetas SD (1)

Accesorios suministrados

Accesorio de acoplamiento VF (1)
Asa (1)
Cable VF (A-2203-745-A) (1)
Arandela (circular) (4-730-328-11) (1)
Arandela (1/3 arco) (4-730-328-21) (15)
Tapa del objetivo con soporte E (1)
Antes de utilizar esta unidad (1)

Accesorios opcionales

Visor tipo 0,7 pulgadas
		  DVF-EL200
Sistema de extensión de cámara
		  CBK-3610XS, CBK-3620XS
Adaptador LAN inalámbrica
		  CBK-WA02
Unidad de control remoto
		  RM-B170/B750
		  RCP-1000/1500/1530/3500
		  RCP-1001/1501/3501
Grabadora de memoria portátil
		  AXS-R7
Tarjetas de memoria SxS (SxS PRO X/SxS PRO+/

SxS-1)
		  SBP-240F/120F/64E, 

SBS‑32/64/128G1C

Lector de tarjetas
		  SBAC-US30, SBAC-T40, AXS-AR1
Adaptador para hombro (se coloca en VCT-14 con 

la zapata V)
		  VCT-FSA5
Objetivo con soporte E
		  SELP28135G, SEL1635GM, SEL2470GM, 

SEL70200GM, SEL100400GM, 
SEL1224G, SEL35F14Z, SEL50F14Z, 
SEL85F14GM, SEL90M28G, 
SEL100F28GM

Batería	 BP-FL75, BP-GL95B
Adaptador de CA
		  AC-DN10A
Micrófono	 ECM-680S, ECM-678*, ECM-674* 

(*: EC-0.5X3F5M, cable adaptador 
XLR de 3 terminales a XLR de 
5 terminales necesario)

Adaptador de batería doble
		  BKW-L200 (conexión a través del 

adaptador de conexión de la 
batería)

Monitor SDI/HDMI
		  Serie BVM, serie PVM, serie LMD

El diseño y las especificaciones están sujetos a 
modificaciones sin previo aviso.

Notas
ˎˎ Haga siempre un ensayo de grabación y 
verifique que se grabó bien. SONY NO SE 
HACE RESPONSABLE POR DAÑOS DE NINGÚN 
TIPO, INCLUYENDO PERO NO LIMITADO A 
LA COMPENSACIÓN O PAGO POR FALLO EN 
HACER CUALQUIER TIPO DE CONTENIDO DE 
GRABACIÓN POR MEDIO DE ESTA UNIDAD 
O SU SOPORTE DE GRABACIÓN, SISTEMAS 
DE MEMORIA EXTERNA O CUALQUIER OTRO 
SOPORTE O SISTEMAS DE MEMORIA.
ˎˎ Verifique siempre que esta unidad funciona 
correctamente antes de utilizarla. SONY NO SE 
HACE RESPONSABLE POR DAÑOS DE NINGÚN 
TIPO, INCLUYENDO PERO NO LIMITADO A LA 
COMPENSACIÓN O PAGO POR LA PÉRDIDA DE 
GANANCIAS PRESENTES O FUTURAS DEBIDO 
AL FALLO DE ESTA UNIDAD, YA SEA DURANTE 
LA VIGENCIA DE LA GARANTÍA O DESPUÉS 
DEL VENCIMIENTO DE LA GARANTÍA NI POR 
CUALQUIER OTRA RAZÓN.
ˎˎ SONY NO SE HACE RESPONSABLE POR 
RECLAMACIONES DE NINGÚN TIPO 
REALIZADAS POR USUARIOS DE ESTA UNIDAD 
O POR TERCEROS.
ˎˎ SONY NO SE HACE RESPONSABLE POR LA 
PÉRDIDA, REPARACIÓN O REPRODUCCIÓN 
DE CUALQUIER DATO GRABADO EN EL 
SISTEMA DE ALMACENAMIENTO INTERNO, 
SOPORTES DE GRABACIÓN, SISTEMAS DE 
ALMACENAMIENTO EXTERNO O CUALQUIER 
OTRO SISTEMA DE ALMACENAMIENTO.
ˎˎ SONY NO SE HACE RESPONSABLE DE LA 
FINALIZACIÓN NI DE LA INTERRUPCIÓN, 
POR LA CIRCUNSTANCIA QUE FUERA, DE 
CUALQUIER SERVICIO RELACIONADO CON 
ESTA UNIDAD.
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Dimensiones

147

25
25
25
25
15,2

27,7

25

4,45

14

25

25

25
25
13

Ø5,2, profundidad: 5
UNC 1/4-20, profundidad: 10,5

2-UNC 3/8-16, 
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profundidad: 5

2-M3, 
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73

57,1 57,1
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80 85,5

Marcas registradas

ˎˎ XAVC y  son marcas comerciales 
registradas de Sony Corporation.
ˎˎ Los términos HDMI y HDMI High-Definition 
Multimedia Interface, y el Logotipo HDMI 
son marcas comerciales o marcas registradas 
de HDMI Licensing Administrator, Inc. en los 
Estados Unidos y en otros países.
ˎˎ Todos los nombres del sistema y de productos 
son marcas comerciales o marcas registradas 
de sus respectivos propietarios. Los elementos 
registrados como marca no están señalados con 
los símbolos ® o ™ en este documento.
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